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Preface

Audience for This Guide
Welcome to Release 11i of the Oracle Quoting User Guide.

This guide assumes you have a working knowledge of the following:

The principles and customary practices of your business area.
Oracle Quoting
The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications
product information.

How To Use This Guide

This guide contains the information you need to understand and use Oracle

Quoting.

Chapter 1 provides overviews of the application and its components, and
explanations of key concepts, features, functions, and the application's
relationships to other Oracle or third-party applications.

Chapter 2 provides process-oriented, task-based procedures for using the
application to perform essential business tasks.

Chapter 3 lists the procedures needed to create quotes (HTML)
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Chapter 4 includes information on creating, modifying, and deleting templates
(HTML)

Chapter 5 provides procedures for performing searches (HTML)
Chapter 6 provides information on performing credit checks (HTML)
Chapter 7 includes information on pricing (HTML)

Chapter 8 provides information on customers and relationships (HTML)

Chapter 9 contains information on entering and modifying address and
payment information (HTML)

Chapter 10 contains information on modifying quotes (HTML)
Chapter 11 includes procedural information for copying quotes (HTML)
Chapter 12 provides information on creating proposals.

Chapter 13 describes the concepts and procedures associated with approvals
(HTML)

Chapter 14 contains information on contracts integration (HTML)

Chapter 15 provides information on creating notes, tasks, and attachments
(HTML)

Chapter 16 lists the steps necessary to enable and use security (HTML)
Chapter 17 contains information on publishing and printing (HTML)
Chapter 18 contains information on placing orders from quotes (HTML)
Chapter 19 provides information on using folder functionality (Forms)
Chapter 20 lists the procedures needed to create quotes (Forms)
Chapter 21 provides procedures for performing searches (Forms)

Chapter 22 provides information and procedures for performing credit checks
(Forms)

Chapter 23 includes information on pricing (Forms)
Chapter 24 provides information on customers and relationships (Forms)

Chapter 25 contains information on entering and modifying address and
payment information (Forms)

Chapter 26 contains information on modifying quotes (Forms)

Chapter 27 includes procedural information for copying quotes (Forms)



Chapter 28 describes the concepts and procedures associated with approvals
(Forms)

Chapter 29 contains information on contracts integration (Forms)

Chapter 30 provides information on creating notes and attachments (Forms)
Chapter 31 lists the steps necessary to enable and use security (Forms)
Chapter 32 contains information on publishing and printing (Forms)
Chapter 33 contains information on placing orders from quotes (Forms)

Appendix A provides a reference to the Oracle Quoting HTML User Interface
an.

Appendix B provides a reference to the Oracle Quoting Forms User Interface
an.

Typographic Conventions

The following table lists the typographic conventions used in this manual:

Convention Meaning

italic text Book titles

Courier text User commands and file content examples

UPPERCASE Structured Query Language (SQL) commands, initialization

parameters, responsibilities, or environment variables

boldface text Menu, button, keyboard, form options, and profile options

<>

Emphasized words or phrases

Angle brackets enclose user-supplied names.

Note: Do not type the angle brackets.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible, with good usability, to the disabled community. To that end, our
documentation includes features that make information available to users of
assistive technology. This documentation is available in HTML format, and contains
markup to facilitate access by the disabled community. Standards will continue to
evolve over time, and Oracle Corporation is actively engaged with other
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market-leading technology vendors to address technical obstacles so that our
documentation can be accessible to all of our customers. For additional information,
visit the Oracle Accessibility Program Web site at

http:/ /www.oracle.com/accessibility /.

Accessibility of Code Examples in Documentation

JAWS, a Windows screen reader, may not always correctly read the code examples
in this document. The conventions for writing code require that closing braces
should appear on an otherwise empty line; however, JAWS may not always read a
line of text that consists solely of a bracket or brace.

Other Information Sources

XXii

You can choose from many sources of information, including online documentation,
training, and support services, to increase your knowledge and understanding of
Oracle Quoting.

If this guide refers you to other Oracle Applications documentation, use only the
Release 11i versions of those guides.

Online Documentation

All Oracle Applications documentation is available online (HTML or PDF). Online
help patches are available on MetaLink.

Related Documentation

Oracle Quoting shares business and setup information with other Oracle
Applications products. Therefore, you may want to refer to other product
documentation when you set up and use Oracle Quoting.

You can read the documents online by choosing Library from the expandable menu
on your HTML help window, by reading from the Oracle Applications Document
Library CD included in your media pack, or by using a Web browser with a URL
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at
http:/ /oraclestore.oracle.com.



Documents Related to All Products

Oracle Applications User’s Guide

This guide explains how to enter data, query, run reports, and navigate using the
graphical user interface (GUI) available with this release of Oracle Quoting (and any
other Oracle Applications products). This guide also includes information on
setting user profiles, as well as running and reviewing reports and concurrent
processes.

You can access this user’s guide online by choosing “Getting Started with Oracle
Applications” from any Oracle Applications help file.

Documents Related to This Product

Oracle Quoting Implementation Guide

This document provides information and instructions to help you successfully
implement Oracle Quoting.

Installation and System Administration

Oracle Applications Concepts

This guide provides an introduction to the concepts, features, technology stack,
architecture, and terminology for Oracle Applications Release 11i. It provides useful
information to read before an installation of Oracle Applications. This guide also
introduces the concepts behind Applications-wide features such as Business
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications

This guide provides instructions for managing the installation of Oracle
Applications products. In Release 117, much of the installation process is handled
using Oracle Rapid Install, which minimizes the time to install Oracle Applications,
the Oracle8 technology stack, and the Oracle8i Server technology stack by
automating many of the required steps. This guide contains instructions for using
Oracle Rapid Install and lists the tasks you need to perform to finish your
installation. You should use this guide in conjunction with individual product
user’s guides and implementation guides.
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Upgrading Oracle Applications

Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or
Release 11.0 products to Release 11i. This guide describes the upgrade process and
lists database and product-specific upgrade tasks. You must be either at Release 10.7
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i.
You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications

Use this guide to help you run the various AD utilities, such as AutoUpgrade,
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and
others. It contains how-to steps, screenshots, and other information needed to run
the AD utilities. This guide also provides information on maintaining the Oracle
applications file system and database.

Oracle Applications Developer’s Guide

This guide contains the coding standards followed by the Oracle Applications
development staff. It describes the Oracle Application Object Library components
needed to implement the Oracle Applications user interface described in the Oracle
Applications User Interface Standards for Forms-Based Products. It also provides
information to help you build your custom Oracle Forms Developer 6i forms so that
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle
Applications development staff. It describes the UI for the Oracle Applications
products and how to apply this Ul to the design of an application built by using
Oracle Forms.

Other Implementation Documentation

Oracle Applications Flexfields Guide

This guide provides flexfields planning, setup and reference information for the
Oracle Quoting implementation team, as well as for users responsible for the
ongoing maintenance of Oracle Applications product data. This manual also
provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals

Each eTechnical Reference Manual (eTRM) contains database diagrams and a
detailed description of database tables, forms, reports, and programs for a specific



Oracle Applications product. This information helps you convert data from your
existing applications, integrate Oracle Applications data with non-Oracle
applications, and write custom reports for Oracle Applications products. Oracle
eTRM is available on Metalink

Oracle CRM Application Foundation Implementation Guide

Many CRM products use components from CRM Application Foundation. Use this
guide to correctly implement CRM Application Foundation.

Training and Support

Training

Oracle offers training courses to help you and your staff master Oracle Quoting and
reach full productivity quickly. You have a choice of educational environments. You
can attend courses offered by Oracle University at any one of our many Education
Centers, you can arrange for our trainers to teach at your facility, or you can use
Oracle Learning Network (OLN), Oracle University's online education utility. In
addition, Oracle training professionals can tailor standard courses or develop
custom courses to meet your needs. For example, you may want to use your
organization’s structure, terminology, and data as examples in a customized
training session delivered at your own facility.

Support

From on-site support to central support, our team of experienced professionals
provides the help and information you need to keep Oracle Quoting working for
you. This team includes your Technical Representative, Account Manager, and
Oracle’s large staff of consultants and support specialists with expertise in your
business area, managing an Oracle8i server, and your hardware and software
environment.

OracleMetalLink

OracleMetaLink is your self-service support connection with web, telephone menu,
and e-mail alternatives. Oracle supplies these technologies for your convenience,
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain
information and advice from technical libraries and forums, download patches,
download the latest documentation, look at bug details, and create or update TARs.
To use MetaLink, register at (http:/ /metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows:
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Technical Libraries/ERP Applications/Applications Installation and
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the
Self-Service Toolkit page as follows: Technical Libraries/ERP
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data
Browser, database triggers, or any other tool to modify Oracle Applications data
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using
Oracle Applications can update many tables at once. But when you modify Oracle
Applications data using anything other than Oracle Applications, you may change a
row in one table without making corresponding changes in related tables. If your
tables get out of synchronization with each other, you risk retrieving erroneous
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications
automatically checks that your changes are valid. Oracle Applications also keeps
track of who changes information. If you enter information into database tables
using database tools, you may store invalid information. You also lose the ability to
track who has changed your information because SQL*Plus and other database
tools do not keep a record of changes.

About Oracle
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Oracle Corporation develops and markets an integrated line of software products
for database management, applications development, decision support, and office
automation, as well as Oracle Applications, an integrated suite of more than 160
software modules for financial management, supply chain management,
manufacturing, project systems, human resources and customer relationship
management.

Oracle products are available for mainframes, minicomputers, personal computers,
network computers and personal digital assistants, allowing organizations to



integrate different computers, different operating systems, different networks, and
even different database management systems, into a single, unified computing and
information resource.

Oracle is the world’s leading supplier of software for information management, and
the world’s second largest software company. Oracle offers its database, tools, and
applications products, along with related consulting, education, and support
services, in over 145 countries around the world.
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Part |

Introduction and Overview

This part contains the following chapters:
s Chapter 1, "Introduction to Oracle Quoting"
s Chapter 2, "Overview of Using Oracle Quoting"






1

Introduction to Oracle Quoting

This chapter discusses the key features and process flows of Oracle Quoting.
Sections in this chapter include:

Section 1.1, "Overview"
Section 1.2, "Oracle Quoting Key Features"
Section 1.3, "Oracle Quoting Integrations”

Section 1.4, "What’s New"
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Overview

1.1 Overview

Oracle Quoting enables simple, secure creation and management of customer
quotes across all sales and interaction channels. Organizations can use Oracle
Quoting to propose product solutions and perform negotiations, while enforcing
consistent business rules throughout the sales cycle.

Quoting users can create quotes using modifiable quote templates, add and
configure complex products, manually adjust prices, and perform real-time global
availability checks. Users can accept product trade-ins and assign sales credits.
Quoting integration with Contracts allows users to negotiate a quote with a specific
sales contract. Complex customer approval chains are supported and users can
publish and print quotes, and eventually convert quotes to orders.

Oracle Quoting is available with an HTML and a Forms user interface. Oracle
Quoting-HTML is integrated with Sales Online and Oracle Quoting-Forms with
Oracle TeleSales.

1.2 Oracle Quoting Key Features

Oracle Quoting allows you to:

= Add configured products to quote (including guided selling)

= Add service products to quote

= Save/personalize searches (HTML only) and use advanced search capabilities
= Allocate sales credits

= Initiate approvals, using the Oracle Approvals engine, with out-of-the-box
notifications

s Check availability of products

= Convert quotes to orders

= Copy existing quotes

= Create notes, tasks (HTML only), and attachments
= Create quote from opportunity

s Create quotes from templates (HTML only)

= Allow terms and conditions to be displayed with and printed on the quote
through enhanced integration with Oracle Contracts

= Print quotes in PDF and RTF formats with enhanced printing
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Oracle Quoting Integrations

Enforce key business practices in the sales cycle with enhanced quote status and
transition model

Control quote access and update with quote security
Restrict salesperson’s quote creation ability to specific customers
Search Customer Install Base for Trade-Ins (HTML only)

Search customer Install Base and Pending Orders for products to which you can
apply services

Share quotes with customers via the Oracle iStore web storefront
Split-ship products
Support flexible pricing within a quote including manual price overrides

Authorize credit card payment

1.3 Oracle Quoting Integrations

Oracle Quoting integrates with the following modules:

Section 1.3.1, "Oracle Receivables"

Section 1.3.2, "Oracle Advanced Pricing"
Section 1.3.3, "Oracle Bill of Materials"

Section 1.3.4, "Oracle General Ledger"

Section 1.3.5, "Oracle Inventory"

Section 1.3.6, "Oracle Order Management"
Section 1.3.7, "Oracle Approvals Management"
Section 1.3.8, "Oracle Advanced Planning”"

Section 1.3.9, "Oracle Configurator”

1.3.1 Oracle Receivables

Provides tax information and customer account information. Refer to the Oracle
Receivables User Guide for complete information.
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Oracle Quoting Integrations

1.3.2 Oracle Advanced Pricing

Allows set up of price lists, discounts, adjustments, and promotions. Refer to the
Oracle Pricing User’s Guide for complete information.

1.3.3 Oracle Bill of Materials

Contains information about the components associated with a product. Refer to the
Bill of Materials User’s Guide for complete information.

1.3.4 Oracle General Ledger

Enables set up of ledgers and books and store exchange rates. Refer to the Oracle
General Ledger User Guide for complete information

1.3.5 Oracle Inventory

Provides Availability to Promise (ATP) and reservation functions, and all product
information from Inventory. Refer to the Oracle Inventory User’s Guide for complete
information

1.3.6 Oracle Order Management

Allows creation of orders from quotes. Refer to the Oracle Order Management User’s
Guide for complete information

1.3.7 Oracle Approvals Management

Allows set up of approvals hierarchies, rules and notifications. Refer to
Implementing Oracle Approvals Management for complete information.

1.3.8 Oracle Advanced Planning
Oracle Quoting uses Advanced Planning and Scheduling for Global ATP Check.

1.3.9 Oracle Configurator

Provides the ability to configure model items. Refer to the Oracle Configurator
Installation Guide and Oracle Configurator Implementation Guide for complete
information.
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What's New

1.4 What’s New

This document describes functionality to be delivered in the Oracle E-Business Suite
11.5.9 release. If you are implementing this product prior to the release, using
product minipacks or family packs, some new functionality may be dependent on
integration with other Oracle products. Please consult MetaLink for relevant
product patches and documentation.

The following functionality is new in this release:

Customer Credit Checking

Oracle 8i interMedia-based Product Search
Quoting to Prospects

Quote Pricing and Tax Calculation on Request
Quote and Template Line Copying

Defaulting of Shipping and Billing Information
Terms Substitution

Compliance with Latin American Tax Requirements
Improved Configuration and Display
Enhanced Line Numbering

Account Description Display

Solution-Based Modeling

HTML Ul Only

Selectable Columns

Oracle Proposals Integration
Base UOM Modification
Streamlined Quote Creation Flow

Line-Level Charge Displaying

Forms Ul Only

Enhanced User Interface

Basic and Advanced Quote Searches
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= Improved Customer Search
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Overview of Using Oracle Quoting

This chapter provides an overview of the user interface, and the major tasks you can
perform using Oracle Quoting. Sections in this chapter include:

= Section 2.1, "Accessing Oracle Quoting HTML Interface"
= Section 2.2, "Accessing the Oracle Quoting Forms User Interface"

= Section 2.3, "Summary of Oracle Quoting Tasks"
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Accessing Oracle Quoting HTML Interface

2.1 Accessing Oracle Quoting HTML Interface

The Quotes page is the gateway to viewing quote details and modifying existing
quotes. From this page you can search for quotes, create a new quote, and copy an

existing quote into a new quote.

At initial login the Quotes page displays the default Saved Search results as follows:

s Quote name

s Quote number

s Opportunity Name

»  Customer name

s Customer account number
»  Customer contact name

= Status

= Web published or not

= Expiration date

=  Amount

s Order detail

You can designate a different Saved Search as your Quotes page default listing. For

more information see Section 5.4, "Saved Searches".

Prerequisites

You must be logged in as a valid Quoting user. This will be assumed for all of the

HTML procedures in this guide.

Steps

1. Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA HTML/jtflogin.jsp

Note: Your system administrator can give you the values that
should replace <host > and <apache ports> in this URL.

2. Enter your user name and password, then select Go.
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Summary of Oracle Quoting Tasks

The Quotes page opens, displaying the default saved search results.

2.2 Accessing the Oracle Quoting Forms User Interface

The Quoting form is your main workspace in the Forms UI. From this form you can
create new quotes, query and modify existing quotes, view customer history, and
print quotes, in addition to a number of other tasks.

To access the Quoting form in the Oracle Quoting forms Ul:

Login
Log into Oracle Applications.

Responsibility
Quoting Sales Agent or Quoting Sales Manager

Prerequisites
You must be set up as an Application User with a valid password.

Steps
1. In the Navigator, choose Quoting.

The Quoting form displays.

2.3 Summary of Oracle Quoting Tasks
Use Oracle Quoting to perform the following types of tasks:

HTML
= Chapter 3, "Creating Quotes"

s Chapter 4, "Creating and Modifying Templates"
s Chapter 5, "Searching"

s Chapter 6, "Credit Checks"

s Chapter 7, "Pricing Products and Quotes"

s Chapter 8, "Customers and Relationships"

»  Chapter 9, "Entering Address and Payment Information"
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= Chapter 10, "Modifying Quotes"

= Chapter 11, "Copying Quotes"

»  Chapter 12, "Creating Proposals from Quotes"
s Chapter 13, "Initiating Approvals"

»  Chapter 14, "Applying Contracts to Quotes"

s Chapter 15, "Enabling Quoting Security"

= Chapter 16, "Notes, Tasks, and Attachments"
s Chapter 17, "Publishing and Printing"

= Chapter 18, "Placing Orders"

Forms
= Chapter 19, "Using Folder Functionality"

s Chapter 20, "Creating Quotes"

»  Chapter 21, "Searching"

»  Chapter 22, "Credit Checks"

s Chapter 23, "Pricing Products and Quotes"
»  Chapter 24, "Customers and Relationships"
= Chapter 26, "Modifying Quotes"

= Chapter 25, "Entering Address and Payment Information"
s Chapter 27, "Copying Quotes"

»  Chapter 28, "Initiating Approvals"

s Chapter 29, "Notes and Attachments"

= Chapter 30, "Applying Contracts to Quotes"
= Chapter 31, "Publishing and Printing"

»  Chapter 32, "Enabling Quoting Security"

»  Chapter 33, "Placing Orders"
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User Procedures - HTML

This part contains the following chapters:

= Chapter 3, "Creating Quotes"

s Chapter 4, "Creating and Modifying Templates”
s Chapter 5, "Searching"

s Chapter 6, "Credit Checks"

s Chapter 7, "Pricing Products and Quotes"

s Chapter 8, "Customers and Relationships"

s Chapter 9, "Entering Address and Payment Information”
s Chapter 10, "Modifying Quotes"

s Chapter 11, "Copying Quotes"

s Chapter 12, "Creating Proposals from Quotes"

s Chapter 13, "Initiating Approvals"

s Chapter 14, "Applying Contracts to Quotes"

s Chapter 15, "Enabling Quoting Security"

= Chapter 16, "Notes, Tasks, and Attachments"

s Chapter 17, "Publishing and Printing"

= Chapter 18, "Placing Orders"
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Creating Quotes

This section explains the procedures necessary to create a quote in Oracle Quoting.

Overview of Creating Quotes

Creating a Quote

Creating a Quote From an Opportunity
Creating a Quote From a Template

Creating a New Version of a Quote

Creating Quotes  3-1



Overview of Creating Quotes

3.1 Overview of Creating Quotes
A quote can be created as a new quote or as a copy of an existing quote.

When you create a quote, you must specify the quote name, the customer, and the
customer account (if the customer has an existing account). If the customer does not
have an existing account, it is created based on the setting of the profile option
ASO: Auto Account Creation. See Section 8.1.2, "Creation of Accounts" for more
information. Defaulting logic exists for many of the other fields. A record for the
new quote is created when you enter the quote name, a customer and select Apply.

With the exception of customer, customer account, currency and order type, other
attributes can be changed or added after quote creation.

The searchable list of customers comes from Oracle Receivables. You can create new
customers if the profile option ASO: Create New Customer is set to Yes at the
appropriate level.

3.1.1 Understanding Quotes

A quote is an offer to a customer that contains priced products and shows a total
price for the offer. You create a quote when you accumulate products for a customer
and save your work.

Oracle Quoting maintains a list of all of the quote versions you have created. You
can modify only the latest version of a quote. Previous versions of a quote are
read-only: You can neither modify the quote from the user interface nor change the
quote status but you can create new versions from old versions.

You cannot delete quotes once you have created them. Your administrator can set
quotes to expire automatically after a certain period of time.

3.1.2 Quote Status

The status of a quote indicates the evolution of a quote from the initial offer to order
placement. Quote status and transitions reflect your sales process. Status data
indicates progression of the sales cycle.

The status of a quote determines what kind of activities related to that quote are
possible. Your application administrator can set up and customize the rules
governing each updateable status in several ways, including the following:

= Decide which statuses allow modification of the quote and which are read-only

s Add statuses
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= Change status names
= Define, by application, a default quote status on a new quote or version

= Decide the statuses to which a given status can change

3.1.2.1 Pre-Defined Quote Statuses
The following table shows the seeded quote statuses that are available.

Quote Status Description Read-only
Approval Canceled  Sales representative canceled the approval process. No
Approval Pending Quote is pending approval. Yes
Approval Rejected Approval was rejected by the approvers. No
Approved Approved by the approvers. Yes
Contract Canceled Contract canceled by the contract administrator. Yes
Contract Pending Contract is review with the contract specialist. Yes
Contract Required Contract specialist to author and approve contract Yes
required after approval process.
Draft Initial status. No
Inactive No more activity allowed. Yes
Order Submitted Order submitted to Oracle Order Management. Yes
StoreDraft For iStore internal use only. No

The statuses in the following table exist for backward compatibility (for previous
version of Oracle Quoting), but there is no functionality behind them.

Quote Status Description Read-only
Bid Could be used to show that the quote was presented to No

a customer.
Lost Could be used to show that the customer No

declined /rejected the quote.
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Quote Status Description Read-only

Problem Could be used to show there is a problem with the No

quote being submitted as an order.

Note: The system will not automatically set this status
if the order is not submitted.

Reviewed Could be used to show that the quote was reviewed No

internally.

If a quote status is read only you only update the following attributes:

Modify tasks and notes.

Change the quote status, as long as the transition is valid. Thus, you can
potentially place an order, initiate approval, request contract creation or change,
etc.

Publish or unpublish a quote, if publishing is enabled and the quote satisfies
publishing criteria.

Modify payment information, until the order is submitted.

Add attachments. You cannot remove, or replace existing attachments.

Note: A user can fully update a quote in read-only status if the
system administrator sets the profile option ASO: Status Override
to Yes for that specific user. The user must have update access to
the quote to be able to modify it.

If you want to update a quote in read-only status:

Transition to an updateable status.
Create a new quote version.

Use Duplicate Quote to create a brand new quote.

3.1.2.2 Rules for Quote Status Changes

Status changes are regulated to prevent accidental changes, such as reverting an
ordered quote status back to a non-ordered status.

The following table shows the seeded transition rules for quote status changes.
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Table 3-1 Seeded Quote Status Transitions

From To User Maintainable
Approval Pending Approved No
Approval Pending Approval Canceled No
Approval Pending Approval Rejected No
Approval Pending Contract Required No
Contract Pending Contract Approved No
Contract Pending Contract Cancelled No
StoreDraft Draft No
StoreDraft Inactive No
StoreDraft Order Submitted No
StoreDraft Contract Pending No

3.2 Creating a Quote

To create a quote in the HTML UL

Prerequisites

The profile option ASO: New Quote Security must be set to No or Sales Team at
the appropriate level to create new, standalone quotes. If set to Yes, you can still
create quotes from opportunities. See Chapter 15, "Enabling Quoting Security", for

more information.

Steps

1. In the Quotes page, select Create Quote.

Note: If the ASO: Automatic Numbering profile option is set to
No at the appropriate level, you can enter a quote number which
will be unique across all quotes. If this profile option is set to Yes,

the system will automatically assign a number.

The Create Quote page opens.

2. Enter a name in the Quote Name field.
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3. Enter the full Customer Name or enter a partial value and select Go to search
for a customer.

When you select a customer from the search results:

= If you select a customer with an address, the address field is automatically
populated. See Section 9.2, "Address Defaulting" for more information.

= The contact field is automatically populated, if a contact is displayed in the
customer search. If there is no contact, the field is left blank.

= The account number field is automatically populated based on the selection
in the search results. If the customer has no accounts, one will be created
based on the setting of ASO: Auto Account Creation. See Section 8.1.2,
"Creation of Accounts” for more information.

Note: You can also search by entering the exact account number in
the Account Number field and selecting Go. The Customer Name
and address will be populated from the values associated with the
account number selected from the search results.

4. Optionally, enter a Contact Name or enter a partial value and select Go to
search for the contact.

5. Optionally, change the defaulted quote-to address, if any, or select Go to search
for customer addresses.

6. Optionally, change the default expiration date.

The expiration date is defaulted based on the profile options ASO: Default
Expiration Date GL Calendar and ASO: Default Expiration GL Period Type,
or the profile option ASO: Quote Duration. See the Oracle Quoting
Implementation Guide for more information.

7. Optionally, select a different Primary Salesperson.

Note: The Primary Salesperson defaults to the user creating the
quote, if that user is set up as a salesperson for the current
operating unit. If not, it defaults to the sales representative
designated in the profile option ASO: Default Salesrep.

8. Optionally, select a different primary salesgroup from the drop-down menu.
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10.

1.
12.

13.
14.
15.
16.

The primary salesgroup defaults from the profile option ASO: Default
Salesgroup. See the Oracle Quoting Implementation Guide for more information.

Optionally, select a different sales channel using the drop-down menu.
Optionally, select a source for the quote.

Source Name refers to various marketing sources, such as campaign, that are set
up in Oracle Marketing Online. If the quote is created from an opportunity, the
source name defaults from Oracle Sales Online (OSO). If you are creating a
quote directly, you can specify a source name in this field.

Optionally, use the drop-down menu to select a different Order Type.

Optionally, use the drop-down menu to select an Agreement. The Agreement
menu lists agreements that are valid for the customer and agreements that
apply to all customers.

Optionally, use the drop-down menu to select a different Currency.
Optionally, use the drop-down menu to select a different price list.
Optionally, use the drop-down menu to select a different Contract Template.
Select Apply. The quote is created and the Lines page opens.

From this page you can:

= Add products to the quote

= Add services to the quote

Note: A record for the new quote is created when you enter the
quote name. Oracle Quoting then generates the quote and version
numbers, creation date, and status.

The quote number is unique across all quotes for all customer IDs
and account numbers. For a new quote the version number is 1 and
the status is draft.
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3.3 Creating a Quote From an Opportunity

To create a quote from an opportunity:

Prerequisites
The user must be logged into Oracle Sales Online to perform this procedure.

Use an existing opportunity or create a new one. See the Oracle Sales Online User
Guide for detailed instructions on creating and accessing opportunities.

Steps
1. Navigate to Opportunity > Opportunities.

2. Select the opportunity you want to use. The Opportunity Details page opens.
3. Select Create Quote. The Create Quote From Opportunity page opens.

4. The Quote Name field defaults from the Opportunity Name. This field can be
edited.

5. The following fields, when available, are defaulted to the quote, and cannot be
changed:

s Customer Name

s Account Number

Note: If the customer has only one account number, the account
number and description default into the account field. If there are
multiple account numbers, they are displayed, with descriptions, in
a drop-down menu for selection. If there are no account numbers,
one will be created in Quoting based on the setting of the profile
option ASO: Auto Account Creation. See Section 8.1.2, "Creation of
Accounts" or the Oracle Quoting Implementation Guide for more
information.

s Opportunity Name

6. To select or change the Contact Name, enter a partial value and %, then press
Go, for a limited list. Press Go for a full list of all possible contacts.

7. To change the default Address:
»  Edit the field directly

3-8 Oracle Quoting User Guide



Creating a Quote From a Template

= Enter a partial value and %, then press Go for a limited list
= Press Go for a full list of all available customer addresses
8. Enter a new expiration date or use the calendar icon to choose a date.

9. To select or change the Primary Salesperson, enter a partial value and %, then
press Go, for a limited list, or press Go for a full list of contacts.

10. Optionally, using the relevant drop-down menu, select the:
s Primary Sales Group
= Sales Channel
= Source Name
s Order Type
= Agreement
s Price List
= Contract Template
s Currency
11. Select Apply to create the quote.
The Lines page opens.

3.4 Creating a Quote From a Template
To create a quote from a template:

Prerequisites
None

Steps
1. Navigate to the Templates page

2. Select the template(s) to use by checking the appropriate box(es).
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Note: If the profile option ASO: Manage Quote Template is set to
No at the appropriate level, you will be able to create a quote by
selecting the template hyperlink and then selecting Create Quote.
You will not be able to update templates.

3. Select Create Quote. The Create Quote page opens. Refer to Section 3.2,
Creating a Quote for detailed information.

3.5 Creating a New Version of a Quote

View all versions of a quote from the Overview page, left menu bar by selecting
Versions under Other Information.

To create a new version of a quote:

Prerequisites
= The user must have update access to the quote.

= The highest version of the quote is not in one of the following statuses:
= Approval Pending
s Ordered
= Contract Cancelled

= A contract is not attached to the quote.

Steps
1. Display the quote in the Quote Overview page.

Note: To view all versions of the quote navigate to Other
Information in the left hand menu bar and select Versions.

2. From the Actions menu, select Create New Version.

The page displays confirmation that a new version was created. The version
number increases by one.
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Creating and Modifying Templates

This section outlines the creation and use of templates in Oracle Quoting. This
functionality is only available in the HTML UL

Overview of Templates

Creating a Template

Creating a Quote From a Template
Modifying a Template

Deleting a Template
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4.1 Overview of Templates

In Oracle Quoting you can create quote templates that predefine products and
quantities thus automating recurrent quote content. For configured products, add a
product to your template, launch Configurator and save the resulting configuration
in the template. You can add service products to templates.

4.2 Creating a Template

To create a quote template:

Prerequisites

= The profile option ASO: Manage Quote Template must be set to Yes. If set to
No, you will not be able to update templates.

Steps
1. Select the Templates link in the main Quotes page. The Templates page opens.

2. Select Create Template. The Create Template page opens.
3. Enter a name in the Template Name field.

4. Optionally, enter a description for the template.

5

Select Apply. A Template Detail page displays with confirmation that the
template was created.

6. Toadd a line to the template, select Add Product. The Search and Select:
Product page opens.

7. Select a product category and type in keyword criteria for your product search.
8. Select Go. The search results display at the bottom of the page.

9. Select the product(s) to add to your template by placing a check in the Select
box.

10. Choose Select to add the products to the quote
OR

Choose Select and Add More to add selected products to the quote and return
to the Search and Select: Product page to search for more products. The
Template Details page displays the template with the products you added.

From this page, you can:
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1.

= Change the quantity of a product by overwriting the value in the Quantity
field and selecting Apply. If changing the quantity of a model product, the
quantity of all the components will be updated to match the model
product’s quantity. If changing the quantity of a component, the top level
model product and all other components will be updated to match the
quantity.

Note: The quantities of the model and components will be
synchronized but will not necessarily be equal.

= Add a service by choosing Add Services from the drop-down menu and
selecting Go. See Section 10.3, "Adding Services to Quotes" for more
information.

= Configure a model product by choosing Configure from the drop-down
menu and selecting Go. See Section 10.4, "Configuring Products" for more
information.

= Duplicate an existing configuration or a line by selecting Duplicate Line
from the drop-down menu and selecting Go. See Section 10.4.2,
"Duplicating an Existing Configuration in a Quote" and Section 10.5,
"Duplicating a Line" for more information.

= Delete a line or a component line by choosing Remove Line from the
drop-down menu and selecting Go. See Section 10.2, "Removing Products
From the Quote" and Section 10.4.1, "Deleting a Component" for more
information.

= Modify an existing service by selecting Modify Service from the
drop-down menu and selecting Go. See Section 10.3.3, "Modifying a
Service" for more information.

Select Apply to save the template.
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4.3 Creating a Quote From a Template

To create a quote from a template:

Prerequisites
None

Steps

1.
2.

Navigate to the Templates page
Select the template(s) to use by checking the appropriate box(es).

Note: If the profile option ASO: Manage Quote Template is set to
No at the appropriate level, you will be able to create a quote by
selecting the template hyperlink and then selecting Create Quote.
You will not be able to update templates.

Select Create Quote. The Create Quote page opens. Refer to Section 3.2,
"Creating a Quote" for detailed information.

The products from the template are added to the quote and displayed in the
Lines page.

4.4 Modifying a Template

To modify a template:

Prerequisites

The profile option ASO: Manage Quote Template must be set to Yes. If set to No,
you will not be able to update templates

Steps

1.
2.
3.

Navigate to the Templates page.
Select to search by template name or description.

Enter the template name or description in the text field, using the wildcard as
necessary.

Select Go. The template matching the search criteria displays in the Results
section.

4-4 Oracle Quoting User Guide



Modifying a Template

Select the Name hyperlink for the template you want to modify. The Template
Detail page opens.

Add a product by selecting Add Product.
Change quantities by entering a number in the Quantity field.

If changing the quantity of a model product, the quantity of all the components
will be updated to match the model product’s quantity. If changing the quantity
of a component, the top level model product and all other components will be
updated to match the quantity.

Note: The quantities of the model and components will be
synchronized but will not necessarily be equal.

Select the product line to modify.

a. Add a service by selecting Add Service > Go. See Section 10.3, "Adding
Services to Quotes" for more information.

b. Configure a product by selecting Configure > Go. See Section 10.4,
"Configuring Products" for more information.

c. Duplicate a line by selecting Duplicate Line > Go. See Section 10.4.2,
"Duplicating an Existing Configuration in a Quote" and Section 10.5,
"Duplicating a Line" for more information.

d. Remove a product by selecting Remove Line > Go. See Section 10.2,
"Removing Products From the Quote" and Section 10.4.1, "Deleting a
Component" for more information.

e. Modify an existing service by selecting Modify Service > Go. See
Section 10.3.3, "Modifying a Service" for more information.

Select Apply to save your changes and return to the Templates page.
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4.5 Deleting a Template

To delete a template:

Prerequisites

The profile option ASO: Manage Quote Template must be set to Yes. If set to No,
you will not be able to delete templates

Steps
1. Navigate to the Templates page.

2. Select whether you want to search by template name or description.

3. Enter the template name or description in the text field, using the wildcard
character as necessary.

4. Select Go.

The template matching the search criteria displays in the Results section.
5. Place a check in the Select box next to the template you want to delete.
6. Select Delete.

The Template page refreshes and displays confirmation that the template was
deleted.
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Searching

This section contains information on performing searches in Oracle Quoting.
= Overview of Searching for Quotes

s Basic Search for Quotes

s Advanced Search for Quotes

= Saved Searches

= Using interMedia Search
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5.1 Overview of Searching for Quotes

In the Quotes page, you can search for quotes assigned to you. A basic search
allows you to search using the following criteria:

s Quote number

s Quote name

s Customer name

= Account number

= Contact name

An Advanced search allows you to search using;:
s Quote name

s Quote number

s Customer name (Party Name)

s Customer type

s Account number (financial account)
= Contact name

= Opportunity name

= Status

= Web published

= Quote amount range

s Currency

»  Update date range

= Expiration date range

»  Creation date range

= Sales person

= Sales group

= Option to restrict to primary salesperson and primary sales group
= Sales channel

s Source name
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You can combine search criteria, or leave all fields blank to display all quotes that
you can access.

The search process returns the highest quote versions that match the specified
criteria and are accessible to you. You can use % as a wildcard character. For
example, you can enter "quote%," but not "%quote."

5.2 Basic Search for Quotes

To perform a basic search for a quote:

Prerequisites
None

Steps

1. In the Quote Search section, enter criteria for the search or if you wish to
display all quotes accessible to you, leave the criteria fields blank.

2. Select Go. The Results section of the Quotes page displays the quotes assigned
to you that match the search criteria. The results are sorted by Update Date
(descending order). Only the latest versions of quotes appear.

5.3 Advanced Search for Quotes

To perform an advanced search for a quote:

Prerequisites
None

Steps
1. In the Search box, select the Advanced Search link. The Advanced Search page
displays.

2. Enter the criteria for your search. To display all quotes that you have access to,
leave all fields blank.

3. Select Go. The results display in the Results section on the Advanced Search
page. The most recently updated quote appears at the top of the list.

4. To save your search, select Save Search Criteria. The Create Saved Search page
displays.
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5. Enter saved search name and select Apply.

6. To create a quote, select Create Quote.

5.4 Saved Searches

Saved Searches allow you to save query criteria, select and organize the displayed
columns, define sort criteria, and define one saved search as the default view of the
Quote page. My Open Quotes is the seeded default view for the Quotes page.

There are four seeded saved searches:

= My Open Quotes — Quotes with a status of Draft, Approval Canceled, or
Approval Rejected.

= My Approved Quotes — Quotes with a status of Approved or Contract
Required.

= My Pending Quotes — Quotes with a status of Approval Pending or Contract
Pending.

s My Ordered Quotes — Quotes with a status of Order Submitted.

Note: Seeded searches only search against quotes belonging to the
sales team of the logged-on user. Seeded searches cannot be
modified or deleted.

Seeded saved search results are sorted by Update Date in descending order.

5.4.1 Creating a Saved Search

To create a saved search:

Prerequisites
None

Steps
1. Select Personalize in the Saved Searches bin. The Saved Searches page opens
displaying a list of your saved searches.

2. Select Create Saved Search. The Create Saved Search page opens.

3. In the Query Properties section, enter search criteria for the saved search.
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In the Column Properties section, select the order and content of the columns
that will display in your saved search.

In the General Properties section, enter a name in the Saved Search Name field.

To designate the saved search as the default view for the Quotes page, select the
Use as Default Saved Search box.

Optionally, select the number of displayed rows and enter a description for the
search.

Select Apply to save the search.

Select Apply and View to save the search and view it in the main Quotes page.

5.4.2 Viewing a Saved Search

To view a saved search:

Prerequisites
None

Steps

1.
2.

In the Saved Searches bin, select the saved search from the drop-down menu.

Select Go. The Saved Search displays in the Results section of the Quotes page.

5.4.3 Modifying a Saved Search

To modify a saved search:

Prerequisites
None

Steps

1.

Select Personalize from the Saved Searches bin. The Saved Searches page
opens.

Select the linked Name of the saved search. The Update Saved Search page
opens.

Make the necessary changes to your search criteria.

Select Apply to save the search.
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5. Select Apply and View to save the search and view it in the main quotes page.

5.4.4 Deleting a Saved Search

To delete a saved search:

Prerequisites
None

Steps

1. In the Saved Searches bin, select Personalize. The Saved Searches page opens.
2. Select the radio button for the saved search you want to delete.

3. Select Delete.

Note: You cannot delete or modify seeded saved searches or
searches marked with an asterisk.

5.4.5 Copying a Saved Search

To copy a search:

Prerequisites
None

Steps

1. In the Saved Searches bin, select Personalize. The Saved Searches page opens.
2. Select the search you want to copy.

3. Select Duplicate. The Create Saved Search page opens with the initial saved
search’s criteria defaulted in the fields.

Modify the search criteria as necessary.
Enter a name in the Saved Search Name field.

Select Apply to save the search.

N o a &

Select Apply and View to save the search and view it in the main quotes page.
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5.5 Using interMedia Search

If ASO: Enable interMedia Search is set to Yes, you can search the product catalog
for products using the interMedia search. interMedia search allows you to search
for products using any of the following criteria:

= Part Number

s Description

s Long Description

interMedia search performs keyword searches and does not require wildcards.

If interMedia search is not enabled, you can search by Product Number and
Description in the Product field. You must enter a value followed by the wildcard or
an exact match.
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Credit Checks

This section contains information about performing credit checks.
s Overview of Credit Checking
= Performing a Credit Check
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6.1 Overview of Credit Checking

Credit checking in Oracle Quoting allows the user to determine the credit
worthiness of a customer while working on a quote. The user can decide if the
quote should be submitted for business approvals credit verification. The profile
option ASO: Enable Credit Check determines if credit checks can be performed.
See the Oracle Quoting Implementation Guide for more information.

There are two types of credit checks available in Oracle Quoting:

Internal — Internal credit checking is based on transaction data in the quote,
and historic transaction data in Oracle Order Management and Oracle
Receivables. It pertains to quote header level billing information. Internal credit
checks are performed by the public credit check API OE_EXTERNAL_CREDIT_
PUB.

The key differences between internal credit checking and the credit checking
functionality in Oracle Order Management are:

= Item category limits are not checked in the public credit check API provided
for internal credit checks.

s Credit checking is only available at the header level in internal credit
checking, while OM credit checking supports both header and line level
credit checks.

= There is no Holds functionality for Internal credit check

External — External credit checks are configurable by the application developer
and allow users to make calls to non-Oracle applications. Please see the Oracle
Quoting Implementation Guide for more information.

Based on setup, internal and/or external credit checks may be performed. The
internal credit check is performed if ASO: Credit Check Rule is set at the
appropriate level. The external credit check is performed if it is configured by the
application developer.

6.2 Performing a Credit Check
To perform a credit check:

Prerequisites
= ASO: Enable Credit Check must be set to Yes at the appropriate level.

= The quote status must not be Order Submitted
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= The quote must not be expired.
= The highest version of the quote must be used.
= The quote must not be submitted for batch pricing.

s There must be a designated Billing customer with an account and a billing
address on the quote.

= Pricing and Tax Statuses must both be complete.

Steps

1. Navigate to the Overview page.
2. Select Actions > Initiate Credit Check and select Go.

3. A window displays the results of the credit check.

Note: The results of the credit check are not saved in the quote.
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Pricing Products and Quotes

This section provides information and instructions on pricing products or entire
quotes.

= Overview of Pricing
= Freezing Prices for a Quote

= Executing Manual Pricing Requests for a Quote
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7.1 Overview of Pricing

The price your customer pays for an product depends on the price lists, manual
adjustments, and promotional discounts as well as on automatic modifiers set up in
Oracle Advanced Pricing.

7.1.1 Price Lists

Price lists are set up in Oracle Advanced Pricing. Your company may have several
different price lists mapping to different customer types. Separate price lists often
exist for consumers and corporate customers, reflecting volume discounts for
organizations that purchase in large quantities. Additional price lists may reflect
special contractual arrangements with other customers.

You can select a price list for the quote as a whole as well as for each individual
product. The product price list supersedes the whole quote price list when
determining the price for that specific product.

The header price list defaults based on the following information on the quote (in
the following order):

= Agreement
s Quote-to Customer
s Order Type

If you leave the header price list field blank, the price list is determined by Oracle
Advanced Pricing based on Price List setup. See the Oracle Pricing User’s Guide for
more information.

7.1.2 Discounts

Oracle Quoting allows both order-level and line-level discounts. Order-level
discounts are applied to each line on the quote, while line-level discounts are
applied to specific lines only. If there are multiple discounts available for an order or
a line, the application combines them.

Example

A customer purchases a $200 coat and a $100 shirt. There is a 10% discount
available for the shirt and a 50% discount available for the entire order. The quote
price is calculated as follows:

s The coat: $200 - 50% = $100
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»  The shirt: $100 - 60% = $40
= Total price = $140

7.1.3 Pricing Adjustments

Oracle Quoting displays automatic adjustments (calculated in Oracle Advanced
Pricing) applicable to the selected product and customer.

If ASO: Calculate Price is set to Automatic, each time you change a product in a
quote, the whole quote is repriced automatically. A change in one product can affect
the level of other offers and discounts.

Pricing Date

Oracle Pricing uses the Pricing Date to interpret the effective dates set up in pricing.
Pricing Date is useful if you want to ensure that the prices on a quote do not change
if product prices are updated in Oracle Pricing. You may also want to initially quote
prices based on historical pricing information or future pricing information.

7.1.4 Manual Adjustments

You can manually override prices at the header level or line level.

Manual adjustments at the header level are entered in the Header Manual Discount
field in the Grand Total section of the Lines page. All header manual discounts are
applied as percentages.

Depending on which columns are exposed in the Lines page, you could potentially
perform the following manual discounts at the line level:

= Enter a value in the Line Discount field
» Enter a value in the Unit Adjustment Percent

= Override the Unit Selling Price

Note: If these fields are enabled and you enter conflicting values
in the fields, the line is priced based on:

Unit Selling Price
Unit Adjustment Percent

Line Discount

Pricing Products and Quotes 7-3



Applying Header Promotion Codes

Manual adjustments are available only if the profile ASO: Discounting Privilege is
set to Full.

7.1.5 Terms Substitution

When a quote is priced using Advanced Pricing, the pricing engine checks if there
are terms substitutions available at either the header or line level. The following
terms substitution types are supported by Oracle Advanced Pricing:

= Payment Terms Substitution
= Freight Terms Substitution
= Shipping Method Substitution

Depending on the defined modifiers, any of the available values can be substituted
after the pricing engine call.

For more information on modifiers and terms substitution, see the Oracle Advanced
Pricing User’s Guide and the Oracle Advanced Pricing Implementation Manual.

7.2 Applying Header Promotion Codes

Oracle Quoting allows you to enter promotion codes (also known as offer codes) to
capture automatic discounts set up as available on request in the Oracle Pricing
engine.

To apply header level promotion codes:

Prerequisites
None

Steps
1. Navigate to the Pricing page for the quote.

2. In the Promotion Code section select Add Promotion Codes. The Search and
Select: Promotion Codes page displays.

3. Select to search by Promotion code or name.

4. Enter a promotion code/name, a partial code/name and %, or % alone and
select Go. % and Go will display a list of all available promotions. The results
section displays the promotion code search results.
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Select the promotion code(s) to apply to the quote by placing a check in the
Select box.

Choose Select. The Pricing page displays with the selected promotion codes in
the Promotion Code section.

Note: You cannot add duplicate promotion codes.

Optionally, remove a promotion code by selecting the checkbox next to it and
selecting Delete.

Select Apply when you have finished entering promotion codes. The promotion
codes are applied to the quote.

7.3 Applying Line Level Promotion Codes

To apply line level promotion codes:

Prerequisites
None

Steps

1.
2.
3.

Navigate to the Lines page for the quote.
Select the line for the promotion code.

Select Actions > Adjust Pricing and select Go. The Adjust Pricing page
displays Pricing detail.

Select Add Promotion Codes. The Search and Select: Promotion Codes page
displays.

Follow steps 3-6 in Section 7.2, "Applying Header Promotion Codes", above.

Optionally, remove a promotion code by selecting the checkbox next to it and
selecting Delete

Choose Select. The Adjust Pricing page displays with the selected promotion
codes in the Promotion Code section.

Select Apply when you have finished entering promotion codes. The promotion
codes are applied to the quote line.
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7.4 Applying a Header Discount

To apply a header level discount:

Prerequisites
= ASO: Discounting Privilege must be set to Full at the appropriate level.

= Set up at least one header level, overrideable modifier in Oracle Pricing.

Steps
1. Navigate to the Grand Total region of the Lines page.

2. Enter the discount amount (percent) to apply in the Header Manual Discount
field.

Note: The sign of the percentage is interpreted based on the
setting of ASO: Require Minus Sign for Manual Discount. See the
Oracle Quoting Implementation Guide for more information.

3. Select Apply. The page refreshes, displaying confirmation that the change
occurred. The Price Adjustments column also displays the header discount
amount.

7.5 Applying a Line Level Discount

To apply a line level discount:

Prerequisites
= ASO: Discounting Privilege must be set to Full at the appropriate level.

= Set up at least one line level, overrideable modifier in Oracle Pricing.

Steps
1. Navigate to the Lines page.

2. Select the line to discount.
3. Apply a discount in one of the following ways:

= Enter a value in the Unit Adjustment Percent.
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The Unit Adjustment Percent column on the Lines page displays the total of
all adjustments currently applied to the line. This value is shown as a
percent of the unit list price. If this value is changed, the difference is
applied to a manual pricing modifier.

A positive number is applied as a surcharge and a negative number is
applied as a discount.

= Override the value in the Unit Selling Price field

s In the Line Discount field, enter the discount amount and select whether it
will be applied as a percentage or as an amount.

The profile ASO: Require Minus Sign for Manual Discount determines if
the value entered in this field is applied as a discount or a surcharge based
on whether it is negative or positive. See the Oracle Quoting Implementation
Guide for more information.

Note: If these fields are enabled and you enter conflicting values
in the fields, the line is priced based on:

Unit Selling Price
Unit Adjustment Percent

Line Discount

4. Select Apply. The page refreshes, displaying confirmation that the change
occurred. The Price Adjustments column also displays the line discount
amount.
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7.6 Applying Pricing Agreements

Pricing agreements are created in Oracle Order Management or Oracle Pricing by
your system administrator or sales manager.

When creating a quote, you can select an applicable pricing agreement. For an
existing quote you can select a pricing agreement in the General page.

The Agreement LOVs display all customer specific and universal pricing
agreements.

Prerequisites

Pricing agreements must be set up for the customer in Oracle Order Management or
Oracle Pricing.

Steps
1. Ineither the Create Quote page or General page, use the LOV to select an
Agreement.

2. Select Apply. The quote is priced based on the selected agreement.

7.7 Freezing Prices for a Quote

Oracle Pricing uses the Pricing Date to interpret the effective dates for prices. If the
Pricing Date is set to January 1, 2002, only prices, discounts and adjustments that
are valid as of January 1, 2002 are calculated.

Note: Pricing Date is not limited to the current date, but can be
any date in the past or future.

Pricing Date ensure that the prices on a quote do not change if product prices are
updated in Pricing. You can quote prices based on historical or future pricing
information.

By selecting the Freeze Price option in the Actions menu, you can save the current
date and reuse it for future pricing calls. This date subsequently appears on the
quote as the Pricing Date. You can also change the Pricing Date to any date,
including past or future dates.

If no date is selected, Oracle Quoting uses the current date for prices, discounts, and
adjustments.
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Prerequisites

The highest version of the quote must be used.

The quote is not in a read-only status.

Steps

1.
2.

Navigate to the Overview page.

Choose Freeze Prices from the Actions menu and select Go. The page displays
confirmation that the quote was updated.

In the Pricing page, the Pricing Date field shows today’s date. This date is used
for all subsequent pricing checks.

Optionally, you can unfreeze prices, by choosing Unfreeze Prices from the
Actions menu and selecting Go.

7.8 Executing Manual Pricing Requests for a Quote

Out of the box, Oracle Quoting automatically prices a quote whenever a change is
made to the quote that affects pricing, A quote change that affects the pricing will
also affect tax values. Therefore, the pricing call also calculates taxes. Tax is
computed after the pricing call, since it is dependant on product pricing. Any quote
change NOT listed below affects the pricing for a quote:

Sales credits changes

Attachments changes

Notes changes

Tasks changes

Initiate/Cancel Approvals

Request Contract Creation or Assistance
Sales Team changes

Web Publish or Unpublish

Initiate Credit Check

Sales Supplement changes

System driven quote status changes

Place Order
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You can now choose when each quote is priced, if the profile option ASO: Calculate
Price is set to Manual. You can also choose to calculate tax manually by setting
ASO: Calculate Tax to Manual. Depending on the setting of ASO: Enable Batch
Processing you can choose to price the quote interactively or through a batch
request. See the Oracle Quoting Implementation Guide for more information.

Note: Setting ASO: Calculate Price to Manual and ASO:
Calculate Tax to Automatic is not supported because quote tax is
based on the quote product pricing.

A user can still manually price a quote by selecting Price Quote, even if the profiles
ASO: Calculate Price and ASO: Calculate Tax are set to Automatic. It is possible
that pricing on a quote may not be current, due to pricing setup changes or the
setting of pricing date. The user can manually price the quote to get the price/tax
based on the latest setup.

If the Pricing Date is set, Oracle Quoting will price the quote as of the date specified
in the Pricing Date field. The date can be any time in the past or future. If this field
is blank, quotes are priced as of the current date and time.

The option to manually price a quote is particularly helpful to users who are:
= Entering a large number of quotes lines

= Entering a large number of quote lines in a Configurator session

= Making a large number of quote line changes

= Entering a large number of quote lines in a quote template or across multiple
templates.

=  Have complex tax or pricing setups.

These actions can all take a considerable amount of time if the quote is repriced
after each change or addition. Therefore, the ability to price the quote manually will
save time.

If the pricing or tax statuses are incomplete, users will not be allowed to:
= Submit a quote for approval
= Approve a quote
s Request Contract Creation

= Web publish a quote
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» Initiate a credit check
= Print a quote
»  Create a proposal

s Place an order

To manually price a quote:

Prerequisites

The highest version of the quote must be used.
The quote is not in a read-only status.

The user has Update access to the quote

The quote has not been submitted to batch pricing

Steps

1.

Navigate to the Overview page and select Price Quote from the Actions menu.

If ASO: Calculate Price is Automatic AND ASO: Calculate Tax is Automatic
AND ASQO: Enable Batch Processing is No, the Price Quote page will not be
shown but the quote will be priced. For any other combination of these three
profiles, the Price Quote page will be displayed.

Choose to compute price only, tax only, or both.
Choose when you want to price the quote.

If you have ASO: Enable Batch Processing set to Yes, you will have two
options for pricing the quote: Now or Submit pricing request and
notify me when it is complete.If ASO: Enable Batch Processing it set
to No, these options disappear and the application defaults to Now. See the
Oracle Quoting Implementation Guide for more information.

Select Submit.

The quote is locked until the pricing request is complete or canceled. The
Overview page displays the Pricing and Tax Statuses, and the Pricing Request
number, if you selected Submit pricing request and notify me when
it is complete in the Submissions Options field on the Price Quote page.
The Pricing Request field does not appear if the profile ASO: Enable Batch
Processing is set to No. Additionally, the pricing and tax status indicators are
part of the quote context and appear wherever the quote context is shown.
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The Pricing Updated On date and Tax Updated On date appear on the Pricing
page.

7.8.1 Viewing Details of the Pricing Request

You can view the pricing request details if ASO: Enable Batch Processing is set to
Yes and a pricing request has been submitted for batch execution.

To view pricing request details:

Prerequisites
= ASO: Enable Batch Processing must be set to Yes.

s The user must have Update access
= The quote must not be in a status that is read-only

= The quote has been submitted for batch pricing

Note: After the batch pricing request completes the user will
receive an email notification.

Steps
1. Select the Pricing Request link on the Overview page.

2. The Pricing Request Details page displays:
= Pricing and Tax Statuses
s Pricing Request ID
= Date Submitted
= Request Name
= Phase
= Requestor
= Date Started

= Status
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7.8.2 Canceling a Pricing Request

To cancel a pricing request:

Prerequisites

ASO: Enable Batch Processing must be set to Yes.
The quote has been submitted for batch pricing

Note: when a quote is submitted for batch pricing, the phase may
be one of the following: Pending, Inactive or Running.

These highest version of the quote must be used.
The quote is not in a read-only status.

User must have Update access

Steps

1.

Select Cancel Pricing Request from the Actions menu on the Overview page.

The Pricing Request status changes to Canceled. A message displays indicating
that the pricing request was canceled.

The user also receives an email notification confirming the cancellation.
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Customers and Relationships

This chapter contains information about customer types, customer data, and
customer relationships.

s Overview of Customers and Relationships

s Creating Customers
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8.1 Overview of Customers and Relationships
There are two customer types in Quoting:
= Person

= Organization

Parties of type person are individuals purchasing on their own behalf. A person
can have multiple addresses and telephone numbers.

Parties of type organization may be a company, a company subsidiary or branch, an
association, a non-profit, or a government branch. Each organization must have a
primary address, but can have multiple additional addresses and contacts
associated with it. Each address belongs to the organization, not to individual
contacts for the organization.

A contact is a representative of an organization. Any individual at an organization
can be a contact. Contacts within an organization are set up with roles such as
contact for Organization A or employee of Organization B.

8.1.1 Customer Data

To create quotes and orders, certain standard customer information is necessary.

Note: The customer, referred to in Quoting as the Quote-to
customer, is the party for whom the quote is being created. This
party becomes the sold-to customer when the quote is converted
into an order in Oracle Order Management.

The following table shows the mapping of the HTML Ul terminology to the Oracle
Receivables (AR) TCA terminology.

Location in Ul Quoting Terminology AR Terminology (TCA)

General Page Quote-to Customer, Quote-to Sold-to Customer, Sold-to
Contact, Quote-to Address Contact

Note: The quote-to address is
not passed into OM.

Shipping and Billing Page Customer Name, Contact, Ship-to Customer, Ship-to
Address Contact, Ship-to Address
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Location in Ul Quoting Terminology AR Terminology (TCA)

Shipping and Billing Page Customer Name, Contact, Bill-to Customer, Bill-to
Address Contact, Bill-to Address

Customer information can be grouped into the following areas:

Quote-To Information

s Quote-To Customer — The name and financial account of the customer.
Sometimes only the name of the customer is known, as there may not be a
financial account set up for the customer. The quote-to customer is financially
responsible for the order; for example, credit and collections contacts the
quote-to customer if payment is not received.

= Quote-To Contact — A person representing the quote-to customer, only when
the quote-to customer is of party type organization. You cannot enter a contact
if the Quote-To Customer is of type Person. This field is optional.

= Quote-To Address — Address for the quote-to customer or quote-to contact.
This address is used for mailing purposes. The Quote-to address is an optional
address. It may be passed to the quote from an opportunity, but it is not passed
into Oracle Order Management when converting a quote to an order

Bill-To Information

s Bill-to Customer — The name and financial account of the customer to be
invoiced for the goods or service ordered.

= Bill-to Contact — A person representing the billing customer who deals with all
invoice-related issues for the order, only when the billing customer is of party
type organization. This field is optional.

= Bill-to Address — A physical location where the invoice is sent. This address
can be associated with either the bill-to customer or the bill-to contact. If you
choose an address that is not of the type bill-to, then it is created as a bill-to
address when the quote is saved.

Ship-To Information

= Ship-to Customer — The name and financial account information of the
customer to whom the goods or services are delivered.

= Ship-to Contact — A person representing the shipping customer, only when the
shipping customer is of party type organization, who deals with all shipping
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related issues for the order, and who typically receives the shipment. This is an
optional field.

= Ship-to Address — A physical location where the products are sent. The ship-to
address can be associated with either the ship-to customer or ship-to contact. If
you select an address that is not of type ship-to, it is created as a ship-to address
when the quote is saved.

8.1.2 Creation of Accounts

Out of the box, Oracle Quoting does not require financial accounts—for customers
without any accounts—when creating a quote. Sales representatives can create
quotes for either prospects or customers. A prospect does not have a financial
account, while a customer has one or more financial accounts.

Oracle Quoting allows you to determine at which point an account is created. For
more information on the following profile options, see the Oracle Quoting
Implementation Guide.

Account creation is based on the following profile options:

»  ASO: Auto Account Creation—Determines when an account should be
automatically created.

Depending on how you set the profile option ASO: Auto Account Creation, you
can set up account restriction in the following ways:

= Always create accounts—Accounts are created for customers when the quote is
saved.

= Create accounts as necessary—Accounts are created only when a quote is web
published, a non-standard contract is created, or when a quote is converted into
an order.

= Create accounts only when Place Order—Accounts are created only when the
quote is converted into an order.

The following table shows the behavior of Oracle Quoting based on the settings of
the profile options.
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Table 8-1 Quoting Behavior Based on Profile Options

Initiate
Create Select Non-Stand
Profile Option Create Select Ship-To/B Ship-To/Bi Web ard Order
Setting Sold-To Sold-To ill-To Il-To Publishing Contract Conversion
ASO: Auto Create Create Create Create NA NA NA
Account account accountif account account if
Creation set to party does party does
Always not have not have
any any
ASO: Auto Do not Do not Do not Do not Create account Create Create
Account create create create create for all account for account for
Creation set to  account account account account customersin  all all
As Required quote without customers customers
account in quote in quote
without without
account account
ASO: Auto Do not Do not Do not Do not Throw error if Throw Create
Account create create create create any customers error if any account for
Creation setto  account account account account on quote do customers  all
Place Order not have on quote  customers
accounts do not on quote
have without an

accounts account

If ASO: Auto Account Creation is set to Always, an account is created for each
party on the quote (that does not have an account) when the user saves a quote.

If ASO: Auto Account Creation is set to As Required, an account is created for each
customer on the quote (that does not have an account) when the quote is:

= Web published
= A non-standard contract is initiated
= The quote is converted into an order.

If ASO: Auto Account Creation is set to Place Order, an account is created for each
customer on the quote without an account when the quote is converted into an
order.
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8.2 Creating Customers

The customer is typically created in Oracle Sales Online or Oracle Receivables.
Oracle Quoting offers a generic procedure for customer creation, capturing the
minimum information necessary to place an order.

To create a new customer in Oracle Quoting:

Prerequisites

ASO: Create New Customer must be set to Yes at the appropriate level.

ASO: Create New Shipping/Billing Customers must be set to Yes to create
new shipping or billing customers.

Steps

1.

Navigate to the Search and Select: Customer page. You can access the Search
and Select: Customer page by entering a value in the Customer field and
selecting Go in any of the following pages:

s Create Quote page

= Modify Shipping and Billing page

= Shipping and Billing page

Select Create Customer. The Create Customer page opens.
Enter the customer information:

a. Select the Organization radio button if your customer is an organization.
Enter the organization’s name in the text field below.

Select the Person radio button if your customer is an individual. Enter the
last name, first name, and middle initial in the respective fields. Optionally,
enter your customer’s e-mail address in the Email field.

b. Optionally, enter the customer’s country code in the first Phone Number
field, phone number in the second field, and extension in the third field.

c. Select the customer address country from the Country pull-down menu.

d. Enter the address type, Home, Office, or another name, in the Address
Name field.

e. Enter the customer address city in the City field.

f. Optionally, enter the customer address county in the County field.
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g. Enter the customer address state in the State field.

h. Enter the customer address zip code in the Zip field.

Note: If the address combination is not set up in Oracle
Receivables, an address validation error will occur. See the Oracle
Quoting Implementation Guide for more information.

4. Select Apply.

8.2.1 Creating Contacts

Contacts for customers are typically created in Oracle Sales Online or Oracle
Receivables. Oracle Quoting offers a generic procedure for customer contact
creation, capturing the minimum information necessary to place an order.

To create a contact in Oracle Quoting;:

Prerequisites
ASO: Update Customer must be set to Yes at the appropriate level.

Steps

1. Navigate to the Search and Select: Contact page. Select Create Contact. The
Create Contact page opens. You can access the Search and Select: Contact page
by entering a value in the Contact field and selecting Go in any of the following

pages:

= Create Quote page

= General page

= Modify Shipping and Billing page
Shipping and Billing page

2. Enter the contact information:

a. Enter the last name, first name, and middle initial in the respective fields.
Optionally, enter your customer’s e-mail address in the Email field.

b. Enter the contact’s daytime, evening, and fax phone numbers, in the
respective fields.

c. Inthe Country pull-down menu, select the contact address country.
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d. Enter the address type, Home, Office, or another name, in the Address
Name field

e. Enter the contact address In the Address fields.

.-h

Enter the contact address city in the City Field.
g. Enter the contact address county in the County field.
h. Enter the contact address state in the State field.
i. Enter the contact address zip code in the Zip field.
3. Select Apply.

8.2.2 Creating Addresses

Addresses for customers are typically created in Oracle Sales Online or Oracle
Receivables. Oracle Quoting offers a generic procedure for customer address
creation and updating, capturing the minimum information necessary to place an
order.

To create an address in Oracle Quoting:

Prerequisites
ASO: Update Customer must be set to Yes at the appropriate level.

Steps
1. From the Shipping and Billing Information page, navigate to the Search and
Select: Address page.

2. Select Create Address. The Create Address page opens.
3. Enter the address information in the Create Address page as follows:
a. In the Country pull-down menu, select the country.
b. Optionally, enter an address name.
c. Enter the address and city.
d. Optionally, enter the county.
e. Enter the state and zip code.

4. Select Apply.
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Entering Address and Payment Information

This section contains the processes and procedures necessary for entering and
maintaining address and payment information.

Overview of Address and Payment Information
Entering Shipping and Billing Information
Entering Line-Level Shipping or Billing

Entering Payment Information
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9.1 Overview of Address and Payment Information

You can designate several addresses, serving different purposes on a quote. Not all
are mandatory.

s Quote-To Address — Address for the customer or contact.

The quote-to address is optional. It may be passed to the quote from an
opportunity, but it is not passed into Oracle Order Management when
converting a quote to an order.

= Ship-To Address — Address where the order is sent.

The ship-to address can be associated with either the ship-to customer or
contact. If you select an address that is not of type ship-to, it is created as a
ship-to address when the quote is saved.

» Bill-To Address — Address where the bill is sent.

This address can be associated with either the bill-to customer or contact. If you
choose an address that is not of type bill-to, it is created as a bill-to address
when the quote is saved.

You can also designate billing and shipping addresses at the line level.

Line level billing is controlled by the profile option ASO: Enable Line Level
Billing. Line level billing is not supported when the payment type is Credit Card,
Check or if a Purchase Order number is specified.

9.2 Address Defaulting

Addresses default into quotes, based on the following conditions, when creating
quotes standalone, from opportunities, or from templates.

The application searches for and defaults only active addresses.

Quote-To

The Quote-To Address is defaulted at the time of quote creation either from the
search results or as described below.

If Quote-To Customer is an Organization and the Quote-To Contact is specified,
the application searches for a value from the following sources (in the order
below) and accepts the first one it finds:

a. Primary Sold-To address type usage for the Quote-To Contact
b. Identifying address for the Quote-To Contact
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c. Primary Sold-To address type usage for the Quote-To Customer
d. Identifying address for the Quote-To Customer

If the Quote-To Customer is an Organization and no Quote-To Contact is
specified, the application searches for a value from the following sources (in the
order below) and accepts the first one it finds:

a. Primary Sold-To address type usage for the Quote-To Customer
b. Identifying address for the Quote-To Customer

If the Quote-To Customer is a Person, the application searches for a value from
the following sources (in that order) and accepts the first one it finds:

a. Primary Sold-To address type usage for the Quote-To Customer
b. Identifying address for the Quote-To Customer

Bill-To
The Bill-To Address is defaulted at the time of quote creation based on the
following conditions:

If Bill-To Customer is an Organization and the Bill-To Contact is specified, the
application searches for a value from the following sources (in the order below)
and accepts the first one it finds:

a. Primary Bill-To address type usage for the Bill-To Contact
b. Identifying address for the Bill-To Contact

c. Primary Bill-To address type usage for the Bill-To Customer
d. Identifying address for the Bill-To Customer

If the Bill-To Customer is an Organization and no Bill-To Contact is specified,
the application searches for a value from the following sources (in the order
below) and accepts the first one it finds:

a. Primary Bill-To address type usage for the Bill-To Customer
b. Identifying address for the Bill-To Customer

If the Bill-To Customer is a Person, the application searches for a value from the
following sources (in the order below) and accepts the first one it finds:

a. Primary Bill-To address type usage for the Bill-To Customer
b. Identifying address for the Bill-To Customer
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Ship-To

The Ship-To Address is defaulted at the time of quote creation based on the
following conditions:

If Ship-To Customer is an Organization and the Ship-To Contact is specified, the
application searches for a value from the following sources (in the order below)
and accepts the first one it finds:

a. Primary Ship-To address type usage for the Ship-To Contact
b. Identifying address for the Ship-To Contact

c. Primary Ship-To address type usage for the Ship-To Customer
d. Identifying address for the Ship-To Customer

If the Ship-To Customer is an Organization and no Ship-To Contact is specified,
the application searches for a value from the following sources (in the order
below) and accepts the first one it finds:

a. Primary Ship-To address type usage for the Ship-To Customer
b. Identifying address for the Ship-To Customer

If the Ship-To Customer is a Person, the application searches for a value from
the following sources (in the order below) and accepts the first one it finds:

a. Primary Ship-To address type usage for the Ship-To Customer
b. Identifying address for the Ship-To Customer

9.3 Entering Shipping and Billing Information

To enter shipping and billing information for a quote:

Prerequisites
None

Steps

1.

Select Shipping and Billing from the sidebar menu. The Shipping and Billing
page displays.

The shipping and billing customer fields are automatically populated with the
Quote-To Customer name and account, if any. Optionally, enter different
shipping and billing customers.
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Note: To create a new ship-to or bill-to customer, select Create
Customer in the Search and Select: Customer page. This button
does not appear on the page if ASO: Create New Shipping/Billing
Customers is set to No. See Section 8.2, "Creating Customers" for
more information.

3. Optionally, select a shipping contact and a billing contact.

Note: To create a new ship-to or bill-to contact, select Create
Contact in the Search and Select: Contact page. If Quoting Security
does not permit you to create a new contact, this button does not
appear on the page. See Section 8.2.1, "Creating Contacts" for more
information.

4. Optionally, change the shipping and billing addresses.

The shipping and billing address have default values based on the information
in Section 9.1, "Overview of Address and Payment Information".

Note: To create a new ship-to or bill-to address, select Create
Address in the Search and Select: Address page. If Quoting security
does not permit you to create a new address, this button does not
appear on the page. See Section 8.2.2, "Creating Addresses" for
more information.

5. Optionally, select shipping method and request a delivery date.
6. Optionally, enter shipping and packing instructions.

7. Select Apply.
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9.4 Entering Payment Information

Note: Oracle Quoting supports the use of Payment Terms
Substitution. Please see Section 7.1.5, "Terms Substitution” for more
information.

To enter payment information for a quote:

Prerequisites
None

Steps
1. Select Shipping and Billing from the sidebar.

2. In the Payment section, select or change the Payment Terms.

Payment Terms are defaulted at the time of quote creation, based on the
following conditions:

= Header-level Agreement
s Quote-To Customer Account

Payment term defaulting can also occur when the Header-level Agreement is
assigned or changed, or the Quote To Customer Account is assigned.

3. Select a payment type from the drop-down menu. Available payment types are
Cash, Check, Credit Card, or blank.

4. Optionally, enter a purchase order (PO) number for the quote.
5. If the payment type is Check, enter the check number.

6. If the payment type is Credit Card, select the credit card type, and enter the
credit card number, cardholder name, and credit card expiration date.

7. Select Apply.

Note: If Oracle /Payment is implemented, the application
performs a credit card check. For more information, consult the
Oracle iPayment Concepts and Procedures.
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9.5 Entering Line-Level Shipping or Billing

To designate line level shipping or billing:

Prerequisites

You can only designate line billing information if the header Payment Type is Cash
or Blank and the Purchase Order number is not specified.

Steps

1.
2.
3.

N o a &

Select Lines from the sidebar. The quote lines information displays.
Select the line for which to designate shipping or billing information.

From the Actions drop-down menu, select Modify Shipping and Billing
Information and select Go. The Modify Shipping and Billing page opens.

Note: To designate shipping information, perform the following
steps in the Shipping section. To designate billing information,
perform the following steps in the Billing section.

Enter the customer name and account number.

Optionally, enter a contact for the customer.

Enter the address to which the product(s) will be billed or shipped.
If you are entering shipping information:

a. Optionally, select a shipping method.

b. Optionally, enter a requested delivery date.

c. Optionally, enter shipping and/or packing instructions.

Select Apply.
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Modifying Quotes

This chapter contains information on modifying quotes in Oracle Quoting. Sections
include:

Adding Products to the Quote
Removing Products From the Quote
Adding Services to Quotes
Configuring Products

Adding Related Product

Checking Product Availability
Allocating Sales Credits

Adding Trade-Ins to Quotes
Splitting Lines

Viewing and Entering Quote Tax Details
Viewing Quote History

Linking a Quote to an Opportunity
Changing the Base UOM for a Line
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10.1 Adding Products to the Quote

You can search for products to add to quotes. For information on how the product
search is filtered, refer to Section 5.5, "Using interMedia Search".

To add products to the quote:

Prerequisites
None

Steps

1.
2.
3.

Navigate to the Lines page.
Select Add Product. The Product page opens.
Ensure that the Source is Product Catalog.

In the Product pull-down menu, choose the product inventory category.
Selecting All will search across all inventory categories.

In the text field, enter the part number or product name for an exact match, or
partial information and % for a limited list.

Note: If interMedia search is enabled, you can search by Part
Number, Description, or Long Description.

Select Go. The Product page lists the product(s) matching your search criteria,
including part number, product description, and unit of measure.

Check the Select box next to the product(s) to add to the quote.
Optionally, select a line price list for the selected product(s).

Choose Select to add the product(s) to the quote and return to the Lines page or
choose Select and Add More to add the product(s) and then search for
additional products in different categories.
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10.1.1 Line Numbers

Line numbering in Quoting are based on product type. Line numbers are formatted
as follows:

The first tier, A, indicates a major line number grouping. The line numbering for
this group starts with 1 and increments by 1 with each new group. This group
includes the following product types:

» Standard product that is not a top level model, model component, or
serviceable product

= Serviceable product without service products attached

= Service product associated with a serviceable product on a pending order or
in the customer’s installed base

= Top level model and selected components under the model

= Serviceable product and any service products associated with it
s Tradein a top level model

= Selected trade-in component under the trade-in model

s Trade in a standard product

The second tier, B, indicates a component within a model configuration. The first
component has a value of 0, while each additional component increments by 1.

The third tier, C, indicates a service. This applies only for a service associated with a
serviceable product in the current quote.

The following table shows an example of what quote line numbers look like based
on product type.

Table 10-1 Line Numbers and Product Types

Line Number Product Type

1.0 Standard Product

2.0 Top level model product
2.0.1 Service for model

2.0.2 Service for model

21 Component #1 (option class)
211 Service for component
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Table 10-1 Line Numbers and Product Types

Line Number Product Type

2.2 Component #2 (Child of option class)

3.0 Service for serviceable product in the Installed Base
4.0 Serviceable product

4.0.1 Service for serviceable product

4.0.2 Service for serviceable product

When you delete lines the line numbers are adjusted accordingly. Line numbers
displayed on the quote print out match the line numbers in the Quote Lines page.
Quote line numbers are not passed to Oracle Order Management when a quote is
converted into an order.

10.2 Removing Products From the Quote

To remove a product from a quote:

Prerequisites
None

Steps
1. Navigate to the Lines page.

2. Select the product you want to remove.

3. Choose Remove Line from the Actions menu and select Go. The product is
removed from the quote.

4. Optionally, change the quantity to zero and select Apply to remove products
from the quote.
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10.3 Adding Services to Quotes

Services are available to customers ordering serviceable products in Quoting -
HTML. There are two types of services:

= Warranties — Services automatically included with the purchase of a product.

Warranties are defined as a component in the Bill of Materials for a serviceable
product. They are included in the list price of the serviceable product and
cannot be sold as separate products. Each serviceable product can ship with one
or more base warranties.

= Extended Warranties — Services that may be purchased in addition to a
product.

Services can apply to serviceable products:
= On the current quote
= In the customer’s Install Base

= Onapending order

Note: You cannot associate services to products of Line Type
Return.

To add a service to a product in the current quote:

Prerequisites
There must be a serviceable product added to the quote.

Steps
1. Navigate to the Lines page.

2. Select the line for which you want to add a service.

3. Choose Add Services from the Actions menu and select Go. The Select: Service
page displays the included optional services for the line.

4. Select one or more services by checking Select box(s).

5. Optionally, use the Calendar button to select a different start date for the
service.

6. Optionally, change the duration of the service.

Modifying Quotes 10-5



Adding Services to Quotes

7. Optionally, use the Period LOV to select a different period for the service.
8. Optionally, select a different price list.

9. Choose Select to apply the changes to your quote. The service becomes a
separate line under the serviceable product.

10.3.1 Adding a Service to the Quote for a Product in the Customer’s Installed Base

To add a service for a product in the Installed Base:

Prerequisites

There must be a serviceable product in the Installed Base to which you can associate
the service.

Steps
1. Navigate to the Lines page.

2. Select Add Service to Previous Purchase.

3. Select Installed Base to search the customer’s Install Base for a serviceable
product.

4. Enter search criteria and select Go. You can search by:
= Category
s Order Number
s Order Date
= Product
= Description
= Serial Number
= System
= Installed At City
= Installed At Country
= Attribute Name
= Attribute Value

s Instance Number
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12.

Results show serviceable products in the customer’s Install Base that meet your
search criteria.

Select the serviceable product(s) to associate your service to and select Add
Service.

The Select: Service page opens, displaying service reference information for the
selected serviceable products and available services for that product.

Select the service(s) to add to the quote.

Use the calendar icon to select a start date for the service.
Optionally, change the Duration.

Optionally, change the Period.

. Optionally, select a Line Price List.

. Choose Select to apply your changes. The service(s) appear as separate lines on

the quote.

Optionally, select the linked description of the service to view product details
and service reference information.

10.3.2 Adding a Service for a Product on a Pending Order

To add a service to a serviceable product on a pending order:

Prerequisites

There must be a serviceable product in the Pending order to which you can
associate the service.

Steps

1.
2.
3.

Navigate to the Lines page.
Select Add Service To Previous Purchase.
Select Pending Orders from the Source drop-down menu.

Enter search criteria and select Go. You can search by Order Number, Order
Date, Product, or Description or leave all fields blank.

Results show serviceable products on the customer’s pending orders that meet
your search criteria.
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10.
1.
12.

13.

Select the serviceable product(s) to associate your service with and select Add
Service.

The Select: Service page opens, displaying service reference information for the
selected serviceable products and available services for that product.

Select the service(s) to add to the quote.

Use the calendar icon to select a start date for the service.
Optionally, change the Duration.

Optionally, change the Period.

Optionally, select a Line Price List.

Choose Select to apply your changes. The service(s) appear as separate lines on
the quote.

Optionally, select the linked description of the service to view product details
and service reference information.

10.3.3 Modifying a Service

To modify services after they are added to the quote:

Steps

1.
2.
3.

Select the service to modify.

Choose Modify Service from the Actions menu and select Go.

Revise the service information.

a. To change the start date, use the Calendar icon.

b. To change the duration, overwrite the value in the Duration field.

c. To change the period, select a new value from the drop-down menu.

Select Apply.
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10.4 Configuring Products

Note: Oracle Quoting supports multiple instantiation, through
integration with Oracle Configurator. For more information, see the
latest Oracle Configurator documentation.

To configure a Model product:

Prerequisites

Verify that the product is a model by selecting the Product Details link.
The quote must be saved.

The user can only change the quantity of model products if ASO: Allow
Quantity Updates for Top Level Model Item is set to Yes.

The user can only change quantity for components if ASO: Allow Quantity
Updates for Component Item is set to Yes.

The user must have update access to the quote.
The quote must not be in a read-only status.
The highest version of the quote must be used.

The quote must not be submitted for batch processing.

Steps

1.
2.

Select the configurable product.

Choose Configure from the Actions menu and select Go. The Configurator
page opens.

Configure the product as necessary. For more information on using Oracle
Configurator, see the <Insert product doc name here>.

Select Done. The Lines page displays the total price of the configured model
below the model description.

The Lines page displays the collapsed model. You can expand the model to
show immediate child components. It will not display all components.
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Note: A configuration is incomplete if the top level model product
added to the quote using Configurator is missing mandatory
components. A configuration is also incomplete if a model product
was added to the quote, but Configurator has not been invoked. An
incomplete configuration becomes complete after missing
components are added to the model configuration.

5. Optionally, change the quantity of the top level model or one of its components
by overwriting the value in the Quantity field and selecting Apply. If changing
the quantity of the top level model product, the quantity of all the components
will be updated to match the model product’s quantity. If changing the
quantity of a component, the top level model product and all its child
components will be updated to match the quantity.

10.4.1 Deleting a Component

You can delete components of model products without launching Oracle
Configurator. Configurator rules are invoked after each deletion and the incomplete
indicator appears if the deletion results in an incomplete configuration. This applies
to products on the quote and in quote templates. If the deletion results in an invalid
configuration, you cannot save the configuration. In this case, the configurations for
the model products and components revert back to the previously saved
configurations.

Note: If you delete a component with an associated service, the
service is deleted from the configuration as well.

Prerequisites
= ASO: Allow Quantity Updates for Component Item must be set to Yes.

= The user must have update access to the quote.

s The quote must not be in a read-only status.

s The component must not be part of a network container model.
s The highest version of quote must be used.

= The quote must not be submitted for batch processing.
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Steps
1. Navigate to the Lines page.

2. Expand the configuration for the top level model product.
3. Select the component to delete and select Remove Line from the Actions menu.

4. Select Go. The component is removed from the configuration.

10.4.2 Duplicating an Existing Configuration in a Quote

You can copy a top level model product to a new model product within a quote.
When copied, the top level model product with its components is an exact copy of
the original configuration.

If the original configuration has services associated with it, they are copied into the
new configuration.

Line level attributes, including price list, line level billing, line level flexfields, and
line level attachments are copied as well. This applies to products on the quote and
in quote templates.

Prerequisites
= Verify that the product is a model by selecting the Product Details link.

= The model must not be a Network Container

= The user must have update access to the quote.

s The quote must not be in a read-only status.

= The highest version of the quote must be used.

= The quote line must not be a service.

= The quote line must not be a model component.

= The quote line must not be a trade-in from the Installed Base.

= The quote must not be submitted for batch processing.

Steps
1. Navigate to the Lines page.

2. Select the Configuration model to copy.

3. Select Duplicate Line from the Actions menu.
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4. Select Go. The duplicated configuration is added after the last line in the quote.

10.5 Duplicating a Line

When you duplicate a line, line level attributes, including price list, line level
billing, line level flexfields, and line level attachments are copied into the new line.
If a service is associated with the line, the service is copied as well. This applies to
products on the quote and in quote templates.

To duplicate a line:

Prerequisites
= The user must have update access to the quote.

= The quote must not be in a read-only status.

= The highest version of the quote must be used.

= The quote line must not be a service.

= The quote line must not be a model component.

= The quote line must not be a trade-in from the Installed Base.

= The quote must not be submitted for batch processing.

Steps
1. Navigate to the Lines page.

2. Select the quote line to copy.
3. Select Duplicate Line from the Actions menu.

4. Select Go. The duplicated line is added after the last line in the quote.
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10.6 Adding Related Product

To add a related product to the quote:

Prerequisites
Product relationships must be set up in Oracle Inventory.

Steps

1.

Navigate to the Lines page and select the product to which you want to add a
related product.

Choose Add Related Products from the Actions menu and select Go.

Choose a relationship category or All to search across all categories and select
Go.

Select the related product to add to the quote.
Optionally, select a price list for the related product.
Choose Select.

10.7 Checking Product Availability

To check the availability of products in a quote:

Prerequisites
None

Steps

1.
2.

Navigate to the Lines page.

Select Check Availability. The Availability Information page opens, displaying
availability information for selected product, quantity and date needed.

Optionally, change the Need By date and select Check Availability.

Select Done to return to the Lines page.
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10.8 Allocating Sales Credits

Several sales credit types can be defined in Oracle Order Management. Each sales
credit type is either revenue or non-revenue. The sum of the allocations of revenue
sales credit types must equal 100% in a quote.

Prerequisites

The resource for allocation of sales credits must be set up in Oracle Receivables as a
valid sales representative.

Steps

1. To allocate sales credits:
s At the header level, select Sales Credits from the sidebar menu

s At the line level, select Sales Credits from the Actions menu on the Lines
page. The Sales Credits page opens.

Note: If you do not specify a header level sales credit, it will
default 100% to the primary salesperson.

If you do not specify a line level sales credit, the existing header
level sales credit is assigned to the line by default.

If you assign a sales credit to a line and exit without selecting
Update, the header level sales credit is defaulted into the line.

However, once you assign a line level sales credit and select
Update, the header level sales credit information no longer applies.

2. To allocate revenue sales credits:
a. In the Revenue Sales Credits section, select Add Person.

b. To search for sales representatives for sales credit allocation:

*  Choose a category from the Search pull-down menu

*  Enter the sales representative’s name or the wildcard character and a
partial name in the adjacent text field

*  Select Go. The page refreshes, showing your search results

c. Highlight the Select radio button adjacent to the appropriate sales
representative and choose Select. The Assign Sales Credits page refreshes,
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showing the sales representative in the Revenue Credits sales representative
listing.

d. Optionally, select a sales group for the sales representative.

e. For each sales representative, choose a revenue credit type from the
pull-down menu in the Credit Type column.

f. Indicate the percentage of sales credits each sales representative should
receive if this quote is placed as an order, in the text field in the Credit
Percent column.

Note: The sum of the allocations of revenue sales credit types
must equal 100% in a quote.

Select Apply to save your changes.
Optionally, select Revert to revert to your last-saved changes.

i. Optionally, to remove a sales representative from the Revenue Credits
section, check the Select checkbox for the appropriate sales representative
and select Delete.

To allocate non-revenue sales credits:

a. Inthe Non-Revenue Credits section, select Add Person.

b. To search for sales representatives for non-revenue credit allocation:
*  Choose a category from the Search pull-down menu

*  Enter the sales representative’s name or the wildcard character and a
partial name in the adjacent text field

*  Select Go. The page refreshes, showing your search results

c. Highlight the Select radio button adjacent to the appropriate sales
representative and select Select. The Assign Sales Credits page refreshes,
showing the sales representative in the Non-Revenue Credits sales
representative listing.

d. Optionally, select a sales group for the sale representative.

e. For each sales representative, choose a non-revenue credit type from the
pull-down menu in the Credit Type column.
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Indicate the percentage of non-revenue credits each sales representative
should receive, if this quote is placed as an order, in the text field in the
Credit Percent column.

Select Apply to save your changes.
Optionally, select Revert to revert to your last-saved changes.

Optionally, to remove a sales representative from the Non-Revenue Credits
section, check the Select checkbox for the appropriate sales representative

and select Delete.

10.9 Adding Trade-Ins to Quotes

If your merchant organization provides credit to customers for returning or
decommissioning existing products when they purchase new products, you can add

customer trade-ins to a quote.

When the application calculates the order total, it recognizes products with the line
type Return as trade-ins. The application treats trade-in prices as credits and
subtracts them from the order total. Pricing, taxes, and shipping charges are
calculated for trade-ins, for the current date.

You can also search the current quote-to customer’s Install Base for trade-ins. Install
Base only supports the trade-in of serialized products with a line flow of "Return
with Receipt." You can search the Install Base by:

Category

Order Number
Order Date
Product
Description
Serial Number
System

Installed At City
Installed At Country
Attribute Name
Attribute Value
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s Instance Number

You can also leave all fields blank and allow Install Base to return all products that
are active, returnable, and serialized.

You can select a model product for trade-in as long as it is serialized. If selected, the
model product and its children default into the quote as trade-ins. The children do
not need to be serialized to be traded in with the model product. Once defaulted,
you can remove one or more children. You can also select a child of a model product
without selecting the model product, if the child is serialized and returnable.

You can override trade-in product prices manually, as detailed in Section 7.1.4,
"Manual Adjustments"

Quoting supports the following trade-in flow:

Quoting and Installed Base Integration Overview - Trade Ins
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This flow demonstrates what occurs when a customer purchases a product and then
decides to trade it in. Initially, a salesperson creates a quote for the product and
converts it into an order. The serial number of the product is recorded in the
Shipping module and the customer’s Install Base is updated with the product
information. The customer then decides to return the product. In Quoting, the
salesperson searches the customer’s Install Base for the serialized product and
quotes a trade-in price. If the price is satisfactory, the salesperson submits the quote
as an order. The customer then ships the product to return. When the returned
product is received, the serial number of the product is entered in Shipping and the
customer’s Install Base is updated to reflect that the trade-in was returned.
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10.9.1 Adding a Trade-in to the Current Quote

To add a trade-in to a quote:

Prerequisites

ASO: Enable Line Type must be set to Yes at the appropriate level.
The order type must be Mixed.

The product total of the quote must exceed the value of the trade in(s).

Steps

1.
2.
3.

Navigate to the Lines page.
Select Add Product.

Using the procedure outlined in Section 10.1, "Adding Products to the Quote",
search for and select the product you want to trade-in.

Choose Adjust Pricing from the Action menu and select Go. The Adjust Pricing
page opens.

In the Summary section, change the Line Category Code to Return.
Select Return from the Line Type drop-down menu.
Select Apply.

On the Line page the Unit Net Price will appear in brackets, indicating that the
value is negative.

Note: Oracle Quoting will not accept an order total that is
negative.

Optionally, view line details by selecting the linked trade-in description.
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10.9.2 Adding a Trade-in From the Customer Install Base

To add a trade-in from the customer Install Base to a quote:

Prerequisites
The order type must be Mixed.

Steps

1.
2.
3.

Navigate to the Lines page.
Select Add Product.
Select Installed Base from the Source drop-down menu.

Enter search criteria and select Go. The results matching your search criteria
display at the bottom of the page.

Note: In order for Install Base to be updated with return
information, each trade-in must be serialized products with a line
type of Return Receipt Required.

Optionally, select the View Relationships icon. This icon appears for
Configurator model products only. The View Relationships page displays the
components of the model.

Select the product(s) to trade-in.
Optionally, select a line price list for the product(s).

Choose Select to add the trade-in(s) to the quote and return to the Lines page or
choose Select and Add More to add the trade-ins and then search for additional
trade-ins in different categories.

On the Lines page the Unit Net Price will appear in brackets, indicating that the
value is negative.

Optionally, view line details by selecting the linked trade-in description.
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10.10 Splitting Lines

To split a line:

Prerequisites

The quantity of the line you want to split must be greater than 1.
The user must have update access to the quote.

The quote must not be in a read-only status.

The highest version of the quote must be used.

The quote line must not be a service.

The quote line must not be a model component.

The quote line must not be a trade-in from the Installed Base.

The quote must not be submitted for batch processing.

Steps

1.
2.
3.

Navigate to the Lines page.
Select the line you want to split.

Choose Split Line from the Actions menu and select Go. The Split Line page
opens.

In the Split field, enter the quantity to split into another line.
Select Apply. The Lines page displays the split quantities as separate lines.
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10.10.1 Splitting a Configured Line

If you split a configured line, the new model and its components appear on a
separate line as an exact duplicate of the original line. The relationships are
preserved. All service items and line attributes (price list, line level billing, line level
shipping, line level attachments, etc.) are copied as well.

To split a configured line:

Prerequisites

The quantity of the line you want to split must be greater than 1.
The user must have update access to the quote.

The quote must not be in a read-only status.

The highest version of the quote must be used.

The quote line must not be a model component.

The model must not be a Network Container.

Steps

1.
2.
3.

Navigate to the Lines page.
Select the model product line to split.

Choose Split Line from the Actions menu and select Go. The Split Line page
opens.

In the Split field, enter the quantity you want to split into another line.
Select Apply. The Lines page displays the split quantities as separate lines.

Modifying Quotes 10-21



Viewing and Entering Quote Tax Details

10.11 Viewing and Entering Quote Tax Details

To enter tax exemption information for a quote. Tax handling options are located on
the Pricing page.

There are three tax options:
= Exempt — The current quote is exempt for a normally taxable customer site.

= Require — The current quote is taxable for a normally non-taxable, ship-to
customer or product.

= Standard — Taxation for the current quote should be based on existing
exemption rules.

Prerequisites
None

Steps

1. Select Pricing from the sidebar menu. The Pricing page opens.
2. Use the Tax Handling LOV to select the tax method.
If you select Exempt, then:
*  Select an Exemption Reason from the drop-down menu.

The menu displays tax exemption reasons defined in the Receivables
QuickCodes window.

*  Enter the exempt number in the Exempt Number field.

3. Select Apply.
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10.12 Viewing Quote History

To view the history of the current quote:

Prerequisites
None

Steps

1. Select Versions from the sidebar menu. The Versions page displays all versions
of the current quote.

2. Select the linked version number to access an overview of the quote version.

10.13 Linking a Quote to an Opportunity

To link a quote to an opportunity:

Prerequisites
None

Steps
1. Navigate to the General page.

2. Enter a partial value and a wildcard and select Go. The Search and Select:
Opportunity page opens.

3. Select to search by Name or Number, enter a value in the text field, and select
Go.

4. Select the opportunity and choose Select.

10.14 Entering Sales Supplement Information

Sales Supplement allows the capture of additional quote-specific information that is
not passed into Oracle Order Management.

To enter Sales Supplement information:

Prerequisites
= ASO: Enable Sales Supplement must be set to Yes at the appropriate level.

= Sales Supplement templates must be set up in Oracle Quoting - Forms.
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Steps

1.
2.

Navigate to the Sales Supplement page.

Select a template from the Template drop-down menu. The page refreshes,
displaying the template.

From the View drop-down menu choose the section in which you want to enter
information and select Go. The page displays the section with editable fields.

Enter information into the appropriate fields and select Apply to save your
changes.

Note: Once you enter responses and save, you cannot change the
template.

10.15 Changing the Base UOM for a Line

To change the base UOM for a line:

Prerequisites
None

Steps

1.
2.

Select the line for which you want to change the UOM.

Select Adjust Pricing from the Actions drop down box and select Go. The
Adjust Pricing page opens.

In the Summary section, use the drop-down menu to change the UOM.

The UOM drop-down menu displays only UOMs that are valid for the selected

product. If the selected UOM is not valid for the selected Price List, an error
message appears.
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Copying Quotes

This section contains information on copying quotes.
s Overview of Copying a Quote

s Copying Quotes
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11.1 Overview of Copying a Quote

In Oracle Quoting you can copy existing quotes to create new quotes. You can only
copy quotes for the same customer.

The table below lists the information copied in each Copy Quote method.

Table 11-1 Copy Quote Behavior

Copy to New Quote
Quote Name Yes
Quote Number No
Version Number No
Opportunity No
Contract Template Yes
Contract Number No
Contract Approval Level No
Expiration Date No
Status No
Published Flag No
Sales Channel Ye
Campaign Yes
Primary Salesperson Yes
Primary Sales Group Yes
Order Number No
Customer (party and account) Yes
Contact Yes
Quote-To Address Yes
Ship-To Customer (Party and Yes
Account)/Contact/Address at Header Level
and Line Level
Shipping Method, Shipping Instructions, Yes

Packing Instructions, Requested Delivery
Date at Header and Line Level
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Table 11-1 Copy Quote Behavior

Copy to New Quote
Bill-To Customer (Party and Yes
Account)/Contact/Address at Header Level
and Line Level
Payment Terms at Header Level Yes
Payment and Tax Information at Header and Yes
Line Level
Regular Products, Configured Products, Yes
Services and their reference source, Quantity,
and UOM
Manual Price Adjustments Yes
Automatic Price Adjustments Yes
Currency at Header Level Yes
Price List at Header Level and Line Level Yes
Pricing Agreement at Header Level Yes

Promotion Codes at Header and line Level Yes

Line Types Yes
Line Category Code Yes
Order Type Yes
Sales Credits at Header and Line Levels Yes
Attachments No
Notes No
Tasks No
Descriptive Flexfields at the Header and Line Yes
Level

Sales Team No
Approval History No
Sales Supplement No
Pricing Updated On No
Pricing Status No
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Table 11-1 Copy Quote Behavior

Copy to New Quote

Tax Updated On No

Tax Status No

11.2 Copying Quotes

To copy a quote into a new quote:

Prerequisites
None

Steps
1. In the Quotes page, select the quote to copy.

2. Select Duplicate. The Quote Overview page displays the new quote.
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Creating Proposals from Quotes

This chapter covers proposals integration.
= Overview of Proposals
s Creating a Proposal

= Viewing Proposal Details
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12.1 Overview of Proposals

Integration with Oracle Proposals allows sales representatives to create proposals
based on quotes and submit them to customers. Oracle Proposals streamlines
proposal creation by automating time- and resource consuming tasks. You can
generate proposals from templates that package recurring proposal elements such
as cover letters, executive summaries, and product descriptions.

When creating a proposal from Quoting, essential quote information, such as the
customer name, is automatically pulled into the proposal.

12.2 Creating a Proposal

To create a proposal:

Prerequisites

The quote is not expired

The quote has not been submitted for batch pricing call
The quote is not in Order Submitted status

The highest version of the quote must be used.

Pricing and Tax status must be Complete.

Steps

1.

2.
3.

Select Proposals from the Sidebar menu.
The Proposals page lists all proposals created for the quote.
Select Create Proposal.

Following the instructions listed in the Oracle Proposals User Guide.
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12.3 Viewing Proposal Details

To view proposal details:
Prerequisites

Steps

1. Select Proposals from the Sidebar menu.
2. Select the hyperlinked name of the proposal to view details.
The proposal details display.
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This chapter discusses the approval process in Quoting.

Overview of Approvals
Initiating an Approval

Viewing Approval Details
Cancelling the Approval Process
Approving a Quote

Rejecting an Approval

Reassigning an Approval

Initiating Approvals
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13.1 Overview of Approvals

Oracle Quoting uses the Oracle Approvals Management (OAM) engine to define
rules governing approvals. Within OAM, a situation or rule requiring approval is
defined using Attributes, Conditions, and Approval Type.

Attributes are used to define Conditions, and Approval Type determines the
contents and hierarchy of the approvers. One or more Conditions and an Approval
Type constitute a Rule.

A quote can be submitted for approval only if it meets the following conditions:
= Thelogged in user has update access to the quote.
= The highest version of the quote must be used.

s There is a transition defined from the current quote status to Approval Pending.

13.2 Initiating an Approval

When you initiate an approval, you can view the list of approvers and rules
applicable to the quote, if any. If Contracts integration is enabled, you can specify
that a non-standard contract is required by using the checkbox, so that the quote
status becomes Contract Required instead of Approved when all business approvals
are received for the quote. If you do not require a non-default contract, the quote
status changes to Approved when all approvals are received for the quote.

The ability to skip approvers is determined by the profile option ASO: Allow Skip
Approvers. When set to Yes you may skip approvers. If set to No, approvers cannot
be skipped.

To initiate an approval:

Prerequisites
= ASO: Enable Approvals must be set to Yes at the appropriate level.

= The highest version of the quote must be used.

»  There is a transition defined from the current quote status to Approval Pending.

Steps
1. Navigate to the Approvals page.

2. Select Initiate Approval. The Initiate Approvals page opens, displaying the
approvers and applicable rules for the approval process.
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Optionally, enter comments.
Optionally, select the checkbox if a non-standard contract is required.

To begin the approval chain with the next approver in the hierarchy, select
Obtain approvals from the entire list of approvers.

To skip approvers, choose the Obtain approval from the list of approvers
starting with radio button and select the approver from the drop-down menu.

Select Submit. The Approvals page displays confirmation that the quote was
submitted for approval. An email is sent to the next approver.

Optionally, select Cancel Approval Process to stop the approval process.

Optionally, select the linked Result to view the approval detail.

13.3 Viewing Approval Details

To view approval details:

Prerequisites
ASO: Enable Approvals must be set to Yes at the appropriate level.

Steps

1.
2.

Navigate to the Approvals page.

Select the approval Result link, to view details. The Approval Details page
opens.

Optionally, select the Approver Comments link to view each approver’s
comments.

Optionally, select the Notification Detail link to view notifications sent to each
approver.

Select Done to exit the page.
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13.4 Cancelling the Approval Process

To cancel an approval process:

Prerequisites
None

Steps
1. Navigate to the Approvals page.

2. Select Cancel Approval Process. The page refreshes, displaying confirmation
that the process was canceled.

13.5 Approving a Quote

Once an approval is initiated, it is passed on to the next approver. Each approver in
the hierarchy receives notification that the quote is ready for approval when it is
their turn to approve.

Refer to Oracle Workflow Guide for more information.

To approve a quote:

Prerequisites
ASO: Enable Approvals must be set to Yes at the appropriate level.

Steps
1. Login to Oracle Self Service Applications.

2. Select Workflow Administrator Web Applications.

3. Select Worklist.

4. Select the notification for the quote requiring approval.
5

To view quote details, select Click Here For Quote Details. The Quote
Overview page opens.

If you are logged into OSO or the Quoting - HTML UI, the Quote Overview
page opens. If not, the JTF login page opens and you must log in to access the
Quote Detail page.

6. Navigate back to the Workflow form.
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7. Optionally, enter comments.

8. Select Approve.

13.6 Rejecting an Approval

To reject an approval:

Prerequisites
ASO: Enable Approvals must be set to Yes at the appropriate level.

Steps
1. Follow steps 1 through 7 in Section 13.5, "Approving a Quote" above.

2. Select Reject. The quote status is now Approval Rejected.

13.7 Reassigning an Approval

To reassign an approval.

Prerequisites
ASO: Enable Approvals must be set to Yes at the appropriate level.

Steps
1. Follow steps 1 through 7 in Section 13.5, "Approving a Quote" above.

2. Select Reassign.
3. Select the person to whom you want to assign the approval.

4. To transfer ownership, select the Transfer ownership of this notification radio
button.

5. To delegate authority for the notification, select the Delegate authority for
responding to this notification radio button.

6. Optionally, enter comments.

7. Select OK.
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Applying Contracts to Quotes

This chapter covers contracts.
= Overview of Contracts

s Creating a Contract with Non Default Terms and Conditions
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14.1 Overview of Contracts

The objective of Quoting/Contracts integration is to automate the creation and
delivery of quotes with default or negotiated terms. Contracts integration into
Quoting includes the following;:

= Automatic creation and delivery of quotes with default terms and conditions,
without involving a contract administration team.

= Ability to request the assistance of a contract specialist to create or modify
non-default terms.

= Ability to print a quote with or without default or negotiated terms and
conditions.

= Support for contract integration during order placement and publishing.

= Ability to view contract reference, summary information, and terms and
conditions from Quoting.

Contracts integration is controlled by the profile option ASO: Enable Use
Contracts. If the profile is set to No, all menu options, buttons, and links related to
Contracts integration are disabled.

Note: You cannot remove a contract once it is associated with a
quote. You must change the status to Contract Canceled.
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14.1.1 Quotes and Contract Versioning

If a quote has an instantiated contract attached to it, the latest version of the contract
is attached to the quote.

You cannot create a new version of a quote that has a contract attached to it. The
instantiated contract is always attached to the latest version of the quote.

Note: If you copy a quote with an attached contract to a new
quote, the contract will not copy.

14.1.2 Contracts Quote Statuses

The following quote statuses support Contracts Core integration. For more
information on quote statuses, see Chapter 3.1.2, "Quote Status".

Contract Required — A quote was approved but the quote needs contract
authoring. The sales representative can request contract creation from this
status.

Contract Pending — A contract is being authored by a contract specialist. This
is a read only status.

Contract Canceled — The contract was canceled by the contract specialist. This
is a read only status.

Contract Approved — The contract was approved.
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14.2 Creating a Contract with Non Default Terms and Conditions

To create a contract with non default terms and conditions:

Prerequisites
= ASO: Enable Use Contracts must be set to Yes at the appropriate level.

= A contract administrator must be designated in OKC: Default Contract
Administrator for notifications.

s There must be a transition from the current status to Contract Pending.

s There must be an account designated for the quote.

Steps
1. Navigate to the Contracts page by selecting Contracts from the sidebar.

Note: To review Standard Terms and Conditions, select Review
Terms and Conditions on the Contracts page.

2. Select Request Contract Creation.

3. Enter Comments and select Submit. The Contracts page displays details about
the standard contract. The contract creation request is submitted to the contract
specialist. The Contract Specialist then submits the contract to the Contract
Administrator once the appropriate changes are made.

The Contracts page displays details about the contract. The quote is now in
Contract Pending status.

Note: After the contract is created and approved by the Contract
Administrator, you can select Request Contract Creation to request
additional modifications to the terms and conditions.
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Enabling Quoting Security

This chapter outlines the procedures necessary to enable and use Quoting Security.
= Overview of Security
= Adding a Resource to the Quote Sales Team

s Changing the Primary Sales Agent
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15.1 Overview of Security

Quoting Security is composed of three essential components:
= Quote Access Security
= Quote Function Security

= New Quote Security

Quote Access Security

Quote Access Security designates what quotes the user may access. A user should
only have access to quotes for the sales team the user belongs to and, if the user is a
manager, for the sales teams where the user’s subordinates are members.

Quote Access Security also determines whether the user has update or view-only
access to their quotes.

Quote Function Security

Quote Function Security determines whether there are user restrictions on
particular quote functionality. For example, a user can be restricted from placing
orders.

This security is controlled by profile options and /or permissions assigned to a user
or responsibility.

New Quote Security

New Quote Security determines if users can create new standalone quotes and for
which customers.

Primary Sales Agent

The Primary Sales Agent for a quote has quote ownership responsibility. The quote
creator must be set up as a valid resource in Resource Manager and as a sales
representative to default as the Primary Sales Agent.

If the quote creator does not meet these criteria, the sales representative selected in
the profile option ASO: Default Salesrep will default as the primary sales agent.
For more information on Primary Sales Agents, see the Oracle Quoting
Implementation Guide.

Note: The user cannot save or submit a quote without a primary
sales agent.
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15.1.1 Quote Access Security

Quote Access Security is controlled by the profile options ASO: Enable Security
Check. When the profile is disabled, users have access to all quotes. When it is
enabled, quotes access is restricted based on:

= Quote Availability Security — Restricts the quotes available to users based on
hierarchy and sales teams.

= Quote Data Security — Determines if users have update or view-only access to
quotes.

15.1.1.1 Quote Availability Security

Quote availability security restricts the quotes available to each user. A user must be
set up as a valid resource in order to view quotes when security is enabled. If the
user is a valid resource, the following quotes are available to that user:

= All quotes where the user is on the quote sales team. This includes all quotes
created by the user and all the other users on the quote sales team.

If the user is a manager, the following quotes are also available:

= All quotes for teams where the user’s subordinates are members

15.1.1.2 Quote Data Security

Quote Data Security is controlled by the Full Access checkbox on the Sales Team
page. Full access allows the user to modify any quote field and perform any
function that is not restricted by other Quoting requirements. If the quote is
changed to a read only status, the user may only update the payment information
and other fields that are updateable for read only statuses.

If a user has view-only access to a quote, the user cannot modify fields or perform
any function on the quote.

Manager Access

Managers have access to quotes for sales teams to which their subordinates belong.
The level of manager access is a combination of the level of subordinate access and
the profile option ASO: Manager Role Access.

If the profile is set to Update, the manager can update all quotes for the sales
team(s) their subordinates belong to.

If the profile is set to Inherit, the manager has the same access level as the
subordinate. If the profile is set to Inherit and the manager has multiple
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subordinates on the team with different access levels, the manager should inherit
the highest access level.

15.1.2 Quote Function Security

Quote function security determines what actions a user with update access can
perform. Profile options and permissions restrict the following functionality and
allow the user to:

= Override a quote status — The value of profile option ASO: Status Override
controls the user ability to update a quote when it is in read only status. This
ensures that the user can override quote data if a mistake was made before the
quote was transitioned to a read only status.

s Override the price list — The value of profile option ASO: Price List Override
controls the user ability to change the selected price list for a quote. This
functionality ensures that a user does not inadvertently quote an inaccurate
price based on the selection of an incorrect price list.

»  Create new customers — The value of profile option ASO: Create New
Customer controls a user’s ability to create new customer information. This
functionality ensures that customers wishing to protect the integrity of
customer data can restrict the creation of new customers to a limited number of
users.

= Update customer information — The value of profile option ASO: Update
Customer controls the user ability to create new customer contacts and
addresses.

= Update sales team information — The value of profile option ASO: Update
Sales Team controls the user ability to manually update sales team information,
including manual assignment of the primary sales agent.

For more information on the Quote Function Security profile options, see the Oracle
Quoting Implementation Guide.
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15.1.3 New Quote Security

New Quote Security restricts the parties for which a sales agent can create quotes. It
is governed by the profile option ASO: New Quote Security. If set to Yes, the user

cannot create new standalone quotes or copy existing quotes to new quotes. The

user can create quotes from opportunities.

If this profile is set to No, the user can create quotes for all customers.

If the profile option is set to Sales Team, the user must be on the account sales team
for the customer in order to select that customer in the quote header or copy a quote
for the customer.

Note: For integrated Quoting, account sales team information is
collected from either Oracle TeleSales or Oracle Sales Online.

15.2 Adding a Resource to the Quote Sales Team

To add a resource to the quote sales team:

Note: The Keep Flag is not supported in this release.

Prerequisites
You must have ASO: Update Sales Team set to Yes at the appropriate level.

Steps

1.
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Navigate to the Sales Team page.
Select Add Person. The Search and Select: Person page opens.

Enter search criteria and select Go.

In the results section, select the resource you want to add to the sales team.

Choose Select. The Sales Team shows the new sales team member.
Optionally, select a sales group for the new team member.
Optionally, select the Full Access checkbox to allow update access.

Select Apply.

Enabling Quoting Security
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15.3 Changing the Primary Sales Agent

To assign a new primary sales agent:

Prerequisites
= ASO: Update Sales Team must be set to Yes at the appropriate level.

= The person that you want to act as the Primary Sales Agent must be set up as a
valid resource in Resource Manager and as a sales representative.

Steps
1. Navigate to the General Page.

2. Inthe quote header, use the Salesperson LOV to select a new primary sales
agent.

3. Save the quote.
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Notes, Tasks, and Attachments

This section contains the processes and procedures necessary to view, add, and
modify notes, tasks, and attachments.

Overview of Notes, Tasks, and Attachments
Adding Notes to a Quote

Searching for Notes

Creating a Task

Searching for Tasks

Modifying a Task

Deleting a Task

Creating an Attachment

Viewing an Attachment

Deleting an Attachment
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16.1 Overview of Notes, Tasks, and Attachments

Notes — Notes contain descriptive information generated by users about business
transactions. Users can reference notes for additional information about specific
quotes.

Tasks — Tasks include actions that must be performed by the assigned user. You
can add and assign tasks in Oracle Quoting.

Attachments — Users can add attachments to their quotes depending on their
business needs, to store relevant documents or files along with orders in Order
Management. For example, you can attach communications from customers or sales
representative’s notes.

16.2 Adding Notes to a Quote

To create notes for a quote:

Prerequisites
None

Steps
1. Navigate to the Notes page by selecting Notes from the sidebar menu.

2. Select Create.

3. Select a note Type and Status.

4. Enter the note text in the Note field.
5

Optionally, select More to enter additional text beyond the character limit in the
main notes text box.

o

Optionally, relate the note to another note.
7. Select Create to create the note.

8. Select Create and Create Another to create the note and begin another new
quote.
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16.3 Searching for Notes
To search for notes:

Use this procedure to search for notes in the Notes form.

Prerequisites
None

Steps
1. Navigate to the Notes page by selecting Notes from the sidebar.

2. Choose the note Type and select Apply.
The page displays the matching notes.
3. View all notes for the quote by selecting All Notes.

16.4 Creating a Task
To create a task:
Prerequisites
None
Steps
1. Navigate to the Tasks page by selecting Tasks from the sidebar.
2. Select Create.

3. Fill out the Create Tasks form as described in the Oracle CRM Application
Foundation Concepts and Procedures.
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16.5 Searching for Tasks
To view all tasks associated with a quote:
Prerequisites
None
Steps
1. Navigate to the Tasks page by selecting Tasks from the sidebar.
Select if you want to view the Source or References.
Optionally, enter a date range.
Optionally, select the task type.
Optionally, select the priority.
Optionally, select the status.

To include private tasks, select the Include Private checkbox.
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Select Apply.
The page displays all matching tasks.

9. To view the task detail, select the linked task number.

16.6 Modifying a Task
To modify a task:
Prerequisites
None
Steps
1. Navigate to the Tasks page by selecting Tasks from the sidebar.
2. Select the linked task number.
The Task Details page opens.
3. Make the necessary changes and select Update.
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16.7 Deleting a Task
To delete a task:
Prerequisites
None
Steps
1. Navigate to the Tasks page by selecting Tasks from the sidebar.
2. Select the Remove checkbox for the task.
3. Select Update.

16.8 Creating an Attachment

In the HTML U], all attachments belong to the Miscellaneous category. Only
attachments with the document type File are supported.

To create an attachment:
Prerequisites
= The highest version of the quote must be used.

= The user must have update access to the quote.

Steps

1. Select Attachments from the sidebar.
The Attachments page opens.
2. Select Add Attachment.
3. Enter the file name or select Browse to search for the file.
4. Enter a description for the attachment and select Apply.

The attachment shows in the Attachments page.
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16.9 Viewing an Attachment

To view a document that is attached to a quote:

Prerequisites

The quote containing the attachments you want to view must be displayed in the
Quote Overview page.

Steps

1. Select Attachments from the sidebar.

2. Select the linked attachment name.

16.10 Deleting an Attachment

To remove an attachment from a quote:

Prerequisites
= The highest version of the quote must be used.

s The user must have Update access to the quote.

= The quote must not be in a read-only status.

Steps

1. Display the quote you want to remove the attachment from.
2. Select Attachments from the sidebar.

3. Select the attachment to delete.

4. Select Delete.
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Publishing and Printing

This section contains the processes and procedures necessary to print and publish
quotes in Oracle Quoting.

s Overview of Printing
= Printing a Quote
= Overview of Publishing Quotes

= Web Publishing a Quote
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17.1 Overview of Printing

The ability to print a quote allows you to offer customers hard copies of quotes
created in Oracle Quoting.

The print outs for Print Quote vary depending on whether or not the quote is
executable. A quote is executable if there is a valid transition from the current
quote status to Order Submitted status.

The non-executable Print Quote report displays key information available to you in
the Oracle Quoting Ul in addition to a customizable disclaimer:

= Quote information — Quote number, revision, date, expiration date, header
level payment term

s Customer information — Customer name, address, email address, and phone
number; ship-to customer name, address, and phone number; bill to customer
name, address, and phone number

= Pricing Agreement information — Agreement name, number, revision, and
revision date

= Line information — Product number and description, UOM, Qty, Unit Net
Price, Total Net Price, Sales Tax, Configurations for model products, Total price
for model products

= Attachments — Text type header attachments that are associated with the
document category Miscellaneous

s Charges — Quote line level charges and a summary of charges for entire quote
The following information is added if the quote is executable:

s Contract Information — Terms and Conditions for a contract associated with
the quote

Note: Contract information is only available on the Print Quote
report if Contracts integration is enabled.

= Signature block

There are templates available from which you can choose the print quote layout.
The seeded option is Default Print Layout. You can also choose to output format.
The seeded output formats are: PDF format or Rich Text Format (RTF). Oracle
Quoting uses Oracle Reports 6i to produce the Print Quote report.
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17.2 Printing a Quote

To print a quote:

Prerequisites
The highest version of the quote must be used.

Steps

1.

From the Quotes page, select on the quote name link.
The Overview page opens.
Select Print Quote from the Actions menu and select Go.

Depending on your browser, either a browser window opens displaying the
printout or you are asked to open or save the printout.

Select the Output Format from the drop-down menu.
Select the checkbox if you want to:

= Show subtotal by product category

= Show Price Adjustments

= Show Header Attachments (text type only)

= Show Charges

= Print in executable mode (This option will not appear if the quote is not
executable.)

Select a template from the drop-down menu.
Select Submit.

If you need a paper copy of the quote, choose your browser’s Print option to
print the report.
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17.3 Overview of Publishing Quotes

Sales representatives have the ability to share quotes with customers by web
publishing. A quote version may be web published if it meets all of the following
conditions:

The user has update access to the quote

The highest version of the quote must be used

The quote is not in Order Submitted or Inactive status

The quote is not expired

If the customer is of type organization, a contact has been specified

There is at least one specialty store in which the quote can be web published

Note: If a web published quote does not meet all of the
aforementioned criteria after it is web published, the Publish flag
still indicates that it is web published, but it will not show up in the
customer facing UL

If the customer is of type Person, the sales representative publishes the quote
directly to the customer. If the customer is of type Organization, the sales
representative publishes the quote to the contact. A quote version can only be
published to an FND_USER. Oracle Quoting verifies that the customer/contact is
an FND_USER. If the customer is not an FND_USER, the sales representative can
create an FND_USER for the customer by entering a username when attempting to
publish a quote.
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17.4 Web Publishing a Quote

To web publish a quote:

Prerequisites

ASO: Enable Web Publishing must be set to Yes at the appropriate level.
The user must have Update access to the quote.

The highest version of the quote must be used.

The quote is not in Ordered or Inactive status.

The quote is not expired.

If the customer is of type organization, a contact has been specified.

There is at least one specialty store in which the quote can be web published.

Steps

1.
2.
3.

Navigate to the Overview page.
Choose Web Publish Quote from the Actions menu and select Go.

If the customer is not an FND_USER, you will be prompted to enter a User
Name. The system auto generates a password and creates an FND_USER for
the customer. This information is then emailed to the customer.

Select the store the quote will be published to.

The Specialty Store ID will be stored in the quote header.

Select whether to send the email to an existing address or a new address.
Optionally, enter comments and select Submit.

In the Overview page, you receive a confirmation that the quote was
published.
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17.4.1 Unpublishing a Quote
To unpublish a previously published quote:

Prerequisites
= ASO: Enable Web Publishing must be set to Yes at the appropriate level.

= The highest version of the quote must be used.
= The user must have update access to the quote.

= The quote is not in Ordered or Inactive status.

Steps

1. Navigate to the Overview page.
2. Choose Web unPublish Quote from the Actions menu and select Go.

In the Overview page you receive a confirmation that the quote was
unpublished.
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Placing Orders

This section contains information about submitting orders to Oracle Order
Management.

= Overview of Placing Orders

= Placing an Order
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18.1 Overview of Placing Orders

When you submit an order in Oracle Quoting, the quote passes into an order using
Oracle Order Management.

18.2 Placing an Order

Note: Often the choices of a customer, contact, and address cannot
be separated from each other, since they are usually viewed as a
combination. If you change the customer, the address is replaced
and the contact is removed. If you change the contact, and the
address is associated with the contact rather than the organization,
remove the address. If you change the address, and the new
address is associated with a contact rather than the organization,
replace the contact with the new contact who has the new address.
If you change the address to a corporate address that is associated
with the organization, do not change the contact.

To place an order:

Prerequisites

There is a valid transition defined from the current status to Order Submitted.
The user must have Update access to the quote

The highest version of the quote must be used.

ASO: Enable Submit Button is set to Yes at the appropriate level.

There is at least one line in the quote.

The quote is not expired.

The quote must not be submitted for batch pricing.

Steps

1.
2.

Navigate to the Quote Overview page.

Add products to the quote, if necessary. See Section 10.1, "Adding Products to
the Quote" for instructions.
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Adjust discounts. This is an optional step. It is only necessary if there is a
discount you wish to apply to the order. See Chapter 7, "Pricing Products and
Quotes".

If the billing and shipping information has not been entered, then enter it.
If the payment information has not been entered, then enter it.
From the Actions menu, select Place Order.

The Overview page refreshes, displaying confirmation that the quote was
submitted as an order. The Order Number displays as a link.

Select the Order Number link to view the order details.
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Using Folder Functionality

This section contains information on using folder functionality in the Forms UL

19.1 Using Folder Functionality to Customize Forms

You can customize some forms in the Forms Ul. Once you make changes to an
existing folder, you can save the changes to a new folder or the same folder. Forms
Quoting uses Oracle Applications Folder technology to allow users to customize the
following forms:

Quote Customer Search
Quote Search

Quote Header

Quote Lines

Sales Team

You can change fields in the following ways:

Hide/Show
Move fields
Change field size

Rename Prompt

Prerequisites
None
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Steps

1. Place your cursor in a field on the form you want customize and right click, or
select an action from the Folder menu.

For information on hiding or showing a field, changing a prompt, changing the

length of a field, moving a field, or saving a folder configuration, see the Oracle

Application User’s Guide, Folders.

19.1.1 Fields That Cannot be Hidden

There are specific fields in the Forms Ul that users cannot hide.

Note:

Users should not hide mandatory fields.

The following table lists fields that cannot be hidden in each form.

Table 19-1 Fields That Cannot be Hidden

Form

Field

Quote Search

Quote Number

Customer Search > Organization Customer

Customer Search > Person Last Name

Quote Header > Summary Order Type

Quote Header > Summary Currency

Quote Header > Summary Salesperson

Quote Header > Addresses Quote To Address Details
Quote Header > Addresses Bill To Address Details
Quote Header > Addresses Ship To Address Details

Quote Header > Addresses

Default From Quote To (Bill To)

Quote Header > Addresses

Default From Quote To (Ship To)

Quote Header > Addresses

Bill To Customer

Quote Header > Payment, Shipping

Payment Terms

Quote Header > Payment, Shipping

Payment Type

Quote Header > Tax

Tax Handling

19-2 Oracle Quoting User Guide



Using Folder Functionality to Customize Forms

Table 19-1 Fields That Cannot be Hidden

Form Field

Quote Header > Tax Tax Code
Quote Header > Tax Amount

Quote Lines > Pricing Line

Quote Lines > Pricing Model Status
Quote Lines > Pricing Product

Quote Lines > Pricing Qty

Quote Lines > Pricing UuoOM

Quote Lines > Bill To Customer
Quote Lines > Ship To Customer
Quote Lines > Shipping Requested Date
Quote Lines > Service Reference Type
Sales Team Full Access
Sales Team Name
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Creating Quotes

This section explains the procedures necessary to create a quote in Oracle Quoting.
s Overview of Creating Quotes
s Creating a Quote

= Creating a Quote From an Opportunity
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20.1 Overview of Creating Quotes

A quote can be created as a new quote, as a copy of an existing quote, or from an
opportunity. If created from an opportunity, the opportunity name is displayed in
the Quote Name field.

Quotes have certain basic attributes. These attributes include quote name, quote
number, version number, customer, status, creation date, and assignment to a sales
representative.

When you create a quote, you must initially specify:

s Customer

s Customer account, if the customer has an active account

= Primary salesperson

= Expiration date

s Order type

s Currency

= Quote number, if ASO: Automatic Numbering is set to No

= Contract template, if ASO: Enable Use Contracts is set to Yes.

A record for the new quote is created when you enter the mandatory fields and save
the quote. Oracle Quoting then generates the quote number, version number,
creation date, and status. The quote number is unique across all quotes for all
customer IDs and account numbers. For a new quote, the version number is always
1 and by default the status is draft. If no Quote Name is specified when creating a
quote, the Quote Name defaults to Quote for <Quote To Customer>.

Quote number, customer, customer account (if specified), and currency cannot be
changed after the quote is saved.

The searchable list of customers comes from the customer repository in the Trade
Community Architecture (TCA). You can create new customers if the profile ASO:
Create New Customer is set to Yes at the appropriate level. You can create account
customers from the AR Customers form. You can create prospect customers from
Oracle Sales Online, Oracle TeleSales, or Oracle Quoting - HTML.
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20.1.1 Understanding Quotes

A quote is an offer to a customer that contains priced products and shows a total
price for the offer. You create a quote when you accumulate products for a customer
and save your work.

Oracle Quoting automatically assigns a number to the quote. This number appears
in the Quote Number field. The quote number is composed of the quote number
itself and a version number that increments each time a new quote version is
created.

Note: In the Forms U], the profile option ASO: Automatic
Numbering determines if the system automatically generates a
quote number. For more information, see the Oracle Quoting
Implementation Guide.

In the Forms UlI, your administrator can specify that when a quote is in the draft
stage, any changes you make simply overwrite your previous entries. If the quote is
in a status is auto-version enabled, each time the user selects the Save icon in the
toolbar, the application creates a new version.

These restrictions and permissions can be fully determined by your organizational
policies and implemented by your System Administrator. See Section 20.1.2, "Quote
Status" for more details.

Oracle Quoting keeps a list of all of the quote versions you have created. You can
view general information about all previous quotes for the customer. You can also
view the history of the current quote. In the Oracle Quoting main form, you can
modify only the latest version of a quote. Previous versions of a quote are read-only:
you can neither modify the quote from the user interface nor change the quote
status. However, in the Forms Ul you can use the Copy Quote functionality to
create a new quote version from a previous quote version if all the following
conditions are met:

= The highest quote version is not in the Contract Canceled or Order Submitted
status

= The highest quote version has no contract attached to it
= The highest quote version is not in Approval Pending status

= The quote is not submitted for batch pricing

Creating Quotes 20-3



Overview of Creating Quotes

You cannot delete quotes once you create them. You can inactivate quotes or set
quotes to expire automatically after a certain period of time.

20.1.2 Quote Status

The status of a quote indicates the evolution of a quote from the initial offer to order
placement. Quote status and transitions reflect your sales process. Status data
indicates progression of the quote life cycle. You may define your quote statuses to
determine what kind of changes a sales representative can make to the quote.

Oracle Quoting is delivered with predefined quote statuses. You can define new
quote statuses to reflect your business processes. But you cannot modify seeded
statuses unless they are user maintainable. In addition, you cannot delete any
statuses. You must deactivate those statuses you no longer want to use. See the
Oracle Quoting Implementation Guide for more information.

The status of a quote determines what kind of activities related to that quote are
possible. Your application administrator can set up and customize the rules
governing each updateable status in several ways, including the following;:

= Decide for each status if a new version of the quote is created or if the quote is
overwritten when you select the Save icon in the toolbar

= Decide which statuses allow modification of the quote and which are read-only
= Add statuses

= Change status names

= Define, by application, a default quote status on a new quote or version

= Decide the statuses to which a given status can change

20.1.2.1 Pre-Defined Quote Statuses
The following table shows the available seeded quote statuses.

Quote Status Description Read-only
Approval Canceled  Sales representative canceled the approval process. No
Approval Pending Quote is pending approval. Yes
Approval Rejected Approval was rejected by the approvers. No
Approved Approved by the approvers. Yes
Contract Canceled Contract canceled by the contract administrator. Yes
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Quote Status Description Read-only
Contract Pending Contract is review with the contract specialist. Yes
Contract Required Contract specialist to author and approve contract Yes
required after approval process.
Draft Initial status. No
Inactive No more activity allowed. Yes
Order Submitted Order submitted to Oracle Order Management. Yes
StoreDraft For iStore internal use only. No

The statuses in the following table exist for backward compatibility (for previous
version of Oracle Quoting), but there is no functionality behind them.

Quote Status Description Read-only
Bid Could be used to show that the quote was presented to No

a customer.
Lost Could be used to show that the customer No

declined /rejected the quote.

Problem Could be used to show there is a problem with the No
quote being submitted as an order.

Note: The system will not automatically set this status
if the order is not submitted.

Reviewed Could be used to show that the quote was reviewed No
internally.

Note: The statuses Ordered and Entered are obsolete in this release. They still appear
in the Quote Status setup form but they will be locked. You will not be able to create
any transitions to them, nor will you have the ability to enable them.

If a quote status is read only you only update the following attributes:
= Modify notes.

= Change the quote status, as long as the transition is valid. Thus, you can
potentially place an order, initiate approval, request contract creation or change,
etc.
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s Publish or unpublish a quote, if publishing is enabled and the quote satisfies
publishing criteria.

= Modify payment information, until the order is submitted.

= Add attachments. You cannot remove, or replace existing attachments.

Note: A user can fully update a quote in read-only status if the
system administrator sets the profile option ASO: Status Override
to Yes for that specific user. Yet, even if the profile is set to Yes, the
user must have update access to the quote to be able to modify it.

If you want to update a quote in read-only status:
» Transition to an updateable status.
s Create a new quote version.

= Use Copy Quote to create a brand new quote.

20.1.2.2 Rules for Quote Status Changes

Status changes are regulated to prevent accidental changes, such as reverting an
ordered quote status back to a non-ordered status.

Note:
status.

You cannot set up a transition from a status to the same

The following table shows the seeded transition rules for quote status changes.

Table 20-1 Seeded Quote Status Transitions

From To User Maintainable
Approval Pending Approved No
Approval Pending Approval Canceled No
Approval Pending Approval Rejected No
Approval Pending Contract Required No
Contract Pending Contract Approved No
Contract Pending Contract Cancelled No
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Table 20-1 Seeded Quote Status Transitions

From To User Maintainable
StoreDraft Draft No
StoreDraft Inactive No
StoreDraft Order Submitted No
StoreDraft Contract Pending No
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20.2 Creating a Quote

A quote lists the products your customer is interested in purchasing before you
place an order.

The behavior of the Customer and Account LOVs in the header depends upon the
ASO: Auto Account Creation profile option setting. See Section 24.1.1, "Customer
Data" for more information.

Note: The maximum number of results in the LOVs for the Quote
To, Ship To, and Bill To customers and accounts at the header and
line level is limited by the profile option ASO: Max Number of
Results.

You must enter the following information to create a quote:
»  Customer
»  Customer Account (if the customer has an active account)
= Primary Salesperson
= Expiration Date
s Order Type
s Currency
= Quote Number (if ASO: Automatic Numbering is set to No)
s Contract Template (if ASO: Enable User Contracts is set to Yes)

To create a quote:

Prerequisites
None

Steps
1. Log in to Oracle Forms with the Quoting Sales Agent responsibility.

2. Choose Quoting from the Navigator.
3. Enter the customer information for the quote:

a. Optionally, enter a quote name.
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b. Use the Customer LOV to select the customer name or use the Customer
search. See Section 21.3, "Searching for Customers".

c. Use the Account LOV to select an active account number for the customer.
This field automatically populates when you select the customer.

If the customer does not have an account number, one is created based on
the setting of the profile option ASO: Auto Account Creation. See
Chapter 24, "Customers and Relationships" for more information.

If the customer is not specified, the user can use the Account LOV to select
the Quote To customer and account. The Quote to customer will be copied
to the Customer field.

d. Optionally, use the Contact LOV to select a contact for the customer.
e. Optionally, enter a different expiration date.
f. Optionally, use the Order Type LOV to select a different order type.

This field is automatically populated with the value from the profile option
ASO: Default Order Type.

g. Use the Salesperson LOV to select a primary sales agent for the quote.

This field is automatically populated with the current user if the user is set
up as a valid salesperson. If not, the field defaults to the sales representative
designated in ASO: Default Salesrep.

h. Optionally, use the Contract Template LOV to select a different contract
template.

This field is automatically populated based on the setting of the profile
option ASO: Contract Template for Standard Terms and Conditions.

4. Add products to the quote:

For information on adding products to a quote, see Section 26.2, "Adding
Products to the Quote".

5. Select the save icon.

The application saves the quote and generates a quote number that is displayed
in the Quote Number field. The Quote Name will be populated with Quote for
<Customer> if it is not specified.

20.2.1 Selecting an Existing Customer in the Oracle Quoting Form

To find and select a quote-to customer in the header of the Oracle Quoting form:
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Note: The maximum number of results in the LOVs for the Quote
To, Ship To, and Bill To customers and accounts at the header and
line level is limited by the profile option ASO: Max Number of
Results.

Prerequisites
The customer must exist in the database as a party of type Person or Organization.

Steps
1. Navigate to the Oracle Quoting form.

2. Use the Customer LOV to select the customer’s name, or enter some portion of
the customer name and the wildcard (%).

The behavior of the Customer LOV is controlled by the profile option ASO:
View Customers Without Accounts. If set to Yes, the LOV displays all active
parties of types Person and Organization. If set to No, the LOV displays active
parties of type Person and Organization that have active accounts. The account
number is copied to the Account field when the customer is selected and an
account exists for the customer. For more information, see the Oracle Quoting
Implementation Guide.

3. Optionally, use the Account LOV to select a different account number.

Oracle Quoting automatically populates the Account field when you select the
Customer. The LOV displays all active accounts for the selected customer.

= Ifno account exists, one may be created for the customer based on the
setting of the profile option ASO: Auto Account Creation. See
Section 24.1.2, "Creation of Accounts" for more information.

= If no customer was selected, the LOV displays all accounts and their related
parties.

4. Optionally, use the Contact LOV to select a contact for the customer.

The LOV displays all parties of type Person that have a party relationship with
the customer.

You can also select a customer by entering the account number in the Account field
Oracle Quoting then populates the Customer field.
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20.3 Creating a Quote From an Opportunity

To create a quote from an opportunity:

Prerequisites

You must be logged onto Oracle TeleSales to perform this procedure.

Use an existing opportunity or create a new one. See the Oracle TeleSales User
Guide for detailed instructions on creating and accessing opportunities.

Steps

1.

2
3.
4

Navigate to Opportunity Center or to eBusiness Center > Opportunity.
Select the opportunity you wish to use.

Select Create Quote. The Create Quote From Opportunity form opens.

The following fields, when available, are defaulted and cannot be changed:
s Customer Name

= Quote Number (if ASO: Automatic Numbering is set to No)

= Opportunity Name

Optionally, select an Account Number for the customer.

The LOV displays all account numbers for the customer. If there is only one
account number, it defaults into this field.

Optionally:

= Select a different Contact.

= Select a different Address.

s Enter a different Quote Name.

= Select a different Order Type.

= Select an Agreement.

= Select a different Currency.

= Select a different Price List.

= Select a different Contract Template.
= Select a different Salesperson.

= Select a Sales Group.
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m Select a Sales Channel.
m  Select a Source Name.
7. Select Create Quote.

The new quote displays in the main Quoting form.
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Searching

This section contains information on performing searches in Oracle Quoting.
= Searching Using the Query Method

= Searching for Quotes

= Searching for Customers

= Using interMedia Search
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21.1 Searching Using the Query Method

The query method allows you to search for quotes using the following criteria:

s Quote Name

s Quote Number

s Quote Status

s Customer (quote-to)

s Account (Quote-To Customer)

s Contact (Quote-To Customer)

The query method allows you to search for lines (in the Lines tab) using the
following criteria:

Model Status

Specify an asterisk as the search criteria if you want to search for incomplete
configuration.

Product

Qty

UOM

Price List (Pricing Region)

Line Category (Pricing Region > Details)

Line Type (Pricing Region > Details)

Configurable (Pricing Region > Details > Attributes)
Shippable (Pricing Region > Details > Attributes)
Support Service (Pricing Region > Details > Attributes)
Serviceable (Pricing Region > Details > Attributes)
Returnable (Pricing Region > Details > Attributes)
Reference Type (Service region)

Specify UNSPECIFIED as the search criteria to search for service items that do
not have a serviceable item reference.

To search using the query method:
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Note: This general method of searching can also be used
in other Forms application windows.

Prerequisites
If searching in the Lines tab, a quote must be displayed in the Quoting form.

Steps

1.
2.

Place your cursor in one of the fields in the region that you wish to search.

From the View menu, choose Query by Example > Enter. The color of the
searchable fields changes to blue.

Enter a full or partial value into one of the fields. You can use the wildcard %.
For example, the value F%, returns all entries starting with the letter F.

From the View menu, choose Query by Example > Run.
The application displays a matching entry, if any.

Check the status bar to see how many matching entries were found. If the
application found more than one matching entry, then place the cursor in any
field and use the down arrow on the keyboard to scroll through.

21.2 Searching for Quotes

You can search for quotes using the following criteria:

Customer Name
Account Number
Contact Name

Quote Name

Quote Number

Quote Status

Product

Expiration Date (From)
Expiration Date (To)
PO Number
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s Opportunity Name
= Opportunity Number
= Phone Number

s Quote Version

Note: If searching by quote version, you must also enter a quote
number.

s Currency

m  Price List

s Order Type

= Agreement

s Quote Amount (From)
s Quote Amount (To)

s Creation Date (From)
s Creation Date (To)

» Update Date (From)
=  Update Date (To)

= Web Published

= Primary Salesperson
s Primary Sales Group
= Salesperson

= Sales Group

= Sales Channel

= Source Name

Once the search results display, you can view the quotes. The number of results
displayed depends on the profile option ASO: Max Number of Results. For more
information, see the Oracle Quoting Implementation Guide.
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You can also hide infrequently used criteria or rearrange the search criteria fields so
that key criteria appear at the top of the criteria section. After making changes, you
can save the new search criteria arrangement and use it for subsequent searches.

Note: The Quote Number field cannot be hidden.

21.2.1 Basic Search

To search for quotes:

Prerequisites
None

Steps

1.

Access the Quote Search form in one of the following ways:
= Select Quote Search from the Navigator

= Select View > Find.

= Select the flashlight icon

Select the Basic tab.

Select Quote from the Find drop-down menu.

Enter search criteria in the appropriate fields. You must enter a value in at least
one field.

Note: You cannot specify leading wildcard characters ("%, '_") in
the search criteria.

Select Search. The results display in the Results section.

Optionally, view a quote by highlighting it and selecting View.

Note: The maximum number of results in the LOVs for the
customer and account in the Basic Search form is limited by the
profile option ASO: Max Number of Results.
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21.2.2 Advanced Search

To search for quote:

Prerequisites
None

Steps

1. Access the Quote Search form in one of the following ways:
= Select Quote Search from the Navigator

= Select View > Find.

= Select the flashlight icon

Select the Advanced tab.

Select Quote from the Find drop-down menu.

Select a value from the Item LOV.

Select a condition.

@ o » w N

Enter a value in the Value field.

[

Note: You cannot specify leading wildcard characters ('%/,
the search criteria.

) in

7. Select Search. The results display in the Results section.
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21.3 Searching for Customers

You can perform a fuzzy search, widening the scope of a search and presenting data
comparable to the search criteria. The fuzzy search method uses Word Replacement
Rules to map a word, abbreviation, or special character to a similar word,
abbreviation, or special character.

You can search for customers of party type Organization using the following
criteria:

s Customer Name

s Account Number

s Taxpayer ID

s Tax Registration Number
s Contact Last Name

s Contact First Name

= Contact Phone

= Original Reference

Note: You can only perform a fuzzy search for an Organization if
you enter either Customer Name or Contact First Name and
Contact Last Name.

You can search for customers of party type Person using the following criteria:
s First Name

s Last Name

= Account Number

= Phone Number

s Taxpayer ID

s Tax Registration Number

= Original Reference
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Note: You can only perform a fuzzy search for a Person if you
enter either First Name and Last Name.

Once the search results display, you can view the quotes. The number of results
displayed depends on the profile option ASO: Max Number of Results. For more
information, see the Oracle Quoting Implementation Guide.

You can also rearrange the search criteria fields so that key criteria appear at the top
of the results section or hide infrequently used criteria. Once you make changes,
you can save the new search criteria arrangement and use it for subsequent
searches. See Chapter 19, "Using Folder Functionality" for more information.

21.3.1 Searching for an Organization

To search for an organization:

Prerequisites
None

Steps

1. Access the Customer Search form in one of the following ways:
= Select Customer Search from the Navigator
= Select View > Find.
= Select the flashlight icon

2. Select Organization from the Find drop-down menu.

3. Enter search criteria in the appropriate fields. You must enter a value in at least
one field.

4. Select Exact Search to execute an exact search.
Select Fuzzy Search to execute a fuzzy search.
The search results display.

5. Optionally, highlight a customer in the search results and select Apply to Quote
to use this customer (as the Quote-To Customer) in the current quote.
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21.3.2 Searching for a Person

To search for a person:

Prerequisites
None

Steps

1. Access the Customer Search form in one of the following ways:
= Select Customer Search from the Navigator
= Select View > Find.
= Select the flashlight icon

2. Select Person from the Find drop-down menu.

3. Enter search criteria in the appropriate fields. You must enter a value in at least
one field.

4. Select Exact Search to execute an exact search.
Select Fuzzy Search to execute a fuzzy search.
The search results display.

5. Optionally, highlight a customer in the search results and select Apply to Quote
to use this customer (as the Quote-To Customer) in the current quote.

21.4 Using interMedia Search

You can search for products using the interMedia search if the profile option ASO:
Enable interMedia Search is set to Yes. interMedia search allows you to search on
the Product field in the Lines tab, using any of the following criteria:

= Part Number
= Description
s Long Description

If interMedia search is not enabled, you can only search by Part Number and
Description in the Product LOV.
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Credit Checks

This section contains information about performing credit checks.
s Overview of Credit Checks

= Performing a Credit Check
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22.1 Overview of Credit Checks

Credit checking in Oracle Quoting allows the user to determine the credit
worthiness of a customer while working on a quote. The user can decide if the
quote should be submitted for business approvals credit verification. The profile
option ASO: Enable Credit Check determines if credit checks can be performed.
See the Oracle Quoting Implementation Guide for more information.

There are two types of credit checks available in Oracle Quoting:

Internal — Internal credit checking is based on transaction data in the quote,
and historic transaction data in Oracle Order Management and Oracle
Receivables. It pertains to quote header level billing information. Internal credit
checks are performed by the public credit check API OE_EXTERNAL_CREDIT_
PUB.

The key differences between internal credit checking and the credit checking
functionality in Oracle Order Management are:

= Item category limits are not checked in the public credit check API provided
for internal credit checks.

s Credit checking is only available at the header level in internal credit
checking, while OM credit checking supports both header and line level
credit checks.

= There is no Holds functionality for Internal credit check

External — External credit checks are configurable by the application developer
and allow users to make calls to non-Oracle applications. Please see the Oracle
Quoting Implementation Guide for more information.

Based on setup, internal and/or external credit checks may be performed. The
internal credit check is performed if ASO: Credit Check Rule is set at the
appropriate level. The external credit check is performed if it is configured by the
application developer.

22.2 Performing a Credit Check
To perform a credit check:

Prerequisites
= ASO: Enable Credit Check must be set to Yes at the appropriate level.

= The quote status must not be Order Submitted

22-2 Oracle Quoting User Guide



Performing a Credit Check

= The quote must not be expired.

= The highest version of the quote must be used.

= The quote must not be submitted for batch pricing.

»  There must be a designated Billing customer on the quote.
s The billing customer must have an account.

s There must be a billing address designated on the quote.

= Pricing and Tax Statuses must both be complete.

Steps
1. Select Actions > Initiate Credit Check and select OK.

2. A pop-up window displays the results of the credit check.

Note: The results of the credit check are not saved in the quote.

Credit Checks 22-3



Performing a Credit Check

22-4 Oracle Quoting User Guide



23

Pricing Products and Quotes

This section provides information and instructions on pricing products or entire
quotes.

Overview of Pricing

Executing Manual Pricing and Tax Requests for a Quote

Pricing a Product

Applying Custom Pricing Attributes
Overriding Price Break Level Adjustments
Pricing Configurable Products

Applying Promotion Codes

Adjusting the Price of a Product in the Quoting Form

Applying a Non-Automatic Discount to a Product or the Entire Quote

Manually Adjusting Prices in the Price Adjustments Form

Freezing Prices for a Quote
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23.1 Overview of Pricing

The price your customer pays for a product depends on the price lists, manual
adjustments, and promotional discounts you enter.

23.1.1 Price Lists

Price lists are set up in Oracle Advanced Pricing or Oracle Order Management. Your
company can have many different price lists. For example, there may be a price list
for a consumer and a price list for corporate customers who receive an automatic
discount because they buy from your company in bulk. You may have yet another
price list for customers with special contractual arrangements with your
organization.

You can select a price list for the order as a whole and for each individual product.
The price list for a product supersedes the price list for the entire quote when
determining the price for that specific product.

The header price list defaults based on the following information on the quote (in
the following order):

= Agreement
s Quote-to Customer

s Order Type

23.1.2 Custom Pricing Attributes

Custom Pricing Attributes allow you to price a product based upon multiple
factors, allowing for greatly increased product and price flexibility. For example, the
price of a one year service agreement may depend upon many factors, such as
response time, support hours, and coverage. With Custom Pricing Attributes, you
can set up one product with a formula that determines the price based on the
selected attributes. Custom pricing attributes can be set up in the Oracle Pricing UL
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23.1.3 Discounts

Oracle Quoting allows both header-level and line-level discounts. Order-level
discounts are applied to each line on the quote, while line-level discounts are
applied to specific products only. If there are multiple discounts available for an
order or a line, the application combines them.

Example

A customer purchases a $200.00 coat and a $100.00 shirt. There is a 10% discount
available for the shirt and a 50% discount available for the entire order. The quote
price is calculated as follows:

= The coat: $200 - 50% = $100.00
»  The shirt: $100 - 60% = $40.00
= Total price = $140

23.1.4 Pricing Adjustments

Quoting is set up to display automatic adjustments (which are calculated in Oracle
Advanced Pricing) applicable to the selected product and customer. You can also
manually apply non-automatic adjustments.

If ASO: Calculate Price is set to Automatic, each time you change a product in a
quote, the whole quote is repriced automatically. A change in one product can affect
the level of other offers and discounts.

Pricing Date

Oracle Pricing uses the Pricing Date to interpret the effective dates set up in Pricing.
Pricing Date is useful if you want to ensure that the prices on a quote do not change
if product prices are updated in Oracle Pricing. You may also want to initially quote
prices based on historical pricing information or future pricing information.
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23.1.5 Manual Adjustments

There are two ways to manually adjust prices in Oracle Quoting. You can either
manually override the price of a product in the main Quoting form or change the
manual override adjustment value, for a product or the whole quote, in the Price
Adjustment form.

You can manually adjust prices at the line level in Oracle Quoting, if ASO:
Discounting Privilege is set to Full. If set to Full, you can modify the Unit Net Price
field to reflect an adjustment or override the value of a non-automatic discount in
the Price Adjustments form.

23.1.6 Terms Substitution

When a quote is priced using Advanced Pricing, the pricing engine checks if there
are terms substitutions available at either the header or line level. The following
terms substitution types are supported by Oracle Advanced Pricing:

» Payment Terms Substitution
»  Freight Terms Substitution
= Shipping Method Substitution

Depending on the defined modifiers , any of the available values can be substituted
after the pricing engine call.

For more information on modifiers and terms substitution, see the Oracle Advanced
Pricing User’s Guide and the Oracle Advanced Pricing Implementation Manual.

23.2 Executing Manual Pricing and Tax Requests for a Quote

Out of the box, Oracle Quoting automatically prices and calculates tax for a quote
whenever a change is made to the quote that affects pricing, A quote change that
affects the pricing will also affect tax values. Tax is computed after the pricing call,
since it is dependant on product pricing. The following quote changes do not affect
quote pricing:

= Sales credits changes

= Attachments changes

= Notes changes

» Initiate/Cancel Approvals

= Request Contract Creation or Assistance
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= Sales Team changes

= Web Publish or Unpublish

s Initiate Credit Check

= System driven quote status changes
s Place Order

If the profile option ASO: Calculate Price is set to Manual, you can choose when to
calculate prices and tax for the quote. You can also choose to calculate tax manually
by setting ASO: Calculate Tax to Manual. Depending on the setting of ASO:
Enable Batch Processing you can choose to price the quote interactively or through
a batch request. See the Oracle Quoting Implementation Guide for more information.

Note: Setting ASO: Calculate Price to Manual and ASO:
Calculate Tax to Automatic is not supported because quote tax is
based on the quote product pricing.

A user can still manually price a quote by selecting Price Quote, even if the profiles
ASO: Calculate Price and ASO: Calculate Tax are set to Automatic. Manual pricing
and tax calculations allow the user to capture the most recent price/tax information.

If the Pricing Date is set, Oracle Quoting will price the quote as of the date specified
in the Pricing Date field. The date can be any time in the past or future. If this field
is blank, quotes are priced as of the current date and time.

The option to manually price a quote is particularly helpful to users who are:
= Entering a number of quotes lines

= Entering a number of quote lines in a Configurator session

= Making a number of quote line changes

= Entering a number of quote lines in a quote template or across multiple
templates

= Entering line with complex tax or pricing setups

Repricing after each change or addition increases processing time. Therefore, the
ability to price the quote manually is more efficient.

If the pricing or tax statuses are incomplete, users will not be allowed to:

= Submit a quote for approval
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= Approve a quote

s Request Contract Creation
= Web publish a quote

» Initiate a credit check

= Print a quote

= Place an order

To manually price a quote:

Prerequisites
= The highest version of the quote must be used.

= The quote is not in a read-only status.
»  The user has Update access to the quote.

= The quote has not been submitted to batch pricing.

Steps
1. Select Price Quote.

If ASO: Calculate Price is Automatic AND ASO: Calculate Tax is Automatic
AND ASO: Enable Batch Processing is No, the Price Quote form will not be
shown but the quote will be priced. For any other combination of these three
profiles, the Price Quote page is displayed.

2. Choose to compute price only, tax only, or both.
3. Choose when you want to price the quote.

If you have ASO: Enable Batch Processing set to Yes, you will have two
options for pricing the quote: Now or Submit pricing request and
notify me when it is complete.If ASO: Enable Batch Processing it set
to No, these options are not available and the application defaults to Now. See
the Oracle Quoting Implementation Guide for more information.

4. Select Submit.

If you chose Submit pricing request and notify me when it is
complete, a pop-up window confirms that the pricing request has started and
gives you a concurrent request number that you can use to search for pending
requests. Once the pricing request is complete, a notification is sent to the user
who initiated the pricing and tax request.
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The quote is not updateable (except for notes and attachments) until the pricing
request is complete or canceled. The Summary Region of the Quote Header tab
displays the Pricing and Quote Statuses, and the Pricing Request number, if you
selected Submit pricing request and notify me when it is
complete in the Submissions Options field on the Price Quote page.

23.2.1 Viewing Details of the Pricing Request

You can view the pricing request details if ASO: Enable Batch Processing is set to

Yes.

To view pricing request details:

Prerequisites

ASO: Enable Batch Processing must be set to Yes.
The highest version of the quote must be used.
The quote is not in a read-only status.

The quote has been submitted for batch pricing.

Note: After the batch pricing request completes the user will
receive an email notification.

Steps

1.
2.

Select Actions > Pricing Request Details and select OK.
The Pricing Request Details form displays:

s Pricing Request ID

= Date Submitted

= Request Name

= Phase

= Requestor

= Date Started

= Status
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23.2.2 Canceling a Pricing Request

To cancel a pricing request:

Prerequisites
= ASO: Enable Batch Processing must be set to Yes.

= The highest version of the quote must be used.
= The quote is not in a read-only status.

= The quote has been submitted for batch pricing.

Note: When a quote is submitted for batch pricing, the phase may
be one of the following: Pending, Inactive or Running.

Steps
1. Navigate to the Pricing Request Details form.

2. Select Cancel Pricing Request.
The Pricing Request status changes to Canceled.
OR
1. Select Actions > Cancel Pricing Request and select OK.
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23.3 Pricing a Product

To price a product in the Lines tab:

Prerequisites
None

Steps
1. To apply a price list only to the product displayed in the Pricing section of the
Lines tab:

a. Enter the product number or use the LOV to search for a product.
b. Enter the quantity in the Qty field.
Enter the UOM.

o

e

Use the LOV to enter a price list.

e. If the Bill of Materials (BOM) item type is Model, then you must view its
price following the procedure outlined in Section 23.6, "Pricing
Configurable Products".

f.  If the product is a Service, navigate to the Service section and use the Period
and Duration LOVs to enter the period and duration of the service, and
enter a start date.

The product pricing appears when you tab out of the Price List field. The Unit List
Price shows the list price of this product from the price list displayed in the Price
List field. The Unit Adjustment field shows all adjustments on the line. The Unit %
Adj shows the percentage of the adjustments on the line. The Unit Selling Price
shows the selling price per unit. The Total Price shows the total price for a product.

You are now ready to:
= Add another product to the quote
= Adjust prices

= Enter payment information
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23.4 Applying Custom Pricing Attributes

To apply custom pricing attributes:

Prerequisites
Pricing attributes must be set up in Oracle Advanced Pricing.

Steps

1.

To apply custom pricing attributes at the header level, place the cursor in the
header of the Quoting form or the Quote Header tab.

To apply custom pricing attributes at the line level, place the cursor on a line in
the Lines tab.

Select Actions > Promotions/Pricing Attributes.

Use the LOV to select a Pricing Context. The Level field is populated
automatically based on the selected Pricing Context.

Select Apply.

If ASO: Calculate Price is set to Automatic, Quoting automatically reprices the
product price(s) based on the pricing attributes.

23.5 Overriding Price Break Level Adjustments

For more information on price break adjustments, see the Oracle Advanced Pricing
User’s Guide.

To override a price break level adjustment:

Prerequisites

In Oracle Pricing, the Override Flag for the price break adjustment must be
enabled.

ASO: Discounting Privilege must be set to Full.
The user must have Update access.

The highest version of the quote must be used.
The quote must not be in a read-only status.

The quote must not be submitted for batch pricing.
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Steps

1.
2.
3.

N o a &

Select Actions > Price Adjustments > OK.
Highlight the price break adjustment on the Line Level Adjustments form.
Select Details.

The Details button is enabled only if the adjustment is a price break adjustment.
The Price Adjustments Details form displays the price break level records set up
for the price break adjustment.

To change the value of the adjustment, enter a new number in the Value field.
Select a reason code from the Reason Code LOV.

Enter a reason for the change in the Reason Text field.

Select OK.

You are taken back to the Price Adjustments form.

Select Apply.

23.6 Pricing Configurable Products

You must configure model products before pricing because their price depends on
the options your customer chooses.

To price configurable products:

Prerequisites

The Lines tab must display a model product. Use the Product Details button,
located in the Details section, to verify that the product is a configurable product, or
expose the Configurable field in the Pricing region of the Quote Lines tab.

Steps

1.

The Lines tab displays the model product. This is usually the most basic
configuration.

Configure the product. See Section 26.7, "Configuring a Product" for
instructions.

List prices for each component are visible in the Configurator form.

Select the model line or any of its components to view the total price of the
product and its options.
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The total price for the configured model appears in the Line Total field in the
Details section.

4. If your customer decides not to purchase the product after configuration, you
must remove the product. The components are removed automatically when
you remove the product. See Section 26.3, "Removing Products from the Quote"
for instructions.

23.7 Applying Promotion Codes

You can modify the price of a whole quote or a single line by applying Promotions
to the quote. You will see all available promotions that are set up in Pricing, even
those that are not applicable to your quote. When you select the promotion, the
quote price is adjusted.

To apply promotion codes to a line or to the entire quote:

Prerequisites

The quote to which you want to apply a promotion must be displayed in the
Quoting form.

Steps

1. Select Actions > Promotions/Pricing Attributes > OK.
The Promotions/Pricing Attributes form opens.
2. Select the promotion from the Promotion No LOV.
3. Optionally, choose the list line for the promotion and select Apply.

The prices in the quote are repriced based on the promotion amount.
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23.8 Adjusting the Price of a Product in the Quoting Form

In order to adjust the price of a product in the Quoting form, there must be a
modifier set up in Pricing where the Override flag is checked and the adjustment
amount/percent is zero. Changing the unit selling price on the Oracle Quoting form
overrides the adjustment amount of the modifier value (zero) and changes it to the
indicated amount.

There are two types of manual adjustments:

s Discount — An adjustment that reduces the net price and is displayed as a
negative amount and percent in the adjustment form

= Surcharge — An adjustment that increases the net price and is displayed as a
positive amount and percent in the adjustment form

Note: The manual adjustment cannot make either the product
total price. The unit list price can be a negative value.

Repricing Rules
If repricing leads to changes at the line and /or header level, the manual
adjustments should remain unchanged, as illustrated in the following table.

Table 23-1 Repricing Example

Before Reprice After Reprice
Unit List Price $100.00 $100.00
Automatic Adjustment $20.00 $10.00
Manual Adjustment $20.00 $20.00
Unit Net Price $60.00 $70.00

Manual adjustments include, for example discounts or surcharges. To apply manual
adjustments to a line.

Prerequisites

s The product intended for price adjustment must be added to the quote and
displayed in the Quote Lines tab.
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= Manual adjustments are possible if the ASO: Discounting Privilege profile
option is set to Full. If it is set to Partial or None the Unit Selling Price field is
read only.

Steps
1. Use your cursor to highlight the price listed in the Unit Selling Price field.

2. Enter the price for the product. It can be a negative value.

3. Save the quote.

Oracle Quoting automatically calculates the adjustment amount based on the list
price of the product and enters it into the Unit Adjustment field. You can also view
the adjustment in the Price Adjustments form.

23.9 Applying a Non-Automatic Discount to a Product or the Entire

Quote

To apply a non-automatic discount to a product or to the entire quote:

Prerequisites
A non-automatic discount must be set up in Oracle Pricing.

Steps
1. To apply a non-automatic discount at the header level, place the cursor in the
header of the Oracle Quoting form.

To apply a non-automatic discount at the line level, place the cursor in the Lines
tab.

2. Select Actions.

3. Select Price Adjustments and select Go.
The Price Adjustments form opens.

4. Use the LOV to select the Modifier Name of the adjustment you want to apply.
The subsequent fields for this adjustment populate automatically.

To adjust the amount of the price adjustment, see Section 23.10, "Manually
Adjusting Prices in the Price Adjustments Form".
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23.10 Manually Adjusting Prices in the Price Adjustments Form

You can change a manual override adjustment value from the Price Adjustments
form if, when the adjustment was created in Pricing, the Override Allowed flag was
set to Yes. You can only override adjustments in the Price Adjustments form if the
profile ASO: Discounting Privilege is set to Full. If the profile is set to Partial, you
can still apply non-automatic discounts.

You can apply manual adjustments in the Price Adjustments form either at the
header or line level.

To manually override the adjustment amount of a non-automatic discount either at
the header or line level:

Prerequisites
None.

Steps

1. Select Price Adjustments from the Actions menu.
The Price Adjustments form opens.

2. Select a non-automatic adjustment as described in Section 23.9, "Applying a
Non-Automatic Discount to a Product or the Entire Quote".

You can also manually override price break adjustments. See Section 23.5,
"Overriding Price Break Level Adjustments” for more information.

3. In the Value field for the non-automatic discount you wish to override, type in
the new discount amount.

Note: The Value field can be updated only if the profile ASO:
Discounting Privilege is set to Full and the Override Allowed flag
is enabled.

Enter a Reason Code.
Optionally, enter Reason Text.

Select Apply.

N o a &

Optionally, reset the adjustments to their original values, select Reset.
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23.11 Freezing Prices for a Quote

Oracle Pricing uses the Pricing Date to interpret the effective dates for prices. If the
Pricing Date is set to January 1, 2002, only prices, discounts and adjustments that
are valid as of January 1, 2002 are calculated.

Note: Pricing Date is not limited to the current date, but can be
any date in the past or future.

Pricing Date ensures that the prices on a quote do not change if product prices are
updated in Pricing. You can quote prices based on historical or future pricing
information.

By selecting the Freeze Price option in the Actions menu, you can save the current
date and reuse it for future pricing calls. This date subsequently appears on the
quote as the Pricing Date. You can change the Pricing Date to any date.

If no date is selected, Oracle Quoting uses the current date to get the most current
prices.

Prerequisites
= The highest version of the quote must be used.

= The quote is not in a read-only status.

Steps

1. Choose Actions > Freeze Prices > OK.

In the Summary section of the Quote Header tab, the Pricing Date field shows
the current date. This date is used for all subsequent pricing calculations.

2. Optionally, you can unfreeze prices, by choosing Actions > Unfreeze Prices >
OK.

In the Summary section of the Quote Header tab, the Pricing Date field is
cleared. The current date is used for all subsequent pricing calculations.
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Customers and Relationships

This chapter contains information about customer types, customer data, and
customer relationships.

s Overview of Customers and Relationships

s Creating a Customer
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24.1 Overview of Customers and Relationships
There are two customer types in Oracle Quoting:
= Person

= Organization

Parties of type Person are individuals who are purchasing on their own behalf. A
person can have multiple addresses and phone numbers. For example, a person can
have a home address and multiple shipping addresses for vacation homes, friends,
and relatives.

Parties of type Organization may be a company, a company subsidiary or branch,
an association, a non-profit, or a government branch. Each organization must have a
primary address, yet can have multiple addresses and contacts associated with it.
Each address belongs to the organization, not to individual contacts for the
organization.

A Contact represents an organization. Any individual at an organization can be
your contact. Contacts within an organization are set up with roles such as contact of
or employee of.

24.1.1 Customer Data

To create quotes and orders, certain standard customer information is necessary.
The bill-to and ship-to information, which is optional when creating the quote, is
mandatory when converting the quote into an order.

Note: The customer, referred to in Quoting as the Quote-to
customer, is the party for whom the quote is being created. This
party becomes the sold-to customer when the quote is converted
into an order in Oracle Order Management.

The following table shows the mapping of Oracle Quoting terminology to the
Oracle Receivables (AR) Trading Community Architecture (TCA) terminology.
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Location in Ul Quoting Terminology AR Terminology (TCA)

Quote Header tab Quote-to Customer, Quote-to Sold-to Customer, Sold-to

Contact, Quote-to Address Contact
Note: The quote-to address is

not passed into OM.
Addresses Section of the Ship-to Customer, Ship-to Ship-to Customer, Ship-to
Quote Header tab Contact, Ship-to Address Contact, Ship-to Address
Addresses Section of the Bill-to Customer, Bill-to Bill-to Customer, Bill-to
Quote Header tab Contact, Bill-to Address Contact, Bill-to Address

This customer data can be grouped into the following areas:

Quote-To Information:

Quote-To Customer — The name and financial account of the customer.
Sometimes only the name of the customer is known, as there may not be a
financial account set up for them yet. The quote-to customer is financially
responsible for the order; for example, credit and collections contact the
quote-to customer if payment is not received.

Quote-To Contact — A person representing the quote-to customer, only when
the quote-to customer is of party type Organization. You cannot enter a contact
if the Quote-To Customer is of type Person. Optional field.

Quote-To Address — Address for the quote-to customer or quote-to contact.
This address is used for mailing purposes. The Quote-to address is an optional
address. It may be passed to the quote from an opportunity, but it is not passed
into Oracle Order Management when converting a quote to an order.

Bill-To Information:

Bill-To Customer — The name and financial account of the customer to be
invoiced for the goods or service ordered.

Bill-To Contact — A person representing the bill-to customer who deals with all
invoice-related matters for the order, only when the billing customer is of party
type Organization. Optional field.

Bill-To Address — A physical location where the invoice is sent. This address
can be associated with either the bill-to customer or the bill-to contact. If you
choose an address that is not of type bill-to, then it is created as a bill-to address
when the quote is submitted as an order.
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Ship-To Information

= Ship-to Customer — The name and financial account information of the
customer to whom the goods or services are delivered.

= Ship-to Contact — A person representing the shipping customer, only when the
shipping customer is of party type Organization, who deals with all shipping
related issues for the order, and who typically receives the shipment. Optional
field.

= Ship-to Address — A physical location where the products are sent. The ship-to
address can be associated with either the ship-to customer or ship-to contact. If
you select an address that is not of type ship-to, it is created as a ship-to address
when the quote is saved.

24.1.2 Creation of Accounts

Out of the box, Oracle Quoting does not require financial accounts—for parties
without any accounts—when creating a quote. Sales representatives can create
quotes for either prospects or customers. A prospect does not have a financial
account, while a customer has one or more financial accounts.

Oracle Quoting allows you to determine at which point an account is created. For
more information on the following profile options, see the Oracle Quoting
Implementation Guide

Account creation is based on the following profile options:

s ASO: Auto Account Creation—Determines when an account should be
automatically created.

Depending on how you set the profile option ASO: Auto Account Creation, you
can set up account restriction in the following ways:

= Always create accounts—Accounts are created for customers when the quote is
saved.

= Create accounts as necessary—Accounts are created only when a quote is web
published, a non-standard contract is created, or when a quote is converted into
an order.

= Create accounts only when Place Order—Accounts are created only when the
quote is converted into an order

The following table shows the behavior of Oracle Quoting based on the settings of
the profile options.
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Table 24-1 Quoting Behavior Based on Profile Options

Initiate
Profile Create Select Non-Sta Order
Option Create Select  Ship-To/ Ship-To/ Web ndard Conversi
Setting Sold-To Sold-To Bill-To Bill-To Publishing Contract on
ASO: Auto  Create Create Create Create NA NA NA
Account account account account account
Creation set if party if party
to Always does not does not
have any have any
ASO: Auto Do not Donot Donot Donot Create Create Create
Account create create create create account for account account
Creation set account account account account all for all for all
to As customers customer customer
Required in quote sin s in quote
without quote without
account without account
account

ASO: Auto Do not Donot Donot Donot Throwerror Throw Create

Account create create create create if any errorif  account

Creation set account account account account customers any for all

to Place onquotedo customer customer

Order not have son son
accounts quotedo quote

not have without
accounts an
account

If ASO: Auto Account Creation is set to Always, an account is created when the
user saves a quote. In addition, each time a new party is created, as account is
created as well.

ASO: Auto Account Creation is set to As Required, an account is created for each
customer on the quote (that does not have an account) when the quote is:

= Web published
= Anon-standard contract is initiated
= The quote is converted into an order

If ASO: Auto Account Creation is set to Place Order, an account is created for each
party on the quote (that does not have an account) when the quote is converted into
an order.
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24.2 Creating a Customer

You can create customers in the Forms Ul by selecting Enter Customer from the
Actions menu. This menu option calls up the Oracle Receivables form that you can
use to create customers. Refer to the Oracle Receivables User’s Guide, Release 11i for
more information.

Note: The Oracle Receivables Enter Customer form always
creates accounts for new customers. Thus, this form must be
disabled if users should be able to create customers without
creating financial accounts. See the Oracle Quoting Implementation
Guide for more information.

To create a new customer in Oracle Quoting:

Prerequisites
ASO: Create New Customer must be set to Yes at the appropriate level.

Steps

1. Select Actions > Enter Customer and select OK.
The Oracle Receivables customer form appears.

2. Fill in the form as described in the Oracle Receivables Users Guide, Release 11i.

Note: You can create prospect customers from Quoting - HTML,
Oracle Telesales, or Oracle Sales Online.

24-6 Oracle Quoting User Guide



25

Entering Address and Payment Information

This section contains the processes and procedures necessary for entering and
maintaining address and payment information.

Overview of Address and Payment Information
Entering Billing Information

Entering Shipping Information

Entering Quote-to Address

Entering Line-level Billing

Entering Line-Level Shipping

Entering Line Level Shipping Details

Entering Header Shipping Details

Entering Header Payment Information
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25.1 Overview of Address and Payment Information

You can designate a number of different addresses on a quote. Each address serves a
different purpose, but they are not all mandatory.

Quote-To Address — Physical address associated with the Quote-To customer
or contact.

The Quote-to address is an optional address. It may be passed to the quote from
an opportunity, but it is not passed into Oracle Order Management when
converting a quote to an order.

Ship-To Address — Address where the order is sent.

The ship-to address can be associated with either the ship-to customer or
ship-to contact. If you select an address that is not of type ship-to, it is created as
a ship-to address when the quote is submitted as an order.

Bill-To Address — Address where the bill is sent.

This address can be associated with either the bill-to customer or the bill-to
contact. If you choose an address that is not of type bill-to, then it is created as a
bill-to address when the quote is submitted as an order.

You can also designate billing and shipping addresses at the line level. Therefore, if
you have an order where you need to invoice some of the items to one location and
invoice part of the order to another location or organization, you can designate that
information in the quote.

Line level billing is controlled by the profile option ASO: Enable Line Level
Billing. Line level billing is available if the payment type is Cash or not specified
and the Purchase Order number is not specified. Line level billing is not supported
if payment type is Credit Card or Check, or a purchase order number is specified.
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25.2 Defaulting of Addresses

Addresses are defaulted into the Addresses tab of the Quoting form, based on the
following conditions, when creating quotes standalone, from opportunities, or from
templates.

Quote-To Address

The Quote-To Address is defaulted at the time of quote creation either from the
search results or as described below.

If Quote-To Customer is an Organization and the Quote-To Contact is specified,
the application searches for a value from the following sources (in that order)
and accepts the first one it finds:

a. Active Primary Sold-To address type usage for the Quote-To Contact
b. Identifying address for the Quote-To Contact

c. Active Primary Sold-To address type usage for the Quote-To Customer
d. Identifying address for the Quote-To Customer

If the Quote-To Customer is an Organization and no Quote-To Contact is
specified, the application searches for a value from the following sources (in
that order) and accepts the first one it finds:

a. Active Primary Sold-To address type usage for the Quote-To Customer
b. Identifying address for the Quote-To Customer

If the Quote-To Customer is of type Person, the application searches for a value
from the following sources (in that order) and accepts the first one it finds:

a. Active Primary Sold-To address type usage for the Quote-To Customer

b. Identifying address for the Quote-To Customer

Bill-To Address

The Bill-To Address is defaulted at the time of order creation based on the
following conditions:

If Bill-To Customer is an Organization and the Bill-To Contact is specified, the
application searches for a value from the following sources (in that order) and
accepts the first one it finds:

a. Active Primary Bill-To address type usage for the Bill-To Contact
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b. Identifying address for the Bill-To Contact
c. Active Primary Bill-To address type usage for the Bill-To Customer
d. Identifying address for the Bill-To Customer

If the Bill-To Customer is an Organization and no Bill-To Contact is specified,
the application searches for a value from the following sources (in that order)
and accepts the first one it finds:

a. Active Primary Bill-To address type usage for the Bill-To Customer
b. Identifying address for the Bill-To Customer

If the Bill-To Customer is a Person, the application searches for a value from the
following sources (in the order below) and accepts the first one it finds:

a. Active Primary Bill-To address type usage for the Bill-To Customer
b. Identifying address for the Bill-To Customer

Ship-To Address

The Ship-To Address is defaulted at the time of order creation based on the
following conditions:

If Ship-To Customer is an Organization and the Ship-To Contact is specified, the
application searches for a value from the following sources (in that order) and
accepts the first one it finds:

a. Active Primary Ship-To address type usage for the Ship-To Contact
b. Identifying address for the Ship-To Contact

c. Active Primary Ship-To address type usage for the Ship-To Customer
d. Identifying address for the Ship-To Customer

If the Ship-To Customer is an Organization and no Ship-To Contact is specified,
the application searches for a value from the following sources (in that order)
and accepts the first one it finds:

a. Active Primary Ship-To address type usage for the Ship-To Customer
b. Identifying address for the Ship-To Customer
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25.3 Entering Billing Information

To enter a bill-to customer and address for an order:

Note: If you wish to bill individual lines to different locations,
refer to Section 25.6, "Entering Line-level Billing".

Prerequisites

The customer must be displayed in the Quoting form.

The individual to be billed and the billing address must already exist in the
database.

Steps

1.
2.

In the Quote Header tab, select Addresses.

Optionally, select Copy From Quote To to copy the bill-to address from the
quote-to address.

Use the Customer LOV to select the customer’s name. The account (if any) is
copied to the Bill To Account field.

Note: The maximum number of results in the LOVs for the Bill To
customer and account at the header and line level is limited by the
profile option ASO: Max Number of Results.

Use the Account LOV to select the customer’s account number.

Note: The Bill-To account is optional when creating/saving the
quote, unless the bill-to customer has at least one active account.

If the Bill-To Customer is copied from the Quote-To Customer, the Quote-To
account value is copied into the Bill-To Account field.

Optionally, use the Contact LOV to select the name.

The LOV displays only contacts (parties of type Person) that have a valid
relationship with the bill-to party.

Use the LOV to select the bill-to address.
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7.

The bill-to address LOV displays all existing addresses for both the customer
and the contact, if there is one. Therefore, if the bill-to contact changes and the
bill-to address belonged to that contact, the address fields clear. If a new contact
is selected, you are prompted to use the Address LOV to enter a new bill-to
address for either the bill-to customer or contact.

If there is no bill-to contact, the LOV displays only addresses for the bill-to
customer.

Note: If the selected Bill-To address is not of usage type bill-to, it
will be created as a bill-to address when the quote is created /saved.

Save the quote.

25.4 Entering Shipping Information

Note: If you wish to ship individual lines to different locations,
refer to Section 25.7, "Entering Line-Level Shipping".

To enter a ship-to customer and address for an order:

Prerequisites

The customer must be displayed in the Quoting form.

The individual to ship to and the shipping address must already exist in the
database.

Steps

1.
2.

In the Quote Header tab, select Addresses.

Optionally, select Copy From Quote To to copy the ship-to address from the
quote-to address.

Use the Customer LOV to select the customer’s name. The account (if any) is
copied into the Ship To Account field.
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Note: The maximum number of results in the LOVs for the Bill To
customer and account at the header and line level is limited by the
profile option ASO: Max Number of Results.

Use the Account LOV to select the customer’s account number.

Note: The Ship-To account is optional when creating/saving the
quote, unless the ship-to customer has at least one active account.

If the Ship-To Customer is copied from the Quote-To Customer, the Quote-To
account value is copied into the Ship-To Account field.

Optionally, use the Contact LOV to select the name.

The LOV displays only contacts (parties of type Person) that have a valid
relationship with the ship-to party.

Use the LOV to select the ship-to address.

The ship-to address LOV displays all addresses for both the customer and the
contact (if there is one). Therefore, if the ship-to contact changes and the ship-to
address belonged to that contact, the address fields clear. If a new contact is
selected, you are prompted to use the Address LOV to enter a new ship-to
address for either the ship-to customer or ship-to contact.

Note: If the selected Ship-To address is not of usage type
"Ship-to," it will be created as a Ship-to address when the quote is
created/saved.

Save the quote.
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25.5 Entering Quote-to Address

To designate a quote-to address:

Prerequisites
None

Steps
1. In the Quote Header tab, select Addresses.
2. Optionally, enter a phone number.
A value is defaulted into this field, based on the following conditions:
*  If the quote-to customer is an organization and a quote-to contact is
specified, this field is populated with the contact’s phone number.

If the quote-to customer is an organization without and no contact is
specified, no defaulting occurs.

If the quote-to customer is a person, this field is populated with the
primary phone number for the quote-to customer.

3. Use the Address LOV to select a quote-to address. The LOV displays all
addresses for the customer and quote-to contact.

The corresponding address fields are automatically populated.

Note: If the selected Quote-To address is not of usage type
"sold-to," it will be created as a sold-to address when the quote is
created.

4. Save the quote.
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25.6 Entering Line-level Billing

To designate line level billing information:

Prerequisites

The item for which you want to designate a different billing address, must be
displayed in the Quote Lines tab.

The payment type on the quote must be either Cash or blank and there must
not be a Purchase Order number specified.

ASO: Enable Line Level Billing must bet set to Yes at the appropriate level.
The highest version of the quote must be used.

The line must not be a component of a configured product.

Steps

1.
2.

Navigate to the Lines tab and select Bill-To from the drop-down menu.
In the appropriate line, use the Customer LOV to select a customer.

The behavior of this field depends on the setting of profile option ASO: Enforce
Account Relationships. See Section 24.1.2, "Creation of Accounts".

An account number is defaulted into the Account field. Optionally, use the
Account LOV to select a different account for the customer.

If the customer is not specified, you can directly select an account. The customer
for the account will be copied to the account field.

Optionally, use the Contact LOV to select a contact.
Use the Address LOV to select a line bill to address.

Save the quote.
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25.7 Entering Line-Level Shipping

To designate line level shipping information:

Prerequisites

The item you want to designate a different shipping address for, must be
displayed in the Quote Lines tab.

The line must not be a component of a configured product.
The highest version of the quote must be used.

The quote is not in a read-only status.

Steps

1.
2.

Navigate to the Lines tab and select Ship-To from the drop-down menu.
In the appropriate line, use the Customer LOV to select a customer.

The behavior of this field depends on the setting of profile option ASO: Enforce
Account Relationships. See Section 24.1.2, "Creation of Accounts".

An account number is defaulted into the Account field, if one exists. Optionally,
use the Account LOV to select a different account for the customer.

If the customer is not specified, you can directly select an account. The customer
for the account will be copied to the account field.

Optionally, use the Contact LOV to select a contact.
Use the Address LOV to select a line ship to address.

Save the quote.
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25.8 Entering Line Level Shipping Details

You can enter line level shipping information in the Quote Lines tab. You can

specify:

Requested Date

Ship From Warehouse

Shipping Method

Shipment Priority
FOB

Freight Terms

Shipping Instructions

Packing Instructions

Prerequisites
The line must not be a component of a configured product.

Steps
1.

2.
3.

Note: You can specify the Warehouse and Requested Date for a

component.

The highest version of the quote must be used.

The quote must not be in a read-only status.

Select Shipping from the drop-down menu on the Quote Lines tab.

Select the line for which you want to designate line level shipping.

Optionally:

Enter a Requested Date.
Enter a ship from Warehouse.
Select a Shipping Method.
Select a Shipping Priority.
Select an FOB.
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= Select the Freight Terms
= Enter Shipping Instructions.
»  Enter Packing Instructions.

4. Save the quote.
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25.9 Entering Header Shipping Details

You can specify the following header-level shipping details on a quote:

= Requested Date

= Ship From Warehouse
= Shipping Method

= Shipment Priority

= FOB

= Freight Terms

= Shipping Instructions
= Packing Instructions

To enter shipping details:

Prerequisites
None

Steps

1. Select Payment, Shipping from the drop-down menu on the Quote Header tab.

2. Optionally:
= Enter a Requested Date.
= Select a Shipping Method.
= Select a Shipping Priority.
= Select an FOB.
= Select the Freight Terms
= Enter Shipping Instructions.
= Enter Packing Instructions.

3. Save the quote.
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25.10 Entering Header Payment Information

Note: Oracle Quoting supports the use of Payment Terms
Substitution. Please see Section 23.1.6, "Terms Substitution" for
more information.

To enter payment information for your customer:

Prerequisites
The Quote Header tab displays the customer.

Steps
1. In the Quote Header tab, select Payment, Shipping from the drop-down menu.

2. Select the payment terms using the Payment Terms LOV.

Payment Terms are defaulted at the time of quote creation, based on the
following conditions:

= Header-level Agreement
s Quote-To Customer Account

Payment term defaulting can also occur when the Header-level Agreement is
assigned or changed, or the Quote To Customer Account is assigned.

3. Enter a Purchase Order number, if necessary.
4. From the Payment Type drop-down menu, select the payment type.
Available payment types: Cash, Check, Credit Card, or blank.

= If you selected Check as the payment type, then enter the check number in
the Check Number field.

s If you selected Credit Card as the payment type, then:

a. From the Credit Card drop-down list, select the credit card type.
b. Enter the credit card holder’s name.

c. In the Credit Card Number field, enter the credit card number.
d. Enter the credit card expiration date.

5. Select Save.
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Note: If Oracle iPayment is also installed, the application
performs a credit card check once the quote is submitted as an
order. For more information, consult the Oracle iPayment Concepts
and Procedures.
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Modifying Quotes

This chapter contains information on modifying quotes in Oracle Quoting. Sections
include:

Modifying a Customer Quote
Adding Products to the Quote
Removing Products from the Quote
Adding a Service to the Quote
Entering Installation Details
Duplicating a Line

Configuring a Product

Adding a Related Product
Checking Product Availability
Allocating Sales Credit

Adding Trade-In Products to Quotes
Using Descriptive Flexfields
Splitting Lines

Entering Tax Details

Viewing Quote Tax Details
Viewing the Quote Versions
Viewing Customer Quotes

Viewing the Order History for a Customer
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26.1 Modifying a Customer Quote

To find and modify a customer quote:

Prerequisites

If finding and modifying quotes using the Customer History form, the customer
must be displayed in the Oracle Quoting form.

Whether you can modify a quote depends on its status. Not all quote statuses allow
you to make modifications. For more information on the quote statuses permitting
updates, see Section 20.1.2, "Quote Status" or the Oracle Quoting Implementation
Guide.

Steps

1. Locate the quote to modify using one of the following methods:

a. The Quote search procedure outlined in Section 21.2, "Searching for
Quotes".

OR

a. The procedure outlined in Chapter 21.1, "Searching Using the Query
Method".

OR

a. From the Reports menu, select Customer History. The Customer History
window appears.

b. Select the Quotes tab. The tab lists all quotes for this customer.

c. If you wish to view the quote and modify it, select View Quote. The quote
displays in the Oracle Quoting form. Only the latest version of a quote can
be modified.

2. Modify the quote by:
= Altering customer information
s Changing product quantities
= Adding Products to the Quote
= Entering Header Payment Information
= Entering Billing Information

= Entering Shipping Information

26-2 Oracle Quoting User Guide



Adding Products to the Quote

»  Creating an Attachment
= Viewing and Adding Notes to a Quote
Select Save.

Depending on the status of the quote, the changes you make are saved either in
the version of the quote you are editing or in a new version. See Section 20.1.2,
"Quote Status" for more information.

26.2 Adding Products to the Quote

To add products to the quote:

Prerequisites
Your customer is displayed in the Header tab of the Oracle Quoting form.

Steps

1.
2.
3.

Navigate to the Quote Lines tab.
Place your cursor in the Product field in the first available line.

If the Product field already displays a product, select New Record in the
toolbar.

Use the Product LOV to select the product or enter the product description or
part number. The behavior of this field depends on whether interMedia Search
is enabled. See Section 21.4, "Using interMedia Search" for more information.

The product displays in the tab.

Or use the product search, by selecting Actions > Product Search, to copy and
paste the part number from the search results to the Product field.

Select the Product Details button to view the product details.

This Product Details form indicates the user item type and whether the product
is returnable, serviceable, shippable, or is a support service.

Optionally, update the defaulted UOM.
Enter the quantity in the Qty field.

The quantity defaults from the profile option ASO: Default Ordered Qty in OC
UL See the Oracle Quoting Implementation Guide for more information.
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8. Use the Price List LOV to select a price list for the line. You can only select a
price list if ASO: Price List Override is set to Yes.

9. If the Item Type is Model, then the product is configurable. The product
displayed is the base model. You can configure this product to add more
components. See Section 26.7, "Configuring a Product” for more information.

For all other products the product pricing appears. The Unit Price shows the list
price on the price list shown in the Price List field.

10. Save the quote.

11. Repeat this procedure to add other products to the quote.

26.2.1 Line Numbers

Line numbering in the Quoting Ul is based on product type. Line numbers are
formatted as follows: A.B.C

The first tier, A, indicates a major line number grouping. The line numbering for
this group starts with 1 and each additional group increments by 1. This group
includes the following product types:

Standard product that is not a top level model, model component, or
serviceable product

Serviceable product without service products attached

Service product associated with a serviceable product on a pending order or
in the customer’s installed base

Top level model and selected components under the model
Serviceable product and any service products associated with it
Trade-in top level model

Selected trade-in component under the trade-in model

The second tier, B, indicates a component within a model configuration. The first
component has a value of 0, while each additional component increments by 1.

The third tier, C, indicates a service. This applies only to a service associated with a
serviceable product in the current quote.

The following table shows an example of what quote line numbers look like based
on product type.
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Table 26—1 Line Numbers and Product Types

Line Number Product Type

1.0 Standard Product

2.0 Top level model product

2.0.1 Service for model in line 2.0

2.0.2 Service for model in line 2.0

2.1 Component #1 (option class)

2.1.1 Service for component in line 2.1

2.2 Component #2 (Child of option class)

3.0 Service for serviceable product in the Installed Base or Pending
Order

4.0 Serviceable product

4.0.1 Service for serviceable product in line 4.0

4.0.2 Service for serviceable product in line 4.0

You can insert or delete lines between existing lines and the line numbers will be
adjusted accordingly. Line numbers displayed on the quote print out match the line
numbers in the Quote Lines tab. Quote line numbers are not passed to Oracle Order
Management when a quote is converted into an order.
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26.3 Removing Products from the Quote

To remove products from the quote:

Prerequisites
There must be at least one product in the quote.

Steps

1.
2.
3.
4.

Navigate to the Quote Lines tab.

Highlight the line to remove.

From the Edit menu, select Delete.

You are asked to confirm the deletion. Select Ok.

The line is removed from the quote and the remaining lines are renumbered.

26.4 Adding a Service to the Quote

Services are available in Oracle Quoting for serviceable products on the current
quote, serviceable products that have been ordered but have not yet shipped, and
serviceable products that were shipped and received.

Note: Services apply to Serviceable products and cannot be sold
without referencing a serviceable product on a current quote, order,
or customer installed base.

There are two types of services:

Warranties — Services automatically included with the purchase of a
serviceable product.

Warranties are defined as a component in the Bill of Materials for a serviceable
product. They are included in the list price of the serviceable product and
cannot be sold as a separate line. Each serviceable product can ship with one or
more base warranties.

Extended Warranties — Services that may be purchased in addition to a
serviceable product. Extended warranties are designated in Oracle Inventory as
follows:

s Service is checked
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= Warranty is unchecked.

Validation of the relationship between a serviceable product and a service is
performed in Oracle Service Contracts. Oracle Service Contracts determines which
services are available for a serviceable product. For each service, customers and
serviceable products can be excluded.

When a service is purchased, the following conditions must be present:
= The service must reference a serviceable product that is:

= On the current quote

= Purchased but has not yet shipped

s Purchased and recorded in the customer install base

s There should be a valid relationship between the service and serviceable
products:

= No relationship — There are no exclusions set up in Oracle Service
Contracts, and therefore every service can be purchased for a serviceable
product.

= Oracle Service Contracts — Serviceable product and customer do not
appear on the list of exclusions for the selected service.

s The serviceable product used as a service reference cannot be a trade-in.

= The period and duration must meet the minimum period and duration set in
Oracle Service Contracts.

26.4.1 Adding a Service to a Serviceable Product on the Quote

To enter a service for a serviceable product on the current quote:

Prerequisites
= The quote line must be saved.

s The product must be a serviceable product.

s The product must not be a trade-in product.
Steps

1. Add a serviceable product. See Section 26.2, "Adding Products to the Quote" for
more information on adding products.
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2. Select Actions > Service Items > OK.

The Service Items form opens displaying included services, services already
included with the serviceable product, and available extended services.

3. Highlight the extended service to apply to the serviceable product in the Other
Available Services table and select Add to Quote.

The Price Lists form opens if the service is not on the current price list.
4. Choose a price list and select OK.

The service product displays in the Quote Lines tab as a subset of the
serviceable product. The duration, period, and start date default into the line.

5. Optionally, change the Duration, Period, or Start Date for the service.

6. Save the quote.
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26.4.2 Adding a Service to the Quote

To add a service to a quote that does not contain serviceable products:

Prerequisites

None

Steps
1.

2.
3.

Navigate to the Service region of the Quote Lines tab.

Place your cursor in the Product field.

If the line already displays a product, then select New in the toolbar.

Either enter the part number into the field or use the LOV to select the product.

The duration, period, and start date default into the appropriate fields.

Optionally, change the Duration, Period, or Start Date.

Note: The actual start date of a service is different from the date
you enter in the Start Date field when adding a service to a quote.

If the serviceable product for the service is already in Oracle Install
Base, then the start date is the day the product is ordered.

If the service is for a serviceable product that you are ordering, the
start date is the actual shipping date of the product plus the value
in the Service Starting Delay field (defined for the product in Oracle
Inventory).

Optionally, change the quantity.

In the Details section, select Reference.

Select the appropriate category from the Service For list:

Current Quote: If the service is for a product in the current quote
Pending Orders: If the service is for a product in an order

Installed Base: If the service is for a product already installed at a customer
site.

If the service is for a product on the current quote:
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a. Use the Product LOV to select the product number, or use the Description
LOV to select the product description.

b. Select Search. The Service Reference form displays all available lines on the
quote that match the search criteria.

c. Select the quote line to associate the service with and select Apply.

The service is displayed in the Quoting form as a separate quote line. The
service information is displayed in the Service section of the Quote Lines
tab. The service line appears after the corresponding serviceable product.

10. If the service is for an ordered product:

a. Search for a serviceable product on a pending order using one (or a
combination) of the criteria below:

*  Order Number
*  System Name
*  Product

*  Description

*  Order Dates

* PO Number

b. Select Search. The Service Reference form displays all available lines on
pending orders or a specific pending order that matches the search criteria.

c. Select the serviceable product to associate the service with and select Apply.

d. The service is displayed in the Quoting form as a separate quote line. The
service information is displayed in the Service section of the Quote Lines
tab

11. If the service is for a product in the customer’s installed base:

a. Search for a serviceable product in the customer’s Installed Base using one
(or a combination) of the following criteria:

*  Serial Number
*  System Name
*  Order Number
*  Product

*  Description
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*  Order Dates

b. Select Search. The Service Reference form displays all available lines in the
customer’s installed base that match the search criteria.

c. Select the serviceable product to associate with the service and select Apply.

d. The service is displayed in the Quoting form as a separate quote line. The
service information is displayed in the Service section of the Quote Lines
tab.

12. Repeat this procedure to add other products to the quote.

13. When you are done you are ready to:

s Create a quote

s Place an order

26.5 Entering Installation Details

This menu option is available only if the Network Logistics Trackable flag is
enabled for the product. This flag is set in the Item master definition in Oracle
Inventory.

To enter installation details for a product that is Network Logistics trackable:

Prerequisites

The product must be saved and selected in the Quote Lines tab.

The user must have Update access to the quote.

The highest version of the quote must be used.

The quote must not be in a read-only status.

The Network Logistics Trackable flag must be set to Yes for the product.

The quote must not be submitted for batch pricing.

Steps

1.

Select Actions > Installation Details > OK.
The Transaction Details form appears. This is an Oracle Install Base form.

Fill out the form as described in the "Using the Transaction Details Window"
section of the Oracle Install Base Concepts and Procedures.
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3.

Save your changes.

The installation details are passed to the order when the quote is submitted to
Oracle Order Management.

26.6 Duplicating a Line

When you duplicate a line, line level attributes, including price list, line level
billing, line level flexfields, and line level attachments are copied into the new line.
If a service is associated with the line, the service is copied as well.

To duplicate a line:

Prerequisites

The user must have update access to the quote.

The quote must not be in a read-only status.

The highest version of the quote must be used.

The quote line must not be a service.

The quote line must not be a model component.

The quote line must not be a trade-in from the Installed Base.

The quote must not be submitted for batch processing.

Steps

1.
2.
3.

Navigate to the Quote Lines tab.
Select the quote line to copy.
Select Actions > Duplicate Line > Go.

The duplicated line is added after the last line in the quote.

26.7 Configuring a Product

To configure a model product:

Prerequisites

Verify that the product is a model product by selecting the oval button to the
right of the Description field or by exposing the Configurable field in the
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Pricing region of the Quote Lines tab. This button accesses the Product Details
form.

The quote must be saved.

The user must have Update access to the quote
The highest version of the quote must be used

The quote must not be in a read-only status

The quote must not be submitted for batch pricing.

You can only change the quantity of model products if ASO: Allow Quantity
Updates for Top Level Model Item is set to Yes.

You can only change the quantity for components if ASO: Allow Quantity
Updates for Component Item is set to Yes.

Steps

1.

Add a model product to the quote using the procedure outlined in Section 26.2,
"Adding Products to the Quote".

The model product appears in its own line on the quote. The Model Status field
indicates if the model is incomplete. If the field is blank, the model is complete.
If there is an * in the field, the model is incomplete.

Place your cursor in the line to configure.
Select Configure. The Oracle Configurator form appears.

Configure the product as necessary. See the latest Oracle Configurator
documentation for more information.

Note: Additionally, ensure that there are no red asterisks in the
category folder icons in the Oracle Configurator form. A red
asterisk next to a category can indicate that the category is
incomplete.

Select Done. The products you selected are added to the quote as separate lines.

Optionally, change the quantity of the top level model or one of its components
by overwriting the value in the Quantity field and saving the quote. If changing
the quantity of the top level model product, the quantity of all the components

will be updated to match the model product’s quantity. If changing the quantity
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of a component, the top level model product and all other components will be
updated to match the quantity.

Note: To ensure that the product has been properly configured,
verify that there is no asterisk in the Model Status field.

26.7.1 Deleting a Component

You can delete components of model products without invoking Configurator.
Configurator rules are invoked after each deletion and the incomplete indicator
appears if the deletion results in an incomplete configuration. If the deletion results
in an invalid configuration, you cannot save the configuration. The configurations
for the model products and components revert back to the previously saved
configurations.

Note: If you delete a component with an associated service, the
service is deleted as well.

Prerequisites
= ASO: Allow Quantity Updates for Component Item must be set to Yes.

s The user must have update access to the quote
= The quote must not be in a read-only status
= The highest version of quote must be used

= The quote must not be submitted for batch processing

Steps

1. Navigate to the Quote Lines form.
2. Select the component to delete and select Delete from the Edit menu.
3. You are asked to confirm the deletion. Select Ok.

4. The component is removed from the configuration and the remaining lines are
renumbered accordingly.
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26.7.2 Duplicating an Existing Configuration in a Quote

You can copy a top level model product to a new model product within a quote.
When copied, the top level model product and its components are an exact copy of
the original configuration. If the original configuration has services associated with
it, they are copied into the new configuration. Line level attributes, including price
list, line level billing, line level flexfields, and line level attachments are copied as
well.

Prerequisites

= Verify that the product is a model by selecting the Product Details link or the
Configurable checkbox

s The user must have update access to the quote
= The quote must not be in a read-only status
= The highest version of the quote must be used

= The quote line must not be a service, a model component, or a trade-in from the
Installed Base

= The quote must not be submitted for batch processing

Steps

1. Navigate to the Quote Lines form.
2. Select the Configuration line to copy:.
3. Select Actions.

4. Choose Duplicate Line > OK. The duplicated configuration is added after the
last line in the quote.

26.7.3 Splitting a Configured Line

If you split a configured line, the new model and its components appear on a
separate line as an exact duplicate of the original line. The relationships are
preserved. All services and line attributes (price list, line level billing, line level
shipping, line level attachments, etc.) are copied as well.

To split a configured line:

Prerequisites
= The quantity of the line you want to split must be greater than 1.
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= The user must have update access to the quote.

= The quote must not be in a read-only status.

= The highest version of the quote must be used.

= The quote line must not be a model component.

= The quote line must not be a service.

= The quote line must not be a trade-in from the Installed Base.

= The quote must not be submitted for batch processing.

Steps
1. Select the configured line to split.

2. Select Actions > Split Line > OK. The Split Line form opens.
3. In the Split field, enter the quantity you want to split into another line.
4. Select Apply. The Lines page displays the split quantities as separate lines.
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26.8 Adding a Related Product

To sell a related product to your customer:

Prerequisites

Related products must be set up for this product.
The user must have Update access to the quote.
The highest version of the quote must be used.
The quote must not be in a read-only status.

The product must not be a trade-in product.

The quote must not be submitted for batch pricing.

Steps

1.
2.
3.

Navigate to the Quote Lines tab.

Select the line to which you want to add related products.
Select Actions > Add Related Products > OK.

To add a related product to the quote:

a. Highlight a product in the list.

b. Select Apply.

A window displays the available price lists for the currency. If only one
price list exists, Oracle Quoting automatically chooses that price list and
prices the product accordingly.

c. Choose a price list for the related product.

d. Select OK to close the price list window and return to the Oracle Quoting
form.

Repeat the procedure for other products, if any.

The product you selected in the Related Products window is inserted after the
related product and the line numbers are recalculated accordingly.

Save the quote.

After saving the quote, the related product is assigned a line number.
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Guidelines
Choosing a related product changes the quote as follows:

= Adding an up-sell product replaces the product in the quote.

= Adding a cross-sell product adds the product to the quote. You can add
multiple cross-sell products to the quote.

= Adding a substitute product replaces the product in the quote.
» Adding any other relationship type adds the product to the quote.

26.9 Checking Product Availability

Quoting will automatically assign a warehouse based on Inventory sourcing rules
or the value in profile option ASO: Default Ship From Org. This inventory
warehouse is used for ATP checks and scheduling once the order is booked in Order
Management.

You may override this warehouse if the profile option ASO: Enable Manual
Warehouse is enabled, by changing the value in the Warehouse field of the ATP
form. The warehouse you select is saved with the quote line and all subsequent ATP
checks are performed against the designated warehouse.

The point at which inventory products are reserved depends on the setting of the
system profile option ASO: Reservation Level. Contact the application
administrator for details. Products are not reserved for your customer before you
successfully place the order.

If you want to check the availability for the order as a whole, the cursor must be in
the header section of the Oracle Quoting form. If you want to check the availability
of a specific product, the product must be displayed in the Oracle Quoting form and
the cursor must be in a Quote Lines tab field.

To find out when the desired quantity of an product will become available:

Prerequisites
The line must not be for a trade-in.

Steps

1. Select Actions > Check Availability > OK. The Available To Promise form
opens, displaying either the single selected product or a list of the products in
the quote.
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The Available To Promise displays for each product:
= UOM

s Quantity

= Request Date

= Available

= Available Date

= Warehouse

= OnHand

The Available Date field displays the date when all of the requested quantity
will be available for shipping.

Select OK.

If you place the order, then your customer receives all of the currently available
quantity. The balance is placed on back order and shipped on the available date.

26.9.1 Manually Selecting a Warehouse

To manually select the warehouse from where the current product will ship:

Prerequisites

The profile option ASO: Enable Manual Warehouse must be set to Yes.

The quote must be saved.

Steps

1.

Navigate to the Shipping section of the Quote Lines tab and select the product
for warehouse designation.

Use the LOV to select a Requested Date.
Use the LOV to select a Warehouse against which the ATP check is performed.
Save the quote.

ATP checks are performed against the selected warehouse.
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26.9.2 Saving the Manually Selected Warehouse for Future ATP Checks

You can save the warehouse so that it is used for subsequent ATP checks.

Prerequisites
The profile option ASO: Enable Manual Warehouse must be set to Yes.

Steps

1. Navigate to the Shipping section of the Quote Lines tab and select the product
with the designated warehouse.

2. Select Actions > Check Availability > OK.
The Available to Promise forms displays.

3. Ensure that the Save Warehouse flag is selected for the product.
Optionally, to clear the saved warehouse, deselect the Save Warehouse box.

4. Select OK.

26.10 Allocating Sales Credit

When there are multiple sales representatives involved in a sales process, you may
need to allocate sales credits appropriately.

If you do not specify header level sales credits, the header level sales credit defaults
100% to the primary salesperson. Sales credits entered at the header level default to
the line level during the sales compensation calculations.

Sales credits can also be specified at the line level. If changes are made at the line
level and additional changes are made later at the header level, the header level
changes will not be reflected at the line level.

You can allocate sales credits to any resource who is set up as a valid sales
representative for the quote-to customer. A sales representative can only be listed
once for each credit type on the Credit Allocation form.

To allocate sales credits at the header and line levels to any number of sales
representatives:

Prerequisites

The resource for sales credit allocation must be set up in Oracle Receivables as a
valid sales representative for the quote-to customer.
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Steps

1.

To allocate a sales credit at the header level, place the cursor in the header of the
Oracle Quoting form.

To allocate a sales credit at the line level, place the cursor in the Quote Lines tab.
Select Actions > Assign Sales Credits > OK.

Use the Salesperson LOV to select the sales representative for sales credit
allocation.

Optionally, select a Sales Group for the salesperson.
Use the Credit Type LOV to enter the type of sales credit.

Credit types are set up in Order Management using the Sales Credit Type form.
Each sales credit is classified as a revenue or non-revenue sales credit type.

= Revenue sales credit — A sales credit you assign to salespeople based on
your invoice lines. The total of all revenue sales credits must equal 100% of
your invoice lines amount. Also known as a quota sales credit because it is
applied to the sales representatives” quotas.

= Non-revenue sales credit — A sales credit you assign to your salespeople
not associated with your invoice lines. This is given in excess of your
revenue sales credits. Also known as a non-quota sales credit because it is
not usually applied to the sales representatives” quotas.

Enter the percent of the allocation.

Note: The Revenue Total box must be blank or equal 100%.

Repeat this process for each sales representative credit allocation.

Select Apply to save your changes.
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26.10.1 Removing a Sales Credit Allocation

To remove a sales credit allocation:

Prerequisites
None

Steps

1.

a2 DN

To remove a sales credit at the header level, place the cursor in the header of the
Oracle Quoting form.

To remove a sales credit at the line level, place the cursor in the Quote Lines tab.
Select Actions > Assign Sales Credits > OK.

The Sales Credits form opens.

Select the allocation and select Remove.

The sales credit allocation is removed and the Revenue and Non-Revenue totals
are recalculated.

Select Apply to apply the change and return to the main Quoting form.

Note: If you remove a sales credit allocation and select Cancel
instead of Apply, the allocation will not be removed from the quote
even though it disappears when you select Remove. You must
select Apply to apply the change to the quote.
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26.11 Adding Trade-In Products to Quotes

This procedure allows you to provide credit to customers for returning existing
products when purchasing new products.

Note: If customers have trade-in products, they must also
purchase products in the same quote. The order total cannot be
negative. The Total Price and Line Total is displayed as a negative
value for the trade-in product.

Pricing, taxes, and charges for trade-ins are calculated exactly as they are for regular
products. When calculating the total price for the order, the returned product is
treated as a credit and subtracted from the total.

Whether or not you can use trade-ins depends on the setting of the profile option
ASO: Enable Line Type. If this profile is set to No, the Line Category and Line Type
fields will be disabled. The Line Category field will be a read-only field with the
value Order. See Oracle Quoting Implementation Guide for more information.

The Line Category field is governed by the Order Type field in the Summary
section. Oracle Quoting supports two Order category types:

s Order — Quotes can contain only orderable products.
= Mixed — Quotes can contain other line types in addition to orderable.

The Order Category Type must be set to Mixed before you can use trade-in
products. Order Types are set up in Order Management. See the Oracle Order
Management User’s Guide, Release 11i for more information.

To enter a product as a trade-in:

Prerequisites

= The product that the customer wants to trade in must be set up with the line
type Return in Inventory.

s The product must be returnable. To verify that it is returnable, select the oval
button located next to the Description field in the Pricing Details section of the
Quote Lines tab.

= The profile option ASO: Enable Line Type must be set to Yes.
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Steps
1. Create a quote by entering the customer information. See Section 20.2, "Creating
a Quote" for more information.

Navigate to the Quote Lines tab.
In the Details section, select Return in the Line Category field.

Use the Product LOV to select the trade-in product.

a » © b

Save the quote.

Oracle Quoting calculates the total price based on the current purchase and the
trade-in, and displays it in the Total Price field on the Oracle Quoting form.

OR

1. If a product has been added with an Order line type, check if it is Returnable by
selecting the oval button to the right of the Description field or expose the
Returnable field in the Pricing region of the Quote Lines tab.

2. Save the quote.

Oracle Quoting calculates the total price based on the current purchase and the
trade-in, and displays it in the Total Price field on the Oracle Quoting form.
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26.12 Splitting Lines

In Oracle Quoting, you can split a line if the quantity is greater than 1. This is useful
if you want to order a large quantity of one product with various ship-to and bill-to
addresses. For example, if want to order 5 laptops, and ship 3 of them to one
location and 2 to another.

To split a line:

Prerequisites

The quote line must be saved and selected in the Quote Lines tab.
The user must have Update access to the quote

The highest version of the quote must be used

The quote must not be in a read-only status

The product must not be a service

The product must not be a trade-in product

The product must not be a model component

The quote must not be submitted for batch pricing.

Steps

1.
2.

Select Actions > Split Line and select OK. The Split Lines form opens.

Enter the quantity you want to split to another line in the Split Quantity field.
The Total field displays the summation of the Split Quantity values.

Select Apply.

In the Quote Lines tab the quantity you split is a separate line.

Modifying Quotes 26-25



Entering Tax Details

26.13 Entering Tax Details

There are three tax options:
= Exempt — The current quote is exempt for a normally taxable customer site.

= Require — The current quote is taxable for a normally non-taxable ship-to
customer (at the quote level only).

»  Standard — Taxation for the current quote should be based on existing
exemption rules.

The following tax details are displayed for each distinct tax code on the quote:
s Taxcode

= Total tax amount for the tax code

= Tax exempt reason and number, if quote is tax exempt

To enter tax exemption information for a quote:

Prerequisites
None

Steps

1. Select Tax from the drop-down menu on the Quote Header tab.
2. Use the Tax Handling LOV to select the tax method.

a. If you select Exempt, then:

*  Enter the exempt number in the Exempt Number field. You can select

an pre-defined tax exemption certificate from the LOV or enter a new,
unapproved exemption number certificate.

Enter an exempt reason in the Exempt Reason field.

If you choose an exempt number from the LOV, the exempt reason

automatically displays in this field. If no reason is defined or you enter
an unapproved exempt number, you will be able to select a tax exemp-
tion reason from those defined in the Receivables QuickCodes window.

Note: The Exempt Number and Exempt Reason fields are
disabled unless you select Exempt as the tax handling method.
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*  Save the quote.

b. If you select Require, save the quote.

c. If you select Standard, save the quote.

26.14 Viewing Quote Tax Details
You can view tax details for each quote line.

To view tax details:

Prerequisites

The line for which you want to view tax details must be selected in the Quote Lines
tab.

Steps
1. I:S,elec’r Actions > Tax Details and select OK. The Tax Details form opens.
The following tax details are displayed:
*  Tax code
*  Taxrate
*

Tax amount

2. Select OK to return to the Quote Lines tab.
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26.15 Viewing the Quote Versions
Use this procedure to view the versions of the current quote. Details include:
= Version Number
= Status
=  Amount
s Currency
»  Created By
s Creation Date
» Updated By
= Update Date

Prerequisites
The quote must be displayed in the Oracle Quoting form.

Steps
1. Navigate to the Quote Versions tab. The Quote Versions tab lists the following
information about each version:

= Version Number
= Status

=  Amount

s Currency

s Created By

»  Creation Date

= Updated By

= Update Date

2. Optionally, select a version and select View. The version is displayed in the
Quoting form.
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26.16 Viewing Customer Quotes

There are two methods a user can use to find and view quotes:

Quote Search

Customer History form

For information on Quote Search, see Section 21.2, "Searching for Quotes".

26.16.1 Using the Customer History Form to View Customers Quotes

Use this procedure to view a list of the quotes prepared for the current customer. In
this window you can identify which quotes were created from opportunities as well
as those quotes converted to orders or leading to contracts.

Since previous versions of Oracle Quoting do not require account numbers to create
a quote, users can view quotes without designating an account number. An account
number is required if you want to update or place an order from the quote.

Prerequisites
The customer must be displayed in the Oracle Quoting form.

Steps

1.

From the Reports menu, select Customer History. The Customer History
window appears.

Select the Quotes tab.

The tab lists all quotes for this customer. Each line lists quote name, quote
number, account number, quote status, quote total, currency, quote expiration,
contact name, and salesperson name. You can also view information on the
opportunity related to the quote or the number of the order placed from the
quote. See Section 26.1, "Modifying a Customer Quote" if you want to make
changes.

Select View Quote to view the selected quote.

If the customer has more than one account, the Account field in the header of
the Customer History window displays an LOV of accounts when you click in
the field. Change the account to view the quotes for that account.
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26.17 Viewing the Order History for a Customer

Use this procedure to view the order history for the customer currently displayed in
the Oracle Quoting form. For a given order, the Order History displays information
regarding the quote related to the order and the order itself. If an account is selected
for the quote-to customer, the Order History displays a list of orders related to the
quote-to customer and designated account. You can select a different quote-to
customer account using an LOV.

Prerequisites
The quote-to customer must be displayed in the header of the Oracle Quoting form.

Steps

1. From the Reports menu, select Customer History.

The Customer History window opens, listing all of the quotes for the
designated quote-to customer. Click on the header of a column to sort the table
by the selected column.

2. Select the Orders tab.

The Orders tab opens, displaying detailed information for each of the
customer’s orders, including;:

s Order number

»  Order status

»  Creation date

= Order total

s Currency

= Account number

s Quote number

s Quote name

» Contact name

= Salesperson name
3. Highlight an order to view the order details.
4. Select View Quote to view the quote that preceded the order.
5. Select View Order to view the Order.
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The Oracle Order Management Sales Order form opens. Close this window to
return to the Customer History form.

6. Select Cancel to return to the main Oracle Quoting form.

26.18 Applying an Agreement to the Quote

Agreement terms with a customer are set up by your company in Oracle Pricing.
Agreements can include price lists, discounts, payment terms, and shipping
address.

To apply an agreement to a quote:

Prerequisites

An agreement with the current customer or a customer related to the Quote To
customer or a universal agreement must exist.

Steps

1. Navigate to the Quote Header tab > Summary section.
2. Use the Agreement LOV to enter an agreement, if one exists.
3. Save the quote.

The agreement terms are applied to the quote.

Note: The price list and payment terms are defaulted based on the
selected agreement.
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26.19 Using Descriptive Flexfields
To enter information into flexfields:

See the Oracle Quoting Implementation Guide and the Oracle Applications Flexfields
Guide for more information on setting up flexfields.

Prerequisites

Flextields must be set up and customized identically in Oracle Quoting and Order
Management.

Steps
1. Select in the descriptive flexfield to display the flexfield form.

2. Enter a value into each segment, either by typing it in or by choosing from the
LOV.

3. Select OK to close the flexfield form.
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Copying Quotes

This section contains information on copying quotes.
s Overview of Copying a Quote

= Copying a Quote
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27.1 Overview of Copying a Quote

In Oracle Quoting you can copy existing quotes to create new quotes or copy a
quote to a new version.

The table below lists the information copied to a new quote and to a new version.

Table 27-1 Copy Quote Behavior

Copy to New Version

Copy to New Quote (Forms only)

Quote Name Yes Yes
Quote Number No Yes
Version Number No No
Opportunity No Yes
Contract Template Yes Yes
Contract Number No N/A
Contract Approval Level No Yes
Expiration Date No Yes
Status No No
Published Flag No No
Sales Channel Yes Yes
Campaign Yes Yes
Primary Salesperson No Yes
Primary Sales Group No Yes
Order Number No N/A
Quote-to Customer (party Yes Yes
and account)

Quote-To Contact Yes Yes
Quote-To Address Yes Yes
Ship-To Customer (Party and Yes Yes

Account)/Contact/Address
at Header Level and Line
Level
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Table 27-1 Copy Quote Behavior

Copy to New Version

Copy to New Quote (Forms only)
Shipping Method, Shipping ~ Yes Yes
Instructions, Packing
Instructions, Requested
Delivery Date at Header and
Line Level
Bill-To Customer (Party and  Yes Yes
Account)/Contact/Address
at Header Level and Line
Level
Payment Terms at Header Yes Yes
Level
Payment and Tax Yes Yes
Information at Header and
Line Level
Regular Items, Configured Yes Yes
Items, Service Items and their
reference source, Quantity,
and UOM
Manual Price Adjustments Yes Yes
Automatic Price Adjustments Yes Yes
Currency at Header Level Yes Yes
Price List at Header Level Yes Yes
and Line Level
Pricing Agreement at Header Yes Yes
Level
Promotion Codes at Header  Yes Yes
and line Level
Line Types Yes Yes
Line Category Code Yes Yes
Order Type Yes Yes
Sales Credits at Header and  Yes Yes
Line Levels
Attachments User Choice Yes
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Table 27-1 Copy Quote Behavior

Copy to New Version

Copy to New Quote (Forms only)

Notes User Choice User Choice
Descriptive Flexfields at the ~ Yes Yes

Header and Line Level

Sales Team No Yes
Approval History No No

Sales Supplement Yes No

Pricing Updated On No No

Pricing Status No No

Tax Updated On No No

Tax Status No No

27.2 Copying a Quote
You can copy the following quote information:
s Quote Header — Header information only

= Lines — Header information as well as line item, billing and shipping
addresses, and payment information

s Notes — Header information and all notes associated with a quote

s Attachments — Header information and all attachments associated with a
quote

s All Quote Info — Includes header information, line information, notes and
attachments

For example, you can use Copy From: Quote Header if you need to create another
quote for the customer whose quote is currently displayed in the Oracle Quoting
form. Copy From: Quote Header can also be used to create a dummy quote, for a
specific quote-to customer, to use as a template for other quotes. Copy From: All
Quote Info could be useful if you want to create two copies of the same quote with
an item difference.

To copy a quote:
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Prerequisites
The original quote must be displayed in the Oracle Quoting form.

Steps
1. Select Actions > Copy Quote > OK. The Copy Quote form displays.

2. Inthe Copy Quote form under the Copy From heading, highlight the radio
button for one of the options below:

s Quote Header

If you choose this option, you can also choose one or more of the

following:
* Lines
*  Notes

*  Attachments
s All Quote Information

3. Under the Copy To heading, highlight the radio button for one of the options
below:

= New quote: This option copies the quote information you selected above
into a new quote. If the profile option ASO: Automatic Numbering is set to
No, you must enter a quote number in the New Quote Number field. This
field is disabled if ASO: Automatic Numbering is set to Yes.

= Version: This option copies the quote information you selected above into a
new version of the existing quote. You cannot create a new version of a
quote in Entered, Ordered, or Order Submitted status.

4. Select OK. A new or revised quote is created and displays in the Oracle
Quoting form.
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Initiating Approvals

This chapter discusses the approval process in Oracle Quoting.

Overview of Approvals
Initiating an Approval

Viewing Approval Details
Canceling the Approval Process
Approving a Quote

Rejecting an Approval
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28.1 Overview of Approvals

Oracle Quoting uses the Oracle Approvals Management (OAM) engine to define
rules governing situations requiring approval. Within OAM, a situation or rule
requiring approval is defined using Attributes, Conditions, and Approval Type.
Each application integrating with OAM must seed the desired Attributes. Attributes
are used to define Conditions, and the Approval Type determines the contents and
hierarchy of the approvers. One or more Conditions and an Approval Type
constitute a Rule.

A quote can only be submitted for approval if it meets the following conditions:
= Thelogged in user has Update access to the quote.
= The highest version of the quote must be used.

»  There is a transition defined from the current quote status to Approval Pending.

28.2 Initiating an Approval

When you initiate an approval, you can view the list of approvers and rules
applicable to the quote, if any. If Contracts integration is enabled, and a non-default
contract is required, once the quote is approved the quote status changes to Contract
Required. If the contract approval level is specified or changed, the list of approvers
and rules should be automatically recalculated. If you do not require a non-default
contract, the quote status changes to Approved when the quote receives all required
approvals.

The ability to skip approvers is determined by the profile option ASO: Allow Skip
Approvers.

Prerequisites
= ASO: Enable Approvals must be set to Yes at the appropriate level.

= The highest version of the quote must be used.

s There is a transition defined from the current quote status to Approval Pending.
s The Pricing and Tax status must be Complete.

= The user must have update access to the quote.

= The quote must not be in Order Submitted status.

= The quote must not be submitted for batch pricing.
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Steps

1.
2.

Select Actions > Approvals > OK.

Select Initiate Approval Process. The Initiate Approval form displays the list of
approvers.

Enter comments to send to the approvers.
Optionally, choose to include a non-standard contract with the quote.

Once the quote is approved, the quote is placed in Contract Required status. You
can request the contract to be authored by the contract administrator.

Optionally, choose to skip approvers.
Select Submit for Approval.

Successful approval submission is confirmed in a pop-up window. The quote is
then Read-only and is in Approval Pending status.

28.3 Viewing Approval Details

To view approval details:

Prerequisites
ASO: Enable Approvals must be set to Yes at the appropriate level.

Steps

1.

Select Actions > Approvals > OK.
The Approvals form displays details about the approval process, including the

approval status.
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28.4 Canceling the Approval Process

To cancel an approval process:

Prerequisites

The quote is in Approval Pending status.
The highest version of the quote must be used.
The user must have update access to the quote.

The quote must not be submitted for batch pricing.

Steps

1.
2.

Select Actions > Approvals > OK.
Select Cancel Approval Process.

The quote is now in Approval Canceled status.

28.5 Approving a Quote

Once an approval is initiated, it is passed on to the next approver. Each approver in
the hierarchy receives notification that the quote is ready for approval when it is
their turn to approve.

To approve a quote:

Prerequisites
ASO: Enable Approvals must be set to Yes at the appropriate level.

Steps

1.

2
3
4.
5

Login to Oracle Self Service Applications.

Select Workflow Administrator Web Applications.

Select Worklist.

Select the linked name of the quote requiring approval.

To view quote details, select Click Here For Quote Details.

If you are logged into Oracle Sales Online or the Oracle Quoting - HTML UlI, the
Quote Overview page opens. If not, the JTF login page opens and you must log
in to access the Quote Detail page.
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Navigate back to the Workflow form.
Optionally, enter comments.

Optionally, to reject the approval, select Reject.

© ® N o

Optionally, to reassign the approval, select Reassign.

10. Select Approve. The Approvals page shows confirmation that the quote was
submitted for approval.

11. Select Result to view approval details.

28.6 Rejecting an Approval

To reject an approval:

Prerequisites
ASO: Enable Approvals must be set to Yes at the appropriate level.

Steps
1. Login to Oracle Self Service Applications.

2. Select Workflow Administrator Web Applications.

3. Select Worklist.

4. Select the linked name of the quote requiring approval.
5

To view quote details, select Click Here For Quote Details. The Quote
Overview page opens.

o

Navigate back to the Workflow form.
7. Optionally, enter comments.

8. Select Reject. In Oracle Quoting, the quote status is now Approval Rejected.
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Notes and Attachments

This section contains the processes and procedures necessary to view, add, and
modify notes and attachments.

Overview of Notes and Attachments
Viewing and Adding Notes to a Quote
Searching for Notes

Creating an Attachment

Viewing an Attachment

Deleting an Attachment

Copying an Attachment from Another Quote
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29.1 Overview of Notes and Attachments

Notes contain descriptive information generated by users about specific quotes.

Users can add attachments to their quotes allowing them to store relevant
documents or files. Attachments include communications from customers or sales
representative’s notes about a quote.

29.2 Viewing and Adding Notes to a Quote

Use this procedure to create notes for a quote. Notes contain descriptive
information generated by users about business transactions.

Prerequisites

The quote for which you want to create a note must be displayed in the Oracle
Quoting main form.

Steps

1.

a

© ®» N O

10.
1.

Select Actions > View Notes > OK. The Notes form opens, displaying all notes
relating to the current quote.

Select the Summary tab to see the user, date created, entered by ID, and the first
line of note text for the highlighted note. Use the arrow key to scroll through
and view information for each note.

Select New to create a new note.
Enter the note text into the Notes field.

Select More to enter additional text beyond the character limit in the main notes
text box. The Detailed Note form opens, allowing you to add additional text.

Select OK to close the Detailed Note form.

Use the LOV to enter the note type in the Type field.

Use the pull down menu to enter the note status in the Status field.
Use the LOV to enter related objects in the Related To field.

You can relate the note to any object as well as to the active quote. The note can
have multiple relations.

Use the Value LOV to enter a valid reference number for the related section.

Save the note by selecting the Save icon on the toolbar or choosing File > Save.
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29.3 Searching for Notes

To search for notes in the Notes form:

Prerequisites
None

Steps

1. Select Actions > View Notes > OK. The Notes form opens.
2. Select the Search icon in the toolbar. The Find Notes form opens.
3. Enter a value into one of the search fields.

You can search by:

= Source Code: The application/object from which the note was created. For
example, quote

s Number: The identifier of the object. For example, quote number
= Entered By: Person who entered the note
= Entered Date: Date range for when the note was entered

= Related To: What the note is related to. For example, a quote or an
opportunity

= Value: Identifier of related objects. For example, an opportunity number
= Note Type: Type of note
= Notes: Contents of note

4. Select Search.
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29.4 Creating an Attachment
There are five types of documents you can attach to a quote:

= Document Reference — A reference to any type of document stored in a
database accessed through a Document Management system.

»  Short Text — Text stored in the database containing less than 2000
characters.

= Long Text — Text stored in the database containing 2000 characters or
more.

»  File — A file that requires other server applications to view.

= Web Page — A URL reference to a web page that you can view with a web
browser.

You can create attachments at the header or line level.

To create an attachment for a quote:

Prerequisites

s The Oracle Quoting form must display the quote to which you want to add an
attachment.

= The user must save the quote before creating an attachment.

= To create attachments at the header level, place the cursor in a header field and
follow the instructions below.

To create attachments at the line level, place the cursor in a line level field and
follow the instructions below.

Steps

1. Select the paper clip icon in the tool bar. The Attachments form opens.
2. Use the LOV to select a Category.

The Category controls which applications can access the attachment. The
default category is Miscellaneous, as this category is viewable from all
applications with attachments enabled.

3. Enter a Description for the attachment.
4. Use the LOV to select the Data Type.
The attached document can be any of the following data types:
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Short Text
Long Text

If the Data Type is Long Text or Short Text, a text field is enabled on the
form where you can directly input text.

— Enter the attachment text into the text form.
- Save your work.

Document Reference - A reference to any type of document stored in a
database accessed through a Document Management system.

File
If the Data Type is Document Reference or File, you must upload your file.

- Once you select either Document Reference or File as the Data Type,
the Upload a File window displays.

- Select Browse to search for your file.
- Select a file.
- Select OK to apply the file as an attachment.
If the file uploaded successfully, you will see a confirmation message.
- Close the browser to return to the Attachments form.

The text field on the Attachments form is replaced with an Open Docu-
ment button.

- Select Open Document to view your attached file.

- Close the browser to return to the Attachments form.

- Save your work.

Web Page

If the Data Type is Web Page, you must enter a source in the Source tab.

—  The Source tab automatically displays when you select URL from the
data type list.

- Typein the URL for the web page in the File or URL field.
- Select Open Document to view your attached file.

—  Close the browser to return to the Attachments form.
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- Save your work.

For more information on attachments, refer to the Oracle Applications User’s
Guide.

29.5 Viewing an Attachment

To view a document attached to a quote:

Prerequisites

= The quote containing the attachment(s) you want to view must be displayed in
the Oracle Quoting form.

= To view header attachments, place the cursor in a header level field.

To view line attachments, place the cursor in a line level field.

Steps

1. Select the paper clip icon. The Attachments form opens.
2. Highlight the attachment you want to view.

a. If the attachment is in the category short text or long text, the document
appears in a text block at the bottom of the form.

b. If the document is a file, web page, or document reference, select Open
Document.

The document displays in the browser designated when the attachment
was created.
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29.6 Deleting an Attachment

When you delete an attachment, you remove the association between the attached
document and the quote.

To remove an attachment from a quote:

Prerequisites

= The quote containing the attachment(s) you want to delete must be displayed in
the Oracle Quoting form.

= To view header attachments, place the cursor in a header level field.

To view line attachments, place the cursor in a line level field.

Steps

1. Select the paper clip icon. The Attachments form opens.
2. Select the attachment you want to remove.
3. From the Edit menu, choose Delete.

4. A decision window appears asking if you want to delete the attachment, or the
document and the attachment.

m  Select Attachment to delete the attachment to the file. The file still exists in
the Document Catalog.

s Select Document and Attachment to delete the attachment and delete the
file from the Document Catalog.

5. Save your work.

29.7 Copying an Attachment from Another Quote

To copy an attachment from another quote:

Prerequisites

s The Oracle Quoting form must display the quote to which you want to add an
attachment.

= The user must save the quote before adding an attachment.
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Steps

1. Select the paper clip icon. The Attachments form opens.

2. Select Document Catalog.

3. Enter the search criteria into the Find Existing Documents section.
You can search using the description, category, data type, attached to, file or
URL, or usage.

4. Select Find. The window displays matching documents.

5. Select the box to the left of the document to display the attachment, or place
your cursor in the attachment line and select Preview.

6. Close the browser to return to the Attachments form.

7. Select Attach.

The Attach button lists the number of attachments you are adding to your
quote.
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Applying Contracts to Quotes

This chapter covers contracts.
= Overview of Contracts

s Creating a Quote with Non Default Terms and Conditions
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30.1 Overview of Contracts

The objective of Oracle Quoting/Contracts integration is to automate the creation
and delivery of quotes with default or negotiated terms both on and off line.
Contracts integration into Quoting includes the following functionality:

= Automatic creation and delivery of quotes with default terms and conditions,
without involving a contract administration team.

= Sales representatives can request the assistance of a contract specialist to create
or modify non default terms.

= Print a quote with or without default or negotiated terms and conditions.
= Support contract integration during order placement and publishing.

= View contract reference, contract summary information, and terms and
conditions from Quoting.

Contracts integration is controlled by the profile option ASO: Enable Use
Contracts. If the profile is set to No, all menu options, buttons, and links related to
Contracts integration are disabled.

Note: You cannot remove a contract once it is associated with a
quote. You must change the status to Contract Canceled.
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30.1.1 Quotes and Contract Versioning

If a quote has an existing contract, the contract will always be attached to the latest
version of the quote.

Note: If you copy a quote with an attached contract to a new
quote, the contract will not copy into the new quote. You cannot
create a new version of a quote that has an attached contract.

30.1.2 Contracts Quote Statuses

The following quote statuses support Contracts Core integration. For more
information on quote statuses, see Chapter 20.1.2, "Quote Status".

Contract Required — A quote was approved but requires contract authoring. The
sales representative can request contract creation from this status.

Contract Pending — A contract is being authored by a contract specialist. This is
a read only status.

Contract Canceled — The contract was canceled by the contract specialist. This is
a read only status.

30.2 Creating a Quote with Non Default Terms and Conditions

To create a contract with non default terms and conditions:

Prerequisites

ASO: Enable Use Contracts must be set to Yes at the appropriate level.

A contract administrator must be designated in OKC: Default Contract
Administrator for notifications.

There must be a transition from the current status to Contract Pending.
There must not be a contract currently attached to the quote.

The Pricing and Tax status must be Complete.

Steps

1.
2.

Select Actions > Contract > OK. The Contract Detail Information page opens.

Use the LOV to select a contract template.

Applying Contracts to Quotes 30-3



Viewing a Quote’s Terms and Conditions

3. Select the Request contract creation if you need to negotiate terms and
conditions radio button.

4. Enter comments in the text box and select OK.

The quote number is displayed and a notification is sent to the Contracts
Administrator. The quote is now read-only in Contract Pending status.

30.3 Viewing a Quote’s Terms and Conditions

Steps

1. Select Actions > Contract > OK. The Contract Detail Information page opens.
2. Select Review Terms and Conditions. The Terms and Conditions display.

3. Select Done to return to the Contract Detail Information page.
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Publishing and Printing

This section contains the processes and procedures necessary to print and publish
quotes in Oracle Quoting.

s Overview of Printing
= Printing a Quote
= Overview of Publishing Quotes

= Web Publishing a Quote
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31.1 Overview of Printing

The ability to print a quote allows you to offer customers hard copies of quotes
created in the Oracle Quoting UL

The print outs for Print Quote vary depending on whether or not the quote is
executable. A quote is executable if there is a valid transition from the current quote
status to Order Submitted status. The non-executable Print Quote report displays a
customizable disclaimer in addition to the following key information:

= Quote information — Quote number, revision, date, expiration date, header
level payment term

s Customer information — Customer name, address, email address, and phone
number; ship-to customer name, address, and phone number; bill to customer
name, address, and phone number

= Pricing Agreement information — Agreement name, number, revision, and
revision date

= Line information — Product number and description, UOM, Qty, Unit Net
Price, Total Net Price, Sales Tax, Configurations for model products, Total price
for model products

= Attachments — Text type header attachments that are associated with the
document category Miscellaneous

s Charges — Quote line level charges, quote header level charges, and a
summary of charges for entire quote

The following sections are added if the quote is executable:

s Contract Information — Terms and Conditions for a contract associated with
the quote

Note: Contract information is only available on the Print Quote
report if Contracts integration is enabled.

= Signature block

There are templates available from which you can choose the print quote layout.
The seeded option is Default Print Layout. You can also choose to generate the
output in either Adobe PDF format or Rich Text Format (RTF). Oracle Quoting uses
Oracle Reports 6i to produce the Print Quote report.
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31.2 Printing a Quote

To print a quote:

Prerequisites

The highest version of the quote must be used.
The quote must be saved.

The Pricing status must be Complete.

The Tax status must be Complete.

The quote must not be submitted for batch pricing.

Steps

1.
2.
3.

Select Actions > Print Quote > OK. The Printing page displays.
Select the Output format and template from the drop-down menus.
Select the checkbox(s) to:

= Show subtotal by product category

= Show Price Adjustments

= Show Header Attachments (Text type only)

= Show Line Attachments (Text type only)

= Show Charges

= Print in executable mode (This option will not appear if the quote is not
executable)

Select Submit.

Depending on your browser, either a browser window opens displaying the
printout or you are asked to open or save the printout.

If you need a paper copy of the quote, choose your browser’s Print option to
print the report.

31.3 Overview of Publishing Quotes

Sales representatives can share quotes with customers by web publishing the
quotes. A quote version may be web published if it meets all of the following
conditions:
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»  The user has update access to the quote.

= The highest version of the quote must be used.

= The quote is not in Order Submitted or Inactive status.
= The quote is not expired.

= ASO: Enable Web Publishing is set to Yes.

= If the quote-to customer is of type Organization, a quote-to contact has been
specified.

s Thereis at least one specialty store in which the quote can be web published.
s The quote must not already be web published.

= The quote must not be submitted for batch pricing.

s The pricing and tax statuses must both be Complete.

= The quote name must be specified.

Note: If a web published quote does not meet all of the criteria
above, the Publish flag will indicate that it is web published, but it
will not show up in the customer UL

If the quote-to customer is of type Person, the sales representative publishes the
quote directly to the quote-to customer. If the quote-to customer is of type
Organization, the sales representative publishes the quote to the quote-to contact. A
quote version can only be published to an FND_USER. Oracle Quoting will verify
that the quote-to customer/contact is an FND_USER. If the customer is not an
FND_USER, the sales representative can create an FND_USER for the customer.

31.4 Web Publishing a Quote

To web publish a quote:

Prerequisites
= ASO: Enable Web Publishing must be set to Yes at the appropriate level.

= You must have update access to the quote.
= The highest version of the quote must be used.

= The quote is not in Order Submitted or Inactive status.
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The quote is not expired.

If the quote-to customer is of type Organization, a quote-to contact has been
specified.

There is at least one specialty store to which the quote can be web published.
The quote must not already be web published.

The quote must not be submitted for batch pricing.

The Pricing and Tax statuses must be Complete.

The quote name must be specified.

Steps

1.
2.

o o & W

Select Actions > Web Publish and select OK. The Publish page opens.

If the customer is not an FND_USER, you will be prompted to enter a User
Name. The system auto generates a password and creates an FND_USER for
the customer. This information is then emailed to the customer.

Select the store the quote will be published to.
Enter the email address for the user.
Optionally, enter comments and select Submit.

Upon returning to the main Quoting form, you are asked if the quote was
published successfully. Select OK to continue. A note appears confirming
publication.

31.4.1 Unpublishing a Quote
To unpublish a previously published quote:

Prerequisites

ASO: Enable Web Publishing must be set to Yes at the appropriate level.
The quote must currently be web published.

The highest version of the quote must be used.

The user must have update access to the quote.

The quote is not in Order Submitted or Inactive status.

The quote is not expired.
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= The quote is not submitted for batch pricing.

Steps
1. Select Actions > Web Unpublish > OK.

A note appears confirming that the quote was unpublished.
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Enabling Quoting Security

This chapter outlines the procedures necessary to enable and use Oracle Quoting
Security.

s Overview of Security
= Adding a Resource to the Quote Sales Team

s Changing the Primary Sales Agent
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32.1 Overview of Security
Quoting Security has three essential components:
= Quote Access Security
= Quote Function Security

= New Quote Security

Quote Access Security

Quote Access Security designates which quotes are available to the user. Users
should have access only to quotes for the sales team that both the user and the
user’s subordinates belong to.

Quote Access Security also determines whether the user has update or view-only
access to quotes.

Quote Function Security

Quote Function Security determines whether or not there are user restrictions on
particular quote functions. For example, a user may be restricted from placing
orders. This security is controlled by profile options and/or the permissions
assigned to a user or responsibility.

New Quote Security

New Quote Security determines if users can create new standalone quotes and for
which customers.

Primary Sales Agent

The Primary Sales Agent for a quote has quote ownership responsibility. This is not
necessarily the same individual who creates the quote. If the quote creator meets the
Primary Sales Agent criteria, the quote creator will default as the Primary Sales
Agent. If the quote creator does not meet the criteria, the sales representative
selected in the profile option ASO: Default Salesrep will default as the primary
sales agent. For more information on Primary Sales Agents, see the Oracle Quoting
Implementation Guide.

In order to be a Primary Sales Agent, the user must:
= Bea valid resource, set up in Resource Manager

= Beset up as a sales representative
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Note: A primary sales agent is required on a quote. The user
cannot save or submit a quote without one.

32.1.1 Quote Access Security

Quote Access Security is controlled by the profile options ASO: Enable Security
Check. When the profile is disabled, users have access to all quotes. When it is
enabled, quote access is restricted based on:

= Quote Availability Security — Restricts the quotes available to users based on
hierarchy and sales teams

= Quote Data Security — Determines if users have update access or view-only
access to quotes

32.1.1.1 Quote Availability Security

Quote availability security restricts the quotes available to each user. A user must be
set up as a valid resource in order to view quotes when security is enabled. If the
user is a valid resource, all quotes where the user is on the quote sales team are
available. This includes all quotes created by the user and, by other users on the
quote sales team.

If the user is also a manager, the following quotes are available:
= All quotes where the user is on the quote sales team

= All quotes where the user’s subordinates are on the quote sales team

32.1.1.2 Quote Data Security

Once it is determined what quotes are available to a user, Quote Data Security
determines whether the user has update access to these quotes. The Full Access flag,
located next to each resource on the Sales Team tab, designates the level of access. If
the Flag is selected, the user has full update access to quotes. If the flag is not
selected, the resource has view-only access.

If a user has update access to a quote, the user can modify any quote field and
perform any function that is not restricted by other Quoting requirements. If the
quote is changed to a read-only status, the user may only update the payment
information and other fields that are updateable in read-only statuses.
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If a user has view-only access to a quote, the user cannot modify fields or perform
any function on the quote. When a quote is changed to a read-only status, the user
cannot update payment information or other updateable fields.

Manager Access

Whether or not managers can access quotes for the sales team their subordinates
belong to is controlled by the profile option ASO: Manager Role Access. If the
profile is set to Update, the manager can update all quotes for their subordinates’
sales teams. If the profile is set to Inherit, the manager has the same access level as
the subordinate. If the profile is set to Inherit and the manager has more than one
subordinate on the team with different access levels, the manager should inherit the
highest access level.

32.1.2 Quote Function Security

Quote function security determines which actions a user with update access can
perform on a quote. Profile options and permissions restrict the following
functionality and allow the user to:

= Override a quote status — The value of profile option ASO: Status Override
controls a user’s ability to update a quote when it is in a read-only status. This
will ensure that the user can override quote data if a mistake was made prior to
transitioning the quote to a read-only status.

s Override the price list — The value of profile option ASO: Price List Override
controls a user’s ability to change the selected price list for a quote. This
functionality ensures that a user does not inadvertently quote an inaccurate
price based on an incorrect price list selection.

»  Create new customers — The value of profile option ASO: Create New
Customer controls a user’s ability to create new customer information. This
functionality ensures that customers wishing to protect the integrity of
customer data can restrict the creation of new customers to a limited number of
users.

= Update customer information — The value of profile option ASO: Update
Customer controls a user’s ability to update existing customer information.

= Update sales team information — The value of profile option ASO: Update
Sales Team controls a user’s ability to manually update sales team information,
including manual assignment of the primary sales agent.

For more information on the Quote Function Security profile options, see the Oracle
Quoting Implementation Guide.
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32.1.3 New Quote Security

New Quote Security restricts the parties for which a sales agent can create quotes.
New Quote Security is governed by the profile option ASO: New Quote Security. If
set to Yes, a user cannot create new standalone quotes. This includes copying
existing quotes to new quotes.

Note: Setting this profile to Yes does not restrict a user’s ability to
create quotes from opportunities.

If this profile is set to No, the user can create quotes for all customers. If the profile
option is set to Sales Team, the user must be on the account sales team in order to
select that customer in the quote header.

Note: When Oracle Quoting is integrated with Oracle TeleSales,
account sales team information is collected from Oracle TeleSales.

32.2 Adding a Resource to the Quote Sales Team

You can add resources to the quote sales team, if you have ASO: Update Sales
Team set to Yes at the appropriate level.

Note: The Keep Flag is not supported in this release.

Use the following procedure to add a resource to the quote sales team.

Prerequisites

s The profile ASO: Update Sales Team must be set to Yes at the appropriate
level.

Steps
1. Select Actions > Sales Team > OK.

The Primary Sales Agent is automatically populated in this form. See Section,
"Primary Sales Agent" for more information.

2. Use the Name LOV in the first open line to select a resource.

3. Optionally, use the Group LOV to select a sales group.
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4. Optionally, select the Full Access flag if you want the sales team member to
have update access to the quote.

5. Save the quote.

32.3 Changing the Primary Sales Agent

To assign a new primary sales agent:

Prerequisites
= ASO: Update Sales Team must be set to Yes at the appropriate level.

= The person that you want to act as the Primary Sales Agent must be set up as a
valid resource and as a sales representative.

Steps
1. In the quote header, use the Salesperson LOV to select a new primary sales
agent.

2. Save the quote.

The new primary sales agent shows up in the Sales Team form with the Primary
flag checked.
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33

Placing Orders

This section contains information about submitting orders to Oracle Order
Management.

= Overview of Placing Orders

= Placing an Order
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Overview of Placing Orders

33.1 Overview of Placing Orders

When you place an order in Oracle Quoting, the quote is converted into an order
using Oracle Order Management.

33.2 Placing an Order

To convert a quote into an order:

Prerequisites

= There must be a valid transition from the current quote status to Order
Submitted.

= ASO: Enable Submit Button must be set to Yes at the appropriate level.
s The user must have update access to the quote

= The highest version of the quote must be used

s The quote must not be in Order Submitted status

= The quote must not be submitted for batch pricing.

s There s at least one line in the quote.

= The quote is not expired.

s The Pricing and Tax statuses must be Complete.

Steps
1. If you are creating an order from a quote, display the quote in the Oracle
Quoting form.

2. Add products to the quote, if necessary. See Section 26.2, "Adding Products to
the Quote" for instructions.

3. Adjust discounts. This is an optional step. It is only necessary if there is a
discount you wish to apply to the order. See Chapter 23, "Pricing Products and
Quotes".

4. If the bill-to information has not been entered, enter it. See Section 25.3,
"Entering Billing Information" for instructions.

5. If the ship-to information has not been entered, enter it. See Section 25.4,
"Entering Shipping Information" for instructions.
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If the payment information has not been entered, then enter it. See Section 25.10,
"Entering Header Payment Information" for instructions.

Select Place Order.

Your order is submitted to Oracle Order Management and you receive a
confirmation number. You can then track the order in Order Management.

The order confirmation displays:
s Order Number

s Order Total

= Shipping Method

s Currency

= Ship-To Customer

= Ship-To Account

= Ship-To Contact

= Ship-To Address
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Part IV

Appendixes

This part contains the following Appendixes:
= Appendix A, "Oracle Quoting HTML User Interface Reference"

= Appendix B, "Oracle Quoting Forms User Interface Reference":






A

Oracle Quoting HTML User Interface
Reference

This appendix describes each window or page in the application, including tasks
you can perform, and an explanation of the components. Sections in this appendix
include:

s Common Elements

= Quotes Page

= Advanced Search Page

= Saved Searches Page

»  Create Saved Search Page
= Templates Page

»  Update Template Page

= Template Detail

»  Create Template Page

s Create Quote Page

= Search and Select: Customer Page
s Create Customer Page

= Search and Select: Contact
s Create Contact Page

= Search and Select: Address
»  Create Address Page
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= Search and Select: Person

= Search and Select: Source Name Page

= Search and Select: Sales Group Page

= Quote Overview Page

s Charge Summary Page

s Overview Sidebar

s Price Quote Page

= Pricing Request Details Page

= Print Quote Page

= Publish Page

= General Page

= Search and Select: Opportunity Page

= Lines Page

s Product Details Page

s Charges Details

= Pricing Details Page

= Specify Service Reference

s Search and Select: Product

= Search and Select: Installed Base Product
s Search and Select: Extended Attributes
» Installed Base Relationships Page

» Installed Base Product Details

= Availability Information Page

= Select: Service Page

= Modify Service Page

s Search and Select: Related Products Page
= Adjust Pricing Page

= Assign Sales Credits Page
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Configure Page

Modify Shipping and Billing Page
Split Line Page

Pricing Page

Search and Select: Promotion Code Page
Shipping and Billing Page

Sales Team Page

Sales Credit Page

Proposals Page

Approvals Page

Initiate Approval Page

Approval Detail Page

Approver Notification Detail Page
Approver Comments Page
Contracts Page

Request Contract Creation Page
Contract Details

Contract Terms and Conditions Page
Tasks Page

Sales Supplement Page

Notes Page

Attachments Page

Add Attachments Page

Versions Page

Order Details Page
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Common Elements

A.1 Common Elements

The following table lists and describes the common user interface components in
the application.

Table A-1 Common Elements Page Components

Component Type Description

Quotes Tab Accesses the Quotes Page

Templates Tab Accesses the Templates Page

Quote Name Hyperlink Accesses the Overview page for the quote.

Quote Number | Read-only field | Displays quote number and version number.
Customer Read-only field | Displays customer name. Linked to opportunity if
Name integrated with Oracle Sales Online.

Account Read-only field | Displays account number. Linked to opportunity if
Number integrated with Oracle Sales Online.

Contact Name

Read-only field

Displays contact associated with the Quote To
customer. Blank if the Quote To customer is of type
Person.

Opportunity Read-only field | Displays opportunity name. Linked to opportunity if

Name integrated with Oracle Sales Online.

Pricing Status | Read-only field | Displays the status for pricing calculations on the
quote.

Tax Status Read-only field | Displays the status for tax calculations on the quote.

Number Read-only field | Displays product number.

Description Read-only field | Displays product description.

UuOM Read-only field | Displays product UOM.

Quantity Read-only field | Displays product quantity.

Sub-Total (List
Price)

Read-only field

Displays the sub-total of list prices.

Sub-Total Read-only field | Displays the sub-total of selling prices.
(Selling Price)

Cancel Button Nullifies transaction.

Apply Button Applies changes.

Delete Button Deletes selected line or product.
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Quotes Page

Table A-1 Common Elements Page Components

Component Type Description

Go Button Executes search.

Sign Out Icon Accesses the login page.

Help Icon Accesses online help for the application.

Actions Drop-down Listed value selections allow you to carry out actions
menu for an individual line.

Previous Link Accesses previous page of display.

Next Link Advances to next page of display.

Revert Button Reverts product back to original, saved state in

database.

A.2 Quotes Page

The Quotes page is the landing page in the application.

The following table describes the user interface components on the Quotes page.

Table A-2 Quotes Page Components

Component Type Description
Create Quote Button Access the Create Quotes page and starts the
Create Quote flow.
Results Section Section listing Quote information details.
Select quote | Prompt Identifies action to be takes after selection.
and...
Duplicate Button Creates new Quote based on selected Quote
attributes.
Previous Drop-down Displays next page listing of Quotes.
menu
Next Link Advances to the next page of Quote display.
Select Radio button Selects the quote from which a duplicate is to be
made.
Quote Name | Hyperlink Accesses the Overview page with Quote details.
Quote Read-only field | Displays the quote number.
Number
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Quotes Page

Table A-2 Quotes Page Components

Component Type Description

Opportunity | Read-only Displays Opportunity Name. Links to

Name field/Hyperlink | Opportunity Detail if ASO: Enable OSO
Integration is set to Yes at the appropriate level.

Customer Read-only Displays Customer Name. Links to Customer

Name field/Hyperlink | details if ASO: Enable OSO Integration is set to
Yes at the appropriate level.

Account Read-only Displays Account Number. Links to account

Number field/Hyperlink | details if ASO: Enable OSO Integration is set to
Yes at the appropriate level.

Contact Read-only Displays Contact Name. Links to contact detail if

Name field/Hyperlink | ASO: Enable OSO Integration is set to Yes at the
appropriate level.

Status Read-only field | Indicates the current stage of preparation for a
specific quote.

Web Read-only field | Flag to indicate if quote is published.

Published Only appears if ASO: Enable Web Publishing is
set to Yes at the appropriate level.

Expiration Read-only field | Displays expiration date.

Date

Amount Read-only field | Total quote amount, inclusive of all charges and
taxes.

Order Detail | Hyperlink Displays the order details for the quote. Only
appears if quote status is Order Submitted.

Quote Search Bin Search bin.

Quote Name | Text field Enter Quote Name or partial value for search.

Quote Text field Enter Quote Number or partial value for search.

Number

Customer Text field Enter Customer Name or partial value for search.

Name

Account Text field Enter Account Number or partial value for

Number search.

Contact Text field Enter Contact Name or partial value for search.

Name

Go Button See Section A.1, "Common Elements"
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Advanced Search Page

Table A-2 Quotes Page Components

Component Type Description
Advanced Hyperlink Accesses the Advanced Search page.
Search

Saved Searches Bin Search bin for Saved Searches
Saved Drop-down Lists all saved searches. Defaults to default saved
Searches menu searches.
Go Button Displays search results
Personalize Button Accesses page that lists all saved searches.

See Also:

= Section 5.1, "Overview of Searching for Quotes"
s Section 5.2, "Basic Search for Quotes"

s Section 5.3, "Advanced Search for Quotes"

A.3 Advanced Search Page
Use the Advanced Search page to search for existing quotes.

The following table describes the user interface components on the Advanced

Search page.
Table A-3 Advanced Search Page Components

Component Type Description

Save Search Button Displays the Create Saved Search page.

Criteria

Create Quote Button Displays the Create Quote page.

Advanced Search | Section Section listing the Advanced Search parameters.
Basic Sub-section Sub-section listing the basic elements of the
Information Advanced Search parameters.

Quote Name | Text field Enter the quote name for which you want to
search.

Quote Text field Enter the quote number for which you want to

Number search.
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Advanced Search Page

Table A-3 Advanced Search Page Components

Component Type Description
Customer Text field Enter the customer name for which you want to
Name search.
Customer Drop-down Select customer type. Values are either
Type menu Organization or Person.
Account Text field Enter the account number for which you want to
Number search.
Contact Text field Enter the quote-to contact name.
Name
Opportunity | Text field Enter the opportunity name, if the quote was
Name created from an opportunity.
Quote Text field Restricts search by quote amount range.
Amount
From Text field Starting point of quote amount range
To Text field Ending point of quote amount range
Currency Drop-down Select a currency. Values are Null (Default) and all
menu currencies.
Creation Date | Text Restricts search criteria by date range. Use
field/Calendar Calendar icon tool for range determination.
icon
Status Drop-down Select a status. Values are All (Default) and all
menu statuses.
Update Date | Text Restricts search criteria by update date range. Uses
field/Calendar Calendar icon tool for range determination.
icon
Web Drop-down Indicates if the quote has been published to the
Published menu web. Either Null, Yes, or No.
Appears only if ASO: Enable Web Publishing is
set to Yes at the appropriate level.
Expiration Text Restricts search by expiration date range.
Date field /Calendar
icon
Sales Sub-section Sub-section listing the basic elements of Sales
Information Information.
Salesperson | Text field Displays the Salesperson’s name. Default is logged

in user.
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Table A-3 Advanced Search Page Components

Component Type Description

Go Button Accesses the Search and Select: Person page.

Sales Group | LOV field Select a sales group. LOV searches all Sales
Groups.

Go Button Accesses the Search and Select: Sales Group page.

Restrict to Checkbox Checking this box restricts search to primary

Primary Salespersons and/or primary Sales Group.

Salesperson

and Primary

Sales Group

Sales Channel | Drop-down Select a sales channel. Values are All (Default) and

menu all Sales Channels.
Source Name | Text field Enter a Source Name
Go Button Accesses the Create Saved Search page
Results Section Section listing Search results details.

Quote Name | Hyperlink Links to the Quote Overview page.

Quote Read-only field Displays Quote Number

Number text

Opportunity | Read-only Displays Opportunity Name. Links to the

Name field/Hyperlink | Opportunity Detail if created from an opportunity.

Customer Read-only Displays Customer Name. Links to customer detail

Name field/Hyperlink | if ASO: Enable OSO Integration is set to Yes at
the appropriate level.

Account Read-only Displays Account Number. Links to customer

Number field/Hyperlink | detail if ASO: Enable OSO Integration is set to
Yes at the appropriate level.

Contact Read-only Displays Contact Name. Links to customer detail if

Name field/Hyperlink | ASO: Enable OSO Integration is set to Yes at the
appropriate level.

Status Read-only field Displays Quote Status

Web Read-only field Flag to indicate if quote is published. Values are

Published Yes and No.

Only appears if ASO: Enable Web Publishing is
set to Yes at the appropriate level.
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Saved Searches Page

Table A-3 Advanced Search Page Components

Component Type Description

Expiration Read-only field Displays Expiration Date.

Date

Amount Read-only field Displays total quote amount, inclusive of all
charges and taxes.

Order Detail | Hyperlink Links to order detail page, if quote was converted
into an order.

See Also:

s Section 5.3, "Advanced Search for Quotes"

A.4 Saved Searches Page

The following table lists and describes the user interface components on the Saved

Searches page.

Table A-4 Saved Searches Page Components

Component Type Description

Create Saved Button Accesses the Create Saved Search page.

Search

Select saved Instructional Identifies the action to be taken after selecting a saved

search and... text search.

Duplicate Button Copies the selected saved search and then accesses the
Create Saved Search page.

Delete Button Deletes the selected saved search.

Previous Hyperlink See Section A.1, "Common Elements"

Next Hyperlink See Section A.1, "Common Elements"

Select Radio Button Identifies the saved search on which the action will be
performed.

Name Hyperlink Links to the Update Saved Searches page.

Description Read-only field | Displays saved search description.

See Also:
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Create Saved Search Page

m  Section 5.4, "Saved Searches"

= Section 5.4.1, "Creating a Saved Search"

A.5 Create Saved Search Page

Use the Create Saved Search Page to create saved searches.

The following table lists and describes the user interface components on the Create
Saved Search page.

Table A-5 Create Saved Search Page Components

Component Type Description
Cancel Button See Section A.1, "Common Elements"
Apply Button Saves the search and then accesses the Saved
Searches page.
Apply and View | Button Saves and applies the search. Accesses the default
view with the current search in the Saved Searches
LOV.
Query Properties | Section Section listing search parameters for creating a
Saved Search.
Basic Information | Section Displays basic information about the quote.
Quote Name | Text field Enter quote name.
Quote Text field Enter quote number
Number
Customer Text field Enter Customer Name.
Name
Customer Drop-down Select Customer Type. Values are Null (Default),
Type menu Organization, and Person.
Account Text field Enter account number.
Number
Contact Text field Enter contact name.
Name
Opportunity | Text field Enter opportunity name.
Name
Quote Prompt Restricts search by quote amount range.
Amount
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Create Saved Search Page

Table A-5 Create Saved Search Page Components

Component Type Description
From Text field Starting point of quote amount range.
To Text field Ending point of quote amount range.
Status Drop-down Select from list of indicators for the current stage of
menu. preparation for a specific quote.
Creation Text Restricts search by date range.
Date field/Calendar
icon
From Text field Starting point of creation date range. Set using the
calendar icon tool.
To Text field Ending point of creation date range. Set using the
calendar icon tool.
Update Date | Text Restricts search by update date.
field/Calendar
icon
From Text field Starting point of search. Set by calendar icon tool.
To Text field Ending point of search. Set by calendar icon tool.
Web Drop-down See Section A.1, "Common Elements"
Published menu
Expiration Text Restricts search by expiration date.
Date field/Calendar
icon
From Text field Starting point of search. Set by calendar icon tool.
To Text field Ending point of search. Set by calendar icon tool.
Sales Information | Subsection Subsection listing sales information
Salesperson | Text field Select a primary salesperson. Displays the logged in
user by default.
Go Button Accesses the Search and Select: Person page.
Sales Group | LOV field Enter either sales group name or partial value.
Accesses the Search and Select: Sales Group page.
LOV displays all sales groups.
Go Button Accesses the Search and Select: Sales Group page.
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Table A-5 Create Saved Search Page Components

Component Type Description
Restricts to | Checkbox Restricts search to primary salesperson and/or
Primary primary sales group.
Salesperson
and Primary
Sales Group
Sales Drop-down Select a sales channel. Values are All (Default) and
Channel menu all sales channels.
Source Name | Texfield/LOV | Select a source name.
field
Go Button Accesses the Search and Select: Source Name page.
Column Section Section listing Available Columns, Displayed
Properties Columns, and Sort Settings.
Available Multi-Select Lists all available columns to choose from.
Columns LOV
Move Arrow icon Moves selected product to Displayed Columns
right
Move All Double Arrow | Moves all products to Displayed Columns
icon right
Remove Arrow icon left | Moves selected products to Available Columns
Remove All | Double Arrow | Moves all products to Available Columns.
icon left
Displayed Multi-Select Lists columns chosen for display.
Columns LOV
Sort Settings | Subsection Subsection listing sort settings parameters
First Sort Drop-down Selects first sort order criteria. Default value is
menu Quote Name.
Sort Order Drop-down Select sort order criteria. Values are Ascending and
menu Descending.
Second Sort | Drop-down Selects second sort order criteria. Default value is
menu Quote Name.
Sort Order Drop-down Select sort order criteria. Values are Ascending and
menu Descending.
Third Sort Drop-down Selects third sort order criteria. Default value is
menu Quote Name.
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Table A-5 Create Saved Search Page Components

Component Type Description
Sort Order Drop-down Select sort order criteria. Values are Ascending and
menu Descending.
General Section Section displaying saved search properties
Properties
Saved Search | Text field Displays saved search name. Read Only for existing
Name quote. Mandatory field.
Use as Checkbox Saves search as default display if checked.
Default
Saved Search
Number of Drop-down User chooses from values listed. Values are 5, 10, 15
Rows menu (Default), 20, and 25.
Displayed
Description | Text field Enter description of search.
See Also:

m  Section 5.4, "Saved Searches"

= Section 5.4.1, "Creating a Saved Search"

= Section 5.4.2, "Viewing a Saved Search"

= Section 5.4.3, "Modifying a Saved Search"
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Templates Page

A.6 Templates Page

The following table lists and describes the user interface components on the

Templates page.
Table A6 Template Page Components
Component Type Description
Create Template | Button Accesses the Create Template page.
Only appears if ASO: Manage Quote Templates is set
to Yes at the appropriate level.
Search Section Section for template search functionality.
Template LOV Choose type for restricting template search, either
field / Textbox Name (default) or Description and enter a value in
the textbox.
Go Button See Section A.1, "Common Elements".
Results Section Section listing template search results details.
Select Subsection Section containing options for template tasks.
Template
and...
Delete Button Deletes the selected template.
Only appears if ASO: Manage Quote Templates is set
to Yes at the appropriate level.
Create Button Creates quote from selected template.
Quote Only appears if ASO: Manage Quote Templates is set
to Yes at the appropriate level.
Select Checkbox Identifies the row(s) to be deleted /used for quote
creation.
Disappears if ASO: New Quote Security is set to Yes
at the appropriate level.
Name Hyperlink Linked template name accesses Template Detail.
Description | Read-only field | Description of template.
See Also:

= Section 4.2, "Creating a Template"

= Section 4.3, "Creating a Quote From a Template"
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Update Template Page

A.7 Update Template Page

Use the Template Update page to access and modify templates.

The following table lists and describes the user interface components of the

Template Update page.
Table A-7 Update Template Page Components

Component Type Description

Basic Section Section listing basic template information.

Information
Template Text field Displays template name. Optionally, change the
Name template name. Mandatory field.
Description | Text field Displays template description

Lines Section Section listing products.
Add Button Accesses the product search page.
Product
Select Line | Prompt Identifies action to be taken after selecting line.
and...
Add Menu option Accesses the Select: Service page.
Services
Configure | Menu option Launches Configurator for the selected line.
Duplicate Menu option Duplicates the selected line.
Line
Remove Menu option Removes the selected line.
Line
Modify Menu option Accesses the Modify Service page.
Service
Select Radio Button Selects line.
Line Read-only field | Displays line number
Product Read-only field | Displays the product part number.
Description | Hyperlink Description of template. Link accesses Product Details

page.
UOM Read-only field | Unit of Measurement
Quantity Text field Enter quantity in numeric format. Field is read only if
the product is a service.
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Table A-7 Update Template Page Components

Component Type Description

Revert Button See Section A.1, "Common Elements"

Apply Button See Section A.1, "Common Elements"
See Also:

= Section 4.4, "Modifying a Template"

A.8 Template Detail

Use the Template Detail page to view template details. This page appears if ASO:
Manage Quote Templates is set to No at the appropriate level.

The following table lists and describes the user interface components on the
Template Detail page.

Table A-8 Template Detail Page Components

Component Type Description
Basic Section Section listing basic template information.
Information
Template Text field Displays template name.
Name
Description | Text field Displays template description
Lines Section Section listing products.
Line Read-only field | Displays the line number.
Product Read-only field | Displays the product part number.
Description | Hyperlink Description of the product. Link accesses the Product
Details page.
UOM Read-only field | Displays the product unit of measurement
Quantity Read-only field | Displays the product quantity.
Done Button See Section A.1, "Common Elements"
Create Quote Button Accesses the Create Quote page.

Disappears if ASO: New Quote Security is set to Yes
at the appropriate level.
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Create Template Page

A.9 Create Template Page
Use the Create Template page to create templates.

The following table lists and describes the user interface components on the Create

Template page.
Table A-9 Create Template Page Components
Component Type Description
Cancel Button See Section A.1, "Common Elements"
Apply Button Creates the template and continues to the Template
Details page.
Basic Section Section listing the Template Name and Description
Information
Template Text field Enter a template name. Mandatory field.
Name
Description | Text field Enter a template description.
See Also:

= Section 4.2, "Creating a Template"

= Section 4.3, "Creating a Quote From a Template"
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Create Quote Page

A.10 Create Quote Page

Use the Create Quote Page to create quotes.

The following table describes the user interface components on the Create Quotes
page.

Table A-10 Create Quote Page Components

Component Type Description
Cancel Button Nullifies transaction and takes user back to the prior
page.
Apply Button Creates quote and takes user to the Lines page for
the new quote.
General Section Lists the basic elements of the Create Quote page.
Information
Quote Name | Text field Enter a quote name. This is a mandatory field.
Customer LOV text field Select the Customer Name. Mandatory field.
Name
Go Button Accesses the Search and Select: Customer Page.
Account LOV text field Enter the account number.
Number
Go Button Accesses the Search and Select: Customer Page.
Contact LOV text field Select the Contact Name
Name
Go Button Accesses the Search and Select: Customer Page.
Opportunity | Read-only Displays Opportunity Name. Links to Oracle Sales
Name field/Hyperlink | Online if created from an opportunity and if ASO:
Enable OSO Integration is set to Yes at the
appropriate level.
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Table A-10 Create Quote Page Components

Component

Type

Description

Address

Text field

Optionally, enter a different address.

This field is populated with an active address based
on the following conditions (only at the time of
quote creation):

If the Quote-To Customer is an Organization and a
Quote-To Contact is specified, the application
searches for a value from the following sources (in
that order) and accepts the first one it finds:

= Primary Sold-To address type usage for the
Quote-To Contact

= Identifying address for the Quote-To Contact

= Primary Sold-To address type usage for
Quote-To Customer

= Identifying address for the Quote-To Customer

If the Quote-To Customer is an Organization and a
Quote-To Contact is not specified, the application
searches for a value from the following sources (in
that order) and accepts the first one it finds:

= Primary Sold-To address type usage for the
Quote-To Customer

= Identifying address for the Quote-To Customer

If the Quote-To Customer is a Person, the
application searches for a value from the following
sources (in that order) and accepts the first one it
finds:

= Primary Sold-To address type usage for the
Quote-To Customer

= Identifying address for the Quote-To Customer

Go

Button

Accesses the Search and Select Address page.

Expiration
Date

Text
field/Calendar
icon

Displays the expiration date. Set by Calendar icon.
Mandatory field.

Status

Read-only field
text

Indicates the current stage of preparation for the
quote.
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Table A-10 Create Quote Page Components

Component Type Description
Primary LOV text field | Defaults to the user if the user is set up as a
Salesperson salesperson for the current operating unit. If not,

defaults to resource designated in the profile ASO:
Default Salesrep. Appears as read-only if ASO:
Update Sales Team is set to No at the appropriate

level.

Mandatory field.
Go Button Accesses the Search and Select: Person page.
Primary Drop-down Default is the logged in user as specified in OSO:
Sales Group | menu Default Sales Group and Role. Values are Null and

all Sales Groups.

Appears as Read Only if ASO: Update Sales Team
is set to No at the appropriate level.

Sales Drop-down Defaults to value specified in ASO: Default Sales
Channel menu Channel at the appropriate level. Values are Null
and all Sales Channels.

Source Name | LOV text field Lists the various types of marketing sources that are
set up in Marketing Online. Can be specified for a
quote created directly or can be copied over when a
quote is created from an opportunity.

Go Button Displays the Search and Select: Source Name page
so that user may search for source name by either
name or code.

Order Type | Drop-down Select Order Type. Defaults to value specified in
menu ASO: Default Order Type at the appropriate level.

Agreement | Drop-down Select pricing agreement. Values are Null (Default)
menu and all applicable agreements.

Currency Drop-down Select currency type. Defaults from the default price
menu list.

Price List Drop-down List of all available price lists. Default is from
menu agreement, customer, and order type.

Appears as Read Only if ASO: Price List Override
is set to No at the appropriate level.
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Table A-10 Create Quote Page Components

Component Type Description
Contract Drop-down List of contract templates. Defaults to template
Template menu specified in OKC: Contract Template for Standard
Terms and Conditions set at the appropriate level.
Enabled only if ASO: Enable Use Contracts is set to
Yes at the appropriate level.
See Also:

= Section 3.2, "Creating a Quote"

A.11 Search and Select: Customer Page

Use the Search and Select: Customer page to search for customer details.

The following table lists and describes the user interface components on the Search

and Select: Customer page.

Table A-11 Search and Select: Customer Page Components

Component Type Description

Cancel Button See Section A.1, "Common Elements"

Create Button Accesses the Create Customer page.

Customer

Select Button See Section A.1, "Common Elements"

Search Section Section listing search parameters
Customer | Text field Enter customer name or partial value.
Name
Account Text field Enter account number or partial value and wildcard.
Number
Customer | Radio buttons | Restricts search by Customer Type. Values are
Type Organization and Person.
Contact Text field Enter a contact name or partial value and wildcard.
Name
Display Section Determines how results are displayed.

A-22 Product Title/BookTitle as a Variable




Search and Select: Customer Page

Table A-11 Search and Select: Customer Page Components

Component Type Description
Addresses | Drop-down Lists addresses by country. Values are all countries.
In menu/Radio
button

Contacts Radio button Select to display contact name in the search results.

Go Button Refreshes page and displays search results based on
search parameters.

Results Section Section displaying search results

Select Radio button Selects line.

Customer | Read-only field | Displays customer name.

Name

Account Read-only field | Displays account number.

Number

Address Read-only field | Displays customer address. Appears only if user chose
to display addresses rather than contacts.

Primary Gif Check mark image will show up if primary address is
used for billing, shipping, selling, and marketing.
Appears only if user chose to display addresses rather
than contacts.

Type Read-only field | Displays address type. Appears only if user chose to
display addresses rather than contacts.

Contact Read-only field | Displays contact name for the customer. Appears only

if user chose to display contacts rather than addresses.
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A.12 Create Customer Page
Use the Create Customer page to create customers.

The following table describes the user interface components on the Create
Customer page.

Table A-12 Create Customer Page Components

Component Type Description
Apply Button See Section A.1, "Common Elements"
Organization Radio Identifies customer type as an organization.
button/text
field
Person Radio button Identifies customer type as an individual.
Last Name Text field Enter customer’s last name.
First Name Text field Enter customer’s first name.
ML Text field Enter customer’s middle initial.
Email Text field Enter email address.
Phone Number | Text field Enter phone number.
Customer Section Section listing customer address fields.
Address
Country Drop-down Select country from list. Values are all countries.
menu
Address Text field Enter address type (e.g. Home, Office).
Name
Address Multi-line Text | Enter customer address.
field
City Text field Enter city.
County Text field Enter county.
State Text field Enter state.
Zip Text field Enter zip code.
Country Read-only field | Displays country.

See Also:

= Section 8.2, "Creating Customers"
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A.13 Search and Select: Contact

The following table lists and describes the user interface components of the Search
and Select: Contact page.

Table A-13 Search and Select: Contact Page Components

Component Type Description
Cancel Button See Section A.1, "Common Elements"
Create Contact | Button Accesses the Create Contact page.
Select Button Selects contact and returns to the create quote page.
Search Section Section listing search parameters
Contact Text field Enter full or partial contact name.
Name
Go Button See Section A.1, "Common Elements"
Results Section Section displaying search results
Select Radio Button Identifies the record to be selected.
Contact Read-only field | Displays the contact name.
Name
Primary Read-only field | Displays contact’s phone number.
Phone
Email Read-only field | Displays contact’s email address
Address
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A.14 Create Contact Page
Use the Create Contact page to create a contact and enter contact information.

The following table lists and describes the user interface components on the Create
Contact page.

Table A-14 Create Contact Page Components

Component Type Description
Apply Button See Section A.1, "Common Elements"
Customer Read-only field | Displays customer name.
Name
First Name Text field Enter contact’s first name.
ML Text field Enter contact’s middle initial.
Last Name Text field Enter contact’s last name.
Email Text field Enter email address.
Day Phone Text field Enter daytime phone number.
Evening Phone | Text field Enter evening phone number.
Fax Number Text field Enter Fax number.
Contact Section Section listing contact address fields and information.
Address
Country Drop-down Select country. Values are all countries.
menu
Address Text field Specify address type (e.g. Home, Office)
Name
Address Multi-lineText | Enter customer address.
field
City Text field Enter city.
County Text field Enter county.
State Text field Enter state.
Zip Text field Enter zip code.
Country Read-only field | Displays country.

See Also:
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= Section 8.2.1, "Creating Contacts"

A.15 Search and Select: Address

The following table lists and describes the user interface components of the Search
and Select: Address page.

Table A-15 Search and Select: Address Page Components

Component Type Description/Action
Cancel Button See Section A.1, "Common Elements"
Create Address | Button Accesses the Create Address page.
View All Button Refreshes page, listing all customer contacts.
Contacts
Select Button Selects the selected line and returns to the source page.
Search Section Section listing search parameters
Country Drop-down Select country from list. Values are all countries.
menu
Go Button See Section A.1, "Common Elements"
Results Section Section displaying search results
Select Radio Button Identifies the record to be selected.
Customer | Read-only field | Displays the group name.
Name
Contact Read-only field | Displays contact name.
Name
Address Read-only field | Displays contact’s address
Primary Gif Check mark image identifies address as primary for
shipping, selling, and billing information
Type Read-only field | Address type. Distinguishes between shipping, billing,
and selling addresses.
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A.16 Create Address Page

Use the Create Address page to enter address information.

The following table lists the user interface components on the Create Address page.

Table A-16 Create Address Page Components

Component Type Description

Apply Button See Section A.1, "Common Elements"

Customer Read-only field | Displays customer name.

Name

Country Drop-down Select country from list. Values are all countries.
menu

Address Name | Text field Specify address type (e.g. Home, Office).

Address Multi-lineText | Enter customer address.
field

City Text field Enter city.

County Text field Enter county.

State Text field Enter state.

Zip Text field Enter zip or postal code.

Country Read-only field | Displays country.

See Also:

= Section 8.2.2, "Creating Addresses"

A-28 Product Title/BookTitle as a Variable



Search and Select: Source Name Page

A.17 Search and Select: Person

Use the Search and Select: Person page to search for those people set up as internal
resources and sales representatives. Person Names are in a Last Name, Prefix First

Name format.

The following table lists and describes the user interface components on the Search
and Select: Person page.

Table A-17 Search and Select: Person Page Components

Component Type Description
Search Section Section listing search parameters
Person Drop-down User selects category. Categories are Employee
menu (Default), Partner, Other, Supplier Contact, Party, All
Categories.
Textfield Text field Enter keyword or partial value.
Go Button See Section A.1, "Common Elements"
Results Section Section displaying search results
Previous Hyperlink See Section A.1, "Common Elements".
Next Hyperlink See Section A.1, "Common Elements"
Select Radio button Selects line in search results display.
Name Read-only field | Displays name.
Category | Read-only field | Displays category type (e.g. Employee).
Cancel Button See Section A.1, "Common Elements".
Select Button See Section A.1, "Common Elements".

A.18 Search and Select: Source Name Page

Use the Search and Select: Source Name page to search for marketing sources that
are set up in Marketing Online. Searches are based on either Source Name or Source

Code.

The following table lists and describes the user interface components on the Search
and Select: Source Name page.
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Table A-18 Search and Select: Source Name Page Components

Component Type Description
Cancel Button See Section A.1, "Common Elements".
Select Button Selects the selected source name and returns to the
source page.
Search Section Section listing search parameters
Source Drop-down User selects value. Either Name or Source. Enter
menu/Textfield | keyword or partial value. Leave empty and select Go
to view all source names/codes.
Results Section Section displaying search results
Select Radio Button Identifies the selected record.
Name Read-only field | Displays source name.
Code Read-only field | Displays source code.
Type Read-only field | Describes the source type.

A.19 Search and Select: Sales Group Page

Use the Search and Select: Sales Group to search for sales group information.

The following table lists and describes the user interface components on the Search

and Select: Sales Group page.

Table A-19 Search and Select: Sales Group Page Components

Component Type Description
Select Button Selects the selected source name and returns to the
source page.

Search Section Section listing search parameters
Sales Text field Enter sales group name or partial value before clicking
Group Go to execute the search.

Results Section Section displaying search results
Select Radio Button Identifies the record to be selected.
Name Read-only field | Displays the group name.

See Also:
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Section 15.1, "Overview of Security"

A.20 Quote Overview Page

User the Quote Overview page to access and modify quote details.

The following table lists and describes the user interface components on the Quote
Overview page.

Table A-20 Quote Overview Page Components

Component Type Description

Actions Drop-down See Section A.1, "Common Elements"
menu

Go Button Executes the selected action.

Create New

Action menu

Creates a new version of the quote.

Version ttem Disappears if:
= User does not have update access, OR
= Highest version of quote is in statuses
Approval Pending, Order Submitted, or
Contract Canceled, OR
= The quote has been submitted for batch pricing.
Duplicate Action menu Duplicates the quote.
Quote item

Disappears if:
= Quote has been submitted for batch pricing, OR
s ASO: New Quote Security is set to Yes.

Freeze Prices

Action menu
item

Freezes prices on quote.
Disappears if:
= Pricing date is not null.

= User does not have update access to the quote,
OR

= Not the highest version of the quote, OR

= Quote is in a read-only status, OR

= Quote has been submitted for batch pricing.
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Table A-20 Quote Overview Page Components

Component

Type

Description

Unfreeze
Prices

Action menu
item

Unfreezes prices.

Disappears if:

Pricing date is null.

User does not have update access to the quote,
OR

Not the highest version of the quote, OR
Quote is in a read-only status, OR

Quote has been submitted for batch pricing.

Place Order

Action menu
item

Submits the quote to Order Management.

Disappears if:

ASO: Enable Submit is set to No, OR

User does not have update access to the quote,
OR

Not the highest version of the quote, OR
Quote is in Order Submitted status, OR

Quote has been submitted for batch pricing.

Price Quote

Action menu
item

Prices quote.

Disappears if:

User does not have update access, OR
Not the highest version of the quote, OR
Quote is in a read-only status, OR

Quote has been submitted for batch pricing.

Cancel
Pricing
Request

Action menu
item

Cancels an in-progress pricing request.

Disappears if:

ASO: Enable Batch Processing is set to No, OR

The quote is not submitted for batch
processing, OR

User does not have update access to the quote,
OR

Not the highest version of the quote, OR

Quote is in a read-only status.
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Table A-20 Quote Overview Page Components

Component Type Description
Initiate Action menu Initiates a credit check.
Credit Check | item . .
Disappears if:
s ASO: Enable Credit Check is set to No, OR
= User does not have update access to the quote,
OR
= Not the highest version of the quote, OR
s Quote is in Order Submitted status, OR
= Quote has been submitted for batch pricing.
Web Publish | Action menu Accesses the Publish page.
Quote ttem Disappears if:
= ASO: Enable Web Publishing is set to No, OR
= Quote is web published, OR
= User does not have update access to the quote,
OR
= Not the highest version of the quote, OR
s Quote is in Order Submitted or Inactive status,
OR
= Quote has been submitted for batch pricing.
Web Action menu Unpublishes a quote.
Unpublish item Disappears if:
Quote pp ’
= ASO: Enable Web Publishing is set to No, OR
= Quote is not web published, OR
= User does not have update access to the quote,
OR
= Not the highest version of the quote, OR
s Quote is in Order Submitted or Inactive status,
OR
= Quote has been submitted for batch pricing.
Print Quote | Action menu Accesses Print Quote page.
item . .
Disappears if:
= Not the highest version of the quote, OR
= Quote has been submitted for batch pricing.
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Table A-20 Quote Overview Page Components

Component Type Description
General Section Section listing general quote information.
Information

Quote Name | Read-only field

Displays quote name.

Quote Read-only field | Displays quote number and version.

Number

Customer Read-only Displays Customer Name. Links to customer detail

Name field/Hyperlink | if ASO: Enable OSO Integration is set to Yes at the
appropriate level.

Account Read-only field/ | Displays Account Number. Links to customer detail
Number Hyperlink if ASO: Enable OSO Integration is set to Yes at the
appropriate level.

Contact Read-only field/ | Displays Contact Name. Links to customer detail if

Name Hyperlink ASO: Enable OSO Integration is set to Yes at the

appropriate level.

Opportunity | Read-only field/

Displays Opportunity Name. Links to customer

Name Hyperlink detail if ASO: Enable OSO Integration is set to Yes
at the appropriate level.
Address Read-only field | Displays address. Links to customer details if ASO:

Enable OSO Integration is set to Yes.

Expiration Read-only field

Displays expiration date.

Date

Status Read-only field | Displays quote status

Primary Read-only field | Displays Primary Salesperson name.
Salesperson

Primary Read-only field | Displays Primary Sales Group name.
Sales Group

Sales Read-only field | Displays Sales Channel type.
Channel

Source Name | Read-only field

Displays Source name.

Order Type Read-only field

Displays Order Type.

Agreement Read-only field

Displays Agreement.

Currency Read-only field

Displays currency.

Price List Read-only field

Displays quote price list.
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Table A-20 Quote Overview Page Components

Component Type Description
Contract Read-only field | Displays template name.
Template
Contract Read-only field | Displays contract number.
Number
Pricing Read-only field | Displays the pricing status of the quote.
Status
Tax Status Read-only field | Displays the tax status of the quote.
Order Read-only field | Displays order number.
Number
Web Read-only field | Displays Web Published status: Either Yes or No.
Published
Pricing Read-only field | Displays the pricing request number, if the pricing
Request call was submitted as a concurrent request.
Lines Section Section listing product details.
Line Read-only field | Displays the line number.
Product Read-only field | Displays part number.
Description | Hyperlink Linked text displays product name. Accesses the
Line Details Pop-Up window.
UuoOM Text Displays the unit of measurement.
field /Read-only
field
Quantity Read-only field | Displays product quantity.
Unit List Read-only field | Displays Unit List Price.
Price
Unit Read-only field | Displays the unit adjustment for the line.
Adjustment
Percent
Unit Selling | Hyperlink Linked numeric text displays unit selling price.
Price Opens the Pricing Details Pop-Up window.
Total Price Read-only field
Grand Total Subsection Displays grand total information for the quote.
Sub-Total Read-only field | Displays the sum of the list price for all products
(List Price) and quantity on the quote.
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Table A-20 Quote Overview Page Components

Component Type Description

Total Read-only field | Displays total adjustment percent of (Total

Adjustment Adjustments/Total List Price) for all products and

Percent quantity on the quote. Displayed in brackets if the
amount is negative.

Total Read-only field | Displays the sum of the adjustments for all products

Adjustment and quantity on the quote. Displayed in brackets if

Amount the amount is negative.

Sub-Total Read-only field | Displays the difference between the Subtotal and

(Selling the Total Adjustment Amount.

Price)

US Sales Tax | Read-only field | Displays one line for each tax code applied to the

1 quote. Displays tax code description and total tax
amount for the tax code.

Charges Hyperlink Displays the sum of all freight and special charge
modifiers applied to the quote. Selecting the link
opens the Charge Summary page.

Total Read-only field | Displays the total sum of the following amounts:
Sub-total, Tax Codes, Charges

Addresses Section Section listing address information. Broken into two
section: Shipping and Billing.

Customer Read-only field | Displays customer name.

Name

Account Read-only field | Displays account number.

Number

Contact Read-only field | Displays contact name for customer.

Name

Address Read-only field | Displays address in line-by-line format.

Shipping Section Section listing shipping information.

Shipping Read-only field | Displays shipping method.

Method

Requested Read-only field | Displays the requested delivery date.

Delivery

Date

Shipping Read-only field | Displays shipping instructions.

Instructions
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Table A-20 Quote Overview Page Components

Component

Type

Description

Packing
Instructions

Read-only field

Displays packing instructions.

Payment

Section

Section listing payment information.

Payment
Terms

Read-only field

Lists agreed upon payment terms.

Payment
Type

Read-only field

Displays payment type.

PO Number

Read-only field

Displays purchase order number.

Check
Number

Read-only field

Displays check number.

Credit Card
Type

Read-only field

Displays credit card type.

Credit Card
Number

Read-only field

Displays credit card number.

Cardholder
Name

Read-only field

Displays cardholder’s name.

Credit Card
Expiration

Read-only field

Displays credit card expiration date.

A.21 Charge Summary Page

The Charge Summary page displays the charges total for the entire quote.

The following table lists and describes the user interface components on the Charge
Summary page. For more information on header level fields, see Section A.1,
"Common Elements".

Table A-21 Header Level Charges Page Components

Component

Type

Description

Name

Read-only field

Displays the name of the Freight and Special Charge

modifier.

Level

Read-only field

Displays the modifier level set up in Oracle Pricing.

Type

Read-only field

Displays a concatenation of the type and sub type for

the Freight and Special Charge modifier.
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Table A-21 Header Level Charges Page Components

Component Type Description

Amount Read-only field Displays the amount of the modifier.

Total Read-only field Displays the total of all modifiers applied to the quote.
Close Button Closes the Charges Summary page and returns the user

to the Quote Lines page.

A.22 Overview Sidebar

The Quote Overview page contains a sidebar on the left-side of the page, providing
links to several key areas of the application. The sidebar is broken into three main
sections: Quote Information, Sales, and Other Information. Your Application
Developer can customize this menu and therefore, the options available in your
Sidebar menu may differ from the list below.

The following table lists and describes the user interface components on the
Overview Sidebar.

Table A-22 Overview Sidebar Components

Component Type Description
Overview Hyperlink Accesses the Overview page.
Quote Section Section listing Quote Information links.
Information
General Hyperlink Accesses the General page.
Lines Hyperlink Accesses the Lines page where you can view and edit
product information
Pricing Hyperlink Accesses the Pricing page where you can view and
edit pricing information.
Shipping Hyperlink Accesses the Shipping and Billing Information page,
and Billing where you can view and edit shipping, billing and
payment information.
Additional | Hyperlink Accesses the Additional Information page.
Information
Sales Section Section listing Sales Information links.
Information
Sales Team | Hyperlink Accesses the Sales Team page where you can view

and edit quote Sales Team information.
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Table A-22 Overview Sidebar Components

Component Type Description
Sales Credit | Hyperlink Accesses the Sales Credit page where you can view
and edit credit information.
Proposals Hyperlink Accesses the Proposals page where you can view and
create proposals.
Approvals | Hyperlink Accesses the Approvals page where you can view
and edit approval information.
Contracts Hyperlink Accesses the Contracts page where you can view and
edit contract information.
Tasks Hyperlink Accesses the Tasks page where you can view and edit
Tasks.
Other Section Section listing links for other Information.
Information
Sales Hyperlink Accesses the Sales Supplement page where you can
Supplement view sales supplement information.
Notes Hyperlink Accesses the Notes page where you can view and
edit Notes.
Attachments | Hyperlink Accesses the Attachments page where you can view

attachment information, and add attachments.

Versions Hyperlink Accesses the Versions page where you can view
version information.
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A.23 Price Quote Page

The Price Quote page is used to manually calculate prices and/or taxes for a quote.
The page is not available if:

s ASO: Calculate Price is set to Automatic
s ASO: Calculate Tax is set to Automatic
= ASO: Enable Batch Processing is set to No

The following table lists and describes the user interface components on the Price
Quote page. For more information on header level fields, see Section A.1, "Common
Elements".

Table A-23 Price Quote Page Components

Component Type Description
Compute Radio buttons | Select to calculate Price Only, Tax Only or Both for the
Options quote.

The compute option Tax Only is disabled if ASO:
Calculate Tax is set to Automatic.

Submission Radio buttons | Select to submit the pricing request now or submit the
Options pricing request through a concurrent program and
notify the sales representative when it completes.

Submit pricing request and notify me when it is
complete is disabled if ASO: Enable Batch Processing
is set to No.

Submit Button Select to submit the request.
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A.24 Pricing Request Details Page

The Price Request Details page is used to view the details of a pricing or tax
calculation request. This page is only available if ASO: Enable Batch Processing is

set to Yes.

The following table lists and describes the user interface components on the Price
Request Details page. For more information on header level fields, see Section A.1,
"Common Elements".

Table A-24 Pricing Request Details Page Components

Component

Type

Description

Request Id

Read-only field

Displays the concurrent request ID for the submitted
pricing and/or tax calculation request.

Request Name

Read-only field

Displays the request name.

Phase

Read-only field

Displays the request phase. Possible values are
Pending, Running, or Inactive.

Status

Read-only field

Displays the status of the request.

Date Submitted

Read-only field

Displays the date the request was submitted.

Request

Requestor Read-only field | Displays the requestors name.

Date Started Read-only field | Displays the date the request began running.
Done Button Closes the Pricing Request Details page.
Cancel Pricing | Button Cancels the in-progress pricing request.

A.25 Print Quote Page

Use the Print Quote page (Printing) to choose printout options and print quotes.

The following table lists and describes the user interface components on the Print
Quote page. For more information on header level fields, see Section A.1, "Common

Elements".

Table A-25 Print Quote Page Components

Component Type Description
Done Button Takes you back to previous page.
Submit Button Generates printout.
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Table A-25 Print Quote Page Components

Component Type Description

Output Format | Updateable Allows you to select the output format. Values are
Drop-down Adobe PDF (Default) and Rich Text Format. Values
menu sourced from Order Capture lookup ASO_PQUOTE_

OUTPUT_FMT.

Template Updateable Allows you to select the template for printout. Seeded
Drop-down value is Default print layout. Values sourced from
menu Order Capture lookup ASO_PQUOTE_TEMPLATES.

Show subtotal | Checkbox If checked, the subtotal for each product category will

by product be printed at the end of the report. Use product

category categories belonging to the default category set for the
Order Management functional area.
Should not be checked by default.

Show Price Checkbox If checked, price adjustments and list prices will print.

Adjustments Should be checked by default.

Show Header Checkbox Enabled if ASO: Print Quote Show Attachments is

Attachments Yes. If enabled, it should be unchecked by default.

(text type only) If checked, all header level Text type attachments in the
Miscellaneous document category will print.

Show Charges | Checkbox If checked, charges details appear on the quote
printout. If unchecked, charges details are not printed
but, total charges are displayed in the Subtotal section
of the printout.

Print in Checkbox Should appear only if the quote is executable.

executable With Contracts integration:

mode
If checked, the T&Cs and signature block will print.
Without Contracts integration:

If checked, the signature block will print.
Should be checked by default.
See Also:

= Section 17.2, "Printing a Quote"
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A.26 Publish Page

Use the Publish page to publish quotes online.

The following table describes the user interface components on the Publish page.
For more information on header level fields, see Section A.1, "Common Elements".

Table A-26 Publish Page Components

Component Type Description
Submit Button Publishes the quote.
Username Text field/ If mandatory text field appears, the quote-to customer

Read-only field | is not an FND_USER. Enter a username for the
quote-to customer.

Read-only when quote-to customer is an FND_USER.

Web Publish In | Drop-down Lists specialty stores that quote version is eligible to be
menu published in. Defaults to the Specialty Store ID stored
in the quote header, if one exists.
Send Email To | Prompt Displays options for email contact.
Existing Radio Values are all email address for the sold_to
Address button/Text contact/customer. Disappears if there are no existing
field email addresses.
New Radio Select with radio button and then add in new email
Address button/Text address manually in text field.
field
Comments Text field Enter any relevant comments.
See Also:

= Section 17.4, "Web Publishing a Quote"
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A.27 General Page

Displays general information created when creating a quote. Use this page to view
and modify information.

The following table describes the user interface components on the General page.

Table A-27 General Page Components

Component Type Description

Revert Button Reverts the quote to its saved state in the database.
Disappears if user does not have Update access
and/or quote is not the highest version.

Apply Button Applies changes. Disappears if user does not have
Update access and /or quote is not the highest
version.

General Section Section listing general information.

Information

Quote Name | Text field Enter new quote name. Read-only field if user

does not have Update access and/or quote is not
the highest version and/or the quote version is
Web Published.

Quote Read-only field Displays quote number and version.

Number

Customer Read-only Displays customer name. Links to customer detail

Name field/Hyperlink | if ASO: Enable OSO Integration is set to Yes at
the appropriate level.

Account Read-only Displays account number. Links to account detail

Number field/Drop-down | if ASO: Enable OSO Integration is set to Yes at

menu the appropriate level.

If Quote-To customer has multiple accounts, the
drop-down displays account numbers and
descriptions separated by a dash.

Contact LOV /text field Select new contact name. Read-only field if user

Name does not have Update access and/or quote is not
the highest version and/or the quote version is
Web Published.

Go Button Accesses the Search and Select: Contact page.

Opportunity | LOV/text field Enter a full opportunity name or a partial value

Name and select Go to access the Search and Select:

Opportunity page.
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Table A-27 General Page Components

Component Type Description
Go Button Accesses the Search and Select: Opportunity page.
Address Text field Enter new address. Read-only field if user does
not have Update access and/or quote is not the
highest version.
Go Button Accesses the Search and Select: Address page.
Expiration Text Text field displays expiration date. Use Calendar
Date field/Calendar tool to change expiration date.
tool Read-only field if user does not have Update
access and/or quote is not the highest version.
Status Drop-down menu | Select new status. Values are current status
(default) and all statuses.
Read-only field if user does not have Update
access and/or quote is not the highest version.
Primary LOV Displays salesperson name. Optionally select a
Salesperson different salesperson.
Read-only field if user does not have Update
access and/or quote is not the highest version,
and/or ASO: Update Sales Team is set to No at
the appropriate level.
Go Button Accesses the Search and Select: Person page.
Primary Drop-down menu | Select a different primary sales group. Displays all
Sales Group available sales groups that the salesperson belongs
to.
Read-only field if user does not have Update
access and/or quote is not the highest version,
and/or ASO: Update Sales Team is set to No at
the appropriate level.
Sales Drop-down menu | Select a different sales channel. Values are Null
Channel and all sales channels.

Read-only field if user does not have Update
access and/or quote is not the highest version.

Source Name | LOV Enter a different source name.
Read-only field if user does not have Update
access and/or quote is not the highest version.
Go Button Accesses the Search and Select: Source Name

page.

Oracle Quoting HTML User Interface Reference

A-45



Search and Select: Opportunity Page

Table A-27 General Page Components

Component Type Description

Order Type Read-only field Displays the order type.

Agreement Drop-down menu | Select new agreement. Values are Null and all
universal and customer-specific agreement in
quote currency.

Read-only field if user does not have Update
access and/or quote is not the highest version.

Currency Read-only field Displays currency.

Price List Drop-down menu | Select new price list. Values are Null and all price
lists for the quote currency.

Read-only field if user does not have Update
access and/or quote is not the highest version,
and/or ASO: Price list Override is set to No at the
appropriate level.

Contract Drop-down menu | Select new contract template. Values are all
Template contract templates.

Appears only if ASO: Enable Use Contracts is set
to Yes at the appropriate level.

Read-only field if user does not have Update
access and/or quote is not the highest version,
and/or a contract is attached to the quote.

A.28 Search and Select: Opportunity Page

Use the Search and Select Opportunity page to search for and select an opportunity
to associate to your quote.

The following table lists and describes the user interface components of the Search
and Select: Opportunity page.

Table A-28 Search and Select: Opportunity Page Components

Component Type Description
Search Section Displays the search criteria.
Opportunity Drop-down Select whether you want to search by opportunity

menu/Text field name or number and enter a full or partial value
(followed by a wildcard) in the text field.

Go Button Executes the search.

A-46 Product Title/BookTitle as a Variable



Lines Page

Table A-28 Search and Select: Opportunity Page Components

Component Type Description
Results Section Displays the search results.
Select Radio button Selects the opportunity to be associated with the
quote.
Name Read-only field Displays the opportunity name.
Number Read-only field Displays the opportunity number.
Sales Stage ~ Read-only field Displays the sales stage.
Win Read-only field Displays the opportunity win probability.
Probability
Status Read-only field Displays the opportunity status.
Close Date ~ Read-only field Displays the opportunity close date.
Amount Read-only field Displays the opportunity amount.
Cancel Button Cancels any action and returns the user to the General
page.
Select Button Applies changes and returns the user to the General

page.

A.29 Lines Page

Use the Lines page to access and edit product and discount information.

The following table lists and describes the user interface components of the Lines
page. For more information on header level fields, see Section A.1, "Common

Elements".

Table A-29 Lines Page Components

Component Type Description

Revert Button See Section A.1, "Common Elements"

Apply Button See Section A.1, "Common Elements"

Check Button Accesses the Availability Information page.
Availability

Add Service to | Button Accesses the Specify Service Reference page.
Previous

Purchase
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Table A-29 Lines Page Components

Component Type Description
Add Product Button Accesses the Search and Select: Product page.
Select Line and... | Prompt Identifies action to be taken after line is selected.
Actions Drop-down See Section A.1, "Common Elements"
menu
Go Button Executes the selected Action.
Select Radio button Identifies the record to be selected.
Line Read-only field | Displays the line number.
Product Read-only Displays the Inventory part number.
Description Hyperlink Linked description accesses the Line Details pop-up
window.
If the product is a configured model, the total price
appears below the description.
If the product is a service for a product on the quote,
the line is indented under the serviceable product.
UuOM Read-only field | Displays unit of measurement.
Quantity Text Lists product quantity. Read only if line is a service.
field/Read-only
field
Unit List Price Read-only field | Displays unit list price.
Unit Text Total of all adjustments currently applied to the quote
Adjustment field/Read-only | line. Displayed as a percent of the unit list price.
Percent field Di . . o
isplayed as a negative value if the unit adjustment
is negative; displayed as a positive amount if value is
positive.
Read-only if ASO: Discounting Privilege is set to
Partial or None.
Unit Selling Text field Displays unit net selling price.
Price Updateable if ASO: Discounting Privilege is set to
Full.
Icon links to Adjustments pop-up window.
Total Price Read-only field | Displays total selling price.
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Table A-29 Lines Page Components

Component

Type

Description

Charges

Hyperlink

Displays total of all modifiers of type Freight and
Special Charge for the line. Links to Charges Details

page.

Line Category

Read-only field

Displays line category. Return or Order.

Line Type

Drop-down
menu

Select a line type.

Enabled for non-configured products and configured
products whose line type is not populated by
Configurator.

If ASO: Enable Line Type is set to No, the line type
LOV shows only line types with the line category
Order.

If ASO: Enable Line Type is set to Yes, the Line Type
LOV shows line types with the line categories Order
and Return.

Tax Details

Read-only field

Displays code, rate, and amount for each tax applied
to the line. Only displayed if ASO: Show Line Level
Tax Details is set to Yes.

Instance Name

Read-only field

Displays a unique name generated by Configurator
and passed to Installed Base upon fulfillment.

Applies only to configured products.

Custom Column | Hyperlink This link is defined by the customer. Not enabled
1 unless a JSP page has been provided. Please see the
Oracle Quoting Implementation Guide for more
information.
Custom Column | Hyperlink This link is defined by the customer. Not enabled
2 unless a JSP page has been provided. Please see the
Oracle Quoting Implementation Guide for more
information.
Custom Column | Hyperlink This link is defined by the customer. Not enabled
3 unless a JSP page has been provided. Please see the
Oracle Quoting Implementation Guide for more
information.
Grand Total Subsection Displays grand total information.
Sub-Total Read-only field | Displays the sum of the list price for all products and
(List Price) quantity on the quote.
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Table A-29 Lines Page Components

Component Type Description

Header Text box Displays the header manual discount amount. The

Manual sign of the percentage is interpreted based on the

Discount profile ASO: Require Minus Sign for Manual
Discount.

Appears only if:

ASO: Discounting Privilege is set to Full AND/OR
User has update access to the quote AND/OR
Quote is in the highest version AND/OR

The status is not read-only

Total Read-only field | Displays total adjustment percent of (Total

Adjustment Adjustments/Total List Price) for all products and

Percent quantity on the quote. Displayed in brackets if the
amount is negative.

Total Read-only field | Displays the sum of the adjustments for all products

Adjustment and quantity on the quote. Displayed in brackets if

Amount the amount is negative.

Sub-Total Read-only field | Displays the difference between the Subtotal and the

(Selling Total Adjustment Amount.

Price)

US Sales Read-only field | Displays one line for each tax code applied to the

Tax 1 quote. Displays tax code description and total tax
amount for the tax code.

Charges Hyperlink Displays the sum of all freight and special charge
modifiers applied to the quote. Selecting the link
opens the Charge Summary page.

Total Read-only field | Displays the total sum of the following amounts:
Sub-total, Tax Codes, Charges

See Also:

= Section 10.1, "Adding Products to the Quote"

= Section 10.2, "Removing Products From the Quote"

= Section 10.4, "Configuring Products"
= Section 10.6, "Adding Related Product"
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A.30 Product Details Page

The Product Details page is a pop-up window displaying product details.

The following table lists and describes the user interface components on the Product
Details page.

Table A-30 Product Details Page Components

Component Type Description

Product Read-only field | Displays part number.
Description Read-only field | Displays product description.
Product Type Read-only field | Displays product type.

Support Service

Read-only field

Indicates whether or not the product is a support
service.

Configurable Read-only field | Indicates if the product is configurable.
Serviceable Read-only field | Indicates if the product is serviceable.

Shippable Read-only field | Indicates if the product is shippable.

Returnable Read-only field | Indicates if the product is returnable. Returnable

products can be traded-in.

Serial Number

Read-only field

Displays the product serial number.

Appears only if the product is from the Installed
Base.

System Read-only field | Displays the product’s system.

Appears only if the product is from the Installed Base
Installed At Read-only field | Displays the installed at address.
Address Appears only if the product is from the Installed Base
Order Date Read-only field | Displays the order date.

Appears only if the product is from the Installed Base

Selected Service

Section

Displays service information for the product if the
product is serviceable.

Product Read-only field | Displays the service part number.
Description | Read-only field | Displays the service description.
Duration Read-only field | Displays the service duration.
Period Read-only field | Displays the service period.
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Table A-30 Product Details Page Components

Component Type Description
Start Date Read-only field | Displays the start date for the service.
Included Read-only field | Designates if the service is included in the price of the

product.

Service For

Section

Displays the service reference information.

Appears only if the product is a service.

Service For

Read-only field

Displays the serviceable product location.

Appears only if the product is a service.

Order Date | Read-only field | Displays the order date for the serviceable product.
Appears only if the Service For is Pending Order.
Order Read-only field | Displays the order number for the serviceable
Number product.
Appears only if the Service For is Pending Order.
Order Line | Read-only field | Displays the order line number for the serviceable
Number product.
Appears only if the Service For is Pending Order.
Description | Read-only field | Displays the serviceable product description.
Appears only if the product is a service.
Product Read-only field | Displays the serviceable product part number.
Appears only if the product is a service.
Quantity Read-only field | Displays the serviceable product quantity.
Appears only if the product is a service.
UuOM Read-only field | Displays the serviceable product UOM.
Appears only if the product is a service.
Serial Read-only field | Displays the serial number for the serviceable
Number product.
Appears only if Service For is Installed Base.
System Read-only field | Displays the system for the serviceable product.
Appears only if Service For is Installed Base.
Installed At | Read-only field | Displays the Installed At Address for the serviceable
Address product.

Appears only if Service For is Installed Base.
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Table A-30 Product Details Page Components

Component

Type

Description

Order Date

Read-only field

Displays the order date for the serviceable product.
Appears only if Service For is Installed Base.

Service Details

Section

Displays the service details.

Appears only if the product is a service.

Duration Read-only field | Displays the service duration.
Appears only if the product is a service.
Period Read-only field | Displays the service period.
Appears only if the product is a service.
Start Date Read-only field | Displays the service start date.
Appears only if the product is a service.
Close Button Closes the pop-up window.
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A.31 Charges Details

The Charges Details page displays the line level charges for the product.

The following table lists and describes the user interface components on the
Charges Details page. For more information on header level fields, see Section A.1,
"Common Elements".

Table A-31 Charges Details Page Components

Component Type Description

Name Read-only field Displays the name of the Freight and Special Charge
modifier.

Type Read-only field Displays a concatenation of the type and sub type for
the Freight and Special Charge modifier.

Amount Read-only field Displays the amount of the modifier.

Total Read-only field Displays the total of all modifiers applied to the Line.

Close Button Closes the Charges Details page and returns the user to
the Quote Lines page.

A.32 Pricing Details Page
The Pricing Details page displays all adjustments for a line.

The following table lists and describes the user interface components on the Pricing
Details page. For more information on header level fields, see Section A.1,
"Common Elements".

Table A-32 Pricing Details Page Components

Component Type Description
Pricing Section Displays all pricing adjustments applied to the line.
Adjustments
Name Read-only field Displays the modifier name for the pricing adjustment.
Level Read-only field Displays the level at which the modifier is applied.
Type Read-only field Displays the modifier type.
Amount Read-only field Displays the adjustment amount.
Percent Read-only field Displays the adjustment percent.
Total Read-only field Displays the total of all adjustments.
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Table A-32 Pricing Details Page Components

Component

Type

Description

Close

Button

Closes the page and returns you to the Lines page.

A.33 Specify Service Reference

Use the Specify Service Reference page to add a service to a previous purchase.

The following table lists and describes the user interface components on the Specify
Service Reference page.

Table A-33 Specify Service Reference Page Components

Component Type Description
Source Section Displays the source for the search.
Add Drop-down Specify the source that you want to apply the service to.
Serviceto  menu Changing the selection automatically refreshes the page
Product In to the Installed Base or Pending Orders search screen.
Values are Installed Base or Pending Order.
Search Section Displays the search parameters.
Category ~ Drop-down Select the product category by which to search. Values
menu are null and all product categories for the functional
area Order Entry.
Appears only if the Source is Installed Base.
Order Text field Enter the order number by which to search.
Number
Order Date Text Restricts search by sales order date range. Select the
From box/Calendar  starting date for the order date range.
icon
Order Date Text Select the end date for the order date range.
To box/Calendar
icon
Product Text box Enter the inventory product number.
Description Text box Enter the product description.
Serial Text box Enter the Installed Base serial number.
Number

Appears only if the Source is Installed Base.
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Table A-33 Specify Service Reference Page Components

Component Type Description

System Text box Enter the Installed Base system name.

Appears only if the Source is Installed Base.

Installed At Text box Enter the Installed at City by which to search.
City Appear only if the Source is Installed Base.
Installed At Drop-down Select the Installed at Country by which to search.
Country menu Appear only if the Source is Installed Base.
Attribute Text box Select the attribute name by which to search.
Name Appear only if the Source is Installed Base
Go Button Accesses the Search and Select: Extended Attributes
page.
Attribute Text box Enter an attribute value by which to search.
Value Appear only if the Source is Installed Base
Instance Text box Enter an Instance name by which to search.
Number Appear only if the Source is Installed Base
Go Button Executes the search.
Results Section Displays results of the search if Installed Base is the
source.
Select Prompt Appears only if search has been executed and there is at
Product least one result line.
and...
Add Button Accesses the Add Service page.
Service
Select Radio Button Identifies row to be selected.

Product Read-only field Displays the product number.

Description Hyperlink Linked description accesses the Installed Base Product
Details window.

UuOM Read-only field Displays the UOM.

Quantity Read-only field Displays the quantity.

Serial Read-only field Displays the serial number.

Number

System Read-only field Displays the system name.
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Table A-33 Specify Service Reference Page Components

Component Type Description
Installed At Read-only field Displays the installed at address.
Address
Results Section Displays results of the search if Pending Orders is the
source.
Select Prompt Appears only if search has been executed and there is at
Product least one result line.
and...
Add Button Accesses the Add Service page.
Service
Select Radio button Identifies selected row.

Order Date Read-only field Displays the order date for the order containing the
serviceable product.

Order Read-only field Displays the order number for the order containing the
Number serviceable product.

Order Line Read-only field Displays the order line number for the serviceable
Number product.

Product Read-only field Displays the serviceable product part number.

Description Read-only field Displays the serviceable product description.
UuOM Read-only field Displays the serviceable product UOM.

Quantity Read-only field Displays the serviceable product quantity.

Cancel Button Cancels the process and returns you to the Lines page.
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A.34 Search and Select: Product

The following table lists and describes the user interface components on the Search
and Select: Product page.

Table A-34 Search and Select: Product Page Components

Component Type Description
Source Section Displays the source of the search.
Search In Drop-down Choose to search the product catalog for products to
menu add to the quote or search the Installed Base for

trade-ins. Selecting Installed Base accesses the
Search and Select: Installed Base page.

Cancel Button See Section A.1, "Common Elements"
Select and Add | Button Adds selected products to the quote and returns the
More user to the Search and Select: Product page,
allowing the user to search for more products.
Select Button Adds the selected product(s) to the quote and
returns to the Lines page.
Search Section Section listing search parameters
Product Drop-down User selects product category. Values are All
menu Categories (Default) and all categories in the
category set defined for the functional area Order
Entry.
Text field Text field Enter product name or partial value before selecting
Go to execute the search.
Go Button See Section A.1, "Common Elements"
Results Section Section displaying search results
Previous Read-only See Section A.1, "Common Elements"
field/Hyperlink
Next Read-only See Section A.1, "Common Elements"
field/Hyperlink
Select Checkbox Identifies the record to be selected.
Product Read-only field | Displays product number.

Description | Read-only field | Displays product description.

UOM Read-only field | Displays unit of measurement.
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Table A-34 Search and Select: Product Page Components

Component Type Description
Line Price Drop-down User selects price list. Values are Null (Default), and
List menu all valid price lists for the quote’s currency.

Disappears if ASO: Price List Override is set to Yes
at the appropriate level.

A.35 Search and Select: Installed Base Product

The following table lists and describes the user interface components on the Search
and Select: Installed Base page.

Table A-35 Search and Select: Installed Base Page Components

Component Type Description
Source Section Displays the source of the search.
Search In Drop-down Choose to search the product catalog for products
menu to add to the quote or search the Installed Base for
trade-ins. Selecting Product Catalog accesses the
Search and Select: Product page.
Cancel Button See Section A.1, "Common Elements"
Select and Add Button Adds selected products to the quote and returns
More the user to the Search and Select: Product page,
allowing the user to search for more products.
Select Button Adds the selected product(s) to the quote and
returns to the Lines page.
Search Section Section listing search parameters
Action Section Displays the current action.
Search for Read-only field | Prompt
Product to:
Basic Information | Section Displays basic search criteria.
Category Drop-down User selects product category. Values are All
menu Categories (Default) and all products in the
category set defined for the functional area Order
Entry.
Order Text field Enter the order number by which to search.
Number
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Table A-35 Search and Select: Installed Base Page Components

Component Type Description

Order Date Text Enter the order start date.

From field/Calendar
icon

Order Date To | Text Enter the order ending date.
field /Calendar
icon

Product Text field Enter the product part number.

Description Text field Enter the product description.

Serial Text field Enter the product serial number.

Number

System Text field Enter the system name.

Installed At Text field Enter the installed at city by which to search.

City

Installed At Drop-down Select the installed at country by which to search.

Country menu

Attribute Text field Enter an attribute by which to search.

Name

Go Button Accesses the Search and Select: Extended

Attributes page.

Attribute Text field Enter the attribute value by which to search.

Value

Instance Text field Enter the instance number by which to search.

Number

Go Button Executes search.

Results Section Section displaying search results

Previous Read-only See Section A.1, "Common Elements"
field/Hyperlink

Next Read-only See Section A.1, "Common Elements"
field/Hyperlink

Select Checkbox Identifies the record to be selected.

Product Read-only field | Displays product number.

Description Read-only field | Displays product description.
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Table A-35 Search and Select: Installed Base Page Components

Component Type Description

UOM Read-only field | Displays unit of measurement.

Quantity Read-only field | Displays the product quantity.

Serial Read-only field | Displays the product serial number.

Number

System Read-only field | Displays the system name.

Installed At Read-only field | Displays the installed at address.

Address

View Linked icon Accesses the View Relationships page. Displayed

Relationships only if the product is a configured Model product.

Line Price List | Drop-down User selects price list. Values are Null (Default),

menu and all valid price lists for the quote’s currency.

Disappears if ASO: Price List Override is set to
Yes at the appropriate level.

A.36 Search and Select: Extended Attributes

Access the Search and Select: Extended Attributes page from the Go button located
next to the Attributes field on the Search and Select: Installed Base Product page.

The following table lists and describes the user interface components on the Search

and Select: Extended Attributes page.

Table A-36 Search and Select: Extended Attributes Page Components

Component Type Description
Search Section Displays search criteria for extended attributes.
Attribute  Text field Enter an attribute name by which to search.
Name
Go Button Executed the search.
Results Section Displays results of the search.
Previous Hyperlink Accesses previous page of display.
Next Hyperlink Advances to next page of display.
Select Radio button Indicates selected attribute.
Name Read-only field Displays attribute name.
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Table A-36 Search and Select: Extended Attributes Page Components

Component Type Description
Attribute Read-only field Displays service that attribute is associated with.
Of
Cancel Button Cancels the selection and returns user to the Search and
Select: Installed Base Products page.
Select Button Adds the selected attribute to the Installed Base

product search as part of the search criteria.

A.37 Installed Base Relationships Page

The following table lists and describes the user interface components on the
Installed Base Relationships page.

Table A-37 Installed Base Relationships Page Components

Component Type Description

Product Read-only field Displays the model product part number.
Description Read-only field Displays the model product description.
uoOM Read-only field Displays the model product UOM.
Quantity Read-only field Displays the model product quantity.

Serial Number

Read-only field

Displays the model product serial number.

System Read-only field Displays the system name.
Search Section Displays the search criteria.
Relationshi Read-only field Displays the relationship type of component. Children
p Type in a configuration have this relationship with parent
component.
Results Section Displays the search results.
Product Read-only field Displays the component part number.
Description Hyperlink Linked description accesses the Installed Base Product
Details window.
UuOM Read-only field Displays the component UOM.
Quantity Read-only field Displays the component quantity.
Serial Read-only field Displays the component’s serial number.
Number
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Table A-37 Installed Base Relationships Page Components

Component Type Description
System Read-only field Displays the system name.
Installed At Read-only field Displays the component’s installed at address.
Address

Done Button Returns user to the Search and Select: Installed Base

page.

A.38 Installed Base Product Details

The following table lists and describes the user interface components on the
Installed Base Product Details window.

Table A-38 Installed Base Product Details Window Components

Component Type Description
Product Section Displays product information.
Information
Product Read-only field Displays the part number.
Description Hyperlink Linked description accesses the Installed Base Product
Details window.
UOM Read-only field Displays the UOM.
Quantity Read-only field Displays the quantity.
Serial Read-only field Displays the serial number.
Number
Instance Read-only field Displays the instance number.
Number
System Read-only field Displays the system name.
Order Read-only field Displays the order number that contains the product.
Number
Order Date Read-only field Displays the order date.
Installed At Read-only field Displays the installed at address.
Address
Extended Section Displays all extended attributes with values for the
Attributes product.
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Table A-38 Installed Base Product Details Window Components

Component Type Description

Close Button Closes the page and returns the user to the Search and
Select: Installed Base page.

A.39 Availability Information Page
Use the Availability Information page to check on product availability.

The table below lists and describes the user interface components on the
Availability Information page. For more information on header level fields, see
Section A.1, "Common Elements".

Table A-39 Auvailability Information Page Components

Component Type Description
Done Button Accesses the Lines page.
Check Button Accesses availability information.
Availability
Product Read-only field | Displays product number.
Description Read-only field | Displays product description.
UuoOM Read-only field | Displays unit of measurement.
Quantity Read-only field | Displays order quantity.
Need By Text-field / Select date product needed by.
Calendar tool

Availability Read-only field | Displays availability information.
Information

See Also:

= Section 10.7, "Checking Product Availability"

A-64 Product Title/BookTitle as a Variable



Select: Service Page

A.40 Select: Service Page

Use the Select: Service page to select services for serviceable products in the current

quote, in a pending order, or in the customer’s Installed Base.

The following table lists and describes the user interface components on the Select:
Service Page. For more information on header level fields, see Section A.1,
"Common Elements".

Table A-40 Select Service Page Components

Component Type Description
Cancel Button See Section A.1, "Common Elements"
Select Button See Section A.1, "Common Elements"
Service For Section Section listing serviceable product information.
Service For | Read-only field | Displays the source of the serviceable product.
Values are: Current Quote, Installed Base, or
Pending Order.
Order Date | Read-only field | Displays the order date.
Appears only if the Service For is Pending Order.
Order Read-only field | Displays the order number.
Number Appears only if the Service For is Pending Order.
Order Line | Read-only field | Displays the order line number for the serviceable
Number product. Appears only if the Service For is Pending
Order.
Product Read-only field | Displays the serviceable product number.
Description | Read-only field | Displays the serviceable product description.
UuoOM Read-only field | Displays the serviceable product UOM.
Quantity Read-only field | Displays the serviceable product quantity.
Serial Read-only field | Displays the serviceable product serial number.
Number Appears only if the Service For is Installed Base.
System Read-only field | Displays the installed base system.
Appears only if the Service For is Installed Base.
Installed At | Read-only field | Displays the installed at address.
Address Appears only if the Service For is Installed Base.
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Table A-40 Select Service Page Components

Component Type Description
Order Date | Read-only field | Displays the order date.
Appears only if the Service For is Installed Base.
Selected Section Section listing information for service(s) associated
Service(s) with the serviceable product.
Product Read-only field | Displays service number.
Description | Read-only field | Displays service description.
Start Date Read-only field | Displays service start date.
Duration Read-only field | Displays service duration.
Period Read-only field | Displays duration period.
Included Read-only field | Displays a checkmark if the service is included in
the price of the serviceable product.
Available Section Section listing information for service in addition to
Service(s) initial price.
Select Checkbox Identifies line to be selected.
Product Read-only field | Displays service product number.
Description | Read-only field | Displays service description.
Start Date Text Select start date for service.
field/Calendar
tool.
Duration Text field Enter duration period for service.
Period Drop-down Optionally, change the period.
menu
Line Price Drop-down Select a price list for the service. Optional field.
List menu.
See Also:

= Section 10.3, "Adding Services to Quotes"
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A.41 Modify Service Page

Use the Modify Service page to modify services.

The following table lists and describes the user interface components on the Modify

Service page.

Table A-41 Modify Service Page Components
Component Type Description
Revert Button See Section A.1, "Common Elements"
Apply Button See Section A.1, "Common Elements"
Service For Section Section listing serviceable product information.

Service For

Read-only field

Displays the source (location of the serviceable
product). Can be Installed Base, Pending Order, or
Current Quote.

Order Date | Read-only field | Displays the order date for the order containing the

serviceable product.

Appears only if the source is Pending Order.
Order Read-only field | Displays the order number for the order containing
Number the serviceable product.

Appears only if the source is Pending Order.
Order Line | Read-only field | Displays the order line number for the serviceable
Number product.

Appears only if the source is Pending Order.
Product Read-only field | Displays serviceable product part number.
Description | Read-only field | Displays serviceable product description.
UOM Read-only field | Displays the serviceable product UOM.
Quantity Read-only field | Displays the serviceable product quantity.
Serial Read-only field | Displays the serviceable product serial number.
Number Appears only if the source is Installed Base.
System Read-only field | Displays the Installed Base system name.

Appears only if the source is Installed Base
Installed At | Read-only field | Displays the address the serviceable product is
Address installed at.

Appears only if the source is Installed Base
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Table A-41 Modify Service Page Components
Component Type Description
Order Date | Read-only field | Displays the ordered date of the serviceable

product.
Appears only if the source is Installed Base

Service Details

Section

Section listing service details.

Product Read-only field | Service number.

Description | Read-only field | Service description.

Start Date Text Select new start date for service. Optional.
field/Calendar
tool

Duration Text field Enter new duration for service.

Period Drop-down Select new period for service.
menu

See Also:

= Section 10.3, "Adding Services to Quotes"

= Section 10.3.3, "Modifying a Service"

A.42 Search and Select: Related Products Page

Use the Search and Select: Related Products page to add related products from the
Search and Select: Related Products page.

The following table describes the user interface components on the Search and
Select: Related Products page. For more information on header level fields, see

Section A.1, "Common Elements".

Table A—42 Search and Select: Related Products Page Components

Component Type Description

Product Read-only field | Displays the part number for the product to which
you want to add related products.

Description Read-only field | Displays the description for the product.

Cancel Button Cancels the selection and returns to the Line page.
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Table A-42 Search and Select: Related Products Page Components

Component Type Description

Select Button Adds selected product to the quote.

Appears only if there are available related products
for the existing product.

Search Section Section displaying search parameters.
Relationship | Drop-down Select relationship. Values are All (Default) and all
menu product relationships defined during the
installation.
Go Button Executes the search.
Results Section Section displaying search results.
Previous Hyperlink See Section A.1, "Common Elements"
Next Hyperlink See Section A.1, "Common Elements"
Select Checkbox Identifies the line to be selected.

Relationship | Read-only field | Displays the relationship type.

Product Read-only field | Display the product number.

Description | Read-only field | Displays the product description/name.

UuoOM Read-only field | Displays the unit of measurement.

Line Price Drop-down Select value from list. Values are Null (Default) and
List menu all valid price lists for the quote’s currency.

Disappears if ASO: Price List Override is set to No
at the appropriate level.

See Also:
= Section 10.6, "Adding Related Product"
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A.43 Adjust Pricing Page

Use the Adjust Pricing page to modify pricing information.

The following table describes the user interface components on the Adjust Pricing
page. For more information on header level fields, see Section A.1, "Common

Elements".

Table A-43 Adjust Pricing Page Components

Component Type Description

Revert Button See Section A.1, "Common Elements"

Apply Button See Section A.1, "Common Elements"

Summary Section Section listing Pricing summary information.
Line Drop-down Select line category code from list. Values are
Category menu/Read-only | Order (Default) and Return.

Code field Becomes read-only if ASO: Enable Line Type is
set to No at the appropriate level and/or the
product is a component of a configured product.

Line Type Drop-down Select line type from list. Values are all line types

menu of the line category code.

Header Price

Read-only field

Displays header level price list.

List
Line Price Drop-down Select line prices list from list. Values are Null
List menu/Read-only | (Default) and all price lists for the quote currency.
field Becomes read-only if ASO: Price List Override is
set to No at the appropriate level.
Agreement Read-only field Displays the agreement if an agreement is
available for the line.
Commitment | Read-only field Displays the commitment if a commitment is
available for the line.
UuoOM Drop-down Select a UOM for the product. Displays all valid
menu UOMs for the selected product. If the selected
UOM is not valid for the selected Price List, an
error appears.
Promotion Codes | Section Section listing Promotion Code details for

selection.
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Table A-43 Adjust Pricing Page Components

Component Type Description
Add Button Accesses the Search and Select: Promotion Code
Promotion page.
Code
Select Instructional text | Outlines action to be taken in this section.
promotion
code and...
Delete Button See Section A.1, "Common Elements"
Select Checkbox Identifies the line to be selected.
Name Read-only field Displays Promotion Code name
Code Read-only field Displays Promotion Code
Line Read-only Displays the individual list line number of the
field specific promotion. This value is defined in
Pricing
Tax Details Section Section displaying tax information
Tax Code Read-only field Tax code for the quote line.
Rate Read-only field Tax rate for the tax code and quote line.
Amount Read-only field Tax amount for the tax code and quote line.
Total Read-only field Displays the total taxes for the quote line.
See Also:

= Section 7.1.3, "Pricing Adjustments"
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A.44 Assign Sales Credits Page
Use the Assign Sales Credit page to assign sales credit.

If Sales Credit is not specified for a Line, the Sales Credit specified for the Header is
used.

The following table describes the user interface components on the Assign Sales
Credit page. For more information on header level fields, see Section A.1, "Common
Elements".

Table A-44 Assign Sales Credit Page Components

Component Type Description
Revert Button See Section A.1, "Common Elements"
Apply Button See Section A.1, "Common Elements"
Revenue Section Section listing revenue credit fields.
Credits

Add Button Accesses the Search and Select: Person page.

Person

Select Instructional Explains action to be taken.

person text

and...

Delete Button Deletes selected row.

Select Checkbox Identifies the row to be selected

Name Read-only field | Displays resource name.

Catego Read-only field | Displays resource category.
gory y play gory.

Sales Drop-down Select sales group. Values are Null and all sales groups
Group menu that the resource belongs to.
Credit Drop-down Select credit type. Values are all revenue credit types.
Type menu
Credit Text field Enter credit percentage amount.
Percent
Total Read-only field | Displays sales credit total. Must equal 100%.
Non-Revenue | Section Section listing non-revenue credit fields.
Credits
Add Button Accesses the Search and Select: Person page.
Person
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Table A-44 Assign Sales Credit Page Components

Component Type Description

Select Instructional Explains the action to be taken.
person Text
and...
Delete Button Deletes selected row.
Select Checkbox Identifies the row to be selected
Name Read-only field | Displays resource name.
Category | Read-only field | Displays resource category.
Sales Drop-down Select sales group. Values are Null and all sales groups
Group menu that the resource belongs to.
Credit Drop-down Select credit type. Values are all non-revenue credit
Type menu types.
Credit Text field Enter credit percentage amount.
Percent
Total Read-only field | Displays credit total.

See Also:

= Section 10.8, "Allocating Sales Credits"

A.45 Configure Page

Use this page to configure model products.

The following table describes the user interface components on the Configure page.

Table A-45 Configure Page Components

Component Type Description
Summary Button Accesses Configuration summary and total price.
Done Button Saves configuration.
Cancel Button Cancels configuration.
Configuration | Button Accesses configuration page. Appears in the Summary
page.
See Also:
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= Section 10.4, "Configuring Products"

A.46 Modify Shipping and Billing Page

Use the Modify Shipping and Billing page to modify shipping and billing

information.

If the quote is not the highest version and/or you do not have update access,
and/or the status is Read-only:

Apply and Revert buttons disappear, as does the instructional text attached to them.

All text fields, LOVs, and drop-down menus become Read-only fields.

If ASO: Enable OSO Integration is set to Yes at the appropriate level, customer,
account, contact, and address field become hyperlinks.

The following table lists and describes the user interface elements on the Modify
Shipping and Billing page. For more information on header level fields, see

Section A.1, "Common Elements".

Table A-46 Modify Shipping and Billing Page Components

Component Type Description

Revert Button See Section A.1, "Common Elements"

Apply Button See Section A.1, "Common Elements"

Addresses Section Section listing address fields.
Shipping Column Lists shipping address fields.
Billing Column Section listing billing field and information.
Customer LOV text field Enter customer name. Accesses the Search and Select:
Name Person page.
Account LOV text field Enter account number. Accesses the Search and
Number Select: Customer page.
Contact LOV text field | Enter contact name. Accesses the Search and Select:
Name Customer page.
Address LOV text field | Enter address. Clicking Go accesses the Search and

Select: Customer page.

Shipping Section Section listing shipping fields and information.
Shipping Drop-down Select shipping method. Values are Null (default) and
Method menu all shipping methods.
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Table A-46 Modify Shipping and Billing Page Components

Component Type Description

Requested Text Select requested delivery date.
Delivery field/Calendar
Date tool.
Shipping Text field Enter shipping instructions.
Instructions
Packing Text field Enter packing instructions.
Instructions

See Also:

= Section 9.3, "Entering Shipping and Billing Information"

A.47 Split Line Page

Use the Split Line page to specify line level shipping and to split lines.

The following table describes the user interface components on the Split Line page.
For more information on header level fields, see Section A.1, "Common Elements".

Table A-47 Split Line Page Components

Component Type Description

Revert Button See Section A.1, "Common Elements"

Apply Button See Section A.1, "Common Elements"

Product Read-only field | Displays the product number

Description Read-only field | Displays product description.

UOM Read-only field | Displays unit of measurement.

Quantity Read-only field | Displays quantity.

Split Text fields Enter split quantities.

Add Rows | Hyperlink Adds Split rows, three at a time.

Go Button Add extra fields in Split columns.

See Also:

= Section 10.10, "Splitting Lines"
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A.48 Pricing Page

Use the Pricing page to access and edit the following types of information pricing
information, including price lists, pricing agreements, currency, promotion code, tax
information, and pricing date.

The following table lists and describes the user interface components on the Pricing
page. For more information on header level fields, see Section A.1, "Common
Elements".

Table A-48 Pricing Page Components

Component Type Description
Revert Button See Section A.1, "Common Elements"
Apply Button See Section A.1, "Common Elements"
Summary Section Section listing pricing date information.
Pricing Read-only field Displays the date and time of the last pricing
Updated request.
On
Tax Read-only field Displays the date and time of the last tax
Updated calculation.
On
Pricing Text Select a date in the future or past.
Date fleld/ Calendar This date is used for subsequent pricing calls.
icon tool
Promotion Section Section listing promotion code information.
Codes
Add Button Accesses the Search and Select: Promotion Codes
Promotion page.
Codes
Select Instructional Text | Explains action to be taken
Promotion
code and...
Delete Button Deletes selected line.
Select Checkbox Identifies the row(s) to be selected.
Name Read-only field Displays promotion code name.
Code Read-only field Displays promotion code.
Line Read-only field Displays the individual list line number of the

specific promotion. This value is defined in Pricing.
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Table A-48 Pricing Page Components

Component Type Description

Tax Details Section Section listing tax information.
Tax Drop-down menu | Select from list. Values are Standard (Default),
Handling Exempt, and Require.
Exemption | Drop-down menu | Select reason for exemption from list. Values are all
Reason exemption reasons.
Exemption | Text field Enter exemption number.
Number
Tax Code | Read-only field Displays tax code.
Amount Read-only field Displays total tax amount for the quote.
Total Read-only field Displays the total of all tax codes applied to the

quote.
See Also:

= Section 7.1.3, "Pricing Adjustments"

s Section 7.1.1, "Price Lists"

= Section 7.1.4, "Manual Adjustments"

= Section 7.6, "Applying Pricing Agreements"

A.49 Search and Select: Promotion Code Page

The following table describes the user interface components on the Search and
Select: Promotion Code page.

Table A-49 Search and Select: Promotion Code Page Components

Component Type Description
Cancel Button See Section A.1, "Common Elements"
Select Button See Section A.1, "Common Elements"
Search Section Section listing search parameters.
Promotion | Drop-down Values in drop-down menu are Name (Default) and
menu/LOV Code.
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Table A-49 Search and Select: Promotion Code Page Components

Component Type Description

Go Button Executes search based on Promotion value and values
entered in LOV text field.

Results Section Section displaying search results information.
Previous Hyperlink See Section A.1, "Common Elements"
Next Hyperlink See Section A.1, "Common Elements"
Select Checkbox Identifies the line to be selected.
Name Read-only field | Displays promotion code name.
Code Read-only field | Displays the promotion code.

See Also:

= Section 7.2, "Applying Header Promotion Codes"

A.50 Shipping and Billing Page

The following table describes the user interface components on the Shipping and
Billing page. For more information on header level fields, see Section A.1, "Common

Elements".

Table A-50 Shipping and Billing Page Components

Component Type Description
Revert Button See Section A.1, "Common Elements"
Apply Button See Section A.1, "Common Elements"
Addresses Section Section listing address details.
Copy Button Select to copy the Quote To customer, contact and
address information.
Shipping Column Displays shipping information.
Billing Column Displays billing information.
Customer Text field Searches/displays the selected value from the
Name Search and Select: Customer page.
Defaults from the Quote-To customer.
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Table A-50 Shipping and Billing Page Components

Component Type Description
Account Text field Searches/displays the selected value from the
Number Search and Select: Customer page.
Defaults from the designated Quote To customer
account, if one exists.
Contact Text field Searches/displays the selected value from the

Search and Select: Customer page.
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Table A-50 Shipping and Billing Page Components

Component

Type

Description

Address

Text field

Displays shipping or billing address. Optionally,
change the defaulted addresses.

The Ship-To and Bill-To Addresses are defaulted
at the time of quote creation. Based on the
following conditions, the application searches the
following sources and accepts the first address it
finds.

If Ship-To Customer is an Organization and
Ship-To Contact is specified:

»  Active Primary Ship-To address type usage
for Ship-To Contact

= Identifying address for Ship-To Contact

»  Active Primary Ship-To address type usage
for Ship-To Customer

= Identifying address for Ship-To Customer

If Ship-To Customer is an Organization and no
Ship-To Contact is specified:

»  Active Primary Ship-To address type usage
for Ship-To Customer

= Identifying address for Ship-To Customer

If Bill-To Customer is an Organization and the
Bill-To Contact is specified:

= Active Primary Bill-To address type usage for
Bill-To Contact

= Identifying address for Bill-To Contact

»  Active Primary Bill-To address type usage for
Bill-To Customer

= Identifying address for Bill-To Customer

If the Bill-To Customer is an Organization and no
Bill-To Contact is specified:

»  Active Primary Bill-To address type usage for
Bill-To Customer

= Identifying address for Bill-To Customer

Shipping

Section

Section listing shipping, delivery, and packing
information.
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Table A-50 Shipping and Billing Page Components

Component Type Description

Shipping Drop-down menu | Select shipping method from list. Values are Null

Method (Default) and all shipping methods for the
product validation organization tied to the
quote’s operating unit.

Requested | Text Selects/displays requested delivery date.

Delivery field /Calendar

Date icon

Shipping Text field Enter shipping instructions.

Instructions

Packing Text field Enter packing instructions.

Instructions

Payment Section Section listing payment information.

Payment Drop-down menu | Defaulted at the time of order creation (unless

Terms quote is created from an opportunity) based on:
= Header-level agreement
s Quote-To Customer Account
Optionally, select a different payment term.

Payment Drop-down menu | Select from list of types. Values are Null (Default)

Type and all. Check Number is mandatory if Payment
Type is Check. Credit Card details are mandatory
if Payment Type is Credit Card.

PO Number | Text field Enter purchase order number.

Check Text field Enter check number.

Number

Credit Card | Drop-down menu | Select credit card type from list. Values are all

Type credit card types.

Credit Card | Text field Enter credit card number.

Number

Cardholder | Text field Enter cardholder number.

Name

Credit Card | Text Enter expiration date.

Expiration | field/Calendar tool

See Also:
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A.51 Sales Team Page

= Section 9.3, "Entering Shipping and Billing Information"

The following table lists and describes the user interface components on the Sales
Team page. For more information on header level fields, see Section A.1, "Common

Elements".

Table A-51 Sales Team Page Components

Component Type Description

Revert Button See Section A.1, "Common Elements"

Add Person Button Accesses the Search and Select: Person page.

Apply Button See Section A.1, "Common Elements"

Select person Instructional Explains action to be taken.

and... Text

Delete Button Deletes selected line.

Select Checkbox Identifies the line to be selected.
Disabled if the member is the Primary Sales Agent.

Name Read-only field | Displays sales team member name

Job Title Read-only field | Displays sales team member’s title

Sales Group Read-only field | Displays sales team member’s group.

Phone Read-only field | Displays sales team member’s phone number.

Email Read-only field | Displays sales team member’s email address.

Full Access Checkbox Determines if the sales team member has Update or
View Only access to the quote.

Keep Checkbox Not supported in this release.
Determines if the sales team member can be replaced
by automatic territory manager re-assignment.

Primary Checkbox Indicates the main sales team member assigned to the
quote. Only checked for one member of the sales team.

See Also:

= Section 15.2, "Adding a Resource to the Quote Sales Team"
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A.52 Sales Credit Page

The following table describes the user interface components on the Sales Credit
page. For more information on header level fields, see Section A.1, "Common

Elements".

Table A-52 Sales Credit Page Components

Component Type Description
Revenue Section Section listing revenue credits information.
Credits
Add Button Accesses the Search and Select: Person page.
Person
Select Instructional Explains action to be taken.
person Text
and...
Delete Button Deletes selected row.
Select Checkbox Identifies the line to be selected.
Name Read-only field | Displays Resource name.
Category | Read-only field | Displays Resource Category.
Sales Drop-down User picks sales group. Values are Null and all sales
Group menu group that the resource belongs to.
Credit Drop-down Select credit type. Values are all revenue credit types.
Type menu
Credit Text field Enter credit percentage.
Percent
Total Read-only field | Displays total.
Non-Revenue | Section Section listing non-revenue credits.
Credits
Add Button Accesses the Search and Select: Person page.
Person
Select Instructional Identifies action to be taken after selecting person.
person text
and...
Delete Button Deletes selected row.
Select Checkbox Identifies the line to be selected.
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Table A-52 Sales Credit Page Components

Component Type Description
Name Read-only field | Displays Resource name.
Category | Read-only field | Displays Resource Category:.
Sales Drop-down User picks sales group. Values are Null and all sales
Group menu group that the resource belongs to.
Credit Drop-down Select credit type. Values are all non-revenue credit
Type menu types.
Credit Text field Enter credit percentage.
Percent

Revert Button See Section A.1, "Common Elements"

Apply Button See Section A.1, "Common Elements"

See Also:

= Section 10.8, "Allocating Sales Credits"

A.53 Proposals Page

The Proposals page displays a summary of the proposals that exist for the current
quote. You can also initiate the proposal creation process from this page.

The following table lists and describes the user interface components on the
Proposals page. For more information on header level fields, see Section A.1,
"Common Elements".

Table A-53 Proposals Page Components

Component Type Description

Create Proposal Button Accesses Oracle Proposals, where you can create new
proposals.

Name Hyperlink Displays the Proposal name

Description Read-only field Displays the proposal description.

Owner Read-only field Displays the owner of the proposal. Defaults to the
logged in user.

Due Date Read-only field Displays the due date for the proposal.
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Table A-53 Proposals Page Components

Component Type Description
Status Read-only field Displays the status of the proposal. Possible values are
Draft and Final.

A.54 Approvals Page

Use the Approvals page to:

= View approvals required for a certain quote.

» Initiate the approval process.

= View the progress of the approval process.

= Cancel the approval process.

= View the results of all submissions for approval.

The following table lists and describes the user interface components on the
Approvals page. For more information on header level fields, see Section A.1,
"Common Elements".

Table A-54 Approvals Page Components

Component

Type

Description

Initiate
Approval

Button

Accesses the Initiate Approval page. Only appears if
there is a status transition from the current status to
Approval Pending.

Disappears if:

= Quote is in Approval Pending status, OR

= User does not have update access to the quote, OR
= Not the highest version of the quote, OR

s Quote is in Order Submitted status, OR

= Quote has been submitted for batch pricing.

Cancel
Approval
Process

Button

Cancels the approval process.
Disappears if:
Quote is not in Approval Pending status

User does not have update access to the quote

Not the highest version of the quote
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Table A-54 Approvals Page Components

Component Type Description

Result Hyperlink Linked text displays the result of the approval process.
Accesses the Approval Detail page.

Requester Read-only field | Name of initiator of approval process.

Quote Version

Read-only field

Quote version for the approval.

Start Date Read-only field | Start date (including time stamp) of the approval.
End Date Read-only field | End date (including time stamp) of the approval. Field
should be blank if approval process not complete.
See Also:

= Section 13.1, "Overview of Approvals"
= Section 13.2, "Initiating an Approval"
= Section 13.5, "Approving a Quote"

A.55 Initiate Approval Page

The following table describes the user interface components on the Initiate
Approval page. For more information on header level fields, see Section A.1,
"Common Elements".

Table A-55 Initiate Approval Page Components

Component Type Description

Submit Button Starts the approval process.

Approvers Section Section listing approvers.
Name Read-only field Name of approver.

Rules Section Section listing approval rules.
Rule Read-only field Displays rule description.
Description
Approval Read-only field Displays approval level.

Requestor Text field Enter comments.

Comments
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Table A-55 Initiate Approval Page Components

Component Type Description
Contract Section Section listing contract options. Only appears if
Options ASO: Enable Use Contracts is set to Yes at the
appropriate level.
Non Checkbox Select checkbox if a non-standard contract is
Standard required for this quote.
contract
required for
this quote
Approver List Section Determines which approvers the quote needs
approval from.
Disabled if ASO: Allow Skip Approvers is set to
No.
Obtain Radio button Select to obtain approvals from all names listed in
approvals the Approvers section at the top of the page.
from entire
list of
approvers
Obtain Radio Select the radio button and select a name from
approvals button/Drop-down | the drop-down list. This person will be the first to

from the list
of
approvers
starting
with

menu

receive the approval.

See Also:

Section 13.2, "Initiating an Approval"
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A.56 Approval Detail Page

Use the Approval Detail page to view and modify approval details.

The following table describes the user interface components on the Approval Detail

page. For more information on header level fields, see Section A.1, "Common

Elements".

Table A-56 Approval Detail Page Components

Component Type Description
Done Button Accesses the page containing table of all approval
submissions.

Approvers Section Section listing Approver information
Name Read-only field | Name of approver.
Response Read-only field | Response of approver.
Approver Note icon Icon accesses comments of approver if comments
Comments have been submitted. Otherwise blank.
Notification | Note icon Icon accesses notification history if history has been
Detail submitted. Otherwise blank.

Rules Section Section listing approval rules
Rule Read-only field | Displays rule description.
Description
Approval Read-only field | Displays approval level.

Requester Read-only Displays requester comments.

Comments section

See Also:

= Section 13.3, "Viewing Approval Details"
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A.57 Approver Notification Detail Page

The following table describes the user interface components on the Approver
Notification Detail page.

Table A-57 Approver Notification Detail Page Components

Component Type Description

Sequence Read-only field | Displays sequence.

Name Read-only field | Displays approver name.

Activity Read-only field | Displays action taken by approver.
Date Sent Read-only field | Displays date sent.

Response Date

Read-only field

Displays response date.

Due Date Read-only field | Displays due date.
Status Read-only field | Displays status.
Result Read-only field | Displays result.
Done Button Closes the page and returns the user to Approval
Detail page.
See Also:

= Section 13.5, "Approving a Quote"

A.58 Approver Comments Page

The Approver Comments page shows any comments that the approver has

submitted.

The following table describes the user interface components on the Approver

Comments page.

Table A-58 Approver Comments Page Components

Component Type Description

Approver Section Section listing approver comments.
Coments

Comments field | Read-only Displays approver comments.
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See Also:
= Section 13.5, "Approving a Quote"

A.59 Contracts Page

Use the Contracts page to set up contracts and to view contract information.

The following table lists and describes the user interface components on the
Contracts page. For more information on header level fields, see Section A.1,
"Common Elements".

Table A-59 Contracts Page Components

Component Type Description
Contract Read-only field | Displays contract template name.
Template
Review Terms Hyperlink Links to contract terms and conditions.
and Conditions
Description Read-only field | Displays contract description.
Modifier Read-only field | Displays contract modifiers.
Version Read-only field | Displays contract version number.
Request Button Begins the contract creation process. Only appears if
Contract there is a status transition from the current status to
Creation Contract Pending.
Disappears if:

» A non-standard contract is attached to the
quote OR

= User does not have update access OR
= Not the highest version of the quote, OR
s Quote is in Order Submitted status, OR

= Quote has been submitted for batch pricing.

See Also:

= Section 14.2, "Creating a Contract with Non Default Terms and Conditions"
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A.60 Request Contract Creation Page

Use the Request Contract Creation page to initiate the contract creation process.

The following table lists and describes the user interface components on the
Request Contract Creation page. For more information on header level fields, see
Section A.1, "Common Elements".

Table A-60 Request Contract Creation Page Components

Component Type Description

Submit Button Initiates the contract approval process

Contract Read-only field | Contract template name

Template

Comments Text field Enter comments to be reviewed during contract
authoring. Text field has a 4000 character maximum
limit.

See Also:

= Section 14.2, "Creating a Contract with Non Default Terms and Conditions"

A.61 Contract Details

After initiating the contract creation procedure, the Contract details page is

displayed.

The following table describes the user interface components on the Contract details.
For more information on header level fields, see Section A.1, "Common Elements".

Table A-61 Request Contract Creation Page Two Page Components

Component Type Description
Contract Section Section listing the contract template information.
Template
Information
Contract Read-only field | Displays contract template name.
Template
Description | Read-only field | Displays contract template description.
Modifier Read-only field | Displays contract template modifier.
Version Read-only field | Displays contract template version.
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Contract Details

Table A-61 Request Contract Creation Page Two Page Components

Component Type Description
Contract Section Section listing the contract information.
Information
Contract Read-only field | Displays contract number.
Number
Modifier Read-only field | Displays contract modifier.
Status Read-only field | Displays contract status.
Short Read-only field | Displays short description of contract
Description
Approval Read-only field | Displays contract approval date.
Date
Signature Read-only field | Displays contract signature date.
Date
Termination | Read-only field | Displays contract termination date.
Date
Start Date Read-only field | Displays contract start date.
End Date Read-only field | Displays contract end date.
Description | Read-only field | Displays contract description.
Comments | Read-only field | Displays content entered in Comments field during
creation.
Request Button Requests contract assistance to make changes to an
Contract existing non-standard contract.
Assistance . .
Disappears if:
= Anon-standard contract is not attached to the
quote.
= User does not have update access to the quote
= Not the highest version of the quote
s Quote is in Order Submitted status
= Quote has been submitted for batch processing
See Also:

= Section 14.2, "Creating a Contract with Non Default Terms and Conditions"

A-92 Product Title/BookTitle as a Variable



Tasks Page

A.62 Contract Terms and Conditions Page

The Contract Terms and Conditions page lists the text of the terms and conditions of
the contract. For more information on header level fields, see Section A.1, "Common
Elements".

Table A-62 Contract Terms and Conditions Page Components

Component Type Description

Done Button Accesses the contract summary page.

Contract Terms | Read-only field | List terms and conditions of contract.
and Conditions

See Also:

= Section 14.2, "Creating a Contract with Non Default Terms and Conditions"

A.63 Tasks Page

Use the Tasks page to view, create, or modify tasks.

The following table lists and describes the user interface components on the Tasks
page. For more information on header level fields, see Section A.1, "Common
Elements".

Table A-63 Tasks Page Components

Component Type Description

View Drop-down menu | Select the type of tasks to view.

Date Range Text Select the start date for task date range.
field/Calendar
icon

To Text Select end date for task date range.
field/Calendar
icon

Type Drop-down menu | Select task type to search for.

Priority Drop-down menu | Select priority level to search for.

Status Drop-down menu | Select task status to search for.

Include Private | Checkbox Select this box to include private tasks in the search.
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Table A-63 Tasks Page Components

Component Type Description
Apply Button Executes task search.
Tasks Summary | Section Section listing task summary information.
Update Button Updates task based on changes made
Restore Button Restores task to its original, saved state.
Create Button Accesses the Create Task page
Remove Checkbox Identifies line to be removed.
Number Hyperlink Displays task number. Linked text accesses the Task
Details page.
Name Text field/Note Displays task name. Note icon accesses the Task
icon Details page.
Type Drop-down menu | Use drop-down menu to select a different task type.
Status Drop-down menu | Displays task status.
Priority Drop-down menu | Displays task priority.
Planned Text Enter a different start date for task.
Start Date | field/Calendar
tool/Drop-down
menu
Planned Text Enter a different end date for task.
End Date | field/Calendar
tool/Drop-down
menu
Owner Drop-down menu | Select a different owner type.
Type
Owner LOV Enter a different owner name.
Go Button Accesses the LOV Renderer pop-up window.
See Also:

s Section 16.1, "Overview of Notes, Tasks, and Attachments"

= Section 16.4, "Creating a Task"

= Section 16.5, "Searching for Tasks"

= Section 16.6, "Modifying a Task"
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A.64 Sales Supplement Page

Use the Sales Supplement page to access templates that allow you to capture
additional quote-specific information. For more information on header level fields,
see Section A.1, "Common Elements".

The following table lists and describes the user interface components on the Sales
Supplement page.

Table A-64 Sales Supplement Page Components

Component Type Description

Template Drop-down Select template from list. Page refreshes after template
menu selection, displaying user interface elements based on

selected template.

View Drop-down Displays the section in which to enter information.
menu Lists all sections defined for the selected template.

Go Button Accesses the selected section.

Revert Button See Section A.1, "Common Elements"

Apply Button See Section A.1, "Common Elements"

A.65 Notes Page

Use the Notes page to view, modify, and create Notes.

The following table lists and describes the user interface components on the Notes
page. For more information on header level fields, see Section A.1, "Common

Elements".

Table A-65 Notes Page Components

Component Type Description
Type Drop-down Select note type.
menu
Show Notes for | Text field Enter amount of days for which you want to view
Last...Days notes.
Apply Button Executes note search.
Create Button Accesses the Create Note page.
All Notes Button Accesses the All Notes View page, displaying all

Notes.
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Table A-65 Notes Page Components

Component

Type

Description

Date

Read-only field

Displays Note creation date.

Created By

Read-only field

Displays name of Note creator.

Type

Read-only field

Displays note type.

Status

Read-only field

Displays note status.

Note

Hyperlink

Links to Note Details page.

Text

Read-only field

Displays text of note.

Attachment

Gif

Accesses attached file(s), if any.

See Also:

s Section 16.1, "Overview of Notes, Tasks, and Attachments"

= Section 16.2, "Adding Notes to a Quote"

= Section 16.3, "Searching for Notes"

A.66 Attachments Page

Use the Attachments page to attach files to a quote, and to view attached file

information.

The following table lists and describes the user interface components on the
Attachments page. For more information on header level fields, see Section A.1,
"Common Elements".

Table A-66 Attachments Page Components

Component Type Description

Add Button Accesses the Add Attachments page.
Attachment

Select Instructional Identifies the action to be taken after selecting
attachment text attachment.

and...

Delete Button See Section A.1, "Common Elements"

Select Checkbox Identifies selected line.

Attachment Hyperlink Linked file name opens attached file.
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Table A-66 Attachments Page Components

Component

Type

Description

Created By

Read-only field

Displays user name.

Creation Date

Read-only field

Displays date file was attached to quote.

Description

Read-only field

Displays description of attachment. Defined during the
attach file process.

See Also:

= Section 16.8, "Creating an Attachment"

= Section 16.9, "Viewing an Attachment”

A.67 Add Attachments Page

Use the Add Attachments page to attach and associate files to a quote.

The following table lists and describes the user interface components on the Add
Attachments page. For more information on header level fields, see Section A.1,
"Common Elements".

Table A-67 Add Attachments Page Components

Component Type Description
File Text field Displays file name and path after attached.
Browse Button Accesses the Choose File window. Browse for file.
Description Text field Enter description of file.
Cancel Button See Section A.1, "Common Elements"
Apply Button See Section A.1, "Common Elements"

See Also:

= Section 16.8, "Creating an Attachment"
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A.68 Versions Page

Use the Versions page to view and modify version information. Only the highest
quote version number can be modified. To modify a prior version, save it as a new

version.

The following table lists and describes the user interface components on the
Versions page. For more information on header level fields, see Section A.1,
"Common Elements".

Table A-68 Versions Page Components

Component Type Description

Version Hyperlink Linked text displays version number. Links to quote
Number overview page.

Created By Read-only field | Displays username of person who created the version.

Creation Date

Read-only field

Displays version creation date.

Updated By Read-only field | Displays username of updater.
Update Date Read-only field | Displays update date.
Status Read-only field | Displays quote version status.
Amount Read-only field | Displays quote amount.

See Also:

= Section 3.5, "Creating a New Version of a Quote"
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A.69 Order Details Page

Use the Order Details page to view detailed order information.

The following table lists and describes the user interface components on the Order

Details page.

Table A—69 Order Details Page Components

Component Type Description

Order Number | Read-only field | Displays order number.
Reference Read-only field | Displays reference number.
Number

Web Read-only field | Displays web confirmation number.
Confirmation

Number

PO Number Read-only field | Displays purchase order number.
Customer Read-only field | Displays customer name.

Name

Line Total Read-only field | Displays total amount for line.
Total Charges Read-only field | Displays total charges.

Tax Total Read-only field | Displays tax total.

Order Total Read-only field | Displays total amount for order.
Shipment Read-only field | Displays shipment priority.
Priority

Payment Terms

Read-only field

Displays payment terms.

Freight Terms | Read-only field | Displays freight terms.

Date Ordered Read-only field | Displays order date.

Booked Date Read-only field | Displays booked date.

Order Status Read-only field | Displays order status.

Payment Type | Read-only field | Displays payment type.

Shipments Hyperlink Text links to Shipment Details page.
Shipping Read-only field | Displays shipping address.
Address

Billing Address | Read-only field | Displays billing address.
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Table A-69 Order Details Page Components

Component Type Description

Part Number Read-only field | Displays part number.

Product Read-only field | Displays product.

Qty Ordered Read-only field | Displays quantity ordered.

Unit Selling Read-only field | Displays unit selling price.

Price

Unit Of Read-only field | Displays unit of measurement (UOM).

Measure

Line Total Read-only field | Displays total amount for line equivalent to products

plus tax.

Promise Date

Read-only field

Displays the promise date for the line.

Schedule Ship Read-only field | Displays the scheduled ship date for the line.
Date

Order Line Read-only field | Displays the order line status.

Status

Shipments Hyperlink Text links to Shipment Details page.

Section 18.2, "Placing an Order"
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B

Oracle Quoting Forms User Interface

Reference

This appendix provides a reference to the Oracle Quoting User Interface (UI). Each
component in the Oracle Quoting window has a unique set of behaviors that may

be closely integrated with other fields and with the other Oracle applications with

which Oracle Quoting works.

Oracle Quoting Form

Quote Header Tab > Summary View
Quote Header Tab > Addresses View
Quote Header Tab > Payment, Shipping View
Quote Header Tab > Tax View
Header Actions Menu

Quote Lines Tab > Pricing View
Product Details Form

Quote Lines Tab > Bill To View
Address Details Form

Quote Lines Tab > Ship To View
Quote Line Tab > Shipping View
Quote Lines Tab > Service View

Line Actions Menu

Quote Versions Tab
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s Price Quote Form

= Related Products Form

= Service Reference Form

= Approvals Form

» Initiate Approval Form

= Sales Credits Form

= Available to Promise (ATP) Form

= Contract Detail Information Form

»  Contract Detail Form

= Contract Terms & Conditions Form

= Copy Quote Form

s Price Adjustment Form

= Pricing Request Details Form

s Printing Page

= Promotions/Pricing Attributes Form

= Sales Team Form

= Service Items Form

= Split Lines Form

»  Tax Details Form

»  Publish Form

s Customer History Form

s Quote, Customer Search Form > Quote View
= Quote, Customer Search Form > Organization View
s Quote, Customer Search Form > Person View
= Create Quote From Opportunity Form

s Order Confirmation Form

= Quote Status Setup

= Sales Supplement Setup
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Oracle Quoting Form

B.1 Oracle Quoting Form

Use the main Oracle Quoting form to view and enter basic information about the
customer and the quote.

The following table describes components on the main Oracle Quoting form.

Table B-1 Oracle Quoting Form Components

Component

Type

Description

Quote Name

Text field

View and modify the quote name. The quote name
defaults to Quote for <Quote To Customer> if not
specified during quote creation.

Optional field.

Customer

LOV text field

Search for the name of the Quote To customer. This is
the name of the organization or of the organization’s
representative. The user can enter the name in the text
field or click on the search button to search for the
name. Cannot be changed once the quote is created.

Mandatory field.

Note: If ASO: Auto Account Creation is set to
Always and the party does not have an account then
the account will be created when the quote is created.
If set to As Required, the account will be created at the
time of web publishing, initiation of a non-standard
contract or order conversion.

If set to Place Order an account will be created at
order conversion. If ASO: View Customers Without
Accounts is set to Yes, the LOV shows all parties with
or without accounts. If set to No, the LOV shows only
parties with accounts.

Contact

LOV text field

Search for the Quote to customer contact. The LOV
displays all parties of type Person with a valid party
relationship with the quote-to customer. Disabled if
the Quote To customer type is Person.

Optional field.

Quote Number

Read-only field

Displays the quote number. The quote number is a
concatenation of the quote and version numbers.

Note: If ASO: Automatic Numbering is set to Yes,
Oracle Quoting automatically assigns a number to the

quote. If set to No, the user must enter a value in this
field.
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Oracle Quoting Form

Table B-1 Oracle Quoting Form Components(Cont.)

Component

Type

Description

Account

LOV text field

Select the account number for the quote-to customer.
The LOV displays accounts for the designated
customer if the customer field contains a value.

If the customer field is blank, the Account LOV
displays all active parties with an active account that
matches the account number entered.

The account must be selected if the Quote to customer
has at least one active account.

NOTE: If ASO: Auto Account Creation is set to
Always and the party does not have an account, then
the account will be created when the quote is created.
If set to As Required, the account will be created at
the time of web publishing, initiation of a
non-standard contract and order conversion. If set to
Place Order an account will be created at order
conversion.

Quote Status

LOV text field

Displays the quote status. When a new quote is
created, it is automatically populated by Oracle
Quoting according to the profile option ASO: Default
Quote Status. Use the LOV to change the quote status
manually.

Mandatory field.

Version

Read-only

Displays the quote version.

Pricing Status

Read-only

Displays the status of pricing calculations for the
quote.

Tax Status

Read-only

Displays the status of tax calculations for the quote.

Flexfield

Quote Header

Tab

Displays quote header level information.

Quote Lines

Tab

Displays quote line level information.

Quote Versions

Tab

Displays quote version history.

Actions

Button

Accesses the Actions menu.

Configure

Button

Launches Configurator, where users configure model
products.

Price Quote

Button

Accesses the Price Quote form, where the user
initiates pricing and tax calculations for the lines.
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Quote Header Tab > Summary View

Table B-1 Oracle Quoting Form Components(Cont.)

Component Type Description

Place Order Button Submits the quote to Oracle Order Management. If
submission is successful, user receives a confirmation
number and can track the order in Order
Management. If the submission fails, the user receives
an error message.

See Also:

»  Section 20.1, "Overview of Creating Quotes"

B.2 Quote Header Tab > Summary View

The Quote Header tab > Summary view provides an overview of the criteria
selected for the quote.

The following table describes components on the Quote Header tab > Summary
view.

Table B-2 Quote Header Tab > Summary View Components

Component Type Description
Expires On Read-only field Displays the quote expiration date.
Order Type LOV field Displays the order type.

If you change order type, and there are quote lines
with line category codes that are not valid under the
new order type, the change will not be allowed.

Agreement LOV text field  Displays the agreement pertaining to the Quote To
customer. If Quote To customer is changed,
agreement will be cleared. If agreement is changed,
then it must be reapplied to the quote.
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Quote Header Tab > Summary View

Table B-2 Quote Header Tab > Summary View Components

Component

Type

Description

Price List

LOV text field

Displays the applied price list for the quote. The
applied price list selection is based on the defaulting
sequence of header level agreement, Quote To
customer and then order type. If either the header
level agreement, Quote To customer, order type or
currency is changed then the defaulting logic for the
price list is reapplied.

If no price list is found during reapplication, the
prior price list, if any should be cleared.

The user can select a price list for the currency if
ASO: Price List Override is set to Yes at the
appropriate level.

Currency

LOV text field

Displays the applied currency. The applied currency
selection is based on the profile option ASO:
Default Currency Code.

Pricing Date

Read-only field

Displays the effective date of the quote pricing.
Freeze Price will set the pricing date to the current
date. Unfreeze Price will clear the pricing date.

Defaults to the current date if no pricing date is
selected.

Pricing date may also change if user has update
access, the quote is at the highest version, and quote
status is not read-only.

Contract Template

LOV text field

Enter or select a contract template.

Enabled if ASO: Enable Use Contracts is set to Yes
at the appropriate level. Defaults to the contract
template specified in OKC: Contract Template for
standard terms and conditions at the appropriate
level.

Becomes read-only if a contract is attached to the
quote.

Contract Number

Read-only field

Displays the contract number associated with the
quote.

Pricing Updated
On

Read-only field

Displays the date and time of the last pricing call.

Pricing Status

Read-only field

Displays status of the pricing calculation.

Order Number

Read-only field

Displays the order number if the quote has been
successfully submitted as an order.
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Quote Header Tab > Summary View

Table B-2 Quote Header Tab > Summary View Components

Component

Type

Description

Salesperson

LOV text field

Enter or select the primary salesperson on the quote.
Mandatory field.

Sales Group

LOV text field

Enter or select the salesgroup associated with the
primary salesperson on the quote.

Opportunity

LOV text field

Enter or select an opportunity to associate with the
quote.

Can be updated if the user has Update access, quote
is at the highest version, and quote status is not
read-only.

Sales Channel

LOV text field

Enter or select a sales channel and description.
Defaults to sales channel designated in opportunity
if created from one.

Can be updated if the user has Update access, quote
is at the highest version, and quote status is not
read-only.

Source Name

LOV text field

Enter or select source name, code and type.

Can be updated if the user has Update access, the
quote is at the highest version, and quote status is
not read-only.

If quote is created from an opportunity, the source
name is copied over from the opportunity and can
be changed. If the source name in the opportunity is
subsequently changed, it will not be updated in the
quote.

Published

Read-only field

Set to No when the quote is created or if the quote
has not been web- or un-web published. Set to Yes
when the quote has been web-published.

Creation Date

Read-only field

Displays the quote creation date.

Pricing Request Read-only field Displays the pricing request number if the quote
was submitted for batch processing.

Tax Updated On Read-only field Displays the date of the last tax calculation.

Tax Status Read-only field Displays the status of the tax calculation.

List Read-only field Displays the total list price.

Adjustment Read-only field Displays the total adjustment.

Selling Read-only field Displays the total net (selling) price.
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Table B-2 Quote Header Tab > Summary View Components

Component Type Description

Tax Read-only field Displays the total tax for the quote. Should be blank
if the tax has not yet been computed for the quote.

Charges Read-only field Displays the total charges for the quote, including
freight and other applicable charges setup in Oracle
Pricing.

Quote Total Read-only field Displays the quote total.

See Also:

»  Section 20.1, "Overview of Creating Quotes"

B.3 Quote Header Tab > Addresses View

The Quote Header tab > Addresses view provides Quote To, Bill To, and Ship To
customer, contact and address information.

The following table describes components on the Quote Header tab > Addresses

view.

Table B-3 Quote Header Tab > Addresses View Components

Component Type Description
Quote To Region Area where information regarding the Quote To
customer is located.
Customer Read-only field Displays the Quote To customer.
Account Read-only field Displays the Quote To account.
Contact Read-only field Displays the Customer contact name.
Disabled if Quote To customer type is Person.
Phone LOV text field  Enter or select phone number.

Displays phone numbers associated with the Quote
To customer contact if the Quote To customer type is
Organization and Quote To contact is specified.

Displays phone number associated with Quote To
customer if Quote To customer type is Person.

Disabled if Quote To customer type is Organization
and Quote To contact is unspecified.
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Quote Header Tab > Addresses View

Table B-3 Quote Header Tab > Addresses View Components

Component

Type

Description

Address

LOV text field

Enter or select the Quote To address which is the
address to which the quote will be mailed.

Optional field.

If Quote To party is Organization and Quote To
contact is specified, defaults in the following order:
primary Sold To address for Quote To contact,
identifying address for Quote To contact, primary
Sold To address for Quote To customer, and
identifying address for Quote To customer.

If Quote To party is Organization and Quote To
contact is not specified, defaults in the following
order: primary Sold To address for Quote To
customer, and identifying address for Quote To
customer.

If Quote To party is Person, defaults in the following
order: primary Sold To address for the Quote To
customer, and identifying address for the Quote To
customer.

Oval Button

Button

Accesses the Quote To address details.

City

Read-only field

Displays the Quote To city.

State

Read-only field

Displays the Quote To state.

Postal Code

Read-only field

Displays the Quote To postal code.

County

Read-only field

Displays the Quote To county.

Province

Read-only field

Displays the Quote To province.

Country

Read-only field

Displays the Quote To country.

Bill To

Region

Area where information regarding Bill To customer
is located.

Copy From
Quote To

Button

Copies information from the Quote To information
to the corresponding Bill To fields for customer type
(hidden), customer, account, contact and address.
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Quote Header Tab > Addresses View

Table B-3 Quote Header Tab > Addresses View Components

Component

Type

Description

Customer

LOV text field

Enter or select the Bill To customer for the quote.

If ASO: Auto Account Creation is set to Always
and the party does not have an account then the
account will be created when the quote is
created /saved.

If ASO: Enforce Account Relationships is set to No
and ASO: View Customers Without Accounts is
set to Yes, the LOV will list active parties of type
Person and Organization that match the entered
text.

If ASO: Enforce Account Relationship is set to No
and ASO: View Customers Without Accounts is set
to No, the LOV will list active parties of type Person
and Organization with active accounts and match
the text entered.

If ASO: Enforce Account Relationships is set to
Yes, the LOV lists active parties of type Person and
Organization with active accounts, having an
account relationship with the Quote To customer
account and match the text entered.

ASO: View Customers Without Accounts settings
help determine the appearance of the Quote To
customer in the LOV. The LOV shows customer
name, account number and customer type.

Account

LOV text field

Enter or select the Bill To account for the quote.

If customer is entered, LOV lists active account for
the customer matching the account number entered.

If customer is blank and ASO: Enforce Account
Relationships is set to No, LOV lists active parties
of type Person and Organization that have active
accounts and match the account number entered.

If customer is blank and ASO: Enforce Account
Relationships is set to Yes, LOV lists active parties
of type Person and Organization with active
accounts, having an account relationship with the
Quote To customer account and match the account
number entered.

The LOV shows account number, account
description, customer name, and customer type.
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Quote Header Tab > Addresses View

Table B-3 Quote Header Tab > Addresses View Components

Component Type Description
Contact LOV text field Enter or select the customer contact name on the
quote.

Disabled if Bill To customer type is Person.

LOV lists all active parties of type Person that have
a party relationship with the Bill To customer. LOV
lists contact name, address lines 1 - 4, city, state,
postal code, county, province, and country.

Address LOV text field Enter or select the Bill To address, which is the
physical location where the invoice will be sent.

Optional field.

If Bill to party type is Organization and Bill To
contact is not specified, defaults in the following
order: primary active Bill To address for the Bill To
contact, identifying address for the Bill To contact,
primary active Bill To address for Bill To customer,
and identifying address for the Bill To customer.

Oval Button Button Accesses the Bill To address details.

City Read-only field Displays the Bill To city.

State Read-only field Displays the Bill To state.

Postal Code Read-only field Displays the Bill To postal code.

County Read-only field Displays the Bill To county.

Province Read-only field Displays the Bill To province.

Country Read-only field Displays the Bill To country.

Ship To Section Area where information regarding Ship To customer

is located.

Copy From Button Copies information from the Quote To information

Quote To to the corresponding Ship To fields for customer
type (hidden), customer, account, contact and
address.
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Quote Header Tab > Addresses View

Table B-3 Quote Header Tab > Addresses View Components

Component

Type

Description

Customer

LOV text field

Enter or select the Ship To customer for the quote.

If ASO: Auto Account Creation is set to Always
and the party does not have an account then the
account will be created when the quote is
created /saved.

If ASO: Enforce Account Relationships is set to No
and ASO: View Customers Without Accounts is
set to Yes, the LOV will list active parties of type
Person and Organization that match the entered
text.

If ASO: Enforce Account Relationship is set to No
and ASO: View Customers Without Accounts is
set to No, the LOV will list active parties of type
Person and Organization with active accounts and
match the text entered.

If ASO: Enforce Account Relationships is set to
Yes, the LOV lists active parties of type Person and
Organization with active accounts, having an
account relationship with the Quote To customer
account and match the text entered.

ASO: View Customers Without Accounts settings
help determine the appearance of the Quote To
customer in the LOV. The LOV shows customer
name, account number and customer type.
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Quote Header Tab > Addresses View

Table B-3 Quote Header Tab > Addresses View Components

Component Type Description

Account LOV text field  Enter or select the Ship To Account for the quote.

Mandatory if Ship To customer has an active
account when the Ship To customer was specified.

If Ship To customer is specified and ASO: Auto
Account Creation is set to Always, Ship To account
will be created when the quote is created/saved.

If customer is entered, LOV lists active account for
the customer matching the account number entered.

If customer is blank and ASO: Enforce Account
Relationships is set to No, LOV lists active parties
of type Person and Organization with active
accounts and match the account number entered.

If customer is blank and ASO: Enforce Account
Relationships is set to Yes, LOV lists active parties
of type Person and Organization with active
accounts, having an account relationship with the
Quote To customer account and match the account
number entered.

The LOV shows account number, account
description, customer name, and customer type.

Contact LOV text field Enter or select the customer contact name for the
quote.

Disabled if Ship To customer type is Person.

LOV lists all active parties of type Person that have
a party relationship with the Ship To customer.
LOV also lists contact name, address lines 1 - 4, city,
state, postal code, county, province, and country.
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Table B-3 Quote Header Tab > Addresses View Components

Component

Type

Description

Address

LOV text field

Enter or select the Ship To address, which is the
physical location where goods and services will be
sent.

LOV shows all addresses for the Ship To customer
and shows address lines 1 - 4, city, state, postal code,
county, province, country, primary flag, party site
usage and customer name. Lists addresses for the
contact followed by those for the customer.

If Ship To party type is Organization and Ship To
contact is specified, defaults in the following order:
primary active Ship To address for the Ship To
contact, identifying address for the Ship To contact,
primary active Ship To address for the Ship To
customer, and identifying address for the Ship To
customer.

If Ship To party type is Organization and Ship To
contact is not specified, defaults to primary active
Ship To address for the Ship To customer, and
identifying address for the Ship To customer.

If Ship To party type is Person, defaults in the
following order: primary active Ship To address for
the Ship To customer and identifying address for the
Ship To customer.

Oval Button

Button

Accesses the Ship To address details.

City

Read-only field

Displays the Ship To city.

State

Read-only field

Displays the Ship To state.

Postal Code

Read-only field

Displays the Ship To postal code.

County

Read-only field

Displays the Ship To county.

Province

Read-only field

Displays the Ship To province.

Country

Read-only field

Displays the Ship To country.

See Also:

= Section 25.3, "Entering Billing Information”

= Section 25.4, "Entering Shipping Information"

= Section 25.5, "Entering Quote-to Address"
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B.4 Quote Header Tab > Payment, Shipping View

Use the Quote Header tab > Payment, Shipping view to enter payment and
shipping information for the current quote. If you do not enter any information in
this tab, Oracle Order Management enters default payment information once it
receives the order from Oracle Quoting. If you enter information into a Payment
field, you must also enter the other required payment information before you can
submit the order.

The following table describes the components on the Quote Header tab > Payment,
Shipping view.

Table B-4 Quote Header Tab > Payment, Shipping View Components

Component Type Description

Payment Details  Section Area where quote payment information is located.
Payment LOV text field  Displays the payment terms for the quote.
Terms

The defaulting sequence for applying the payment
terms is: header level agreement and Quote To
customer account.

If header level agreement or Quote To customer
account is changed, then payment terms should be
reapplied.

Can be updated if the user has Update access, the
quote is the highest version, and not in Ordered
status.

PO Number  Text field Enter the purchase order number for the quote.

Can be updated if user has Update access, quote is in
the highest version, and quote is not in Ordered

status.
Payment Drop down list  Select one of the following payment types: cash,
Type check, credit card, or blank. Choosing a payment type

here activates the payment tab fields required by the
given payment type.

Can be updated if user has Update access, quote is in
the highest version and quote is not in Ordered status.

Check Text field Enter the check number for the quote. Mandatory if
Number payment type is set to Check.

Can be updated if user has Update access, quote is in
the highest version, and quote is not in Ordered
status.
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Table B-4 Quote Header Tab > Payment, Shipping View Components (Cont.)

Component Type Description

Credit Card  Drop down list Select a credit card type. This menu is active only if

Type payment type is set to Credit Card.

Credit Card  Text field Enter the credit card number for the quote.

Number Mandatory if payment type is set to Credit Card.
Can be updated if user has Update access, quote is in
the highest version, and quote is not in Ordered
status.

Cardholder  Text field Enter the name of the person who owns the credit

Name card to which the order will be charged. Mandatory if
payment type is set to Credit Card.

Can be updated if user has Update access, quote is in
the highest version, and quote is not in Ordered
status.

Credit Card  Text field Enter the expiration date of the credit card to which

Expiration the order will be charged. Mandatory if payment type

Date is set to Credit Card.

Can be updated if user has Update access, quote is in
the highest version, and quote is not in Ordered
status.

Shipping Section Area where shipping detail information for the quote

Details is located.

Requested Date field Enter the requested delivery date. Can be the ship

Date date or the receive date. A date prior to the current
date cannot be entered.

Shipping LOV text field  Enter the shipping method.

Method The LOV shows shipping methods and descriptions.
The shipping methods are valid and active shipping
methods for the product validation organization for
the operating unit associated with the quote.

Shipment LOV text field  Enter the priority level shipping.

Priority

Freight Terms LOV text field  Enter the freight terms for shipping.

FOB LOV text field  Enter the Freight-On-Board (FOB) point or location
from where ownership title of goods is transferred
from seller to buyer.

Shipping Text field Enter any special shipping instructions.

Instructions
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Table B-4 Quote Header Tab > Payment, Shipping View Components (Cont.)

Component Type Description
Packing Text field Enter any special packing instructions.
Instructions

See Also:

= Section 25.9, "Entering Header Shipping Details"

= Section 25.10, "Entering Header Payment Information"

B.5 Quote Header Tab > Tax View

Use the Quote Header Tab > Tax View to designate the tax handling information for
an order.

The following table describes the components on the Quote Header Tab > Tax View.

Table B-5 Quote Header Tab > Tax View Components

Component Type Description
Tax Handling Drop Down Select a tax handling option for the current quote. The
List LOV displays three options: Exempt, Require, or

Standard. Select Exempt to indicate that the quote is
exempt for a normally taxable customer site.

Select Require to indicate that the quote is taxable for
a normally non-taxable ship-to customer.

Select Standard if the taxation should be based on
existing exemption rules.

Exempt Reason Text field If there is no exempt reason designated for the
selected or entered exempt number, select a reason
from the LOV. If an exempt number is selected, the
corresponding exempt reason automatically populates
this field.

Required if the tax handling value is Exempt.

Active only if you select Exempt in the tax handling
field.

Exempt Number LOV text field  Select a tax certificate number from the LOV or enter a
new tax certificate number. Active only if you select
Exempt in the tax handling field.
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Table B-5 Quote Header Tab > Tax View Components

Component Type Description

Tax Code Read-only field Displays the tax details for the quote. Each tax code
on the quote is listed on a separate line.

Amount Read-only field Displays total tax amount for the tax code.

Total Read-only field Displays total tax amount for the quote and the

summation of the tax amount lines.

See Also:
= Section 26.14, "Viewing Quote Tax Details"

B.6 Header Actions Menu
From the Quoting Form, users can select Actions to access the Actions menu.

The following table describes the components on the Header Level Actions menu.

Table B-6 Header Actions Menu Components

Component Type Description

Find Text field Search criteria for the
actions. Enter full action
name or partial name and

a wildcard.
Action Column Title Displays the available
actions.
Approvals Action Accesses the approvals

form where the user can
initiate an approval chain.

Only visible if ASO:
Enable Approvals is set to
Yes at the appropriate
level.

Assign Sales Credits ~ Action Accesses the header level
Sales Credits form.
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Table B-6 Header Actions Menu Components

Component

Type

Description

Cancel Pricing
Request

Action

Cancels an in-progress
pricing request.

Not visible if the user does
not have Update access,
the quote is not in the
highest version, the quote
is in read-only status, or
the quote has not been
created, ASO: Enable
Batch Processing is not set
to Yes, or the quote is not
submitted for batch
pricing.

Check Availability

Action

Accesses the ATP form.

Contract

Action

Accesses the Contracts
form.

Not visible if ASO:
Enable Use Contracts is
set to No.

Copy Quote

Action

Accesses the Copy Quote
form, where the user can
copy an existing quote.

Enter Customer

Action

Accesses AR Customer
Standard form, where the
user creates a new
customer.

If ASO: Create New
Customer is set to No, the
AR Customer standard
form is in read-only mode.

Oracle Quoting Forms User Interface Reference

B-19



Header Actions Menu

Table B-6 Header Actions Menu Components

Component Type

Description

Freeze Prices Action

Freezes the price on the
quote and copies the
current date to the pricing
date field.

Is not visible if the user
does not have Update
access to the quote, the
quote is not in the highest
version, the quote is in a
status that is read-only, the
pricing date is specified, or
the quote is submitted for
batch pricing.

Initiate Credit Check  Action

Activates a credit check by
Order Management.

Is not visible if user does
not have Update access to
the quote, if quote is not in
the highest version, if
ASO: Enable Credit
Check is set to No at the
appropriate level, if the
quote is in Order
Submitted status or if the
quote is submitted for
batch pricing.

Price Adjustment Action

Accesses the form where
the user makes pricing
adjustments to quote lines.
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Table B-6 Header Actions Menu Components

Component Type Description
Pricing Request Action Accesses the Pricing
Details Request Details form,

where the user views
pricing request details.

Is not visible if the user
does not have Update
access to the quote, if the
quote is not in the highest
version, if the quote is in a
read-only status, ASO:
Enable Batch Processing
is not set to Yes, quote is
not submitted for batch
pricing, and last pricing
request is in Pending,
Inactive or Running
status.

Print Quote Action Accesses the Printing form
where the user prints the
existing quote.

Is not visible if the quote is
not in the highest version,
or if the quote is submitted
for batch pricing.

Promotions/Pricing Action Accesses the form where

Attributes the user enters promotion
codes and other pricing
attributes.

Sales Team Action Accesses the Sales Team
form.
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Table B-6 Header Actions Menu Components

Component Type

Description

Unfreeze Prices Action

Unfreezes the prices on the
quote and clears the
pricing date field.

Is not visible if the user
does not have Update
access to the quote, the
quote is not in the highest
version, the quote is in a
status that is read-only, the
pricing date is specified, or
the quote is submitted for
batch pricing.

View Notes Action

Accesses the Notes form.

Web Publish Quote Action

Accesses the Publish form.

Is not visible if ASO:
Enable Web Publishing is
set to No at the
appropriate level, if the
quote is in Order
Submitted or Inactive
statuses, if a contact is not
specified, if the quote is
submitted for batch
pricing, or if the quote is
already web published.

Web Unpublish Quote Action

Unpublishes the quote.

Is not visible if user does
not have Update access,
quote is not in the highest
version, ASO: Enable
Web Publishing is set to
No at the appropriate
level, the quote is not
web-published, the quote
is not in Order Submitted
or Inactive statuses, or the
quote is submitted for
batch pricing.

OK Button

Closes the Actions menu
and navigates to the
selected form.
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Table B-6 Header Actions Menu Components

Component Type Description

Cancel Button Closes the Actions menu.

Find Button Filters the list based on the
text entered in the Find
text field.

B.7 Quote Lines Tab > Pricing View

Use the Quote Lines tab > Pricing view to view and modify products in the current
quote, or to add products to the quote.

The following table describes the components on the Quote Lines tab > Pricing view
of the Oracle Quoting form.

Table B-7 Quote Lines Tab > Pricing View Components

Component Type Description

Folder Icon Button Accesses private and public folders created by user.
Line Read-only field Displays the position of the line in the quote.
Model Status Read-only field Set to blank if the product is not a model or a

component of the model.

Set to I for the model product and its components if
the model is incomplete, or if the model product is
not configured.

Product LOV Text field  Displays the part number for the product.

Read-only if the line is a component of a configured
product, the quote has been saved, user does not have
Update access, quote is not in the highest version,
and/or quote is in a read-only status.

LOV displays product, descriptions, UOM, service
duration, duration period.

Qty Text field Displays the line level quantity.

Read-only if user does not have Update access
and/or quote is not in the highest version.
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Table B-7 Quote Lines Tab > Pricing View Components(Cont.)

Component

Type

Description

UuoOM

LOV Text field

Displays the line level unit of measure.

Read-only if user does not have Update access, quote
is not in the highest version, quote is in read-only
status, product is a model product and the quote line
has been saved, and/or product is a component of a
model product.

Price List

LOV text field

Displays the line level price list.

Header level price list is not defaulted to the line level
price list, but will be used for pricing purposes if the
line level price list is blank.

Read-only if user does not have Update access, ASO:
Price List Override is set to Yes at the appropriate
level, quote is not in the highest version, and/or the
quote is in a read-only status.

Unit List Price

Read-only field

Displays the list price of the product.

Unit Adjustment

Read-only field

Displays the unit adjustment to be made to the list
price.

Unit %
Adjustment

Read-only field

Displays the unit % adjustment to be made to the list
price.

Unit Selling Price

Text field

Displays the unit selling price after the unit
adjustment has been made.

Total Price

Read-only field

Displays the total selling price of the product.

Lines: additional Descriptive Displays the Lines: Additional Information form,

information flexfield where the user accesses color and context value
information.

Details Section Area where additional information for each line is
located.

Description =~ Read-only field Displays the product short description from Oracle
Inventory.

Oval Button  Button Accesses the Product Detail form.

Line Total Read-only field Displays the sum of the total price values for the top
level model product and its components, otherwise
displays the total line level product price.

Quote Total ~ Read-only field Displays the total price of the quote, based on the

quote lines, taxes and shipping charges. Matches the
quote total in the Quote Header tab, Summary view.
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Table B-7 Quote Lines Tab > Pricing View Components(Cont.)

Component Type Description
Line LOV text field  Displays the line category.
Category

Mandatory field. The user can choose either Order or
Return. Defaults to Order for basic products,
services, and for serviceable products with one or
more services associated to them.

Read-only if the line is a component of a configured
product, ASO: Enable Line Type is set to No at the
appropriate level, user does not have Update access,
quote is not in the highest version, and/or quote is in
read-only status.

Line Type LOV text field  Displays the line type corresponding to the line
category.

Read-only if the line is a component of a configured
product, ASO: Enable Line Type is set to No at the
appropriate level, quote is not the highest version
and/or quote is in read-only status.

Header Price  Read-only field Displays the header level price list.
List

Agreement Read-only field Displays the current agreement.

Commitment Read-only field Displays the current commitment.

Attributes Button Displays the Pricing Attributes form, which is the
same as the Pricing Attributes tab of the
Pricing/Promotions form, where the user selects the
pricing attribute context to apply to the quote.

See Also:
= Section 26.2, "Adding Products to the Quote"

= Section 26.3, "Removing Products from the Quote"

B.8 Product Details Form

Use the Product Details Form to obtain additional status information on products in
the quote. This form is accessed by clicking on the oval button located next to the
Description field on the Quote Lines tab > Pricing view, Quote Lines tab > Bill To
view, or Quote Lines tab > Service view.

The following table describes the components on the Product Details form.
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Table B-8 Product Details Form Components

Component

Type

Description

BOM Item Type

Read-only field

Displays the BOM item type of the product.

Inventory Item
Type

Read-only field

Displays the inventory item type of the product.

Configurable Read-only Indicates whether the product is configurable or not.
checkbox Checked if the product is configurable, otherwise
blank.
Returnable Read-only Indicates whether the product is returnable or not.
checkbox Checked if the product is returnable, otherwise blank.
Serviceable Read-only Indicates whether the product is serviceable or not.
checkbox Checked if the product is serviceable, otherwise
blank.
Shippable Read-only Indicates whether the product is shippable or not.
checkbox Checked if the product is shippable, otherwise blank.
Support Service =~ Read-only Indicates whether the product is a support service or
checkbox not. Checked if the product is a support service,
otherwise blank.
OK Button Returns user to the previous form.

B.9 Quote Lines Tab > Bill To View

Use the Quote Lines tab > Bill To view to enter Bill To information about each line in
the quote.

The following table describes the components on the Quote Lines tab > Bill to view.

Table B-9 Quote Lines Tab > Bill to View Components

Component Description

Type

Folder Icon Button Accesses private and public folders created by user.

Line Read-only field Displays the position of the line in the quote.

Model Status Read-only field Set to blank if the product is not a model or a

component of the model.

Set to I for the model product and its components if
the model is incomplete, or if the model product is not
configured.
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Table B-9 Quote Lines Tab > Bill to View Components

Component Type Description

Product LOV text field  Displays the part number for the product.

Read-only if the line is a component of a configured
product, the quote has been saved, user does not have
Update access, quote is not in the highest version,
and/or quote is in a read-only status.

LOV displays product, descriptions, UOM, service
duration, duration period.

Qty Text field Displays the quantity of the product in this quote line.
Mandatory field.

Read-only if user does not have Update access and /or
quote is not in the highest version.

Customer LOV text field Displays the Bill To customer for the product line.

If ASO: Auto Account Creation is set to Always and
the party does not have an account then the account
will be created when the quote is created /saved.

If ASO: Enforce Account Relationships is set to No
and ASO: View Customers Without Accounts is set
to Yes, the LOV will list active parties of type Person
and Organization that match the entered text.

If ASO: Enforce Account Relationship is set to No
and ASO: View Customers Without Accounts is set
to No, the LOV will list active parties of type Person
and Organization that have active accounts and
match the text entered.

If ASO: Enforce Account Relationships is set to Yes,
the LOV lists active parties of type Person and
Organization with active accounts, having an account
relationship with the Quote To customer account and
match the text entered.

ASO: View Customers Without Accounts settings
help determine the appearance of the Quote To
customer in the LOV. The LOV shows customer
name, account number and customer type.

Read-only if the line is a component of a configured
product, ASO: Enable Line Level Billing is set to No
at the appropriate level, user does not have Update
access, quote is not in the highest version, and/or
quote is in a read-only status.
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Table B-9 Quote Lines Tab > Bill to View Components

Component

Type

Description

Account

LOV text field

Displays the Bill To account on the quote. Mandatory
if the Bill To customer had an active account when the
Bill To customer was specified. If the Bill To customer
is specified and ASO: Auto Account Creation is set
to Always then the Bill To account will be created
when the quote is created /saved.

If customer is entered, LOV lists active account for the
customer matching the account number entered.

If customer is blank and ASO: Enforce Account
Relationships is set to No, LOV lists active parties of
type Person and Organization with active accounts
and match the account number entered.

If Customer is blank and ASO: Enforce Account
Relationships is set to Yes, LOV lists active parties of
type Person and Organization with active accounts,
having an account relationship with the Quote To
customer account and match the account number
entered.

Read-only if the line is a component of a configured
product, ASO: Enable Line Level Billing is set to No
at the appropriate level, user does not have Update
access, quote is not in the highest version, and/or
quote is in a read-only status.

Contact

LOV text field

Displays the contact for the Bill To customer for the
product line.

Disabled if Bill To customer type is Person.

LOV lists all active parties of type Person that have a
party relationship with the Bill To customer. Also
shows the existing contact address for the contact.
LOV lists contact name, address Lines 1 - 4, city, state,
postal code, county, province, and country.

Read-only if the line is a component of a configured
product, ASO: Enable Line Level Billing is set to No
at the appropriate level, user does not have Update
access, quote is not in the highest version, and/or
quote is in a read-only status.
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Table B-9 Quote Lines Tab > Bill to View Components

Component

Type

Description

Address

LOV text field

Displays the Bill To address, which is the physical
location where the invoice will be sent.

Read-only if the line is a component of a configured
product, ASO: Enable Line Level Billing is set to No
at the appropriate level, user does not have Update
access, quote is not in the highest version, and/or
quote is in a read-only status.

Details

Section

Area where additional information for each line is
located.

Description

Read-only field

Displays the short description of the product from
Oracle Inventory.

Oval Button

Button

Accesses the Product Detail form.

Line Total Read-only field Displays the sum of the total price values for the top
level model product and its components, otherwise
displays the total price value for the product in the
quote line.

Quote Total Read-only field Displays the total price of the quote, based on the
quote lines, taxes and shipping charges. Matches the
quote total in the Quote Header tab, Summary view.

Address Read-only field The Bill To address.

Oval Button ~ Button Accesses the Address Details form.

City Read-only field The Bill To city.

State Read-only field The Bill To state.

Postal Code  Read-only field The Bill To postal code.

County Read-only field The Bill To county.

Province Read-only field The Bill To province.

Country Read-only field The Bill To country.

See Also:

= Section 25.6, "Entering Line-level Billing"
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B.10 Address Details Form

Use the Address Details form to access additional Address information. There is an
Address Details Bill To form and an Address Details Ship To form, which have
identical components. The Address Details Bill To form is accessible from the oval
button in the Details section of the Quote Lines tab > Bill To View form. The
Address Details Ship To form is accessible from the oval button in the Details
section of the Quote Lines tab > Ship To View form. The Address Details Quote To
form is accessible from the oval button in the Customer Information section of the
Create Quote From Opportunity form.

The following table describes the components on the Address Details Form.

Table B-10 Address Details Form Components

Component Type Description

Address Name Read-only field The party site name.

Address 1 Read-only field Address line 1.

Address 2 Read-only field Address line 2.

Address 3 Read-only field Address line 3.

Address 4 Read-only field Address line 4.

Address Phonetic Read-only field The phonetic pronunciation of the address.
PO Box Read-only field The PO box of the address.

Suite Read-only field The address suite.

City Read-only field The address city.

State Read-only field The address state.

Postal Code Read-only field The address postal code.

County Read-only field The address county.

Province Read-only field The address province.

Country Read-only field The address country.

Timezone Read-only field The address timezone.

OK Button Returns user to the original form on the Quote Lines

tab.
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B.11 Quote Lines Tab > Ship To View

Use the Quote Lines tab > Ship To view to enter Ship To information about each line
in the quote.

The following table describes the components on the Quote Lines tab > Ship To
view form.

Table B-11 Quote Lines Tab > Ship to View Components

Component Type Description

Folder Icon Button Accesses private and public folders created by user.
Line Read-only field Displays the position of the line in the quote.
Model Status Read-only field Set to blank if the product is not a model or a

component of the model.

Set to I for the model product and its components if
the model is incomplete, or if the model product is not
configured.

Product LOV text field  Displays the part number for the product.

Read-only if the line is a component of a configured
product, the quote has been saved, user does not have
Update access, quote is not in the highest version,
and/or quote is in a read-only status.

LOV displays product, descriptions, UOM, service
duration, duration period.

Qty Text field Displays the quantity of the product in this quote line.
Mandatory field.

Read-only if user does not have Update access and/or
quote is not in the highest version.
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Table B-11 Quote Lines Tab > Ship to View Components

Component

Type

Description

Customer

LOV text field

Displays the Ship To customer for the product line.

If ASO: Auto Account Creation is set to Always and
the party does not have an account then the account
will be created when the quote is created /saved.

If ASO: Enforce Account Relationships is set to No
and ASO: View Customers Without Accounts is set
to Yes, the LOV will list active parties of type Person
and Organization that match the entered text.

If ASO: Enforce Account Relationship is set to No
and ASO: view Customers Without Accounts is set
to No, the LOV will list active parties of type Person
and Organization that have active accounts and
match the text entered.

If ASO: Enforce Account Relationships is set to Yes,
the LOV lists active parties of type Person and
Organization with active accounts, having an account
relationship with the Quote To customer account and
match the text entered.

ASO: View Customers Without Accounts settings
help determine the appearance of the Quote To
Customer in the LOV. The LOV shows customer
name, account number and customer type.

Read-only if the line is a component of a configured
product, user does not have Update access, quote is
not in the highest version, and/or quote is in a
read-only status.

B-32 Oracle Quoting User Guide



Quote Lines Tab > Ship To View

Table B-11 Quote Lines Tab > Ship to View Components

Component

Type

Description

Account

LOV text field

Displays the Ship To account for the product line.

Mandatory if the Ship To customer had an active
account when the Ship To customer was specified. If
the Ship To customer is specified and ASO: Auto
Account Creation is set to Always then the Ship To
account will be created when the quote is

created /saved.

If customer is entered, LOV lists active account for the
customer matching the account number entered.

If customer is blank and ASO: Enforce Account
Relationships is set to No, LOV lists active parties of
type Person and Organization that have active
accounts and match the account number entered.

If Customer is blank and ASO: Enforce Account
Relationships is set to Yes, LOV lists active parties of
type Person and Organization with active accounts,
having an account relationship with the Quote To
customer account and match the account number
entered.

Read-only if the line is a component of a configured
product, user does not have Update access, quote is
not in the highest version, and/or quote is in a
read-only status.

Contact

LOV text field

Displays the contact for the Ship To customer for the
product line.

Disabled if Ship To customer type is Person.

LOV lists all active parties of type Person that have a
party relationship with the Ship To customer. Also
shows the address for the contact if it exists. LOV lists
contact name, address lines 1 - 4, city, state, postal
code, county, province, and country.

Read-only if the line is a component of a configured
product, user does not have Update access, quote is
not in the highest version, and/or quote is in a
read-only status.
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Table B-11 Quote Lines Tab > Ship to View Components

Component

Type

Description

Address

LOV text field

Displays the Ship To address, which is the physical
location where the goods and services will be sent.

Read-only if the line is a component of a configured
product, user does not have Update access, quote is
not in the highest version, and/or quote is in a
read-only status.

Details

Section

Area where additional information for each line is
located.

Description

Read-only field

Displays the product short description from Oracle
Inventory.

Oval Button

Button

Accesses the Product Detail form.

Line Total

Read-only field

Displays the sum of the total price values for the top
level model product and its components, otherwise
displays the total price value for the product in the
quote line.

Quote Total

Read-only field

Displays the total price of the quote, based on the
quote lines, taxes and shipping charges. Matches the
quote total in the Quote Header tab, Summary view.

Address

Read-only field

The Ship To address.

Oval Button

Button

Accesses the Address Details form, which includes:
address name, address lines 1 -4, address phonetic,
PO box, suite, city, state, postal code, county,
province, country, and timezone.

City Read-only field The Ship to city.

State Read-only field The Ship to state.

Postal Code  Read-only field The Ship to postal code.

County Read-only field The Ship to county.

Province Read-only field The Ship to province.

Country Read-only field The Ship to country.
See Also:

= Section 25.7, "Entering Line-Level Shipping"
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B.12 Quote Line Tab > Shipping View

Use the Quote Lines tab > Shipping view to enter Shipping details about each line

in the quote.

The following table describes the components on the Quote Lines tab > Shipping

view.

Table B-12 Quote Lines Tab > Shipping View Components

Component

Type

Description

Folder Icon

Button

Accesses private and public folders created by user.

Line

Read-only field

Displays the position of the line in the quote.

Model Status

Read-only field

Set to blank if the product is not a model or a
component of the model.

Set to I for the model product and its components if
the model is incomplete, or if the model product is not
configured.

Product

LOV Text field

Displays the part number for the product.

Read-only if the line is a component of a configured
product, the quote has been saved, user does not have
Update access, quote is not in the highest version,
and/or quote is in a read-only status.

LOV displays product, descriptions, UOM, service
duration, duration period.

Qty

Text field

Displays the quantity of the product in this quote line.
Mandatory field.

Read-only if user does not have Update access and/or
quote is not in the highest version.

Requested Date

Date field

Displays the requested delivery date. The date
requested can be either the shipped or received date.

Read-only if the user does not have Update access,
quote is not in the highest version, and/or the quote
is in a read-only status.
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Table B-12 Quote Lines Tab > Shipping View Components

Component

Type

Description

Warehouse

LOV text field

Displays the ship from warehouse.

Read-only if the user does not have Update access,
quote is not in the highest version, and/or the quote
is in a read-only status.

Disabled if ASO: Enable Manual Warehouse
Selection is set to No.

Shipping Method

LOV text field

Select the shipping method you want for the product.
You can select from high or standard priority.

If warehouse is specified, shipping method is
validated against the carrier-ship method
relationships for the warehouse specified on the quote
line.

If warehouse is not specified, shipping method is
validated against the carrier-ship method
relationships for the inventory organization for the
product on the quote line.

Read-only if the line is a component of a configured
product, user doe not have Update access, quote is
not in the highest version, quote is in a read-only
status.

Shipment Priority

LOV text field

Enter or select the shipment priority for the product.

Read-only if the line is a component for a configured
product, user does not have Update access, quote is
not in the highest version, and/or quote is in a
read-only status.

FOB

LOV text field

Enter or select the Freight on Board (FOB) point for
the product.

Details

Section

Area where additional information for each line is
located.

Description

Read-only field

Displays the product short description from Oracle
Inventory.

Oval Button

Button

Accesses the Product Detail form.

Line Total

Read-only field

Displays the sum of the total price values for the top
level model product and its components, otherwise
displays the total price value for the product in the
quote line.
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Table B-12 Quote Lines Tab > Shipping View Components

Component Type

Description

Quote Total =~ Read-only field

Displays the total price of the quote, based on the
quote lines, taxes and shipping charges. Matches the
quote total in the Quote Header tab, Summary view.

Freight LOV text field

Terms

Enter or select the freight terms for the product,
indicating who pays for freight and when they are
paid, for the product line. Freight terms do not affect
accounting freight charges.

LOV lists all freight terms available in the OM
Lookup FREIGHT_TERMS. See the Oracle Order
Management Suite Implementation Guide for more
information.

Read-only if the line is a component of a configured
product, user does not have Update access, the quote
is not in the highest version, or the quote is in a
read-only status.

Shipping Text field

Instructions

Enter any special shipping instructions for the
product.

Read-only if the line is a component of a configured
product, user does not have Update access, quote is
not in the highest version, and/or the quote is in a
read-only status.

Packing Text field

Instructions

Enter any special packing instructions for the product.

Read-only if the line is a component of a configured
product, user does not have Update access, quote is
not in the highest version, and/or the quote is in a
read-only status.

See Also:

= Section 25.8, "Entering Line Level Shipping Details"

B.13 Quote Lines Tab > Service View

Use the Quote Lines tab > Service view to add service products to the quote.

The following table describes the components on the Quote Lines tab > Service

view.
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Table B-13 Quote Lines Tab > Service View Components

Component

Type

Description

Folder Icon

Button

Accesses private and public folders created by user.

Line

Read-only field

Displays the position of the line in the quote.

Model Status

Read-only field

Set to blank if the product is not a model or a
component of the model.

Set to I for the model product and its components if
the model is incomplete, or if the model product is not
configured.

Product

LOV text field

Displays the part number for the product.

Read-only if the line is a component of a configured
product, the quote has been saved, user does not have
Update access, quote is not in the highest version,
and/or quote is in a read-only status.

LOV displays product, descriptions, UOM, service
duration, duration period.

Qty

Numeric field

Displays the quantity of the product in this quote line.
Mandatory field.

Read-only if user does not have Update access, quote
is not in the highest version, and/or the line is a
service.

Reference Type

Read-only field

Displays the source for the serviceable product:
Current Quote, Pending Order or Installed Base. Set
to Unspecified if serviceable product reference has
not been specified.

Duration

Numeric field

Displays the duration of the service product. Defaults
from the values defined in Inventory for the service.

Mandatory field.

Period

Text field

Displays the period for the service product. Defaults
from the values defined in Inventory for the service.

Mandatory field.

Start Date

Date field

Displays the start date for the service product.
Defaults to the current date.

Mandatory field.

Details

Section

Area where additional information for each line is
located.
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Table B-13 Quote Lines Tab > Service View Components

Component Type Description

Description ~ Read-only field Displays the short description of the product from
Oracle Inventory.

Oval Button ~ Button Accesses the Product Detail form.

Line Total Read-only field Displays the sum of the total price values for the top
level model product and its components, otherwise
displays the total price value for the product in the
quote line.

Quote Total = Read-only field Displays the total price of the quote, based on the
quote lines, taxes and shipping charges. Matches the
quote total in the Quote Header tab, Summary view.

Ref Product Read-only field Displays the part number of the serviceable product.

Desc Read-only field Displays the description for the serviceable product.

UuOM Read-only field Displays the UOM of the serviceable product.

Qty Read-only field Displays the quantity of serviceable product.

Order Num  Read-only field Displays the order number for the serviceable
product. Valid if reference type is Pending Order or
Installed Base.

System Read-only field Displays the system name and description for the
serviceable product. Valid if reference type is
Pending Order or Installed Base.

Serial Num  Read-only field Displays the serial number for the serviceable
product. Valid if reference type is Installed Base.

Order Line  Read-only field Displays the order line number for the serviceable
product. Valid if reference type is Pending Order or
Installed Base.

Order Date ~ Read-only field Displays the order date for the serviceable product.
Valid if reference type is Pending Order or Installed
Base.

Quote Line  Read-only field Displays the quote line number for the serviceable
product.

Reference Button Accesses the Service Reference form.

Enabled only if the product is a service.
See Also:
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= Section 26.4, "Adding a Service to the Quote"

B.14 Line Actions Menu

Use the Line Actions menu to perform actions on a selected quote line.

The following table describes the components on the Line Actions menu.

Table B-14 Line Actions Menu Components

Component Type Description

Find Text field Search criteria for the
actions. Enter full action
name or partial name and
a wildcard.

Action Column Title Displays the available
actions.

Add Related Products Action Accesses the Related

Products form.

Is not visible if the user
does not have Update
access, the quote is not in
the highest version, the
quote is in a read-only
status, the product is a
trade-in product, or the
quote is submitted for
batch pricing.

Add Service to Action
Previous Purchase

Accesses the Service
Reference form, where the
user purchases services for
a previously purchased
product.

Is not visible if the user
does not have Update
access, the quote is not in
the highest version, the
quote is in a read-only
status, or the quote is
submitted for batch
pricing.
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Table B-14 Line Actions Menu Components

Component Type Description

Approvals Action Accesses the Approvals
form where the user
initiates an approval chain.

Is not visible if ASO:
Enable Approvals is not
set to Yes at the
appropriate level.

Assign Sales Credits ~ Action Accesses the Line Level

Sales Credits form.
Cancel Pricing Action Cancels an in progress
Request pricing report.

Is not visible if the user
does not have Update
access, the quote is not in
the highest version, the
quote is in read-only
status, the quote has not
been created, ASO:
Enable Batch Processing
is not set to Yes, or the
quote is not submitted for
batch pricing.

Check Availability Action Accesses the form where
the user checks product
availability.

Is not visible if the line is a
trade-in.

Configure Action Launches Oracle
Configurator.

Is not visible if user does
not have Update access to
the quote, quote is not in
the highest version, quote
is in a read-only status,
current context is not the
Quote Lines tab, current
context is not a top level
model product on the
Quote Lines tab, or quote
is submitted for batch
pricing.
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Table B-14 Line Actions Menu Components

Component Type Description
Contract Action Accesses the Contracts
form.

Is not visible if ASO:
Enable Use Contracts is
set to No.

Copy Quote Action Accesses the Copy Quote
form, where the user
copies the existing quote.

Duplicate Line Action Duplicates the selected
line and adds it to the
quote.

Is not visible if the user
does not have Update
access to the quote, if the
quote is in a read-only
status, if the quote line has
not been saved, if the
product is a service
product, a trade-in
product, a model
component or if the quote
is submitted for batch
pricing.

Enter Customer Action Accesses Oracle
Receivables Find /Enter
Customers form.

In read-only mode If ASO:
Create New Customer is
set to No.

Freeze Prices Action Freezes prices on the quote
and copies the current date
to the Pricing Date field.

Is not visible if the user
does not have Update
access to the quote, the
quote is not in the highest
version, the quote is in a
status that is read-only, the
pricing date is specified, or
the quote is submitted for
batch pricing.
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Table B-14 Line Actions Menu Components

Component Type Description
Initiate Credit Check  Action Activates a credit check by
Order Management on the
customer.

Is not visible if the user
does not have Update
access to the quote, the
quote is not the highest
version, or has not been
created, if ASO: Enable
Credit Check is set to No
at the appropriate level, if
the quote is in Order
Submitted status or if the
quote is submitted for
batch pricing.

Installation Details Action Accesses the Installation
Details form.

Disappears if the user does
not have Update access,
the quote is not in the
highest version, the quote
is in a read-only status, the
Network Logistics
Trackable flag is set to No
for the product, or if the
quote is submitted for
batch pricing.

Price Adjustment Action Accesses the form where
the user makes line-level
pricing adjustments.
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Table B-14 Line Actions Menu Components

Component

Type

Description

Pricing Request
Details

Action

Accesses the Pricing
Request Details form,
where the user views
details of a pricing request.

Is not visible if the user
does not have Update
access to the quote, if the
quote is not in the highest
version, if the quote isin a
read-only status, ASO:
Enable Batch Processing
is not set to Yes, quote is
submitted for batch
pricing, and last pricing
request is in Pending,
Inactive or Running
status.

Print Quote

Action

Accesses the form where
the user prints the existing
quote.

Is not visible if the quote is
not in the highest version,
or if the quote is submitted
for batch pricing.

Product Search

Action

Disappears if user does
not have Update access to
the quote, the quote is not
in the highest version, the
quote is in a read-only
status, or the quote is
submitted for batch
pricing.

Promotions/Pricing
Attributes

Action

Accesses the form where
the user enters promotion
code and other pricing
attributes.

Sales Team

Action

Accesses the form where
the user views and

modifies the appropriate
sales team for the quote.
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Table B-14 Line Actions Menu Components

Component

Type

Description

Service Items

Action

Accesses the Service Item
form, where the user adds
available services to
products in the quote.

Is not visible if the quote
line has not been saved,
the product is not a
serviceable product, or the
product is a trade-in
product.

Split Line

Action

Accesses the Split Line
form where the user splits
the quantity of a line into
separate lines.

Is not visible if the user
does not have Update
access to the quote, the
quote is not in the highest
version, the quote is in a
read-only status, the quote
line has not been saved,
the product is a service
product, the product is a
trade-in product, the
product is a model
component, or the quote is
submitted for batch
pricing.

Tax Details

Action

Accesses the Tax Details
form where the user sees a
line breakdown of applied
taxes.
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Table B-14 Line Actions Menu Components

Component Type

Description

Unfreeze Prices Action

Unfreezes the prices on the
quote and clears the
pricing date field.

Is not visible if the user
does not have Update
access to the quote, the
quote is not in the highest
version, the quote is in a
status that is read-only, the
pricing date is specified, or
the quote is submitted for
batch pricing.

View Notes Action

Accesses the form where
the user views any notes
created for the quote.

Web Publish Quote Action

Accesses the Publish form
where the user publishes
the quote to a web store.

Is not visible if the user
does not have Update
access to the quote, if the
quote is not in the highest
version, if ASO: Enable
Web Publishing is set to
No at the appropriate
level, if the quote is web
published, if the quote is
in Order Submitted or
Inactive statuses, if the
quote is submitted for
batch pricing, or if the
quote has not been
created.
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Table B-14 Line Actions Menu Components

Component Type Description

Web Unpublish Quote Action Unpublishes the quote.

Is not visible if the user
does not have Update
access to the quote, if the
quote is not in the highest
version, if ASO: Enable
Web Publishing is set to
No at the appropriate
level, if the quote is not
web published, if the
quote is not in Order
Submitted or Inactive
status, or if the quote is
submitted for batch
pricing.

OK Button Closes the form and
navigates to the
functionality for the
selected product.

Cancel Button Closes the form and
returns user to the calling
form.

Find Button Filters the list based on the
text entered in the Find
text field.

B.15 Quote Versions Tab

Use the Quote Versions tab to view different versions of the quote.

The following table describes the components on the Quote Versions tab of the
Quoting form.

Table B-15 Quote Versions Tab Components

Component Type Description

Version Number  Column Header Lists the quote version number.

Status ColumnHeader Lists the quote status for the version.

Amount Column Header Lists the amount for the quote version.
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Table B-15 Quote Versions Tab Components

Component Type Description

Currency Column Header Lists the currency for the quote version.

Creation Date Column Header Lists the creation date of the quote version.

Update Date Column Header Lists the update dates of the quote version.

Created By Column Header Lists the person who created the quote version.
Updated By Column Header Lists the person who updated the quote version.

View (K) Button Takes user to the Quote Header tab, Summary view of

the quote version selected.

See Also:

= Section 26.15, "Viewing the Quote Versions"

B.16 Price Quote Form

From the Quoting form, users can select Price Quote to initiate a pricing and tax
calculation request. The page is not available if:

s ASO: Calculate Price is set to Automatic
s ASO: Calculate Tax is set to Automatic
= ASO: Enable Batch Processing is set to No

The following table describes the components on the Price Quote form.

Table B-16 Price Quote Form Components

Component Type Description

Pricing Status Read-only field Displays the pricing calculation status of the quote.

Set to Incomplete if the quote has not been fully
priced and a price affecting change is made to the
quote.

Set to Complete if quote is fully priced.

Tax Status Read-only field Displays the tax calculation status of the quote.
Compute Options Section Select to chose calculation options. Defaults to Both.
Price Only Radio Button  Select to perform pricing calculations only.
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Table B-16 Price Quote Form Components

Component Type Description

Tax Only Radio Button  Select to perform tax calculations only.

Both Radio Button  Select to perform both pricing and tax calculations.

Submission Section Select to chose submission options. Defaults to Price

Options Now.

Now Radio Button  Select to perform a pricing call immediately after
selecting the Submit button.

Submit pricing Radio Button  Select to perform a pricing call via batch processing.

request and notify
me when it is
complete

After selecting the Submit button, user is taken to a
calling form. An informational message containing
the request ID is displayed after request submission.

Disabled if ASO: Enable Batch Processing is set to
No, or the user does not have Update access, or the
quote is not in the highest version, or the last pricing
request is not complete.

Submit Button

If Price Now is selected, the price and/or tax
calculations are initiated immediately. User waits
until the request completes to view the calculations.

If Submit pricing request and notify is selected, user
is taken to calling form after request is submitted. An
informational message containing the request ID is
displayed after request submission.

Cancel Button

Closes the Price Quote form and returns user to the
original form.

See Also:

= Section 23.2, "Executing Manual Pricing and Tax Requests for a Quote”

= Section 23.2.1, "Viewing Details of the Pricing Request"

= Section 23.2.2, "Canceling a Pricing Request"

B.17 Related Products Form

Use the Related Products form, from the Quote Lines tab Actions menu, to
cross-sell, up-sell, or substitute a product.

The following table describes the components on the Related Products form.
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Table B-17 Related Products Form Components

Component Type Description

Line Read-only field Displays the line number for which you are selecting
related products.

Product Read-only field Displays the number of the original product that has
related products.

Description Read-only field Displays the name of the original product.

Currency Read-only field Displays the currency in which the original product is
priced.

UOM Read-only field Displays the UOM for the original product.

Quantity Read-only field Displays the product quantity of the original product.

List Price Read-only field Displays the list price of the original product.

Selling Price Read-only field Displays the selling price of the original product.

Product Column header Displays the part numbers that are related to the
original product.

Description Column header Displays the names of products that are related to the
original product.

Relationship Column header Displays the relationship of the related product to the
original product: cross-sell, up-sell, or substitute.

UOM Column header Displays the UOM of the related products.

Apply Button Adds the related product to the quote and returns
user to the Quote Lines tab.

Cancel Button Cancels your changes and returns user to the Quote
Lines tab.

See Also:

= Section 26.8, "Adding a Related Product"

B.18 Service Reference Form

Use the Add Service to Previous Purchase action to access service reference details
for a service product.

The following table describes the components on the Service Reference form.
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Table B-18 Service Reference Form Components

Component Type Description

Search for LOV field Select the object to which the service is applied. The

Serviceable service can apply to a product on a quote, or an order,

Product In: or to a product already installed at a customer site.
Mandatory field.

If this form was invoked via the Reference button in
the Quote Lines tab, Service view form, then the LOV
field contains Current Quote, Pending Orders and
Installed Base. If this form was invoked via the Add
Service to Previous Purchase action in the Quote
Header tab, then the LOV field contains Pending
Order and Installed Base.

Current Quote LOV Select the Current Quote LOV to search for
serviceable products in current quotes.
Product LOV text field  Enter or select a serviceable product by which to
search.

Description ~ LOV text field  Enter or select a serviceable product description by
which to search.

Search Button Executes the search and displays the results.
Close Button Closes the form and returns user to the Quote Lines
tab.
Clear Button Clears all of the fields in the form.
Results Section Area of the form that displays the results of the
search.
Quote Line Column Displays the quote line number for the serviceable
Header product.
Product Column Displays the product number for the serviceable
Header product.
Description ~ Column Displays the descriptions for the serviceable product.
Header
UOM Column Displays the UOM for the serviceable product.
Header
Quantity Column Displays the quantity for the serviceable product.
Header
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Table B-18 Service Reference Form Components

Component Type Description
Apply Button Closes the form, passes the selected serviceable
product information to the quote and returns user to
the Quoting form.
Installed Base LOV Select the Installed Base LOV to search for
serviceable products in the customer’s installed base.
Serial Text field Enter the serial number by which to search.
Number
System Name Text field Enter the system name by which to search.
System names are groupings of related products that
are defined and maintained in Installed Base.
Order Text field Enter the order number by which to search.
Number
Product LOV text field  Enter or select the part number by which to search.
Description ~ LOV text field  Enter or select the product description by which to
search.
Order Dates  LOV text fields Enter a date range within which the order was
created.
Search Button Executes the search and displays the results.
Close Button Closes the form and returns user to the previous form.
Clear Button Clears all of the fields in the form.
Results Section Displays the results of the search.
System Name Column Displays the system name for the serviceable product.
Header
Order Column Displays the order number for the serviceable
Number Header product.
Product Column Displays the serviceable product number.
Header
Description ~ Column Displays the serviceable product description.
Header
UuOM Column Displays the UOM for the serviceable product.
Header
Quantity Column Displays the quantity for the serviceable product.
Header
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Table B-18 Service Reference Form Components

Component Type Description

Order Date ~ Column Displays the order date for the serviceable product.

Header

Serial Column Displays the serial number for the serviceable

Number Header product.

Installed at Column Displays the installed at address for the serviceable

Address Header product.

Apply Button If this form was invoked via the Reference button in
the Quote Lines tab, Service view form, it applies the
changes to the quote and returns user to the original
form.

Find Service  Button If this form was invoked via the Add Service to

For... Previous Purchase action in the Quote Header tab, it
closes the form, passes the serviceable product
information to the Service Item form, and goes to the
Service Item form.

Pending Orders ~ LOV Select the Pending Orders LOV to search for
serviceable products in orders that are not yet
fulfilled.

Order Text field Enter an order number by which to search for a

Number serviceable product.

System Name Text field Enter a system name by which to search.

System names are groupings of related products that
are defined and maintained in Installed Base.

Product LOV text field  Enter or select the part number by which to search.

Description ~ LOV text field  Enter or select the description by which to search.

Order Dates  LOV text field  Enter or select a date range within which the order
was created.

PO Number  Text field Enter a PO number by which to search.

Search Button Executes the search against the customer’s pending
orders.

Close Button Closes the form and returns user to the Quote Lines
tab.

Clear Button Clears all of the fields in the form.

Results Section Area of the form that displays the results of the

search.
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Table B-18 Service Reference Form Components

Component Type Description

Order Column Displays the order number for the serviceable

Number Header product.

Order Line Column Displays the order line for the serviceable product.
Header

Product Column Displays the serviceable product number.
Header

Description ~ Column Displays the serviceable product description.
Header

UuOM Column Displays the UOM for the serviceable product.
Header

Quantity Column Displays the quantity for the serviceable product.
Header

Order Date ~ Column Displays the order date for the serviceable product.
Header

System Name Column Displays the system name for the serviceable product.
Header

Apply Button If this form was invoked via the Reference button in

the Quote Lines tab, Service view form, it applies the
changes to the quote and returns user to the original

form.
Find Service  Button If this form was invoked via the Add Service to
For... Previous Purchase action in the Quote Header tab, it

closes the form, passes the serviceable product
information to the Service Item form, and goes to the
Service Item form.

See Also:
= Section 26.4, "Adding a Service to the Quote"

B.19 Approvals Form

Use this form by selecting the Approvals action from the Actions menu to view
approval details, and initiate or cancel the approval process.

The following table describes the components on the Approvals form.
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Table B-19 Approvals Form Components

Component Type Description

Customer Type Read-only field Displays customer type.

Customer Read-only field Displays customer name.

Account Read-only field Displays customer account number.
Contact Read-only field Displays customer contact name.

Quote Number Read-only field Displays current quote number and version.

Quote Name

Read-only field

Displays current quote name.

Currency Read-only field Displays currency for quote.

Approval History  Section Displays approval history information.
Requester Read-only field Displays name of person who initiated process.
Result Hyperlink Links to results of approval process.

Quote Version

Read-only field

Displays quote version associated with approval
process.

Start Date

Read-only field

Displays start date of approval process.

End Date

Read-only field

Displays end date of approval process. If process not
complete, this field is blank.

Approval Process  Section Displays information about the approval process.
Approvers Tab Displays information about approvers.
Name Read-only field Displays approver name.

Response Read-only field Displays approver response.

Rules Tab Displays information about approval rules.
Rule Read-only field Displays rule description.

Description

Approval Read-only field Displays rule approval level.

Comments Tab Displays selected approvers comments.
Notification =~ Tab Displays notification history.

History

Sequence Read-only field Displays sequence of notifications.

Name Read-only field Displays name of notified approver.
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Table B-19 Approvals Form Components

Component Type Description
Activity Read-only field Displays notification reason.
Date Sent Read-only field Displays date notification sent.
Response Read-only field Displays response date.
Date
Due Date Read-only field Displays the approval due date.
Status Read-only field Displays the approval status.
Result Read-only field Displays the result.

Requestor Read-only field Displays requester comments.

Comments

Initiate Approval ~ Button Initiates the approval process and takes you to the

Process next approval form.

Disabled if quote is in Approval Pending status, user
does not have Update access, quote is not in the
highest version, quote is in Order Submitted status,
and quote is submitted for batch processing.

Cancel Approval  Button Cancels the approval process.

Process Disabled if quote is not in Approval Pending status,
user does not have Update access, quote is not in the
highest version, quote is submitted for batch
processing.

See Also:

= Section 28.1, "Overview of Approvals"

= Section 28.2, "Initiating an Approval"

= Section 28.3, "Viewing Approval Details"

B.20 Initiate Approval Form

Use this form to initiate the approval process. This form is accessible via the

Approvals form.

The following table describes the components on the Initiate Approval form.
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Table B-20 Initiate Approval Form Components

Component Type Description

Customer Type Read-only field Displays customer type.

Customer Read-only field Displays customer name.

Account Read-only field Displays customer account number.
Contact Read-only field Displays customer contact name.

Quote Number

Read-only field

Displays current quote number and version.

Quote Name

Read-only field

Displays current quote name.

Currency Read-only field Displays currency for quote.

Approval Process Section Displays information about the approval process.
Approvers Tab Displays information about approvers.
Name Read-only field Displays approver name.

Rules Tab Displays information about approval rules.
Rule Read-only field Displays the rule description.

Description

Approval Read-only field Displays the rule approval level.

Requester Text field Enter comments.

Comments

Approver List Section Displays approver list information.

A non Checkbox Requests contract creation after the quote is
standard approved.

contract is

required for

this quote

Obtain Radio button Requires approval from all approvers.
approval

from the

entire list of

approvers

Obtain Radio Allows you to indicate which approver should
approval button/Drop-down start the approval process. Select from list of

from the list
of approvers
starting with

menu

approvers.

You can only use this option if ASO: Allow Skip
Approvers is set to Yes at the appropriate level.
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B.21 Sales Credits Form

Table B-20 Initiate Approval Form Components

Component Type Description

Submit for Button Submits the quote for approval.
Approval

Approve Quote Button Allows sales rep to approve the quote.
Cancel Button Cancels the process and closes the form.
See Also:

= Section 28.1, "Overview of Approvals"

= Section 28.2, "Initiating an Approval"

= Section 28.3, "Viewing Approval Details"

Use the Sales Credits menu option, from the Actions menu, to allocate sales credits
to sales representatives. You can allocate sales credits either at the header or line
level. If your cursor is in the Quote Header tab and you select Sales Credits, the
header sales credit form displays. If your cursor is in the Quote Lines tab, the line
level sales credit form appears.

The following tables describe the components on the header level Sales Credits

form.

Table B-21 Header Sales Credits Form Components

Component

Type

Description

Quote Name

Read-only field

Displays the quote name.

Quote Number

Read-only field

Displays the number of the current quote.

Version Read-only field Displays the quote version.
Customer Read-only field Displays the quote-to customer on the current quote.
Account Read-only field Displays the quote-to account for the current quote.
Contact Read-only field Displays the quote-to contact on the current quote.
Quote Status Read-only field Displays the quote status.

Sales Credit ~ Section Section where details about sales credits are entered.
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Table B-21 Header Sales Credits Form Components

Component Type

Description

Salesperson  LOV text field

Defaults sales credits to the primary salesperson in the
quote header. The default is 100% revenue sales credit
of the default credit type associated with the primary
salesperson.

If the primary salesperson and/or primary sales
group change, the change should be reflected in the
default sales credit as well. If they change after the
header sales credits are applied, the change will not be
reflected in the header sales credit form.

Select a salesperson to whom you wish to allocate a
sales credit. The LOV displays only salespeople who
are set up as valid salesreps.

Sales Group  LOV text field

Defaults from the primary sales group in the quote
header.

Select the sales group for the corresponding
salesperson.

Credit Type  LOV text field

Select the type of sales credit to allocate. A sales credit
can either be Quota Sales Credit or Non-Quota Sales
Credit. A quota sales credit is based on invoice lines
and is applied against a salesperson’s quota. A
non-quota sales credit is not associated with invoice
lines and is not usually applied to a sales
representative’s quota.

Set up in Order Management.

Revenue Read-only field Indicates if the credit is revenue or non-revenue.
Percent LOV text field  Select the percentage of the sales credit.

Revenue Read-only field If the type is Quota Sales Credit, this field must be
Total blank or add up to 100%.

Non-Revenue Read-only field
Total

If the type is Non-Quota Sales Credit, this field can
contain any amount.

Remove Button Removes selected sales credit.
Apply Button Select to apply the sales credits to the quote.
Cancel Button Cancels any changes and returns user to the main

Oracle Quoting form.

The following tables describe the components on the line level Sales Credits form.
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Table B-22 Line Sales Credit Form Components

Component

Type

Description

Line

Read-only field

Displays the line number the sales credit will be
applied to.

Product

Read-only field

Displays the name and number of the product the
sales credit will be applied to.

Description

Read-only field

Displays the name of the product the sales credit will
be applied to.

Currency

Read-only field

Displays the currency used for the price of the
product the sales credit will be applied to.

UuoOM

Read-only field

Displays the unit of measure of the product the sales
credit will be applied to.

Quantity

Read-only field

Displays the quantity of the product the sales credit
will be applied to.

List Price

Read-only field

Displays the list price of the product the sales credit
will be applied to.

Selling Price

Read-only field

Displays the selling price of the product the sale credit
will be applied to.

Salesperson

LOV text field

Select a salesperson you want to allocate a sales credit
to. The LOV displays only salespeople who are set up
as valid salesreps.

If no sales credits are selected for line products, Oracle
Quoting will use the header level sales credits.

Sales Group

LOV text field

Select a sales group for the corresponding
salesperson.

Credit Type

LOV text field

Select the type of sales credit to allocate. A sales credit
can either be Quota Sales Credit or Non-Quota Sales
Credit. A quota sales credit is based on invoice lines
and is applied against a salesperson’s quota. A
non-quota sales credit is not associated with invoice
lines and is not usually applied to a sales
representative’s quota.

Set up in Order Management.

Revenue

Read-only field

Indicates if the credit is revenue or non-revenue.

Percent

Text field

Select the percentage of the sales credit.

Revenue Total

Read-only field

If the type is Quota Sales Credit, this field must be
blank or add up to 100%.
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Table B-22 Line Sales Credit Form Components

Component

Type

Description

Non-Revenue
Total

Read-only field

If the type is Non-Quota Sales Credit, this field can
contain any amount.

Remove Button Removes selected sales credit.

Apply Button Applies the sales credit(s) and returns to the Oracle
Quoting form.

Cancel Button Cancels any changes and returns user to the Oracle
Quoting form.

See Also:

»  Section 26.10, "Allocating Sales Credit"

B.22 Available to Promise (ATP) Form

Use the Available to Promise (ATP) form to check product availability dates by
choosing the Check Availability action from the Actions menu.

The following table describes the components on the Available to Promise (ATP)

form.

Table B-23 Available to Promise (ATP) Form Components

Component Type Description

Item Read-only field Displays the part number for the product currently
selected in the Quote Lines tab.

Description Read-only field Displays a description of the product currently
selected in the Quote Lines tab.

UuOM Read-only field Displays the UOM for the product currently selected
in the Quote Lines tab.

Quantity Read-only field Displays the quantity of the product requested by the
customer.

Request Date Read-only field Displays the date the product was requested.

Available Read-only field Displays the quantity available.

Available Date Read-only field Displays the date the entire desired quantity will be

available.
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Table B-23 Available to Promise (ATP) Form Components

Component Type Description

Warehouse Read-only field Displays the warehouse against which the ATP check
is performed.

Onhand Read-only field Displays the quantity available on hand.

Save Warehouse  Checkbox

Select to save the warehouse for use in future
availability checks.

If a warehouse is already saved for the line, by default
the box is selected. Deselecting this box will remove
the saved warehouse.

Item ATP Read-only field Displays the message generated from Inventory.

Message

OK Button Closes the ATP window and return to the Oracle
Quoting form.

See Also:

= Section 26.9, "Checking Product Availability"

B.23 Contract Detail Information Form

Use the Contract Detail Information form to view contract detail information or
request contract creation by choosing the Contract action from the Actions menu.

The following table describes the components on the Contract Detail Information

form.

Table B-24 Contract Detail Information Form Components

Component Type

Description

Contract Template LOV text field

Select a contract template. Defaults to the contract
designated in OKC: Contract Template for Standard
Terms and Conditions.

Number Read-only field Displays the contract number.
Modifier Read-only field Displays the modifier for the contract.
Version Read-only field Displays the contract version.
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Table B-24 Contract Detail Information Form Components

Component Type Description

Use default terms Radio button Select to use default terms and conditions.

and conditions

defined in

contract template

Request contract ~ Radio button Select to request contract creation.

creation if you

need to negotiate

terms and

conditions

Comments Text field Enter comments about the contract. Read-only unless
contract creation is requested.

Review Terms Button Accesses terms and conditions for the selected
template.

Cancel Button Cancels any changes.

OK Button Begins contract creation processes.
If Request contract creation if you need to negotiate
terms and conditions button is selected, this button is
disabled if a non-standard contract is not attached to
the quote, user does not have Update access, quote is
not in the highest version, quote is in Order
Submitted status, and quote is submitted

See Also:

= Section 30.2, "Creating a Quote with Non Default Terms and Conditions"

B.24 Contract Detail Form

Use the Contract Detail form to view additional details about the contract for the
quote. This form is accessible by selecting Request contract creation if you need to
negotiate terms and conditions on the Contract Details Information form.

The following table describes the components on the Contract Detail form.
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Table B-25 Contract Detail Form Components

Component Type Description
Contract Template Read-only field Displays the contract template name.
Defaults to the contract designated in OKC: Contract
Template for Standard Terms and Conditions.
Number Read-only field Displays the contract number.
Modifier Read-only field Displays the modifier for the contract.
Version Read-only field Displays the contract version.

Contract Number

Read-only field

Displays the assigned contract number.

Modifier

Read-only field

Displays the modifier for the contract.

Status Read-only field Displays the status of the contract approval.

Short description ~ Read-only field Displays a brief description of the quote the contract
originated from.

Approval Date Read-only field Displays the contract approval date.

Signature Date

Read-only field

Displays the contract signature date.

Termination Date

Read-only field

Displays the contract termination date. This value
comes from Oracle Sales Contracts.

Start Date

Read-only field

Displays the start date of the contract.

End Date

Read-only field

Displays the end date of the contract.

Description

Read-only field

Displays the description of the non-standard terms of
the contract.

Review Terms Button Accesses terms and conditions for the selected
template.

Cancel Button Cancels any changes.

Contract Button Requests further contract assistance.

Assistance

Cancel Approval  Button Cancels the approval process.
Disabled if quote is not in Approval Pending status,
user does not have Update access, quote is in Order
Submitted status, quote is submitted for batch
processing.

See Also:
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= Section 30.2, "Creating a Quote with Non Default Terms and Conditions"

B.25 Contract Terms & Conditions Form

Use this form to view the terms and conditions of the contract for the quote. This
form is accessible via the Review Terms Button on the Contract Detail Information
form.

The following table describes the components of the Contract Terms & Conditions
form.

Table B-26 Contract Terms & Conditions Form Components

Component Type Description

Contract Template Read-only field Defaults to the contract designated in OKC: Contract
Template for Standard Terms and Conditions.

Contract Number Read-only field Displays the contract number.

Done Button Returns user to the previous screen.

See Also:

= Section 30.3, "Viewing a Quote’s Terms and Conditions"

B.26 Copy Quote Form

Use this Actions menu option to copy quote information into either a new or
revised quote.

The following table describes the components on the Copy Quote form.

Table B-27 Copy Quote Form Components

Component Type Description
Copy From Section Select the information you want to copy.
Quote Radio button Copies the quote header information into a new or
Header revised quote (includes all Ship To, Bill To, and
payment information).
Lines Checkbox Copies the quote lines.
Notes Checkbox Copies all notes associated with your quote into a new

or revised quote.
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Table B-27 Copy Quote Form Components

Component Type Description
Attachments Checkbox Copies all attachments associated with your quote
into a new or revised quote.
All Quote Radio button Copies all header, address and payment information
Information as well as product details, notes, and attachments into
a revised or a new quote.

Copy To Section Displays where quote information is copied to.

New Quote  Radio button Copies the selected information into a new quote.

New Quote  Read-only Disabled unless the profile option ASO: Auto

Number field/Text field Numbering is set to No and the user selects Copy to >
New Quote. You must enter a quote number for the
new quote.

Version Radio button Copies the selected information into a new version of
the existing quote.

Apply Button Applies changes and returns user to the main Oracle
Quoting form, where new or revised quote is
displayed.

Cancel Button Cancels changes and returns user to the main Oracle
Quoting form.

See Also:

= Section 20.2, "Creating a Quote"

= Section 27.2, "Copying a Quote"

B.27 Price Adjustment Form

Use the Price Adjustments menu option, from the Actions menu, to view the price
adjustments that apply to the products in your quote. If your cursor is in the Quote
Header section when you select the Price Adjustment menu option, the header level
Price Adjustments form displays. If your cursor is in the Quote Lines tab when you
select the Price Adjustments menu option, the line level Price Adjustments form
displays.

The following table describes the components on the header level Price Adjustment
form.
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Table B-28 Price Adjustment Form - Header Level Components

Component

Type

Description

Quote Name

Read-only field

Displays the name of the current quote.

Quote Number

Read-only field

Displays the quote number for the current quote.

Version Read-only field Displays the version of the quote.
Customer Read-only field Displays the Quote To customer designated for the
current quote.
Account Read-only field Displays the Quote To account for the customer
designated on the current quote.
Contact Read-only field Displays the Quote To contact for the customer
designated for the current quote.
Quote Status Read-only field Displays the quote status for the current quote.
Currency Read-only field Displays the designated currency for the current
quote.
Header Section Displays adjustment information that applies to the
Adjustments entire quote.
Modifier Read-only field Displays name of modifier.
Name pr LOV text If ASO: Discounting Privilege is set to Partial or
field. . .
Full, users can apply non-automatic price
adjustments. Therefore, the modifier can also be an
LOV text field.

Level Read-only field Displays the level at which the adjustment is applied.
Since you are in the Header Price Adjustments form,
this field always displays the value order.

Modifier Read-only field Displays the modifier type of the price adjustment.

Type This value is defaulted in from Oracle Pricing.
Oracle Quoting supports the following modifier
types: Discounts, Surcharges, and Price Breaks.

Application ~ Read-only field Displays the application method for the price

Method adjustment. The value can be either % or AMT.

For example, if the application method is % and the
value is 10, there is a 10% discount applied to the
order. If the application method is AMT and the value
is 10, there is a $10 discount applied to the order.
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Table B-28 Price Adjustment Form - Header Level Components

Component

Type

Description

Value

Read-only field
or Text field

Displays the adjustment amount or percent.

If the profile option ASO: Discounting Privilege is set
to Full and the Override flag is selected for the
adjustment in Oracle Pricing, the value can be
overridden in this field.

Adjusted
Amount

Read-only field

Displays the adjusted amount for the quote. For
example, if you apply a discount to the quote, this
field displays the amount subtracted from the quote
total. If you apply a discount, the adjusted amount
field displays a negative value.

Automatic

Read-only
checkbox

Indicates whether the price adjustment is
automatically applied or not. If the box is checked,
adjustments apply whenever the adjustment criteria is
met. If the box is not checked, this is a promotion
applied manually via the Promotions form or a
non-automatic adjustment. You can manually apply
adjustments in this page if ASO: Discounting
Privilege is set to Full or Partial.

This flag is set depending on whether the adjustment
is Automatic or Ask for in the Oracle Pricing engine.

Remove

Checkbox

Check this box to remove a non-automatic discount.

Read-only if the discount is automatic.

Reason Code

Column header

Displays reason code. Mandatory if the user changes
the Value field and the Override flag is enabled.

Reason Text

Column header

Displays text description of reason.

Modifier Read-only field Displays the description of the modifier. The
Description description is defined in Oracle Pricing.
Apply Button Applies the pricing adjustment to the quote and
returns user to the Oracle Quoting form.
Reset Button Resets the price adjustments to their original values.
Cancel Button Returns user to the Oracle Quoting form.

The following table describes the components on the line level Price Adjustment

form.

B-68 Oracle Quoting User Guide



Price Adjustment Form

Table B-29 Price Adjustments Form - Line Level Components

Component Type Description

Line Read-only field Displays the line number of the line currently selected
in the Quote Lines tab.

Product Read-only field Displays the part number and description of the
product currently selected in the Quote Lines tab.

UuOM Read-only field Displays the UOM for the product currently selected
in the Quote Lines tab.

Unit List Price Read-only field Displays the unit list price of the product currently
selected in the Quote Lines tab.

Total List Price Read-only field Displays the total list price for the product based on
the quantity selected in the Quote Lines tab.

Quantity Read-only field Displays the quantity of the product currently selected
in the Quote Lines tab.

Unit Adjustment Read-only field Displays the adjustment per unit.

Total Adjustment Read-only field Displays the total adjustment for the product based on
the quantity.

Currency Read-only field Displays the default currency for the product
currently selected in the Quote Lines tab.

Unit Selling Price  Read-only field Displays the selling price per unit of the product
currently selected in the Quote Lines tab.

Total Price Read-only field Displays the total price of the product after

adjustment.

Line Adjustments Section Displays the line adjustment information.

Modifier Column Displays name of modifier.

Name heading If ASO: Discounting Privilege is set to Partial or
Full, users can apply non-automatic price
adjustments. Therefore, the modifier can also be an
LOV text field.

Level Read-only field Displays line and order level adjustments.

Modifier Column Displays the modifier type of the price adjustment.

Type heading This value is defaulted in from Oracle Pricing.

Oracle Quoting supports the following modifier
types: Discounts, Surcharges, Freight/Special
Charges, and Price Breaks.
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Table B-29 Price Adjustments Form - Line Level Components

Component

Type

Description

Application
Method

Read-only field

Displays the application method for the price
adjustment. The value can be either % or AMT.

For example, if the application method is % and the
value is 10, there is a 10% discount applied to the
product or order. If the application method is AMT
and the value is 10, there is a $10 discount applied to
the product or order.

Value

Read-only field
or Text field

Displays the adjustment amount or percent.
Updateable if:

= Opverride Allowed flag is enabled for the price
break adjustment.

= ASO: Discounting Privilege is set to Full
= User has update access
= Highest version of quote is displayed

= The quote is not in a read-only status

Adjusted
Amount

Read-only field

Displays the adjusted amount for the product. For
example, if you apply a discount to the product, this
field displays the amount subtracted from the unit list
price. If you apply a discount, the Adjusted Amount
field displays a negative value.

Automatic

Read-only
checkbox

Indicates whether the price adjustment is
automatically applied or not. If the box is checked,
adjustments apply whenever the adjustment criteria is
met. If the box is not checked, this is a promotion
applied manually via the Promotions form.

Set in Oracle Pricing.

Remove

Checkbox

Select this box to remove a non-automatic discount.

Read-only if the discount is automatic.

Reason Code

Column header

Displays reason code. Mandatory if the user changes
the Value field and the Override flag is enabled.

Reason Text

Column header

Displays text description of reason.

Modifier
Description

Read-only field

Displays the description of the modifier. The
description is defined in Oracle Pricing.

Apply

Button

Applies the pricing adjustment to the quote and
returns user to the Oracle Quoting form.
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Table B-29 Price Adjustments Form - Line Level Components

Component Type Description
Details Button Accesses the Price Break modifier’s details.
Enabled only if the adjustment is a price break.
Reset Button Resets the price adjustments to their original values.
Cancel Button Returns user to the Oracle Quoting form.
Line Adjustments Section Displays Price Break details. This section is displayed

if the adjustment is a price break and the Details
button is selected.

Modifier Read-only field Displays the modifier name.
Name
Application =~ Read-only field Displays the application method.
Method
Value Read-only The value can be either % or AMT.
field / Text field Updateable if:
s Override Allowed flag is enabled for the price
break adjustment.
= ASO: Discounting Privilege is set to Full
= User has update access
= Highest version of quote is displayed
= The quote is not in a read-only status
Adjusted Read-only field Displays the adjusted amount.
Amount
Break Qty Read-only field Displays the price break quantity.
Break Type Read-only field Displays the price break type. Possible values are

POINT and RANGE.
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Table B-29 Price Adjustments Form - Line Level Components

Component Type

Description

Reason Code Read-only
field/LOV Text

field

Select a reason code for changing the Value field for
the price break adjustment. The LOV shows reason
codes set up in Oracle Order Management.

Mandatory if the Overrideable flag for the price break
adjustment is enabled and the user changes the Value
field.

Updateable if:

s Opverride Allowed flag is enabled for the price
break adjustment.

= ASO: Discounting Privilege is set to Full
= User has update access
= Highest version of quote is displayed

= The quote is not in a read-only status

Reason Text ~ Read-only

field / Text field

Enter a reason for changing the Value field for a price
break adjustment.

Updateable if:

s Opverride Allowed flag is enabled for the price
break adjustment.

= ASO: Discounting Privilege is set to Full
= User has update access
= Highest version of quote is displayed

= The quote is not in a read-only status

OK Button

Applies changes and returns to the default view of the
Line level Price Adjustments form.

Cancel Button

Discards changes and returns to the default view of
the Line level Price Adjustments form.

See Also:

= Section 23.1.4, "Pricing Adjustments"

= Section 23.10, "Manually Adjusting Prices in the Price Adjustments Form"

= Section 23.9, "Applying a Non-Automatic Discount to a Product or the Entire

Quote"
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B.28 Pricing Request Details Form

Select the Pricing Request Details action from the Actions menu to view the Pricing
Request Details form. This form shows details of the latest pricing request.

The following table describes the components on the Pricing Request Details form.

Table B-30 Pricing Request Details Form Components

Component

Type

Description

Quote Name

Read-only field

Displays the quote name.

Customer

Read-only field

Displays the Quote To customer.

Contact

Read-only field

Displays the Quote To contact.

Quote Number

Read-only field

Displays the quote number.

Version Read-only field Displays the quote version.

(Version) Of Read-only field Displays the maximum quote version.

Account Read-only field Displays the Quote To account.

Quote Status Read-only field Displays the quote status.

Request ID Read-only field Displays the request identifier for the concurrent

program used for the pricing request. Use this ID to
query the concurrent request and monitor progress.

Request Name

Read-only field

Displays the concurrent program name for the batch
request, which is Pricing Request.

Phase Read-only field Displays the request phase.

Status Read-only field Displays the request status.

Date Submitted Read-only field Displays the date and time when the batch request
started. Blank if request has not started.

Requestor Read-only field Displays the username of the person submitting the
request.

Date Started Read-only field Displays the date and time when the batch request
started. Blank if the request has not started.

Done Button Closes the form and returns user to the Oracle

Quoting form.
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Table B-30 Pricing Request Details Form Components

Component Type

Description

Cancel Pricing Button
Request

Cancels the submitted request, displays an
informational message containing the request id or
displays error messages for errors, and then closes the
form after the user acknowledges the message.

Is not visible if the quote is not in the highest version,
user does not have Update access, quote is in a
read-only status, and the last submitted pricing
request is not in Pending, Inactive or Running phase.

See Also:

= Section 23.2, "Executing Manual Pricing and Tax Requests for a Quote”

= Section 23.2.1, "Viewing Details of the Pricing Request"

= Section 23.2.2, "Canceling a Pricing Request"

B.29 Printing Page

Select the Print Quote action from the Action menu to print a quote.

The following table describes the components on the Printing page.

Table B-31 Printing Page Components

Component Type Description

Output Format Drop-down Select the output format for the printed quote.
menu

Template Drop-down Select the template for the printed quote.
menu

Show subtotal by ~ Checkbox

Determines if printed quote displays subtotal by

product category product category.

Show price Checkbox Determines if printed quote shows price adjustments.
adjustments

Show Header Checkbox Determines if printed quote shows header
Attachments attachments.

Appears only if ASO: Print Quote Show Attachments
is set to Yes.
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Table B-31 Printing Page Components

Component Type Description
Show Line Checkbox Determines if printed quote shows line attachments.
Attachments

Appears only if ASO: Print Quote Show Attachments
is set to Yes.

Show Charges Checkbox If checked, charges details appear on the quote
printout. If unchecked, charges details are not printed
but, total charges are displayed in the subtotal section

of the printout.
Printin executable Checkbox If contracts integration is enabled, determines if
mode printed quote includes terms and conditions, and
signature block.

If contracts integration is not enabled, determines if
the printed quote shows the signature block.

Appears only if the quote is executable.

Done Button Closes the form and returns user to the original form.
Submit Button Executes the selections made by the user.
See Also:

= Section 31.2, "Printing a Quote"

B.30 Promotions/Pricing Attributes Form

Use the Promotions/Pricing Attributes action from the Actions menu to select a
promotion to apply to a product or quote. Promotions are defined in Oracle
Pricing.

The following table describes the components on the Promotions tab.

Table B-32 Promotions/Pricing Attributes Form - Promotions Components

Component Type Description
Promotions Tab Displays fields related to promotions.
Level Read-only field Displays the level at which the promotion is applied.

The values, which are designated in Oracle Pricing,
are Order or Line. If the level of the promotion is
Order, the promotion applies to all lines in the quote.
If the level is Line, the promotion applies to the line
selected in the Quote Lines tab.
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Table B-32 Promotions/Pricing Attributes Form - Promotions Components

Component

Type

Description

Promotion No

LOV text field

Displays the modifier number for the promotion. This
value is defined in Oracle Pricing.

Promotion Name

Read-only field

Displays the promotion name associated with the
promotion number. A value is defaulted into this
field when the promotion number is entered. This
value is defined in Oracle Pricing.

List Line

LOV text field

Displays the individual list line number of the
specific promotion. This value is defined in Oracle
Pricing.

Date From

Read-only field

Displays the starting date of the promotion, if one
exists. This field is only populated when there is a
finite period of time that the promotion is valid. This
value is defined in Oracle Pricing.

Date To

Read-only field

Displays the ending date for a promotion. This field
is only populated when there is a finite period of time
that the promotion is valid. This value is defined in
Oracle Pricing.

Override Flag

Read-only
Check box

If this box is checked, the amount of the promotion
can be overridden. If it is not checked, the amount
cannot be overridden. Overrides are not supported
on an individual promotion level. They are only
supported through manual overrides. This flag is set
in Oracle Pricing.

Cancel

Button

Cancels the promotion selection in progress and
returns user to the Oracle Quoting form.

Apply

Button

Applies the selected promotion to the quote.

The following table describes the components on the Pricing Attributes tab.

Table B-33 Pricing/Promotions Attributes Form - Pricing Components

Component Type Description
Pricing Attributes Tab Displays fields related to pricing attributes.
Level Read-only field Displays level at which the pricing attribute is

applied.

Pricing Context

LOV text field

Select the pricing attribute context to apply to the
quote.
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Table B-33 Pricing/Promotions Attributes Form - Pricing Components

Component Type Description

Flexfield Flexfield Launches flexfield window if flexfields exist for the
selected context.

Cancel Button Cancels unapplied changes and returns user to the
Oracle Quoting form.

Apply Button Applies pricing attribute changes.

See Also:

= Section 23.4, "Applying Custom Pricing Attributes"

= Section 23.7, "Applying Promotion Codes"

B.31 Sales Team Form

Select the Sales Team action from the Actions menu to designate the sales person
information for an order.

The following table describes the components on the Sales Team form.

Table B-34 Sales Team Form Components

Component

Type

Description

Quote Name

Read-only field

Displays the name of the current quote.

Quote Number

Read-only field

Displays the number of the current quote.

Version Read-only field Displays the version of the current quote.
Customer Read-only field Displays the customer on the current quote.
Account Read-only field Displays the account for the current quote.
Contact Read-only field Displays the contract for the current quote.

Quote Status

Read-only field

Displays the quote status of the current quote.

Folder Icon Button Accesses private and public folders created by user.

Full Access Checkbox Determines if sales team member has update or
view-only access to the quote.

Name LOV text field  Enter the name of the resource to add to the quote
sales team.

Job Title Read-only field Displays sales team member’s job title.
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Table B-34 Sales Team Form Components

Component Type Description

Group Text field Displays the sales team member’s group, as defined
in Resource Manager.

Phone Read-only field Displays the phone number.

Email Read-only field Displays the email address.

Keep Checkbox Determines if sales team member can be replaced by

automatic territory manager reassignment.

Primary Checkbox Determines if the sales team member is the primary
sales agent for the quote. Can only be assigned to one
sales team member.

Apply Button Appl.ies the changes and returns user to the Oracle
Quoting form.

Cancel Button Cancels unapplied changes and returns user to the
Oracle Quoting form.

See Also:
= Section 32.2, "Adding a Resource to the Quote Sales Team"

B.32 Service Iltems Form

Select the Service Items action from the Actions menu to view information on
included services and extended services.

The following table describes the components on the Service Items form.

Table B-35 Service Items Form Components

Component Type Description
Service For Section Displays information about the selected product.
Source Read-only field Displays the reference source: Current Quote,
Pending Order or Installed Base.
Product Read-only field Displays the product that services are associated to.
Description =~ Read-only field Displays a short description for the serviceable
product.
UuOM Read-only field Displays the unit of measure for the serviceable
product.
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Table B-35 Service Items Form Components

Component Type Description

Quantity Read-only field Displays the serviceable product quantity.

Order Date ~ Read-only field Displays the order date for the serviceable product.
Appears if reference source is Installed Base or
Pending Order.

Order Read-only field Displays the order number for the serviceable

Number product.
Appears if reference source is Installed Base or
Pending Order.

Order Line Read-only field Displays the order line number for the serviceable

Number product.
Appears if reference source is Installed Base or
Pending Order.

System Read-only field Displays the system name for the serviceable product.
Appears if reference source is Installed Base or
Pending Order.

Serial Read-only field Displays the system name for the serviceable product.

Number Appears if reference source is Installed Base.

Installed At Read-only field Displays the installed at address for the serviceable

Address product.

Appears if reference source is Installed Base.

Selected Services

Section

Displays information on the service included with the
serviceable product.

Product Read-only field Displays the number of the included service.

Description ~ Read-only field Displays the description of the included service.

Start Date Read-only field Displays the start date of the included service.

Duration Read-only field Displays the duration of the included service.

Period Read-only field Displays the period of the included service.

Included Read-only Checked if the service product is an included
check box warranty.

Available Services Section

Displays information about additional services you
can purchase.
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B.33 Split Lines Form
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Table B-35 Service Items Form Components

Component Type Description
Product Read only Displays the product number of the extended service.
column
Description ~ Read only Displays a description for the extended service.
column
Add to Quote Button Adds the selected extended service to the quote,
closes the form and returns user to the Oracle Quoting
form.
Disabled if there are no applicable services.
Cancel Button Closes the form and returns user to the Oracle
Quoting form.
See Also:

= Section 26.4, "Adding a Service to the Quote"

Use the Split Lines action from the Actions menu to split a line.

The following table describes the components on the Split Lines form.

Table B-36 Split Lines Form Components

Component Type Description

Line Read-only field Displays the line number of the product to be split.

Product Read-only field Displays the number and name of the product for
which you want to split the line.

Description Read-only field Displays the name of the product.

UuOM Read-only field Displays the UOM of the product for which you want
to split the line.

Quantity Read-only field Displays the total quantity of the line.

Split Quantity Text field Enter the quantity that you want to split to a new line.

Total Read-only field Displays the total quantity of the split lines.

Apply Button Splits the original line into the designated quantity

and returns user to the Quote Lines tab, where the
split quantities show up as separate lines.




Tax Details Form

Table B-36 Split Lines Form Components

Component Type Description

Cancel Button Cancels changes and returns user to the Quote Lines
tab.

See Also:

= Section 26.12, "Splitting Lines"

B.34 Tax Details Form

Select the Tax Details action from the Quote Lines tab’s Actions menu to view tax
details for lines in the quote.

The following table describes the components on the Tax Details form.

TabIeB—37Tax Details Form Components

Component Type Description

Line Read-only field Displays the line number for which you are viewing
tax details.

Product Read-only field Displays the product number.

Description Read-only field Displays the product name.

Currency Read-only field Displays the currency.

uoOM Read-only field Displays the UOM.

Quantity Read-only field Displays the quantity.

List Price Read-only field Displays the list price.

Selling Price Read-only field Displays the selling price.

Line Tax Details

Section

Displays the tax details.

Tax Code Read-only field Displays the tax code(s) applied to the line.

Rate Read-only field Displays the rate for the corresponding tax code.

Amount Read-only field Displays the tax amount for the corresponding tax
code.

Total Read-only field Displays the total tax amount for the line.
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Table B-37 Tax Details Form Components

Component Type Description

OK Button Closes this form, and returns user to the Oracle
Quoting form.

See Also:
= Section 26.13, "Entering Tax Details"

B.35 Publish Form

Select the Web Publish Quote action from the Actions menu to publish quotes to a
web storefront.

The following table describes the components on the Publish form.

Table B-38 Publish Form Components

Component Type Description

Quote Name Read-only field Displays current quote name.

Quote Number Read-only field Displays current quote number and version.
Customer Name Read-only field Displays customer name.

Account Number  Read-only field Displays customer account number.

Contact Number ~ Read-only field Displays customer contact name.

Opportunity Name Read-only field Displays the opportunity name if the quote was
created from an opportunity.

Username Text If mandatory text field appears, the quote-to
field/Read-only customer is not an FND_USER. Enter a username
field for the quote-to customer.

Read-only when quote-to customer is an FND_
USER.

Web Publish in Drop-down Select a specialty store where the quote will be
menu published. Lists only stores where the quote version

is eligible for publication.

Send Email To Prompt Prompt

Existing Radio button Select an existing address where publication
Address and Drop-down notifications will be sent.
menu

B-82 Oracle Quoting User Guide



Customer History Form

Table B-38 Publish Form Components

Component Type Description
New Address Radio button Enter a new email address where publication
and Text field notifications will be sent.
Comments Text field Optionally, enter comments about the web
publishing.
Submit Button Submits the web publishing request.
See Also:

= Section 31.4, "Web Publishing a Quote"

B.36 Customer History Form

Use the Customer History menu option, from the Reports menu, to view the history
of a specific customer account. The Customer History shows both quotes and
orders.

The following table describes the components on the main Customer History form.

Table B-39 Customer History Form - Main Components

Component Type Description

Customer Type Read-only field Displays the customer type of the subject of the
customer history.

Customer Read-only field Displays the name of the quote-to customer that is the
subject of the customer history.

Account LOV text field Displays the quote-to account number associated with
the customer that is the subject of the customer
history.

You can use the LOV to choose other accounts for the
customer, if any exist. You can also select ALL, to see
information for all accounts for the customer. If you
choose another account, the screen refreshes with
quote and order information for that account.

View Quote Button Displays the quote for the order that is highlighted in
the Quote tab of the customer history form. Whether
or not you can modify this quote depends on the
quote status.
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Table B-39 Customer History Form - Main Components

Component

Type

Description

View Order

Button

Displays the details of an order in the Order
Management Sales form. Once the order is displayed
in the Order Management form, you can modify it
depending on the order status and the setting of the
profile option ASO: OM Access.

If ASO: OM Access is set to Full, you can modify the
order in OM. If ASO: OM Access is set to Read-only,
you cannot modify the order.

Cancel

Button

Closes the customer history window and returns user
to the Oracle Quoting form.

The following table describes the components on the Customer History form >

Quotes tab.

Table B-40 Customer History Form - Quote Tab Components

Component Type Description
Quote Name Column Displays the names of the quotes belonging to the
heading customer displayed in the header of the Customer
History form.
Quote Number Column Displays the quote number for the quote.
heading
Account Number Column Displays the quote-to account number for the
heading customer displayed in the header of the Customer
History form. If the customer has more than one
account, you can switch the account number in the
header of the Customer History form, or select ALL to
see the information for all of the customer’s accounts.
Quote Status Column Displays the quote status.
heading
Quote Total Column Displays the total amount of the quote.
heading
Currency Code Column Displays the currency used on the quote.
heading
Quote Expiration Column Displays the quote expiration date.
Date heading
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Table B-40 Customer History Form - Quote Tab Components

Component Type Description
Contact Name Column Displays the name of the quote-to contact for the
heading quote. Optional in the Oracle Quoting form, so this
column may be blank.
Salesperson Column Displays the name of the primary sales agent for the
Name Heading quote.
Object Read-only text Displays the source or outcome of the quote. For
box example, a quote is created from an opportunity, or a
quote is submitted and becomes an order.
When you highlight a quote in the table above, these
fields populate with the appropriate information. If a
quote does not have any related objects that meet the
search criteria, the field should remain blank.
Number Read-only text Displays the object ID number.
box
Status Read-only text Displays the status of the object in its respective
box application.
Relationship Read-only text Displays the relationship of the object to the quote. For
box example, if the object is an opportunity, the

relationship is Opportunity to Quote. If the object is
an order, the relationship is Quote to Order.

The following table describes the components on the Customer History form >

Order tab.

Table B-41 Customer History Form - Order Tab Components

Component Type Description
Order Number Column Displays the order number for an order in Order
heading Management. If the order was created from a quote,
the order number serves as a confirmation number in
Oracle Quoting.
Order Status Column Displays the current status of the order in Order
heading Management. There are two statuses in Oracle

Quoting that you can apply to quotes that are
converted to orders: Booked and Entered,. Booked is
the default value for the profile option ASO: Default
Order State.
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Table B-41 Customer History Form - Order Tab Components

Component Type Description
Creation Date Column Displays the date the order was placed.
heading
Order Total Column Displays the total amount charged for the order. The
heading order total includes adjustments and tax information.
Currency Code Column Displays the currency used for the order.
heading
Account Number Column Displays the account number for the quote-to
heading customer displayed in the Customer History form. If

the customer has more than one account, you can
choose one of their other accounts in the header
Account field, or select ALL to view information for
all of the customer’s accounts.

Quote Number Column Displays the quote number concatenated with the
heading version number, from which the order was created.
This column should be blank if the order was not
created from a quote.

Quote Name Column Displays the name of the quote from which the order
heading was created. Should be blank if the order was not
created from a quote.
Contact Name Column Displays the name of the quote-to contact for the
heading order. This contact field is optional in the Oracle

Quoting form and this column should therefore
remain blank if a contact does not exist.

Salesperson Column Displays the primary sales agent for the order.
Name Heading
See Also:

= Section 26.15, "Viewing the Quote Versions"
= Section 26.1, "Modifying a Customer Quote"
= Section 26.17, "Viewing the Order History for a Customer"

B.37 Quote, Customer Search Form > Quote View

Use this form to search for quotes or customers.
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The following table describes the components on the Quote, Customer Search Form

> Quote view.

Table B-42 Quote, Customer Search Form > Quote View Components

Component

Type

Description

Find

Drop-down
menu

Select a search parameter. Possible values are:
Quote, Organization, Person. Defaults to Quote
unless invoked from the Quote To customer,
Quote To account, or Quote To contact fields. In
these cases, defaults to Organization.

Basic

Tab

Area where you conduct a basic search for the
quote.

Folder Icon

Button

Accesses private and public folders created by
user.

Customer Name

LOV text field

Enter or select the customer name on the quote
you are searching for. The LOV will by sorted by
customer name and account number and will
show the following fields: customer name,
account number, and customer type.

ASO: View Customers Without Accounts must
not be used to filter the LOV results.

Account Number

LOV text field

Enter or select the account number of the quote
you are searching for. The LOV will be sorted by
account number and will show the following
fields: account number, account description,
customer name, and customer type.

Contact Name

Text field

Enter the contact name on the quote you are
searching for.

Quote Name

Text field

Enter the quote name of the quote you are
searching for.

Quote Number

Text field

Enter the quote number of the quote you are
searching for.

Quote Status

LOV text field

Enter or select the quote status of the quote you
are searching for.

Product

LOV text field

Enter or select the product on the quote you are
searching for. The LOV will show all active parts
and will show the following fields: product and
description.
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Table B-42 Quote, Customer Search Form > Quote View Components

Component Type Description
Expiration Date ~ Date field Enter the start date of the expiration date range of
(From) the quote you are searching for.
Expiration Date Date field Enter the end date of the expiration date range of
(To) the quote you are searching for.
PO Number Text field Enter the PO number of the quote you are
searching for.
Search Button Executes search.
Close Button Closes the Quote, Customer Search form.
Clear Button Clears the search criteria fields.
Results (Quote) Section Displays results of the Quote search.
Quote Name Read-only Displays quote name.
column
Quote Number  Read-only Displays quote number.
column
Customer Name Read-only Displays customer name.
column
Account Read-only Displays customer account.
column
Contact Name Read-only Displays contact name.
column
Status Read-only Displays quote status.
column
Web Published Read-only Displays if quote is web published.
column
Expiration Date ~ Read-only Displays expiration date of quote.
column
Quote Total Read-only Displays quote total.
column
Opportunity Read-only Displays opportunity name.
Name column
Order Number Read-only Displays order number.
column
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Table B-42 Quote, Customer Search Form > Quote View Components

Component Type Description

Quote Version Read-only Displays quote version.

column

View Button Displays selected quote.

New Quote Button Accesses the Oracle Quoting form.

Advanced Tab Area where you conduct an advanced search for
the quote.

Item LOV text field  Enter or select a search parameter. The
parameters are: customer name, customer type,
account number, contact name, quote name,
quote number, quote version, quote status,
product, expiration date, po number, opportunity
name, opportunity number, phone number
(Quote To customer), currency, price list, order
type, agreement, quote amount, creation date,
update date, web published, primary
salesperson, primary sales group, salesperson,
sales group, sales channel, and source name.

Condition LOV text field Enter or select a search condition. The conditions
are: Less Than, Equal To, Greater Than, and
Like.

Note: The value Like implies a keyword % search.

Value Text field Enter a value for the parameter selected in the
item field.

Search Button Executes search.

Close Button Closes the Quote, Customer Search form.

Clear Button Clears the search criteria fields.

Results Section Displays results of the Quote search.

Quote Name Read-only Displays quote name.

column

Quote Number Read-only Displays quote number.

column

Customer Name Read-only Displays customer name.

column

Account Read-only Displays customer account.

column
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Table B-42 Quote, Customer Search Form > Quote View Components

Component Type Description
Contact Name Read-only Displays contact name.
column
Status Read-only Displays quote status.
column
Web Published Read-only Displays if quote is web published.
column
Expiration Date ~ Read-only Displays expiration date of quote.
column
Quote Total Read-only Displays quote total.
column
Opportunity Read-only Displays opportunity name.
Name column
Order Number Read-only Displays order number.
column
Quote Version Read-only Displays quote version.
column
View Button Displays selected quote.
New Quote Button Accesses the Oracle Quoting form.
See Also:

= Section 21.2, "Searching for Quotes"

B.38 Quote, Customer Search Form > Organization View
Use this form to search for quotes or customers of type Organization.

The following table describes the components on the Quote, Customer Search Form
> Organization view
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Table B-43 Quote, Customer Search Form > Organization View Components

Component

Type

Description

Find

Drop-down menu

Select a search method. Possible values are:
Quote, Organization, Person. Defaults to Quote
unless invoked from the Quote To customer,
Quote To account, or Quote To contact fields. In
these cases, defaults to Organization.

Folder Icon

Button

Opens the private and public folders created by
the user.

Customer Name

LOV text field

Enter or select a customer name by which to
search.

If ASO: View Customers Without Accounts is
set to Yes, LOV shows all parties of type
Organization that match the text entered.

If ASO: View Customers Without Accounts is
set to No, LOV shows parties of type
Organization that match the text entered and
have active accounts.

Account Number

LOV text field

Enter or select an account number by which to
search.

LOV lists active accounts for the customers
matching the account number entered.

Taxpayer ID

Text field

Enter a taxpayer ID by which to search. Also
known as fiscal code or NIE.

Tax Registration
Number

Text field

Enter a tax registration number by which to
search. Also known as VAT number.

Contact Last Name

Text field

Enter a contact last name by which to search.

Contact First Name

Text field

Enter a contact first name by which to search.

Contact Phone

Text field

Enter a contact phone number by which to
search.

Original Reference

Text field

Enter a customer reference by which to search.
An original reference is the customer identifier in
the external system from which the customer was
imported.
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Table B-43 Quote, Customer Search Form > Organization View Components

Component Type Description

Fuzzy Search Button Executes a fuzzy search. Fuzzy search
functionality is provided by TCA.

Displays an error message if the number of
search results exceeds the setting ASO: Max
Number of Results in Search.

Exact Search Button Executes an exact search.

Displays an error message if the number of
search results exceeds the setting ASO: Max
Number of Results in Search.

Close Button Closes the form and returns user to the Oracle
Quoting form.

Clear Button Clears all search fields.
Results Section Displays results of the search.
Customer Name Read-only Displays the customer name.
column
Account Read-only Displays the customer account.
column
Contact Name  Read-only Displays the contact name.
column
Contact Phone  Read-only Displays the contact phone.
column
Apply to Quote Button Accesses the Oracle Quoting form and applies

search results to it.

See Also:

Section 21.3, "Searching for Customers"

B.39 Quote, Customer Search Form > Person View
Use this form to search for quotes or customers of type Person.

The following table describes the components on the Quote, Customer Search form
> Person view.
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Table B-44 Quote, Customer Search Form > Person View Components

Component Type Description
Find Drop-down Select a search method. Possible values are: Quote,
menu Organization, Person. Defaults to Quote unless

invoked from the Quote To customer, Quote To
account, or Quote To contact fields. In these cases,
defaults to Organization.

Folder Icon Button Opens the private and public folders created by the
user.

First Name Text field Enter a first name by which to search.

Last Name Text field Enter a last name by which to search.

Account Number LOV text field Enter or select an account number by which to search.

LOV lists active accounts for the customer matching
the account number entered.

Phone Text field Enter a phone number by which to search.

Taxpayer ID Text field Enter a taxpayer ID by which to search. Also known
as fiscal code or NIF.

Tax Registration ~ Text field Enter a tax registration number by which to search.

Number Also known as VAT number.

Original Reference Text field Enter a customer reference by which to search. An

original reference is the customer identifier in the
external system from which the customer was
imported.

Fuzzy Search Button Executes a fuzzy search. Fuzzy search functionality is
provided by TCA.

Displays an error message if the number of search
results exceeds the setting ASO: Max Number of
Results in Search.

Exact Search Button Executes an exact search.

Displays an error message if the number of search
results exceeds the setting ASO: Max Number of
Results in Search.

Close Button Closes the form.
Clear Button Clears all search fields.
Results Section Displays results of the Person search.
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Table B-44 Quote, Customer Search Form > Person View Components

Component Type Description
Customer Read-only Displays the customer name.
Name column
Account Read-only Displays the account number.
column
Last Name Read-only Displays the last name.
column
Phone Read-only Displays the phone number.
column
Apply to Quote Button Applies the selected customer to the quote. Displays
the Quoting form.
See Also:

= Section 21.3, "Searching for Customers"

B.40 Create Quote From Opportunity Form

Use the Create Quote From Opportunity in Oracle Telesales to create a quote from

an opportunity.

The following table describes the components on the Create Quote From
Opportunity form in Oracle Telesales.

Table B-45 Create Quote From Opportunity Form Components

Component

Type

Description

Quote Information

Section

Fields pertaining to quote information.

Quote Name

Text field

Enter a name for the quote.

Quote Read-only field Quote number is generated after the quote has been
Number saved.

Expires On Date field Enter the date when the quote expires.

Order Type  LOV text field  Enter or select the order type for the quote.
Agreement LOV text field Enter or select the agreement for the quote.

Price List LOV text field  Enter or select the price list for the quote.
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Table B-45 Create Quote From Opportunity Form Components

Component Type Description
Currency LOV text field  Enter or select the currency. Defaults to the currency
of the default price list, and then to the currency in the
opportunity.
Contract LOV text field  Enter or select the contract template for the quote.
Template
Sales Information  Section Fields pertaining to sales information.
Salesperson ~ LOV text field  Enter or select the salesperson for the quote.
Sales Group  LOV text field  Enter or select the sales group for the quote.
Opportunity ~ Read-only field Displays the opportunity name.
Sales Channel LOV textfield Enter or select the sales channel. Defaults to the value
of the source opportunity.
Source Name LOV textfield Enter or select the source name. Defaults to the
source code in the source opportunity.
Customer Section Fields pertaining to customer information.
Information
Customer Read-only field Displays the quote customer.
Account LOV text field  Enter or select the account number for the quote
customer.
Mandatory if the Quote To customer has an active
account.
Contact LOV text field  Enter or select the contact for the quote customer.
Address LOV text field  Enter or select the address for the quote customer.
Oval Button  Button Displays the Address Details form: address name,

address lines 1 - 4, address phonetic, PO box, suite,
city, state, postal code, county, province, country,
timezone.

City Read-only field Displays the address city.

State Read-only field Displays the address state.
Postal Code  Read-only field Displays the address postal code.
County Read-only field Displays the address county.
Province Read-only field Displays the address province.
Country Read-only field Displays the address country.
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Table B-45 Create Quote From Opportunity Form Components

Component Type Description
Copy Tasks Read-only Select to copy tasks from the opportunity to the quote.
checkbox
Copy Notes Read-only Select to copy notes from the opportunity to the
checkbox quote.
Copy Attachments Read-only Select to copy attachments from the opportunity to
checkbox the quote.
Create Quote Button Creates a quote from the opportunity and displays the
quote in the Oracle Quoting form.
Cancel Button Cancels the create quote from opportunity process
and returns user to Oracle Telesales.
See Also:

= Section 20.3, "Creating a Quote From an Opportunity”

B.41 Order Confirmation Form

The Order Confirmation form appears after an order has been placed.

The following table describes the components on the Order Confirmation form.

Table B-46 Order Confirmation Form Components

Component Type Description

Order Number Read-only field Displays the order number.
Shipping Method Read-only field Displays the shipping method.
Order Total Read-only field Displays the order total.

Currency Read-only field Displays the currency.

Ship To Section Displays the Ship To address details
Customer Read-only field Displays the Ship To customer.
Account Read-only field Displays the Ship To account number.
Contact Read-only field Displays the Ship To contact.
Address Read-only field Displays the Ship To address.

Oval Button Button Accesses the Address Detail form.
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Table B-46 Order Confirmation Form Components

Component

Type

Description

City

Read-only field

Displays the Ship To city.

State

Read-only field

Displays the Ship To state.

Postal Code

Read-only field

Displays the Ship To postal code.

Country

Read-only field

Displays the Ship To country code.

OK

Button

Closes the form and return the user to the Oracle
Quoting form.

See Also:

= Section 33.2, "Placing an Order"

B.42 Quote Status Setup

Use this form to define quote statuses and quote status transitions.

The following table describes the components on the Quote Status Setup forms.

Table B-47 Quote Status Form Components

Component Type Description
Quote Statuses Section Displays quote status information.
Code Text field Enter a code for the status.
Read only if the status is not user maintainable.
Name Text field Enter a name for the status.
Description ~ Text field Enter a status description.
Read only if the status is not user maintainable.
Update Checkbox Indicates if the status is read-only or updateable.
Allowed Read only if the status is not user maintainable.
Auto Version Checkbox Determines if a transition to the status automatically
creates a new version.
Enabled Checkbox Determines if the status is user maintainable. If the

status is not user maintainable, this field is not
updateable.
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Table B-47 Quote Status Form Components

Component Type Description

Allowed Section Displays quote status transition information.

Transition to

Status

Code LOV text field  Select the status to which you want to transition.
Read only if the status transition is a system driven
transition.

Name Read-only field Displays the status name.

Description Read-only field Displays the status description.

Transitioned by Read-only field Displays the transition root.

Displays USER if a transition to that state can be done
from either the user interface or application. For
example, you can change the status using an LOV.
Quoting automatically populates this field with
USER, if you create a new status transition.

Displays APPLICATION if a transition can only be
triggered by an event occurring in the application, for
example, placing an order.

Enabled Checkbox Determines if the transaction is allowed.

See Also:
= Section 20.1.1, "Understanding Quotes"
s Section 20.1.2, "Quote Status"

B.43 Sales Supplement Setup
Use this form to set up Sales Supplement templates.

The following table describes the components on the Templates tab of the Sales
Supplement form.

Table B-48 Sales Supplement - Templates Tab Components

Component Type Description
Template Section Displays template information.
Name Text field Enter a template name.
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Table B-48 Sales Supplement - Templates Tab Components

Component Type Description
Description ~ Text field Enter a description for the template.

Sections Section Displays information about the template sections.
Sequence Text field Enter the sequence in which the sections appear.
Name LOV field Enter the section name.

The following table describes the components on the Sections tab of the Sales

Supplement form.

Table B-49 Sales Supplement - Sections Tab Components

Component Type Description

Section Section Displays section information.
Name Text field Enter the section name.
Description ~ Text field Enter a description for the section.
Component  LOV text field Enter or select a component type for the section.
Type
Response LOV text field  Enter or select a response type for the section.
Type
Instruction Text field Enter an instruction for the section.

Components Section Displays component information.
Sequence Numeric field  Enter the sequence in which the components appear.
Component  LOV text field  Select the component name. Values are all
Name components with the type Component.
Presentation =~ LOV text field  Select the presentation style. Values are Checkbox,
Style List of Values, List of Values with Blank, Radio

Group, and Text.

Available only if type is Component, component type
is Question, and response type is Predefined
Response.
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Table B-49 Sales Supplement - Sections Tab Components

Component Type Description

Default Value LOV text field  Select a default value. Values are all responses in the
component-response set.

Available only if type is Component, component type
is Question, and response type is Predefined
Response.

Mandatory if presentation style is drop-down without
blank.

The following table describes the components on the Components tab of the Sales
Supplement form.

Table B-50 Sales Supplement - Components Tab Components

Component Type Description

Component Section Displays component information.
Name Text field Enter a component name.

Mandatory field.

Description ~ Text field Enter a description for the component.
Component  LOV text field Enter or select a component type for the section.
Type
Response LOV text field  Enter or select a response type for the section.
Type
Instruction Text field Enter an instruction for the section.

Responses Section Displays response information.
Sequence Text field Enter the sequence in which the responses appear.
Response LOV text field  Enter or select a response from a list of predefined

responses.

The following table describes the components on the Responses tab of the Sales
Supplement form.

Table B-51 Sales Supplement - Responses Tab Components

Component Type Description

Name Text field Enter a name.
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Table B-51 Sales Supplement - Responses Tab Components

Component Type Description

Description Text field Enter a response description.

Oracle Quoting Forms User Interface Reference B-101



Sales Supplement Setup

B-102 Oracle Quoting User Guide



Glossary

Advanced Pricing

A member of the Oracle Order Management and Logistics application module. It is
integrated within Oracle Quoting, as a setup mechanism and pricing engine that
executes pricing and promotional calculations for Order Management.

AK region

Area where a user with Application Developer Common Module can customize
specific areas of responsibility and modify LOVs, drop down menus, buttons, and
regions in the HTML UL

API

An Application Programming Interface (API) is a published interface to accomplish
a business or scientific function. An API defines a contract to its users by
guaranteeing a published interface, but hides its implementation details.

Approval Canceled

A seeded quote status in Oracle Quoting, indicating that the sales representative has
canceled the approval process.

Approval Pending

A seeded quote status in Oracle Quoting, indicating that the quote is pending
approval, and is read-only.

Approval Rejected

A seeded quote status in Oracle Quoting, indicating that the approval has been
rejected by the approvers.
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Approved

A seeded quote status in Oracle Quoting, indicating that the quote has been
approved by the necessary approvers.

ATP

Availability to Promise. The quantity of current on-hand stock, outstanding receipts
and planned production that has not been committed through a reservation or
placing demand. In Oracle Inventory, you define the types of supply and demand
that should be included in your ATP calculation.

AR

Oracle Accounts Receivable, which is a component of the Oracle Financials
application module.

availability

The percentage or amount of scheduled time that a computing system provides
application service.

attachments

Attachments such as documents or URLs for a single line item on a quote.

batch pricing

The entire quote is priced including any manual /automatic adjustments, pricing
qualifiers, pricing attributes and promotions via a concurrent manager in the
Advanced Pricing module. The quote is considered fully priced after such a pricing
call.

Bill To customer

The name and financial account of the customer who is invoiced for the goods or
service ordered.

BLAF

Browser look and feel.

BOM item type

An item classification that determines the items you can use as components in a Bill
of Material. BOM item types include standard, model, option class, and planning
items.



button

An object on the Ul that accesses a form when the user places the cursor on top of it
and clicks on it.

child

Referring to an itemized level that is below a referenced level.

concatenation

Information from two fields merged together in the output.

Configurator

A member for the Oracle Order Management and Logistics application module. It
is integrated within Oracle Quoting, and allows customers to pick related products
to products they have already selected and configure model products.

contact

A contact is an individual that represents an organization.

Contract Canceled

A seeded quote status in Oracle Quoting, indicating that the contract has been
canceled by the contract administrator.

Contract Pending

A seeded quote status in Oracle Quoting, indicating that the contract is in review
with the contract specialist.

Contract Required

A seeded quote status in Oracle Quoting, indicating that the contract specialist
needs to author and approve a contract after the approval process.

container model

Model where associated components are dynamically selected based on user action
and Configurator rules.

contract

An agreement between the seller and the end user whereby the end user agrees to
purchase the seller’s licenses, products and services per the conditions of the
seller’s current standard agreement.
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credit check

Ability to gauge customer credit worthiness during the quoting process. Oracle
Order Management’s credit check is integrated with Quoting.

cross-sell

A cross-sell item is an item that you can sell as an addition to an item in your quote.

date field

A field in which the user may only enter or select a date.

descriptive flexfield

A field that your organization can extend to capture extra information not
otherwise tracked by Oracle Applications. A descriptive flexfield appears in your
window as a single character, unnamed field. Your organization can customize this
field to capture additional information unique to your business.

discount

Reduces the price by a fixed amount or percentage, or provides a new price.

Draft

A seeded quote status in Oracle Quoting, indicating the initial status of the quote.

financial account

Information for a customer that provides their Quote To, Bill To, Ship To and Sold
To information. Also provides an account number for the customer.

Forms Ul

User interface developed with a Forms based platform.

fuzzy search

Widens the scope of a search and finds data comparable to the search criteria. The
fuzzy search method uses Word Replacement Rules to map a word, abbreviation, or
special character that might be entered by a user as a search criteria to a similar
word.

header level

Level of information for a quote that contains information not related to individual
products, licenses, services, or prices.



HTML UI
User interface developed on an HTML platform.

Inactive

A seeded quote status in Oracle Quoting indicating that no further activity is
allowed on the quote.

installed base

A customer’s installed base lists the products and services installed at the customer
site.

instance

A single representation of an item.

Intermedia

A text search utility that allows keyword searches for greater flexibility when
conducting searches.

item attribute

A feature associated with a particular item type, also known as an item attribute.
An item type attribute is defined as a variable whose value can be looked up and set
by the application that maintains the item. An item type attribute and its value is
available to all activities in a process.

line level

All information associated with a line. It can include price list, adjustment, sales
credit, and tax detail information.

lost

A quote status indicating that the customer did not accept the quote.

LoV

A list of valid values in a text field, from which the user must choose.

LOV text field

A field where the user may either choose a value from an LOV, or type in the name
of the value. The typed value must be a value existing in the LOV.
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mandatory field

Field that must be filled out by the user in order to move to the next field or form.

multiple instantiation

The ability to configure a child model of a top level multiple times in the same
configuration. The child model is only listed in the BOM once but can be spawned
as many times as needed in the configuration.

non-quota sales credit

See non-revenue sales credit.

non-revenue sales credit

Sales credit you assign to your salespeople not associated with your invoice lines.
This is sales credit given in excess of your revenue sales credit.

non-standard contract

A contract that has atypical terms and conditions for purchasing software, products
and services. Non-standard contracts must go through the approvals process before
a quote will be provided with a non-standard contract.

numeric field

A tield where the user may only enter numeric values.

optional field

Field that is not required by the user to filled in order to move to the next field or
form.

opportunity

An opportunity is created in Oracle Sales Online or Oracle Telesales, whereby a
sales representative initiates the sales process with initial customer contact, or lead,
and ends when the sales representative creates a sale or loses the sale. The stored
information is stored as an opportunity. Opportunities can be converted into quotes
in Oracle Quoting.

Order Submitted

A seeded quote status in Oracle Quoting indicating that the quote has been
submitted as an order to Oracle Order Management.



order type

An order transaction type can be for any of the following order categories: ORDER,
RETURN or MIXED. Line transaction types can be for any of t he categories:
ORDER or RETURN. When an order is created with a particular transaction type,
the order category code determines which lines are permitted for that order. If the
category code is ORDER, then the order can have only regular Lines. If the category
code is RETURN, then the order can have only return lines. If the category code is
MIXED, then the order can have both kinds of lines.

partial configuration

The ability to modify part of an existing configuration without launching the entire
configuration in Configurator.

price list

Price lists contain prices and currencies associated with products and services.

product number

Unique instance identifier in Installed Base.

profile option

Features in the Oracle Quoting application that one can set to affect the appearance,
performance and functionality of the application according to each user. Can also
be set at site, application and responsibility levels.

quota sales credits

See revenue sales credit, non-revenue sales credit.

quote

A quote is an offer to a customer that contains priced items and shows a total price
for the offer. You create a quote when you accumulate items and any associated
services and save it.

Quote To customer

The person or organization for whom the quote is being created for.

quote number

Oracle Quoting automatically assigns a quote number to the quote if the profile
option ASO: Automatic Numbering is set to Yes. The quote number is composed
of the quote number itself and a version number that increments each time a new
quote version is created.
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quote status

The quote status indicates the stage of preparation that a quote is in. There are
seeded quote statuses: Approval Canceled, Approval Pending, Approval
Rejected, Approved, Contract Canceled, Contract Pending, Contract Required,
Draft, Inactive, Order Submitted, and Store Draft.

quote version

The quote version, which is part of the quote number, indicates the latest version of
the quote. The version increments when the status of the quote is changed or if the
quote is copied into a revision.

read-only field

Changes cannot be made to the information, if any, in a read-only field, it can only
be viewed.

reconfigure

The ability to make changes to a configured model that has already been purchased
by the Quote To customer.

related items

An acceptable substitute you define for an item so you may receive the item if your
supplier cannot ship the original item on the purchase order.

re-order

The customer is purchasing a model with the same configuration from a previous
order.

resources

Anything of value, except material and cash, required to manufacture, cost, and
schedule products. Resources include people, tools, machines, labor purchased from
a supplier, and physical space.

returnable

An item attribute indicating that an item can be used for a trade-in.

revenue sales credit

Sales credit you assign to your salespeople that is based on your invoice lines. The
total percentage of all revenue sales credit must be equal to 100% of your invoice
lines amount. Also known as quota sales credits. See non-revenue sales credit, sales
credit.



role

One or more users grouped by a common responsibility or position.

role types

A collection of roles associated with a particular CRM module.

search string

Parameters entered into the criteria field when a user conducts a search.

section

A part of the form that is delineated from the other parts of the form by borders
and/or a category name for the section.

seeded

Data already included and/or already a part of the standard Oracle Quoting
application.

serviceable, serviceable item

An item attribute indicating that a service can be associated with the item.

service reference

A form that links a service to its associated serviceable item.

shippable
An item attribute indicating that the item can be shipped.

Ship To customer

The name and financial account information of the customer to whom the goods or
services are delivered.

shopping cart

A collection of items that a customer selects for purchase in an Oracle iStore 11i Web
store. In the context of the quote creator, the shopping cart is referred to as a quote.
Sold To customer

The name and financial account of the customer. The sold-to customer is financially
responsible for the order.
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standard contract

A contract that has Oracle's typical terms and conditions for purchasing Oracle
software, products and services.

Store Draft

A seeded quote status in Oracle Quoting that indicates the quote is for Oracle iStore
internal use only. Allows Oracle iStore to have a Draft to Order flow that is separate
from Oracle Quoting.

substitute

A substitute item is an item you can substitute for one that is not currently
available.

surcharge

Increases the price by a fixed amount or percentage or provides a new price.

system administrator

Individuals who have the ability to set profile options and define users.

taxpayer identification number

Also known as fiscal code or NIF.

taxpayer registration number
Also known as Value Added Tax (VAT) number.

tax exempt

A customer, business purpose, or item to which tax charges do not apply.

TeleSales

An application which is part of the Oracle Sales application module. It integrates
with Oracle Quoting to complete the Opportunity to Quote to Order sales cycle.
trade-in, trade-in item

A trade-in is performed when a customer wants to return an item for credit against
an order.

ul

User Interface.



UOM

Unit of measure.

up-sell

An up-sell item is a more expensive model that you can substitute for an item in
your quote.

web publish

Publishing a quote to a customer via the web, where the quote can be viewed by the
customer via web instead of a hard copy or fax.

wildcard

A special character within a search parameter that tells the application to search for
all records that are similar to the search parameter. In Oracle Quoting, % is the
wildcard character. For example, if you enter order% as a quote name search
parameter, the application returns all quotes with names that begin with order.
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adding products to quote (Forms), 26-3
adding products to quote (HTML), 10-2
adding service products (HTML), 10-5
adding services to quote (Forms), 26-9
address and payment

HTML, 9-2
address and payment (Forms), 25-2
address defaulting (HTML), 9-2
addresses (Forms)

bill-to, 25-2

quote-to, 25-2

ship-to, 25-2
addresses (HTML)

bill-to, 9-2

creating, 8-8

quote-to, 9-2

ship-to, 9-2
adjusting prices (Forms), 23-13

Price Adjustments form, 23-15
adjustments (Forms)

manual, 23-4

price break, 23-10
adjustments (HTML)

manual, 7-3
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initiating, 28-2
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changing base UOM (HTML), 10-24
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configuring an product (Forms), 26-12
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selecting, 20-9
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interMedia (Forms), 21-9
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line categories (Forms), 26-23

line numbers (Forms), 26-4
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